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Notice 

Every effort was made to ensure that the information in this document was 
accurate at the time of release. However, information is subject to change without 
notice, and JDS Uniphase reserves the right to provide an addendum to this 
document with information not available at the time that this document was 
created. 
 

Copyright 

© Copyright 2014 JDS Uniphase Corporation. All rights reserved. JDSU, Network 
and Service Enablement, and its logo are trademarks of JDS Uniphase 
Corporation (“JDS Uniphase”). All other trademarks and registered trademarks are 
the property of their respective owners. No part of this document may be 
reproduced or transmitted electronically or otherwise without written permission of 
the publisher. 
 

Copyright release 

Reproduction and distribution of this document is authorized for Government 
purposes only. 
 

Trademarks 

JDSU and CellAdvisor are trademarks or registered trademarks of JDSU in the 
United States and/or other countries. 
 
Google Maps and Google Earth are either trademarks or registered trademarks of 
Google in the United States and/or other countries. 

 
Bluetooth is a trademark or a registered trademark of Bluetooth Special Interest 
Group (SIG) Inc. in the United States and/or other countries. 
 
Android is a trademark or a registered trademark of Google in the United States 
and/or other countries. 
 
iOS is a trademark or a registered trademark of Apple Inc. in the United States 
and/or other countries. 
 
Windows and Windows 7 are either trademarks or registered trademarks of 
Microsoft Corporation in the United States and/or other countries. 
 
Specifications, terms, and conditions are subject to change without notice. All 
trademarks and registered trademarks are the property of their respective 
companies. 
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Foundation (http://www.apache.org/). 
 
This product used free library for JPEG image compression written and distributed 
by Independent JPEG Group or IJG (http://www.ijg.org/). 
 
See “Viewing OSS license” on page 40 for more information. 
 

Ordering information 

This document is a product of JDSU, issued as part of the JD700B Series 
analyzers. The catalog number for a published manual is JD700B362 - printed. 
The catalog number for an electronic manual on CD-ROM is JD700B361 - 
electronic. 
 

Terms and conditions 

Specifications, terms, and conditions are subject to change without notice. The 
provision of hardware, services, and/or software is subject to JDSU’s standard 
terms and conditions, available at www.jdsu.com/terms. 
 

NRTL compliance 

This product was tested according to UL 61010-1:2012 and CAN/CSA C22.2  
No. 61010-1-12. Conformity with these requirements is based upon compliance 
with the standard IEC 61010-1. A copy of the Declaration of Conformity is 
provided upon your request. 
 
Ce produit a été testé selon la norme UL 61010-1 : 2012 et CAN / CSA C22.2 
No. 61010-1-12. La conformité à ces exigences est fondée sur la conformité à la norme 
CEI 61010-1. Une copie de la déclaration de conformité est disponible sur demande. 
 

EMC directive compliance 

This product was tested and conforms to the EMC Directive, 2004/108/EC and its 
amending directives for electromagnetic compatibility. Conformity with this 
directive is based upon compliance with the harmonized European standards: 
EN61326-1 and CISPR11. A copy of the Declaration of Conformity is provided 
upon your request. 
 

Low voltage directive compliance 

This product was tested and conforms to the Low Voltage Directive, 2006/95/EC 
and its amending directives. Conformity with this directive is based upon 
compliance with the harmonized European standard EN61010-1. A copy of the 
Declaration of Conformity is provided upon your request. 
 

WEEE and battery directive compliance 

JDSU has established processes in compliance with the Waste Electrical and 
Electronic Equipment (WEEE) Directive, 2002/96/EC, and the Battery Directive, 
2006/66/EC. 
 
This product, and the batteries used to power the product, should not be disposed 

http://www.jdsu.com/terms
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of as unsorted municipal waste and should be collected separately and disposed 
of according to your national regulations. In the European Union, all equipment 
and batteries purchased from JDSU after 2005-08-13 can be returned for disposal 
at the end of its useful life. JDSU will ensure that all waste equipment and 
batteries returned are reused, recycled, or disposed of in an environmentally 
friendly manner, and in compliance with all applicable national and international 
waste legislation. 
 
It is the responsibility of the equipment owner to return equipment and batteries to 
JDSU for appropriate disposal. If the equipment or battery was imported by a 
reseller whose name or logo is marked on the equipment or battery, then the 
owner should return the equipment or battery directly to the reseller. 
Instructions for returning waste equipment and batteries to JDSU can be found in 
the Environmental section of JDSU’s web site at www.jdsu.com. If you have 
questions concerning disposal of your equipment or batteries, contact JDSU’s 
WEEE Program Management team at WEEE.EMEA@jdsu.com. 
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Purpose and scope 

The purpose of this guide is to help you successfully operate the JD700B series (firmware version 
3.020 and later) and use its features and capabilities. This document includes instructions that 
describe how to operate, set up, configure, and use the JD700B series, consisting of JD785B/JD745B 
Base Station Analyzer, JD786B/JD746B RF Analyzer, and JD788B/JD748B Signal Analyzer. 
 
Objectif et champ d'application 

Le but de ce guide est de vous aider à utiliser avec succès la série JD700B (version du firmware 3.020 et plus 
tard) et à utiliser ses fonctions et capacités. Ce document contient des instructions qui décrivent comment utiliser, 
créer, configurer et utiliser la série JD700B, composé de JD785B/JD745B Base Station Analyzer, 
JD786B/JD746B RF Analyzer, et JD788B/JD748B Signal Analyzer. 
 

Assumptions 

This guide is intended for novice, intermediate, and experienced users who want to use the JD700B 
series effectively and efficiently. We are assuming that you have basic operation experience and are 
familiar with basic mobile communication concepts and terminology. 
 
Hypothèses 

Ce guide est destiné aux débutants, intermédiaires et les utilisateurs avancés qui veulent utiliser série JD700B 
efficace et efficiente. Nous supposons que vous avez une expérience de base du fonctionnement et êtes familier 
avec les concepts de communication mobile et de la terminologie. 
 

Safety and compliance information 

It is mandatory to permanently connect this product to the protective earth. 
 
When supplying power to this device, always use an AC power cable that includes an earth (safety) 
ground connection. 
 
Informations de sécurité et de conformité 

Il est obligatoire de se connecter en permanence ce produit à la protecteur terre. Lorsque alimenter en énergie 
cet appareil, utilisez toujours un câble d'alimentation secteur qui comprend une terre de sécurité. 
 

 

WARNING 
Do not attempt to service this product yourself, as opening or removing covers may 
expose you to dangerous voltage and other hazards. Refer all servicing to qualified 
service personnel. 
 
AVERTISSEMENT 
Ne pas tenter de réparer ce produit vous-même, car l'ouverture ou le retrait des capots peut vous 
exposer à des tensions dangereuses et autres risques. Confiez toute réparation à un personnel 
qualifié de service JDSU. 

 

 

CAUTION 
This equipment contains parts and assemblies sensitive to electrostatic discharge (ESD). 
Use ESD precautionary procedures when touching, removing, or inserting ESD sensitive 
parts and assemblies, or damage to components could result. 
 
An electrostatic-sensitive device can only withstand voltage spikes of 10 to 100 volts. Any 
discharge greater than this can damage or effectively destroy such a device while going 
unnoticed by a technician. Common plastics (synthetic insulating materials), clothing, and 
paper or cardboard are the most common source of static charges. 
 
MISE EN GARDE 
Cet équipement contient des pièces et des assemblages sensibles aux décharges électrostatiques 
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(ESD). Utilisez ESD procédures de précaution en cas de contact, la suppression ou l'insertion de 
pièces de l'EDD et des assemblages sensibles, ou des dommages aux composants pourraient en 
résulter. 
 
Un dispositif électrostatique sensible ne peut supporter des pointes de tension de 10 à 100 volts. 
Toute décharge supérieur à ce qui peut endommager ou détruire efficacement un tel dispositif alors 
passer inaperçu par un technicien. Matières plastiques (matériaux synthétiques isolants), les 
vêtements et le papier ou le carton sont la source la plus fréquente de charges statiques. 

 

 

CAUTION 
This instrument uses a Lithium Ion battery that, if not connected correctly, may lead to 
explosion. In case the battery needs to be exchanged, it must be the same kind as or 
compatible with the one shipped with your instrument. 
 
The battery must not be disposed of in a landfill site or as municipal waste, and should be 
disposed of according to your national regulations. 
 
MISE EN GARDE 
Cet instrument utilise une batterie lithium-ion qui, s'il n'est pas connecté correctement, peut conduire 
à une explosion. Dans le cas où la batterie a besoin d'être remplacé, il doit être du même type ou 
compatible avec celui fourni avec votre instrument. 
 
La batterie ne doit pas être éliminé dans un site d'enfouissement ou les déchets municipaux, et doit 
être éliminé conformément à la réglementation nationales. 

 

Conventions 

This guide uses typographical and symbols conventions as described in the following tables. 
 
Conventions 

Ce guide utilise les conventions typographiques et les symboles tels que décrits dans les tableaux suivants. 
 

Table 1 Text formatting and other typographical conventions 

Item Text formatting/symbols used Example(s) 

Buttons or hard keys that 
the user presses on a 
physical device 

Bold, all caps, default font Press the ON button. 
Press the MODE hard key. 
Press the MARKER hard key. 

Hot keys that the user 
presses on a physical 
device 

Bold, all caps, italics, default font Press the SYSTEM hot key. 
Press the MEASURE hot key. 

Soft keys or toggle keys 
that the user presses on a 
physical device to select 
corresponding menus 

Bold, default font Press the Span soft key. 
Press the Channel Power soft key. 

Soft key option separators Denoted by a vertical bar | that 
means “or”, only one option can be 
selected with a single press 

Press the Zone [1|2|3] soft key. 

File type Courier New In .tra file type. 

Required arguments (text 
variables in code) 

Denoted by slanted brackets < >. Enter <password> 

 
Table 2 Symbol conventions 

 
This symbol represents a general hazard. It may be associated with either a DANGER, 
WARNING, or CAUTION message. 
 
Ce symbole signale la présence d'un danger général. 
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This symbol represents hazardous voltages. It may be associated with either a 
DANGER, WARNING, or CAUTION message. 
 
Ce symbole signale la présence d'un risque d'électrocution. 

  

 
This symbol represents a risk of explosion. It may be associated with either a DANGER, 
WARNING, or CAUTION message. 
 
Ce symbole signale la présence d'un risque d'explosion. 

  

 

This symbol, located on the equipment, battery, or the packaging indicates that the 
equipment or battery must not be disposed of in a landfill site or as municipal waste, 
and should be disposed of according to your national regulations. 
 
Ce symbole, situé sur l'équipement, la batterie ou l'emballage indique que l'équipement ou de la 
batterie ne doivent pas être jetés dans un site d'enfouissement ou les déchets municipaux, et 
doivent être éliminés conformément à la réglementation nationales. 

 
Table 3 Safety definitions 

DANGER 
 
 
 
DANGER 
 

Indicates a potentially hazardous situation that, if not avoided, will result in 
death or serious injury. It may be associated with either a general hazard, 
high voltage, or risk of explosion symbol. 
 
Indique une situation potentiellement dangereuse qui, si elle n'est pas évitée, 
entraînera la mort ou des blessures graves. 

  
WARNING 
 
 
 
AVERTISSEMENT 

Indicates a potentially hazardous situation that, if not avoided, could result in 
death or serious injury. It may be associated with either a general hazard, 
high voltage, or risk of explosion symbol. 
 
Indique une situation de danger potentiel qui, si elle n'est pas évitée, peut entraîner la 
mort ou des dommages corporels graves. 

  
CAUTION 
 
 
 
 
 
 
MISE EN GARDE 

Indicates a potentially hazardous situation that, if not avoided, could result in 
minor or moderate injury and/or damage to equipment. It may be associated 
with either a general hazard, high voltage, or risk of explosion symbol. 
 
When applied to software actions, indicates a situation that, if not avoided, 
could result in loss of data or a disruption of software operation. 
 
Indique une situation de danger potentiel qui, si elle n'est pas évitée, peut entraîner 
des dommages corporels légers ou modérés. 

 

Technical assistance 

Contact information for technical assistance is listed in the following table. For the latest TAC 
information, go to www.jdsu.com or contact your local sales office for assistance. Contact information 
for regional sales headquarters is listed on the back cover of this document. 
 
Assistance technique 

Coordonnées pour l'assistance technique est listé dans le tableau suivant. Pour les dernières informations de 
TAC, allez à www.jdsu.com ou contactez votre bureau de vente local pour assistance. Coordonnées pour le siège 
régional des ventes est cotée sur le dos de ce document. 
  

http://www.jdsu.com/
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Table 4 Technical assistance centers 

Region Phone Number E-mail Address 

Americas 1-855-ASK-JDSU (option #3) 
(1-855-275-5378, option #3) 

catvsupport@jdsu.com 

Europe, Africa, and Mid-East +49 (0) 7121 86 1345 
(JDSU Germany) 

hotline.europe@jdsu.com 

Asia and the Pacific China 400 122 6542 
Taiwan 008 06651950 
India 1800 103 5378 
Australia 1800 095 127 
New Zealand 0800 448 482 
Japan 005 316 50533 
Korea 007 986 517 490 
Singapore 1800 223 7070 
Malaysia 1800 806584 
Thailand 1800 658177 
Vietnam 12065180 
Philippines 1800 16510736 
Indonesia 001 803657082 

tac.apac@jdsu.com 

 
During off-hours, you can request assistance by doing one of the following: leave a voice mail 
message at the Technical Assistance number, e-mail the North American Technical Assistance Center, 
tac@jdsu.com, or submit your question using our online Technical Assistance Request form at 
www.jdsu.com. 
 
 

mailto:catvsupport@jdsu.com
mailto:hotline.germany@jdsu.com
mailto:tac.apac@jdsu.com
mailto:tac@jdsu.com
http://www.jdsu.com/
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Chapter 1 JD700B Series Overview 

This chapter provides a general description of the JD700B series. Topics discussed in this chapter 
include the following: 
 

 About the JD700B series ........................................................................................................... 23 

 Features and capabilities ........................................................................................................... 23 

 Options ...................................................................................................................................... 24 

 Specifications ............................................................................................................................. 24 
 
  



Chapter 1 JD700B Series Overview 

 JD700B Series User’s Guide 23 

About the JD700B series 

JDSU wireless RF and fiber test solutions for the field include base station analyzers, cable and 
antenna analyzers, and signaling analyzers for the installation and maintenance of modern wireless 
communication systems. RF and fiber test is critical for wireless operators facing challenges of signal 
quality and signaling interference, and maintaining quality high-bandwidth services. 
  
The JD700B series addresses spectrum analysis, interference analysis, and cable, antenna and 
modulation analysis, covering current wideband technologies such as WiMAX and LTE/LTE-A. 
 

Base station analyzer JD785B and JD745B 

The Base Station Analyzer contains all the features and capabilities required to perform field testing of 
cell sites of all wireless technologies, from 2G to 4G. 
 

RF analyzer JD786B and JD746B 

The RF Analyzer provides multi-purpose solution for the analysis of RF systems covering all physical 
aspects of transmission, reception, and interference of RF systems up to 8 GHz and 4 GHz, 
respectively. 
 

Signal analyzer JD788B and JD748B 

The Signal Analyzer contains all the features and capabilities required to perform cell site field testing 
for all wireless technologies from 2G to 4G. 
 

Features and capabilities 

The JD700B series is the optimal test solution for installation and maintenance of cellular base stations 
and cell sites, running with external AC power or battery for the field. 
 
The user interface has been specifically designed with customized menus and simple calibration 
procedures, providing service providers with accurate and reliable measurement results. 
 

Applicable Systems 

 cdmaOne/cdma2000 

 EV-DO 

 WCDMA/HSPA+ 

 GSM/GPRS/EDGE 

 TD-SCDMA 

 WiMAX 

 LTE/LTE-Advanced (FDD/TDD) 

 RF over Fiber 
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Key Features 

Table 5 Key functions 

Functionality JD785B/JD745B JD786B/JD746B JD788B/JD748B 

Spectrum Analyzer    

Cable and Antenna Analyzer    

RF Power Meter    

Optical Power Meter    

Fiber Inspection    

Signal Analyzers (optional)    

RFoFiber (optional)    

Interference Analyzer (optional)    

Channel Scanner (optional)    

OTA Measurement (optional)    

 

Options 

This instrument is provided with various options/features that are available to be ordered. See 
“Appendix I – Ordering information” on page 541 for more information. 
 

Specifications 

AC power 

Input voltage is automatically selected within the instrument’s tolerable input line voltage from 100 to 
240 VAC. This instrument does not have a separate line protection fuse. 
 

Table 6 AC power requirements 

Item JD780B Specification JD740B Specification 

AC Power 100 to 240 V AC, 50-60 Hz 100 to 240 V AC, 50-60 Hz 

Power Consumption 42 W in operation 
54 W with battery charging 

42 W in operation 
54 W with battery charging 

 

Physical specifications 

Table 7 shows weight with standard configurations and the battery pack installed. 
 

Table 7 Physical specifications 

Parameter JD785B/JD786B/JD788B JD745B/JD746B/JD748B 

Height 7.7” (195 mm) 7.7” (195 mm) 

Width 11.6” (295 mm) 11.6” (295 mm) 

Depth 3.2” (82 mm) 3.2” (82 mm) 
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Chapter 2 Getting Started 

This chapter provides general guides of how to get started with your JD700B series instrument. Topics 
discussed in this chapter are as follows: 
 

 Unpacking the JD700B series ................................................................................................... 26 

 Exploring the JD700B series ..................................................................................................... 26 

 Installing battery pack ................................................................................................................ 31 

 Starting up the JD700B series ................................................................................................... 31 

 Managing files ............................................................................................................................ 32 

 Configuring system .................................................................................................................... 35 

 Upgrading firmware ................................................................................................................... 38 

 Managing licenses ..................................................................................................................... 39 

 Performing service diagnostic ................................................................................................... 40 

 Using system administration ...................................................................................................... 42 

 Running IP test .......................................................................................................................... 43 

 Activating StrataSync ................................................................................................................ 43 

 Setting communication .............................................................................................................. 45 
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Unpacking the JD700B series 

Unpack and inspect the shipping package thoroughly to ensure that nothing was damaged during the 
shipment. Also, check that your delivered package includes all of your ordered items in the shipment. If 
contents in the package are damaged or defective or if there are any missing items, keep the shipping 
list and materials for carrier’s inspection and contact your nearest JDSU's authorized sales and service 
office. 
 
A basic test set of JD700B series would include the following items in the package. For more options, 
see “Appendix I – Ordering information” on page 541. 
 

Table 8 Items included in a basic test set shipment 

Item Quantity 

JD700B series instrument 
(JD785B, JD786B, JD788B, JD745B, JD746B, or JD748B) 

1 

AC/DC power adapter and power cord 1 

1.5 meter cross LAN cable 1 

1.8 meter USB A-to-B cable 1 

> 1 GB USB memory 1 

Rechargeable Lithium Ion battery pack 1 

12 V DC automotive adapter 1 

Stylus pen 1 

User’s guide and application software CD 1 

 

Exploring the JD700B series 

 
Figure 1 JD785B front panel view 
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Front panel 

The JD700B series analyzers have the same front panel look as like Figure 1, except for the bumpers 
in different colors. 
 

Power on/off button 

Key Description 

 
POWER ON/OFF – You can turn your instrument on or off. Two LEDs indicate power 
source and status. See “Starting up the JD700B series” on page 31. 

 

Function hard keys 

You can use these hard keys to activate specified functions as labeled on each key. 
 

Key Description 

 
MODE – You can select an analyzer mode from all the standard and optional modes 
available to your instrument. 

 
FREQ/DIST – You can configure frequency or distance settings. 

 
AMP/SCALE – You can configure amplitude and scale settings. 

 
BW/AVG – You can configure bandwidth and average settings. 

 
TRACE/DISPLAY – You can set up trace and display parameters. 

 
MARKER – You can analyze measurements with markers. 

 
PEAK SEARCH – You can set up peak search parameters. 

 

Hot keys 

When the user input field on the screen is inactive, you can use these hot keys to activate specific 
functions instead of numbers. When you see the user input field activated or highlighted, press the 
ESC hard key to use these hot keys. 
 

Key Description 

 
MEASURE – You can select measurements available for your selected analyzer mode. 

 
MEASURE SETUP – You can set measurement parameters available for your selected 
measurement mode. 

 
SAVE/LOAD – You can save or load your current screen, result, setup, or limit into or 
from the internal memory or an external USB memory drive. 

 
SWEEP – You can configure sweep parameters. 

 
TRIGGER – You can select trigger options such as internal, external, and GPS. 

 
SYSTEM – You can configure your system settings or view your current system 
information. 
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PRESET – You can use this key to return to a known state and make measurements. 

 
HOLD – You can change the sweep mode: Continue or Single. 

 
LIMIT – You can set limit settings such as display line, multi segment line, save limits, 
recall limits, or test specification limits. 

 
BACKLIGHT – You can turn the key backlight feature on or off. 

 
HELP – You can have the online help screen on. 

 

Soft keys 

You can use not only the touchscreen keys but also these physical keys placed along the right side of 
the display to start a specific function associated with each soft key, invoke other screen keys, or 
select a unit. The More screen menu indicates that there are more than seven screen menus for the 
level. The small arrowhead symbol in the screen menu indicates that there are screen menus under 
the screen menu. 
 

Data entry and other keys 

Key Description 

 

ROTARY KNOB WITH ENTER KEY – You can change a value with predefined 
increments or move marker position. Rotating this knob clockwise increases value or 
moves a marker to the right and rotating counter clockwise does vice versa. This knob 
works as the ENTER hard key as well. 

  

ARROW KEYS – You can increase or decrease value or move your selection up, down, 
to the left, or to the right. 

 

NUMERIC KEYS – You can manually enter a value for measurement parameters. 

 
DEL – You can delete data entry. After pressing the ENTER key or selecting a unit soft 
key, you cannot delete or remove data entered. 

 
ENTER – You can save and confirm data entry. 

 
ESC – You can cancel any input in the user input field or dismiss a pop-up window on the 
screen. 

 
PREV – You can go back to the previous menu without changing current setup. 

 

Top panel 

The JD700 series products have the same top view as Figure 2 and Figure 3. 
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Figure 2 Top view of JD785B with optical hardware option 

 
 
 

Figure 3 Top view of JD785B without optical hardware option 

 
 

Reflection/RF Out (Cable and Antenna Analyzer) 

The Reflection/RF Out port of the Cable and Antenna Analyzer is a precise 50 Ω N-type female 
connector that is used as the output signal port for the Cable and Antenna Analyzer mode. 
 

 

CAUTION 
Do not apply or connect power exceeding +25 dBm to this Reflection/RF Out port. If such 
power is applied, it will degrade the product’s performance and can cause damage to the 
product in worst case. 

 

RF In (Cable and Antenna Analyzer) 

The RF In port is a precise 50 Ω N-type female connector that is used as the input signal port for 2-
port vector measurements in the Cable and Antenna Analyzer mode. 
 

 

CAUTION 
The maximum power allowed to the RF In port is +25 dBm. If the input power exceeds 
the limit, it may degrade the product performance or cause damage to the instrument in a 
worst case. Do not connect any power feed exceeding 1 W directly to this port. 

 

DC 18 V 

The input power to this port shall be 18 V DC. 
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RF In (Spectrum Analyzer) 

The RF In port is a precise 50 Ω N-type female connector that is used as the input signal port for 
spectrum analysis, signal analysis, and RF power measurement. 
 

 

CAUTION 
The maximum power allowed to the RF In port is +25 dBm for JD780B series and +20 
dBm for JD740B series. If the input power exceeds the limit, it may degrade the product 
performance or cause damage to the instrument in a worst case. 

 

Audio jack 

The audio jack is labeled with a headphones icon. Plugging in headphones or earphones turns the 
speaker off. 
 

USB 

 CLIENT: This is a communication port that you can connect your instrument and your PC with 
application software JDViewer, JDRemote, or JDMapCreator. You must install driver software 
for the instrument on to the computer. See “Appendix H – Device driver installation” on page 
540 for more information. 

 HOST: You can use this port to plug in an external USB memory to extend storage capacity or 
to upgrade the instrument’s firmware. It supports most USB memory devices with 32-bit file 
system. You can also use this port to connect an external power sensor, Bluetooth USB 
adapter, or P5000i fiber microscope. See “Appendix G – Bluetooth connection” on page 537 
on how to set up and use the Bluetooth connection. 

 

LAN 

You can use this Ethernet communication port to connect your instrument and your PC using the 
application software JDViewer or Motorola WinLMF, if necessary. Two LEDs indicate data transfer 
activity and link status. 

 ACTIVITY: The yellow LED is illuminated during data transfer. 

 LINK: The green LED is illuminated when there is a valid communication connection. 
 

SFP/SFP+ 

The RFoCPRI option board supports all type of MSA (Multi-Source Agreement) compliant SFP 
modules. You can use these SFP/SFP+ ports to connect SFP modules to test CPRI protocols, detect 
an error or alarm, perform interference analysis, and transmit test pattern over fiber link. 
 

External In 

 GPS: You can plug in a GPS antenna to this SMA type female connector in order to get 
location information and highly accurate reference. 

 TRIGGER: You can use this SMA type female connector to receive PP2S clock or 10 ms 
synchronization signals from an external timing reference. 

 REF: You can use this SMA type female connector to receive 10 MHz, 13 MHz, or 15 MHz 
reference clock signals from an external frequency source. 
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Installing battery pack 

You need to install the Lithium Ion battery pack provided with your instrument. Follow the instruction to 
install or remove the battery pack as needed. 
 

Procedure 

To install the battery pack: 
1 Loosen the latching screw of the battery cover by turning counter clockwise. 
2 Slide out the battery cover to open. 

3 Insert the battery pack with the connector terminal side up and push in until it stops. 

4 Slide in the battery cover to close. 

5 Tighten the latching screw of the battery cover 
by turning clockwise. 

 
To remove the battery pack: 

1 Loosen the latching screw of the battery cover  
by turning counter clockwise. 

2 Slide out the battery cover. 
3 Hold the battery strap and pull it out. 

 
 

 

 

CAUTION 
The battery pack that came with your instrument is Lithium Ion and it may, if not 
connected correctly, lead to explosion. In case you need to replace the battery, you must 
use one of the same kinds or compatible ones. You must dispose a battery according to 
your local safety and environmental regulations. 

 
 NOTE 

It is recommended that you turn off the instrument to replace the battery. However, if you 
do not want to interrupt the current test, you can leave the module turned on with the AC 
power adapter plugged in. 

 

Starting up the JD700B series 

Use the power button to turn your JD700B series on or off. When external power is supplied via the 
AC/DC adapter, the upper orange LED is illuminated. 
 

Procedure 

To turn on: 
1 Press and hold the      POWER button for a few seconds until the lower green LED indicator is 

illuminated. 
2 Release the button and wait for a few seconds while booting up. 

 
To turn off: 

1 Press and hold the      POWER button for a few seconds until the lower green LED indicator 
goes out. 

2 Release the button. 

 



Chapter 2 Getting Started 

32 JD700B Series User’s Guide 

Managing files 

The JD700B series lets you save and load screen, result, setup, limit, logging data, or Fail events 
depending on your selected measurement mode and option. 
 

 NOTE 
If you see greyed-out menus as you change measurement modes, this indicates that the 
menu(s) are not available to be used. 

 

Using save 

You can save your current screen, result, setup, and limit into the internal memory or your external 
USB memory drive. 
 

Procedure 

1 Press the SAVE/LOAD hot key. The Save/Load screen menu bar appears. 
2 Press the Save soft key. 
3 Select the save option, from the following choices: 

 

To save Select File type 

Current screen Save Screen > Screen .png 

Measurement result in a report 
format with comments 

Save Screen > Report .pdf 

Measurement result Save Result .tra 

.gom 

.grr 

.jdt 

Measurement result (.csv) Save Result as CSV Format .csv 

Setup and test configuration Save Setup .sta 

Limit setting Save Limit .jml 

Logging data Save Logging Data .grr 

.gsr 

.csv 

Automatically screen or results 
that falls outside the defined 
limit settings (Failed event) 

Save On Event .png 

.tra 

.csv 

The on-screen keyboard appears. 
 

 NOTE 
Save Setup saves a test configuration only, not a measurement limit setting. You must 
use Save Limit to save your limit settings. 
 
A RFoCPRI spectrum can be save as a file, but the difference in its data point does not 
allow the saved RFoCPRI spectrum to be overlaid on a standard spectrum. 

 

4 Type the name of the file in the File Name field with or without using a keyword. 
5 Optional. 

–  To create or edit keywords, touch the Edit Keywords button, select your desired keyword 
button in the upper screen, type a keyword, and then tap the Save button on the keyboard. 
See “Editing or adding a custom keyword” on page 551 for more information. 

–  To include a keyword in the file name, touch the Append Keywords button, select your 
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desired keyword, and then tap the Keyboard button. See “Appending a keyword” on page 
552 for more information. 

–  To change the file location in the internal memory or to your USB memory drive, tap the 
Location button, select your desired file path using the touch screen or the rotary knob, 
and then press the Apply soft key. 

–  To create a folder, press the Create Folder soft key, type a directory name, and then press 
the Apply soft key. 

6 Press the Save soft key. 

 

Saving fail events 

Depending on the measurement mode, you can let the instrument automatically save measurement 
screen or result that falls outside the defined limit settings or the Fail indicator is on. You can also set 
to save the first event and hold the measurement or to save all the events continuously. 
 

Procedure 

1 Press the SAVE/LOAD hot key. The Save/Load screen menu bar appears. 
2 Press the Save soft key. 
3 Press the Save On Event soft key. 
4 Press the Save Type soft key, and then select the save option: Screen, Result, or Result as 

CSV Format. 
5 Optional. Toggle the Save Then Stop soft key and select On in order to save the first event that 

falls outside the limit(s) and to hold the measurement. Otherwise, leave this feature off to save 
events continuously. 

6 Press the Start soft key to start saving. The on-screen keyboard appears. 
7 Type the name of the file in the File Name field with or without using a keyword. 
8 Optional. 

–  To create or edit keywords, touch the Edit Keywords button, select your desired keyword 
button in the upper screen, type a keyword, and then tap the Save button on the keyboard. 
See “Editing or adding a custom keyword” on page 551 for more information. 

–  To include a keyword in the file name, touch the Append Keywords button, select your 
desired keyword, and then tap the Keyboard button. See “Appending a keyword” on page 
552 for more information. 

–  To change the file location in the internal memory or to your USB memory drive, touch the 
Location button, select your desired file path using the touch screen or the rotary knob, 
and then press the Apply soft key. 

–  To create a folder, press the Create Folder soft key, type a directory name, and then press 
the Apply soft key. 

9 Press the Done soft key. 
The “Event Save” appears on the screen and the Start screen menu changes to Stop. 

10 Press the Stop soft key to end the event saving. 

 

Saving logging data 

You can save logging data if the measurement mode supports the feature and has the activated Save 
Logging Data soft key. 
 

Procedure 

1 Press the SAVE/LOAD hot key. The Save/Load screen menu bar appears. 
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2 Press the Save soft key. 
3 Press the Save Logging Data soft key. The on-screen keyboard appears. 
4 Type the name of the file in the File Name field with or without using a keyword. 
5 Optional. 

–  To create or edit keywords, touch the Edit Keywords button, select your desired keyword 
button in the upper screen, type a keyword, and then tap the Save button on the keyboard. 
See “Editing or adding a custom keyword” on page 551 for more information. 

–  To include a keyword in the file name, touch the Append Keywords button, select your 
desired keyword, and then tap the Keyboard button. See “Appending a keyword” on page 
552 for more information. 

–  To create a folder, press the Create Folder soft key, type a directory name, and then press 
the Apply soft key. 

–  To change the file location in the internal memory or to your USB memory drive, touch the 
Location button, select your desired file path using the touch screen or the rotary knob, 
and then press the Apply soft key. 

 

 NOTE 
In is recommended that you use an external USB memory drive to save logging data in 
the Auto Measure mode in order to have enough free space. 

 

6 Optional only in the Auto Measure mode. 
Toggle the Save Screen soft key and select All to save all the Auto Measure screens or Fail to 
save only the ones with the Fail on. 

7 Press the Save soft key to start logging. 
The “Recording” appears on the screen. 

8 Press the ESC hard key to stop logging data and complete saving. 

 

Using load 

You can load your saved screen, result, setup, and limit from the internal memory or your external 
USB memory drive. 
 

Procedure 

1 Press the SAVE/LOAD hot key. The Save/Load screen menu bar appears. 
2 Press the Load soft key. The Load screen menu bar appears. 
3 Select the load option, from the following choices: 

 

To load Select 

Saved screen or report Load Screen 

Measurement result Load Result 

Setup and test configuration Load Setup 

Limit setting Load Limit 

Logging data Load Logging Data 

Map file Load Map 

Scenario Load Scenario 

The file manager window appears. 
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 NOTE 
A RFoCPRI spectrum can be recorded and replayed in the RFoCPRI Interference 
Analyzer (IA) mode only. It is not compatible with a standard IA spectrum logging file. 

 

4 Select the name of the file to be loaded from the internal memory or from your USB drive. 
Information of your selected file appears in the File Information pane. 

5 Press the Load soft key. 

 

Using file manager 

The File Manager lets you copy, cut, paste, and delete data files saved in the internal memory or in 
your USB memory drive. 
 

Procedure 

1 Press the SAVE/LOAD hot key. The Save/Load screen menu bar appears. 
2 Press the File Manager soft key. The file manager window appears. 
3 To copy, cut, and paste, complete the following steps: 

 Select a file or folder by using the touch screen or the rotary knob. a
 Select the Copy or Cut soft key. b
 Select the location to which the file or folder to be pasted. c
 Press the Paste soft key. d

4 To delete, complete the following steps: 
 Select a file or folder by using the touch screen or the rotary knob. a
 Press the Delete soft key. b

The confirmation dialog box appears. 
Once the file or folder is deleted, you cannot recover it. 

 Select OK to delete. c
5 Press the Exit soft key or the ESC hard key to close the file manager window. 

 

Configuring system 

Setting frequency reference 

You can improve measurement accuracy by setting frequency reference. 
 

Procedure 

1 Press the SYSTEM hot key. 
2 Press the Freq Reference soft key. 
3 Select the frequency reference option: Internal, External 10 MHz, External 13 MHz, 

External 15 MHz, and GPS. 

 

Setting date and time 

You can set the instrument’ system clock to your region. 
 

Procedure 

1 Press the SYSTEM hot key. 
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2 Select System Configuration > Date/Time. The current time zone information box appears. 
3 To change the standard time zone, complete the following steps: 

 Press the Std Time Zone soft key. a
 Select your time zone by using the rotary knob or arrow keys. You can also use the b

Top/Bottom or Page Up/Down soft keys. 
 Press the ENTER hard key to save your change. You can also press the rotary knob. c

4 To change the date format, complete the following steps: 
 Press the Date Format soft key. a
 Select YYMMDD, MMDDYY, or DDMMYY as needed. b

5 To set the date and time manually, complete the following steps: 
 Select Year, Month, Day, Hour, or Minute soft key as needed. a
 Enter a value by using numeric keys. b
 Press the Enter soft key to save your change. c

6 Press the Apply screen key to save and exit. 

 

Setting language 

You can change the system language for the menus, messages, and information on screen. 
 

Procedure 

1 Press the SYSTEM hot key. 
2 Select System Configuration > Language. 
3 Select the language option from the choices available. 

 

Setting power on 

Procedure 

To set the power-on option: 
1 Press the SYSTEM hot key. 
2 Press the Power On soft key. 
3 Select the power-on option, from the following choices: 

–  Last: Boots up with the last state of the instrument before power-off or shut-down. 

–  Preset: Boots up with the default settings preset in the factory. 

–  User: Boots up with the user-defined setup. 
When the User is selected, the User Setup menu under System becomes activated. 

4 Optional. To specify the user setup file, complete the following steps: 
 Press the User Setup soft key. a
 Select the name of the user setup file. b
 Press the Done soft key. c

 
 NOTE 

The Preset option returns the instrument settings to the factory preset. It is recommended 
that you use this option when you experience badly misadjusted settings. 

 

Changing display mode 

You can change the instrument’s display mode as needed. 
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Procedure 

1 Press the SYSTEM hot key. 
2 Select System Configuration > Display Mode. 
3 Select a display mode from the choices: Indoor, Outdoor, and Night. 
4 The instrument optimizes screen colors to each choice. 

 

Setting sleep time 

You can set the amount of time up to 255 minutes to let the instrument automatically turn the backlight 
off and enter into power saving mode after no actions or data entries. Default setting is zero, which 
indicates that the sleep mode is turned off and screen backlight is always on. 
 

Procedure 

1 Press the SYSTEM hot key. 
2 Select System Configuration > Sleep Time. 
3 Enter the amount of minutes by using the numeric keys. You can also use the rotary knob. 
4 Press the Enter soft key. 

 

Adjusting LCD brightness 

You can adjust display brightness from one to ten as needed. The larger number you set, the brighter 
the display becomes. 
 

Procedure 

1 Press the SYSTEM hot key. 
2 Select System Configuration > LCD Brightness. 
3 Enter a value by using the numeric keys. You can also use the rotary knob. 
4 Press the Enter soft key. 

 

Adjusting volume 

You can turn the sound on or off or adjust the volume from one to ten as needed. 
 

Procedure 

1 Press the SYSTEM hot key. 
2 Select the sound option, from the following choices: 

–  To turn the sound or alarm off, toggle the Sound soft key and select Off. 

–  To turn the sound or alarm on, toggle the Sound soft key and select On. 

–  To adjust the volume, complete the following steps: 
 Press the Sound soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

 



Chapter 2 Getting Started 

38 JD700B Series User’s Guide 

Upgrading firmware 

It is recommended that you maintain your instrument up-to-date with its latest firmware in order to 
achieve the instrument’s optimal performance.  
 

Checking installed firmware version 

Procedure 

1 Press the SYSTEM hot key. 
2 Press the HW/FW Info soft key. 
3 Find the installed version number in the Firmware field. 
4 From a computer with Internet access, visit JDSU’s Software Updates website and check if your 

installed firmware is the latest one. Do the steps 5-6 if you want to update your firmware with 
using your USB memory drive. 

5 Download a latest firmware file from the website to the root directory of your USB memory drive. 
 

 NOTE 
It is recommended that you format your memory drive to have enough space to download 
the file. 

 

6 Unzip the download file into the root directory of your USB memory stick. 
A firmware file (*.fw) and a firmware release note (*.pdf) are extracted. 

 

Installing new firmware 

To update your firmware, you can choose either way of using your USB memory drive or accessing the 
FTP server over the network. 
 

Upgrading from USB memory drive 

Procedure 

1 Power your instrument via the AC-DC adapter to prevent any severe damage to your instrument 
caused by a power-off in the middle of the upgrade, which may require a repair in the factory. 

2 Plug in the USB memory drive to the USB Host port of your instrument. 
3 Press the SYSTEM hot key. 
4 Select More (1/2) > Upgrade > USB. 

The file manager window appears. 
5 Highlight the firmware file (.fw) saved in the root directory of your USB drive. 
6 Press the Select soft key. 

The Update Firmware dialog box appears. 
7 Press the OK button to start to install the new firmware.  

The Upgrade Status bar appears. 
The instrument reboots the system automatically and completes upgrading. 

 

 NOTE 
Firmware upgrade will be done within 30 minutes or so in most cases, but depending on 
the number of files to be reconfigured, it may take longer than that. 

 

8 After the instrument restarted, check the installed firmware version and DSP versions in the 
System settings. Refer to the firmware release note to find correct DSP version and compatible 
application software versions. 

 

http://www.jdsu.com/en-us/Test-and-Measurement/support/Software-Updates/Pages/sw-updates.aspx


Chapter 2 Getting Started 

 JD700B Series User’s Guide 39 

 

WARNING 
Do not remove the USB drive while upgrading the firmware. 

 

Upgrading from FTP server 

Procedure 

1 Power your instrument via the AC-DC adapter to prevent any severe damage to your instrument 
caused by a power-off in the middle of the upgrade, which may require a repair in the factory. 

2 Press the SYSTEM hot key. 
3 Select More (1/2) > Upgrade > FTP Server. 

The upgrade server dialog box appears. 
 

 NOTE 
Older version of firmware does not have the FTP Server option. It is recommended that 
you update your firmware with the USB option first. 

 

4 Enter ftp2.jdsu.com in the server address field. 
5 Enter your proxy server address in the proxy server field, if necessary. 

Contact your system administrator for your proxy server information. 
6 Tap the Check button to check if the installed firmware version is the latest one. 
7 Do one of the following: 

–  If you view the latest firmware version information, tap the Install button to continue 
upgrading. 

–  If the message “Your firmware is up to date.” is displayed, tap the Cancel button. 
 

 NOTE 
Firmware upgrade will be done within 30 minutes or so in most cases, but depending on 
the number of files to be reconfigured, it may take longer than that. 

 

8 After the instrument restarted, check the installed firmware version and DSP versions in the 
System settings. Refer to the firmware release note to find correct DSP version and compatible 
application software versions. 

 

Managing licenses 

The License Manager lets you view installed options, install additional ones, and load evaluation 
licenses. 
 

Checking options 

Procedure 

To view the list of installed or installable options: 
1 Press the SYSTEM hot key. 
2 Select More (1/2) > License Manager. The License Manager screen menu bar appears. 
3 Select the menu, from the following choices: 

–  To view the installed options, select the Installed Options soft key. 
The list of options appears. The “(T)” indicates temporary licenses. 

–  To view the installable options, select the Installable Options soft key. 

4 Press the PREV hard key to return to the previous screen. 
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Installing options 

Procedure 

To install an option that you have purchased: 
1 Press the SYSTEM hot key. 
2 Select More (1/2) > License Manager. 

The License Manager menu bar appears. 
3 Select the Install an Option soft key. The Installable Options window appears. 
4 Highlight the name of the option from the list by using the rotary knob. 
5 Press the ENTER hard key. You can also press the rotary knob. 

The License Code bar appears. 
6 Enter the number of the license to activate by using the numeric keys. 
7 Press the ENTER hard key. You can also select the Enter soft key. 

 

Loading temporary license 

The temporary license that you received from JDSU is intended for your evaluation only and it expires 
after its specified time limit. 
 

Procedure 

To load a temporary license that you have received for evaluation: 
1 Press the SYSTEM hot key. 
2 Select More (1/2) > License Manager.  

The License Manager menu bar appears. 
3 Select the Load Temp License soft key. The file manager window appears. 
4 Select the name of the license file. 
5 Press the Load soft key. 
6 Optional. You can check the loaded license using the Installed Options menu. 

 

Viewing OSS license 

The JD700B series incorporates software that is covered by either the GNU General Public license or 
GNU Lesser General Public License. Check the OSS license notification for more details. 
 

Procedure 

1 Press the SYSTEM hot key. 
2 Select More (1/2) > License Manager. 

The License Manager menu bar appears. 
3 Select the OSS License soft key. 

The Open Source Code Notification & Distribution screen appears. 
4 Press the ESC hard key to return to your previous screen. 

 

Performing service diagnostic 

The Service Diagnostic lets you view system log, perform self test, revert the instrument settings to its 
factory settings, or perform touch alignment. 
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Viewing system log 

Procedure 

1 Press the SYSTEM hot key. 
2 Select More (1/2) > Svc Diagnostic > System Logging. 
3 Optional. Press the Save soft key to save the system log as a .log file type. 
4 Press the PREV hard key to return to the previous screen. 

 

Running self-test 

You can run a self-test on your instrument boards and modules. 
 

Procedure 

1 Press the SYSTEM hot key. 
2 Select More (1/2) > Svc Diagnostic > Self Test. 

The on-screen instruction appears. 
3 Connect a test cable between the Reflection/RF Out port for Cable and Antenna Analyzer and 

the RF In port for Spectrum Analyzer. 
4 Press the Start soft key. 

The test result window appears. 
5 Optional. Press the Save Screen soft key to save the self-test results. 
6 Press the PREV hard key to return to the previous screen. 

 

Performing factory reset 

The Factory Reset is used only when you want to purge all the user settings and data stored in the 
system and return to the instrument’s factory state. 
 

Procedure 

1 Press the SYSTEM hot key. 
2 Select More (1/2) > Svc Diagnostic > Factory Reset. 

The confirmation window appears. 
3 Press the Yes soft key to continue. Otherwise, select No. 
4 Press the PREV hard key to return to the previous menu. 

 
 NOTE 

It is recommended that you copy your setup or result data to an external USB memory 
drive so that you can restore them later. 

 

Re-aligning touch screen 

When you consistently experience of the instrument responding improperly to your touch on the 
screen, you may need to perform this touch-screen alignment. 
 

Procedure 

1 Press the SYSTEM hot key. 
2 Select More (1/2) > Svc Diagnostic > Touch Alignment.  
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The white screen with a plus sign (+) in the upper-left corner appears. 
3 Touch the plus sign and repeat until the previous screen is back on. 

 

Using system administration 

The Administration is used to disable editing limits, enable modifying online help, or change 
administration password. 
 

Logging in 

You need to log in first to access the administration menus. 
 

Procedure 

1 Press the SYSTEM hot key. 
2 Select More (1/2) > Administration. The password box appears. 
3 Enter <password> by using the numeric keys. 

Default password is “0000”. To change the password, see “Changing password” on page 42. 
4 Press the Apply soft key. 

 

Changing password 

Procedure 

1 Press the SYSTEM hot key. 
2 Select More (1/2) > Administration, and then enter your password. 
3 Press the Change Password soft key. The new password box appears. 
4 Enter a new password up to eight digits by using the numeric keys. 
5 Press the Apply soft key. The reconfirmation box appears. 
6 Enter the new password again by using the numeric keys. 
7 Press the Apply soft key to complete changing password. 

 

Locking limit key 

You can lock the LIMIT hot key and disable editing predefined limit settings to prevent any 
unintentional changes, which could result in incorrect measurements. 
 

Procedure 

1 Press the SYSTEM hot key. 
2 Select More (1/2) > Administration, and then enter your password. 
3 Toggle the Edit Limit soft key and select Disable to lock the LIMIT hot key or Enable to unlock 

the key. 

 
 NOTE 

Disabling the Edit Limit limits the access to the LIMIT hot key only. The Limit features 
including displaying limit line(s) and Pass/Fail result function properly as predefined. 
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Running IP test 

You can test an Internet Protocol (IP) configuration of the cell site’s backhaul. 
 

Procedure 

1 Press the SYSTEM hot key. 
2 Select More (1/2) > Utility > IP Test. 
3 Select the command option, from the following choices: 

–  To display the route and measure transit delays of packets, toggle the Commands soft key 
and select Traceroute. 

–  To display the reachability and measure the round-trip time, toggle the Commands soft key 
and select Ping. 

4 To set the destination IP address to be tested, complete the following steps: 
 Press the Destination IP soft key. a
 Press the First Octal soft key. b
 Enter a value, and then press the Enter soft key. c
 Press the Second Octal soft key and repeat step c. d
 Press the Third Octal soft key and repeat step c. e
 Press the Fourth Octal soft key and repeat step c. f

5 Press the Execute soft key and select Start to start testing. 
Test result is displayed on the screen as the test is progressing. 

6 Press the Execute soft key and select Stop to stop testing. 
7 Optional. Press the Save soft key to save the test result as a .txt file type. 

 

Activating StrataSync 

StrataSync is a cloud-based solution that provides asset, configuration, and test data management for 
JDSU instruments. StrataSync manages and tracks test instruments, collects and analyzes results 
from the entire network, and informs and trains the workforce. 
 
The JD700B series is compatible with the JDSU StrataSync cloud. This optional capability allows you 
to manage your instrument inventory ensuring you know where all your valuable equipment is and 
which engineer is using it. In addition, it allows you to keep your instruments current through the 
remote upgrade capability that ensures all instruments have the latest firmware. It also enables the 
centralized distribution of configuration settings to ensure all your engineers use the same instrument 
settings resulting in consistent measurements. 
 
Once testing is completed, the trace files can be uploaded onto StrataSync for secure storage and 
sharing. This sharing capability allows engineers who have a problem they cannot resolve to request 
help from an expert who can analyze the trace file via StrataSync using applications such as JDViewer, 
JDFileViewer, JDPowerMeter, etc. from anywhere without having to be at the instrument, helping 
resolve problems even faster. 
 

Setting up Internet connection 

Your JD700B series instrument must have an access to the Internet to be able to connect to the 
StrataSync. You can connect the Ethernet network to the RJ45 port of your instrument. You can also 
use your mobile device’s data network such as the Bluetooth tethering on an Android-based 
smartphone and the Personal Hotspot on an iOS-based smartphone. If you want to share your 
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mobile’s data network, you need to connect your instrument to your mobile device. 
 

Procedure 

1 Connect one of the Parani-UD100 Bluetooth adapters to the USB port of your JD780B or 
JD740B series. 

2 Turn on Bluetooth on your mobile device, and then activate its tethering or hotspot. 
–  On Android mobile devices: 

a Go to Settings > Connections > Bluetooth. 
b Check the box for Visible to all nearby Bluetooth devices to make your mobile 

device discoverable by your instrument. 
c Go to Settings > More networks > Tethering and portable hotspot. 
d Check the box for Bluetooth tethering to enable sharing your mobile device’s Internet 

connection with your instrument. 
–  On iOS mobile devices: 

a Go to Settings > Bluetooth. 
b Turn on Bluetooth. 
c Go to Settings > Personal Hotspot. 
d Turn on Personal Hotspot to make your mobile device discoverable by your 

instrument and enable sharing your mobile device’s Internet connection with your 
instrument. 

3 On your JD780B or JD740B series instrument, press the SYSTEM hot key. 
4 Select System Configuration > Remote Interface > Bluetooth > Connect. 
5 Press the Scan soft key to discover your mobile device. 

You will find your mobile device from the list on the screen. 
6 Highlight your mobile device name from the list, and then press the Select soft key. 

A dialog box appears. 
7 Tap the Connect button to pair and connect. 
8 On your mobile device, enter 0000 in the PIN field, and then tap the OK button or Pair. 

If the connection is successful, “(Paired & Connected)” appears next to the name of your mobile 
device on your instrument. If the connection is unsuccessful, repeat steps 6 and 7. 

9 Press the PREV hard key to return to the Bluetooth Information screen that displays the paired 
device and connected service. 

 

Establishing a connection to StrataSync 

Procedure 

1 Press the SYSTEM hot key. 
2 Select More (1/2) > Utility > StrataSync. 

The StrataSync setting window appears as shown in Figure 4. 
3 Enter <server address> in the Server Address field for StrataSync. 

The server address at the time of this document production is “stratasync.jdsu.com”, which 
may change. 

 

 NOTE 
JDSU provides you with the information required to access StrataSync at your 
purchase of StrataSync, including the Server Address, Account ID, and Port 
number. See “JD700B Series Common Options” on page 547 for more information 
on available options. 

 

4 Enter <account number> in the Account ID field. 
5 Enter <technician number> in the Technician ID field. 
6 To set the port number and proxy server address, complete the following steps: 

 Tap the Detail Settings button. a
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The input dialog box appears. 
 Enter <port number> in the Port field. b
 Enter <proxy server address> in the Proxy Server address, if necessary. c

Contact your system administrator for your proxy server information. 
 Tap the Apply button to save and exit. d

7 Tap the Start Sync button. 
Once successfully synchronized, the text “Successfully synchronized with server” appears and 
the StrataSync status icon changes accordingly. 

8 Tap the Apply button to exit. 

 
Figure 4 StrataSync setting window 

 
 

StrataSync status indicators 

The StrataSync indication icons provide you with the connection and activity status. 
 

Indicator Description 

   
Indicates that your instrument is idle to be connected and synchronized with the 
StrataSync server. 

   
Indicates that your instrument is acquiring an authentication, synchronizing with the 
server, and sharing data. 

   
Indicates that your instrument is synchronized successfully. 

   
Indicates that your instrument failed to synchronize with the StrataSync server or 
encountered an error. 

 

Setting communication 

JD700B series provides several methods for you to connect your instrument with application software 
or other instruments and devices. 
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Configuring Ethernet 

You can configure a network to connect your JD700B series and PC with JDViewer or JDRemote via 
Ethernet. 
 

Procedure 

1 Press the SYSTEM hot key. 
2 Select System Configuration > Ethernet Config. 

The Ethernet Configuration box appears. 
3 Select the IP addressing option, from the following choices: 

–  To enable automatic IP addressing, toggle the Mode soft key and select DHCP. 

–  To manually assign fixed IP addresses, complete the following steps: 
 Toggle the Mode soft key and select Static. a
 Select Field > IP Address. b
 Press the First Octal soft key. c
 Enter a value, and then press the Enter soft key. d
 Press the Second Octal soft key and repeat step d. e
 Press the Third Octal soft key and repeat step d. f
 Press the Fourth Octal soft key and repeat step d. g
 Select Field > Subnet Mask and repeat steps c-g. h

 Select Field > Gateway and repeat steps c-g. i
4 Press the Apply soft key to complete the network configuration. 
5 Press the ESC hard key to exit. 

 

Setting for JDViewer and JDRemote 

The App SW is set by default to make it easy to connect your instrument to JDViewer or JDRemote. 
After using other remote interfaces such as SCPI, LMF, and USBTMC, it is recommended that you set 
the LAN and USB settings back to App SW. 
 

Procedure 

1 Press the SYSTEM hot key. 
2 Press the System Configuration soft key. 
3 Press the Remote Interface soft key and then do the following: 

–  Select the LAN soft key and then press the App SW soft key. 

–  Select the USB soft key and then press the App SW soft key. 

 

Setting USBTMC mode 

The USB Test & Measurement Class (USBTMC) is a standard for programmatic control of USB-based 
test instruments that defines protocols used to send and receive messages. If you want to use the 
USBTMC protocol to communicate with the instrument remotely, you can turn this TMC Mode on. 
 

Procedure 

1 Press the SYSTEM hot key. 
2 Select System Configuration > Remote Interface > USB. 
3 Press the USBTMC soft key. 
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The confirmation dialog box appears. 
4 Press the USBTMC soft key again to confirm the mode change and reboot the instrument. 

 
 NOTE 

After using the USBTMC mode, you may want to set this setting back to App SW if you 
use JDViewer mainly for remote controlling your JD700B series. 

 

Setting SCPI mode 

You can use SCPI commands to control your JD700B series remotely. 
 

Procedure 

1 Press the SYSTEM hot key. 
2 Select System Configuration > Remote Interface > LAN. 
3 Press the SCPI soft key. 

 
 NOTE 

After using the SCPI mode, you may want to set this setting back to App SW if you use 
JDViewer or JDRemote mainly. 

 

Configuring LMF setting 

The Local Maintenance Facility (LMF) setting is used in order to perform TX Calibration and TX Audit 
on Motorola's CDMA/EV-DO BTS in the RF Power Meter mode. See “Appendix F – Motorola 
CDMA/EV-DO LMF” on page 535 for more information. 
 

Enabling Bluetooth connection 

You can also use the Bluetooth mode to enable communicate between your instrument and your 
computer with application software such as JDRemote and JDViewer or to transfer files to a Bluetooth 
storage device. See “Appendix G – Bluetooth connection” on page 537 for more information. 
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Chapter 3 Analyzing Measurement Results 

This chapter provides instructions on how to use JD700B series’ capabilities for measurement analysis. 
Topics discussed in this chapter are as follows: 
 

 Using marker ............................................................................................................................. 49 

 Using peak search ..................................................................................................................... 50 
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Using marker 

Marker  

Marker is used to get the information about a specific trace. Six markers can be set on the display and 
each marker can be used independently. The X and Y coordinates of the trace are displayed when the 
marker is placed on any position of the trace. The position displaying the marker’s X and Y coordinates 
may be slightly different for each measurement mode and refer to the description of each 
measurement. There are three different marker types available: Normal, Delta, and Delta pair. Marker 
position can be set manually by entering numeric values (frequency) when one of the marker types is 
selected. 

 Select Marker: Selects an active marker whose position can be changed with the rotary knob 
or the arrow keys. The assigned number of the active marker is displayed in the Select Marker 
menu box and the active marker number is also displayed right next to the active marker on 
the trace when the Marker View is set to On. 

 Marker View: Displays the selected marker on the screen or hides it. When the Marker View 
is turned off and then on again in the same measurement mode, markers appear at the 
previous positions. If a measurement mode is changed, markers are not restored to their 
previous positions. 

 Normal: This Normal marker type provides the reading of a marker position on the trace along 
with the marker number between one and six. 

 Delta: This Delta marker type is associated with a Normal marker. A Normal marker must be 
set before a Delta marker is set. When the Delta marker is set, the position set by the Delta 
marker becomes the reference position of the Normal marker and the marker’s X and Y values 
displays the difference compared with the Delta marker. 

 Delta Pair: This Delta Pair marker type is associated with a Normal marker. A Normal marker 
must be set before a Delta Pair marker is set. When the Delta Pair marker is set, the position 
set by the Delta Pair marker becomes the reference position of the Normal marker and the 
marker’s X and Y values displays the difference compared with the Delta Pair marker. The 
reference position will be varied in accordance with trace change. 

 Marker All Off: Turns all the markers the screen off. When the Marker View is selected for 
those markers, the instrument displays those markers back at the previous position. If a 
measurement mode is changed, current settings are not restored. 

 Marker : Sets the X coordinate of the active marker as selected. 
- MarkerCenter: Sets the frequency of the active marker to the center frequency of 

spectrum analyzer. 
- MarkerStart: Sets the frequency of the active marker to the start frequency of spectrum 

analyzer. 
- MarkerStop: Sets the frequency of the active marker to the stop frequency of spectrum 

analyzer. 

 Frequency Count: This Frequency Count is used when a highly accurate reading of the 
frequency is needed for the active marker on the signal. The measurement sweeps get 
significantly slower because the instrument runs the measurement of the signal peak with 1 Hz 
resolution in background. Toggle this key between On and Off to enable or disable the 
frequency count function for the selected marker. 

 Noise Marker: This Noise Marker is used to measure a noise adjacent to a signal by 
averaging several data points to calculate the readout for the Noise Marker as if making a 
measurement using a 1 Hz bandwidth. Toggle this key between On and Off to enable or 
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disable the noise marker function for the selected active marker. 
 

 NOTE 
Frequency Count and Noise Marker functions are used only in the Spectrum Analyzer 
mode. 

 

Using peak search 

Peak search  

Each time the Peak Search soft key is pressed, the active marker is positioned at the highest peak of 
the trace. 

 Peak Search: Moves the active marker to the highest peak of the trace. 

 Next Peak: Moves the active marker to the second highest peak of the trace. 

 Next Peak Right: Moves the active marker to the highest peak to the right of its current 
position. 

 Next Peak Left: Moves the active marker to the highest peak to the left of its current position. 

 Min Search: Moves the active marker to the lowest peak of the trace. 

 Always Peak: When the Always Peak is set to On, the instrument moves the active marker 
automatically to the highest peak of the trace every time the trace is refreshed. 
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Chapter 4 Using Spectrum Analyzer 

This chapter provides instructions for using the Spectrum Analyzer function. Topics discussed in this 
chapter are as follows: 
 

 Introduction ................................................................................................................................ 52 

 Display overview ........................................................................................................................ 52 

 Connecting a cable .................................................................................................................... 53 

 Selecting measurement mode ................................................................................................... 54 

 Conducting spectrum measurements ........................................................................................ 61 

 Conducting RF measurements .................................................................................................. 64 
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Introduction 

The advantage of using the Spectrum Analyzer is easy to verify the presence of unwanted signals 
such as spurious and harmonics, which are normally very hard to identify in time domain analysis.  
 
Performance assurance in wireless communication systems includes the observation of the out-of-
band signal characteristics in order to identify the presence of harmonic signals. Harmonic signals of a 
carrier may interfere with other signals far out of the transmission band, or harmonic signals from other 
transmitter may interfere with in band signals affecting the spectral integrity. 
 
In these days when wide variety of wireless communication services are provided in frequency bands 
assigned very closely to each other, it is critical to ensure that each communication service is carried 
out within their assigned frequency band minimizing interference with adjacent frequency bands. The 
Adjacent Channel Power Ratio (ACPR) characteristic of a power amplifier or other RF components is 
an important factor in evaluating the system performance. 
 
The JD700B series is the optimal solution to perform following measurements: 
 

 Spectrum Analysis 
- Spectrum 

 RF Analysis 
- Channel Power 
- Occupied Bandwidth 
- Spectrum Emission Mask 
- Adjacent Channel Power (ACP) 
- Multi-ACP 
- Spurious Emissions 
- AM/FM Audio Demodulation 
- Field Strength 
- Route Map 
- Dual Spectrum 
- PIM Detection (Single and Multiple Carriers) 

 

Display overview 

Figure 5 provides overview of each segment of the measurement screen. 
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Figure 5 Spectrum measurement screen 

 

 

Connecting a cable 

There are two ways that you can make a connection of your instrument and the base station to be 
tested: direct or indirect. 
 

Procedure 

To make a direct connection: 
1 Connect the Spectrum Analyzer RF In port of the JD700B series and the PA output port of BTS 

as shown in Figure 6. 
 
To make an indirect connection: 

1 Connect the Spectrum Analyzer RF In port of the JD700B series and the monitor (test) port of 
BTS as shown in Figure 7. 

 
Figure 6 Direct connection 

 
JD785B/JD786B/JD745B/JD746B 

 
JD788B/JD748B 
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Figure 7 Indirect connection 

 
JD785B/JD786B/JD745B/JD746B 

 
JD788B/JD748B 

 

 

CAUTION 
The maximum power for the Spectrum Analyzer RF In port is +25 dBm (0.316 W) for 
JD780B series and +20 dBm (0.1 W) for JD740B series. If the level of the input signal to 
be measured is greater than this, use a High Power Attenuator to prevent damage 
when you directly connect the signal to the instrument or connect the signal from the 
coupling port of a directional coupler. 

 

Selecting measurement mode 

Procedure 

1 Press the MODE hard key. 
2 Press the Spectrum Analyzer soft key. The Measure Off mode is selected by default. 
3 Press the MEASURE hot key, and then select the measurement mode from the following 

choices: 
–  Channel Power 

–  Occupied BW 

–  Spectrum Emission Mask 

–  Adjacent Channel Power 

–  Multi-ACP 

–  Spurious Emissions 

–  AM/FM Audio Demod 

–  Field Strength 

–  Route Map 

–  Dual Spectrum 

–  PIM Detection > Single Carrier and Multiple Carriers 

 

Configuring test parameters 

Setting frequency 

You need to set the frequency range to be measured with either the center frequency/span or the 
start/stop frequencies. You can also set the frequency with the channel number and span. 
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Procedure 

To set the center frequency and span: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Freq. 
3 Press the Center Frequency soft key. 
4 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 
5 Select the unit: GHz, MHz, kHz, or Hz. 
6 Press the Span soft key, and then do one of the following: 

–  To set the span manually, select Span, enter a value, and then select the unit. 

–  To set the span automatically, select Full Span, Zero Span, or Last Span as needed. 
 

 NOTE 
The Zero Span option is available only in the Spectrum mode. If you have selected Zero 
Span, select TRIGGER > Free Run, External, GPS, Video, or Display Position. 

 
To set the start and stop frequencies: 

1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Freq. 
3 Press the Start Frequency soft key. 
4 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 
5 Select the unit: GHz, MHz, kHz, or Hz. 
6 Press the Stop Frequency soft key. 
7 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 
8 Select the unit: GHz, MHz, kHz, or Hz. 

 
To set the channel number and span: 

1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Channel. 
3 To select the standard channel, complete the following steps: 

 Press the Channel Std soft key. The standard channel window appears. a
See “Appendix C – Band, frequency & channel standard” on page 530 for more information. 

 Highlight the band to be measured by using the rotary knob, the arrow keys, or the Page b
Up/Page Down soft keys. 

 Press the Select soft key or the rotary knob to confirm the selection. c
4 Toggle the Link soft key to select the sweep direction and select Fwd for forward or Rev for 

reverse. 
5 To set the channel number, complete the following steps: 

 Press the Channel Number soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key or ENTER hard key to complete the entry. c

The instrument automatically displays the corresponding center frequency value for the 
selected channel number. 

6 To set the span, complete the following steps: 
 Press the Span soft key. a
 Select the span option, from the following choices: b

–  To set the span manually, select Span, enter a value, and then select the unit. 

–  To set the span automatically, select Full Span, Zero Span, or Last Span as needed. 
 

 NOTE 
The Zero Span option is available only in the Spectrum mode. If you have selected Zero 
Span, select TRIGGER > Free Run, External, GPS, Video, or Display Position. 
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Optional. To define the amount of frequency increment for the rotary knob: 
1 Press the Frequency Step soft key, if the Freq is selected. 
2 Enter a value by using the numeric keys. 
3 Press the unit: GHz, MHz, kHz, or Hz. 

 
Optional. To define the amount of channel increment for the rotary knob: 

1 Press the Channel Step soft key, if the Channel is selected. 
2 Enter a value by using the numeric keys. 
3 Press the Enter soft key. 

 
 NOTE 

This setting is not used in the Spurious Emissions mode. 
 

Setting amplitude 

Reference level and attenuation 

You can set the reference and attenuation levels automatically or manually to optimize the display of 
the traces measured, as you desire. 
 

Procedure 

To automatically set the reference and attenuation level: 
1 Press the AMP/SCALE hard key. 
2 Press the Auto Scale soft key. 

Each time you press this key, both of the Y-axis scale and input attenuation level change to be 
optimized with some margin. 

 
To set the reference or attenuation level manually: 

1 Press the AMP/SCALE hard key. 
2 To set the maximum reference level on the Y-axis manually, complete the following steps: 

 Press the Reference Level soft key. a
 Enter a value by using the numeric keys or the rotary knob with 10 dB increments. b
 Press the dBm soft key or the ENTER hard key. c

This unit key name changes according to the setting in the Units menu. 
3 To set the attenuation option, select one from the following choices: 

–  To set the input attenuator’s level automatically, select Attenuation > Auto. 
 

 NOTE 
It is recommended that you set the Attenuation to Auto in most situations so that the 
level of the input attenuator can be set automatically according to your input signal level. 

 

–  To set the input attenuation manually up to 55 dB for JD780B series or 50 dB for JD740B 
series to optimize S/N, complete the following steps: 

 Select Attenuation > Manual. a
 Press the Attenuation Value soft key to set the level. b
 Enter a value in fives by using the numeric keys. c
 Press the dB soft key or the ENTER hard key. d

–  To couple the input attenuator’s level with your reference level setting, select Attenuation > 
Couple. 
As you increase the reference setting, the attenuation level also increases acoordingly. 

 
Optional. To change the scale unit: 

1 Select More (1/2) > Units. 
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2 Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W. 
The scale unit on the screen changes accordingly. 

 

 NOTE 
For the Field Strength mode, the units change to dBµV/m, dBmV/m, dBV/m, Volt/m, 
Watt/m^2, and dBm/m^2. 

 

 

Pre-amplifier 

You can turn the internal pre-amplifier on to correct and compensate for the gain of the preamplifier so 
that amplitude readings show the value at the input connector. 
 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Toggle the Preamp soft key and select On or Off as needed. 

 
 NOTE 

You can turn the Preamp on when the input attenuation range is from 0 dB to 10 dB. If 
the attenuation value is manually set to greater than 10 dB, the instrument will 
automatically turn off the pre-amplifier to display low-level signal properly on the chart. 

 

External offset 

You can turn the External Offset on and manually set the external offset value. An offset consists of a 
cable loss and a user offset and the measurement result shows the value reflecting both offset values. 
When the external offset value is set at 40 dB in the Spectrum mode, the measurement result 
compensates 40 dB at both the Spectrum Analyzer and Signal Analyzer modes 
 

Procedure 

To set the external offset: 
1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select On. 
3 Enter a value by using the numeric keys. 
4 Press the dB soft key to complete the entry. 

 
To turn the external offset off: 

1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select Off. 

 
 NOTE 

This setting is not used in the Field Strength mode. 
 

Scale per division 

You can use the Scale/Div feature available for the spectrum measurement screen. It represents the 
value of one division on the horizontal scale. The default setting is 10 dB per division and the 
maximum value can be set up to 20 dB. 
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Procedure 

To set the scale per division: 
1 Press the AMP/SCALE hard key. 
2 Select More (1/2) > Scale/Div. 
3 Enter a value between 1 and 20 by using the numeric keys. 
4 Press the dB soft key to complete the entry. 

 

Setting bandwidth 

You can manually set the Resolution Bandwidth (RBW), Video Bandwidth (VBW), and the proportional 
VBW based on the designated RBW. Selecting Auto changes the value to correspond to your 
frequency span setting for RBW and to the current RBW and VBW/RBW settings for VBW. 
 

Procedure 

To automatically set the RBW and VBW to your selected VBW/RBW ratio: 
1 Press the BW/AVG hard key. 
2 Press the VBW/RBW soft key to set the proportional VBW based on the designated RBW. 

Table 9 shows the ratio example for 30 kHz RBW. 
3 Select the ratio: 1, 0.3, 0.1, 0.03, 0.01, or 0.003. 
4 Toggle the RBW soft key and select Auto. 
5 Toggle the VBW soft key and select Auto. 

The RBW or VBW value on the screen changes accordingly based on the span. 
 
To manually set the RBW or VBW to your selected VBW/RBW ratio: 

1 Press the BW/AVG hard key. 
2 Press the RBW soft key. 
3 Enter a value between 1 Hz to 3 MHz in 1-3 sequence by using the numeric keys. 
4 Select the unit: MHz, kHz, or Hz. 

The RBW setting automatically changes to Manual. 
5 Press the VBW soft key. 
6 Enter a value by using the numeric keys. 
7 Select the unit: MHz, kHz, or Hz. 

The VBW setting automatically changes to Manual. 
The RBW or VBW value on the screen changes accordingly. 

 
 NOTE 

This setting is not used in the Spurious Emissions mode. 
 

Table 9 VBW/RBW ratio example 

RBW Ratio (VBW/RBW) VBW 

30 kHz 1:1 30 kHz 

 1:0.3 10 kHz 

 1:0.1 3 kHz 

 1:0.03 1 kHz 

 1:0.01 300 Hz 

 1:0.003 100 Hz 
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Setting average 

You can set the number of measurements to be averaged for the trace presentation. A maximum of 
100 times of averaging can be set. When the averaging reaches to your setting, a new measurement 
value replaces the measurement value in sequence from the earliest. 
 

Procedure 

1 Press the BW/AVG hard key. 
2 Press the Average soft key. 
3 Enter a value between 1 and 100 as needed by using the numeric keys. 
4 Press the Enter soft key. 

 

Setting sweep 

The SWEEP hot key is used to set and control the sweep time, sweep mode, gated sweep settings, 
and gated sweep on or off. 
 

Sweep time 

You can set the sweep time automatically or manually. Manual setting allows you to set the sweep time 
beyond an automatic setting. 
 

Procedure 

1 Press the SWEEP hot key. 
2 Select the sweep time option, from the following choices: 

–  To automatically set, toggle the Sweep Time soft key and select Auto. 

–  To manually set, complete the following steps: 
 Press the Sweep Time soft key. a
 Enter a value by using the numeric keys. b
 Select the unit: Sec, mSec, or µSec. c

The sweep time mode automatically changes to Manual. 

 
 NOTE 

This setting is not used in the Spurious Emissions mode. 
 

Sweep mode 

The default settings of the sweep mode are Continue and Normal to sweep continuously at a normal 
speed for most on-going measurements. If you want to hold the measurement or get a single sweep, 
you can change the sweep mode. 
 

Procedure 

To select the single sweep mode: 
1 Press the SWEEP hot key. 
2 Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key. 

The letter HOLD in red appears and the sweeping is paused. 
3 Optional. Press the Sweep Once soft key to get a new measurement. 
4 Optional. To speed up sweeping, press the Sweep Mode soft key and then select Fast. 



Chapter 4 Using Spectrum Analyzer 

60 JD700B Series User’s Guide 

 
 NOTE 

Selecting Sweep Mode > Fast may reduce the measurement accuracy, but it is useful to 
identify the existence of interfering signals. 

 
To return to the continuous sweep mode: 

1 Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key. 
The letter HOLD in red disappears and the sweeping resumes. 

 
 NOTE 

This setting is not used in the in the Field Strength mode, the AM/FM Audio Demodulation 
mode, and the Route Map mode. 

 

Gated sweep 

You can configure the gated sweep settings with an internal or external trigger source. If you select 
Gated Sweep Settings, you can view the signal in time domain. 
 

Procedure 

1 Press the SWEEP hot key. 
2 Press the Gated Sweep Settings soft key. 
3 Optional. Adjust sweep time to allow enough time for a cycle by completing the following steps: 

 Press the Zero Span Time soft key. a
 Enter a value by using the numeric keys. b
 Select the unit: Sec, mSec, or µSec. c

4 Set the period, if using the internal trigger source, by doing one of the following: 
–  To select the preset period, complete the following steps: 

 Toggle the Period soft key and select StdSignal. a
 Press the StdSignal soft key, and then select the period from the choices:  b

GSM (4.615 ms), WCDMA (10 ms), LTE (10 ms), EV-DO (5 ms), TD-SCDMA (5 ms), 
and WiMAX (10 ms). 

–  To manually set the period, complete the following steps: 
 Toggle the Period soft key and select Manual. a
 Press the Period soft key to enter the amount of time. b
 Enter a value by using the numeric keys. c
 Select the unit: Sec, mSec, or µSec. d

5 Press the TRIGGER hot key, and then do one of the following: 
–  Select External for an external trigger source. 

–  Select Video or Display Position for the internal trigger source. 

6 Press the PREV hard key to continue setting the gated sweep. 
7 Set the gate delay by completing the following steps: 

 Press the Gate Delay soft key. a
 Enter a value by using the numeric keys. b
 Select the unit: Sec, mSec, or µSec. c

8 Set the gate length by completing the following steps: 
 Press the Gate Length soft key. a
 Enter a value by using the numeric keys. b
 Select the unit: Sec, mSec, or µSec. c

9 Press the PREV hard key to enable gated sweeping. 
10 Toggle the Gated Sweep soft key and select On. 
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 NOTE 
This setting is not used in the in the Spurious Emissions mode, the Field Strength mode, 
and the Route Map mode. 

 

Using RF source 

You can turn the RF Source feature on to provide different power levels as like using a CW signal 
generator. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the RF Source soft key. 
3 Press the Frequency soft key to set the frequency of the RF source. 
4 Enter a value, and then select the unit: GHz, MHz, kHz, or Hz. 
5 Press the Power Level soft key. 
6 Enter a value between -60 and 0, and then select the dBm soft key. 
7 Toggle the RF Source soft key and select On. 

 

Conducting spectrum measurements 

If you have configured test parameters as described in the “Configuring test parameters” on page 54, 
your measurement is displayed on the screen as like the following example, Figure 8. 
 

Figure 8 Spectrum measurement with spectrum analyzer 
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Figure 9 Gate sweep measurement with spectrum analyzer 

 
 

Setting trace 

You can display up to six traces on the measurement chart simultaneously. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6. 

The legend shape of the selected trace changes from square to round to indicate that the trace is 
the active one now. 

3 Toggle the Trace View soft key and select On. 
4 Do one of the following: 

 

To Select Trace Legend 

Clear current data and display with new 
measurements 

Clear Write W 

Display the input signal’s maximum response only 
(unlimited or for a certain amount of time) 

Max Hold M 

Display the input signal’s minimum response only 
(unlimited or for a certain amount of time) 

Min Hold m 

Capture the selected trace and compare traces Capture C 

Load a saved trace More (1/2) > Load L 

Hide the selected trace Trace View > Off F 

Remove all the traces and initialize the trace 
settings 

More (1/2) > Trace 
Clear All 

 

 
 NOTE 

For the Max Hold and Min Hold, your instrument compares newly acquired data with the 
active trace and displays larger maximum values or smaller minimum values on the 
screen. You can set it to Unlimited to hold and view maximum or minimum data or 
specify a certain amount of time up to 60 seconds by using numeric keys or the rotary 
knob. 
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5 To select the detection option, press the More (1/2) > Detectors, and then do one of the 
following: 

 

To display Select 

Random noise better than the peak without missing signals Normal 

The highest value in each data point Peak 

The root mean squared average power across the spectrum RMS 

The lowest value in each data point Negative Peak 

The center value in each data point Sample 
 

6 Optional. Press the More (1/2) > Trace Info soft key, and then select the trace number to view 
the trace’s parameter setting information stored at the time of the measurement or None to hide 
the information display. 

7 Optional. If you have the two traces T1 and T2, you can perform trace math. To view the power 
difference between the traces, press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key. 
The result is overlaid on the screen along with the second Y-axis. 

 
 NOTE 

To be able to load a trace, the trace to be overlaid must be saved in the same 
measurement mode and frequency setting as the current measurement. 

 

Setting limit 

Procedure 

To use the display line: 
1 Press the LIMIT hot key. 
2 Press the Display Line soft key for a reference line. 
3 Enter a value, and then press the dBm unit soft key. 
4 Toggle the Display Line soft key between On and Off to display and dismiss the reference line. 

The straight line appears across the screen to be used as a visual reference only. 
 
To display the multiple segment line: 

1 Press the LIMIT hot key. 
2 Press the Multi Segment Line soft key for Pass/Fail indication. 
3 Toggle the Limit soft key between Upper and Lower to select the one to be displayed. 
4 Set the number of segments for the selected upper or lower limit line. You can set up to 50 

segments. 
 Press the # of Line soft key. a
 Enter a value between 1 and 50 by using the numeric keys. b
 Press the Enter soft key. c

5 Press the Autoset soft key to let the instrument set the limit for each segment and display the 
line. 

6 Optional. To move the limit line, complete the following steps: 
 Select Limit Up/Down or Limit Left/Right. a
 Turn the rotary knob to move the line as desired. You can also manually enter a value. b

7 Optional. To edit the segment properties, complete the following steps: 
 Press the Edit Limit soft key. a
 Press the Move soft key and then turn the rotary knob to select the segment to edit. b
 Select the menu option, from the following choices: c
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–  To hide the line for the selected segment, toggle the Line soft key and select Off. 

–  To add a new point, press the Add Point soft key. 

–  To delete the selected point, press the Delete Point soft key. 

–  To change the position, press the Frequency or Amplitude soft key, and then turn the 
rotary knob to change the value as desired. 

8 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 32 for more information. 

 

Conducting RF measurements 

Channel power 

The Channel Power measurement is a common test used in the wireless industry to measure the total 
transmitted power of a radio within a defined frequency channel. It acquires a number of points 
representing the input signal in the time domain, transforms this information into the frequency domain 
using Fast Fourier Transform (FFT), and then calculates the channel power. The effective resolution 
bandwidth of the frequency domain trace is proportional to the number of points acquired for the FFT. 
 
The channel power measurement identifies the total RF power, power spectral density, and Peak to 
Average Ratio (PAR) of the signal within the channel bandwidth. 
 

Setting measure setup 

After configuring test parameters, you can set the measure setup to continue your measurement. The 
measurement settings can be saved and recalled as a file. You can also use JDViewer, PC application 
software to configure a measure setup, save as a file, and load the file on to the instrument. 
 

Procedure 

1 Configure test parameters as described in the “Configuring test parameters” on page 54. 
2 Press the MEASURE SETUP hot key. 
3 Set the channel power measurement bandwidth to be measured: 

 Press the Integrated BW soft key. a
 Enter a bandwidth by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

4 Set the frequency range over which the instrument will sweep: 
 Press the Span soft key. a
 Enter a span frequency value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

5 Set the number of measurements to be averaged: 
 Press the Average soft key. a
 Enter a value between 1 and 100. b
 Press the Enter soft key. c

 

Setting limit 

Procedure 

1 Press the LIMIT hot key. 
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2 Press the Channel Power soft key to set the limit parameters. 
3 Toggle the Test Limits soft key between On and Off to enable or disable the Pass/Fail indication. 
4 Set the upper threshold: 

 Press the High Limit soft key. a
 Enter a value for the upper limit. b
 Press the dBm unit soft key. c

5 Set the lower threshold: 
 Press the Low Limit soft key. a
 Enter a value for the lower limit. b
 Press the dBm unit soft key. c

6 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 32 for more information. 

 

Measurement example 

Figure 10 Channel power measurement with spectrum analyzer 

 
 
Channel power measurement result shows channel power and spectrum density in a user specified 
channel bandwidth. The peak to average ratio (PAR) is shown at the bottom of the screen as well. The 
shaded area on the display indicates the channel bandwidth. 
 

Occupied bandwidth 

The Occupied Bandwidth measures the percentage of the transmitted power within a specified 
bandwidth. The percentage is typically 99%. 
 

Setting measure setup 

After configuring test parameters, you can set the measure setup to continue your measurement. The 
measurement settings can be saved and recalled as a file. You can also use JDViewer, PC application 
software to configure a measure setup, save as a file, and load the file on to the instrument. 
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Procedure 

1 Configure test parameters as described in the “Configuring test parameters” on page 54. 
2 Press the MEASURE SETUP hot key. 
3 Set the percentage of power within the bandwidth to be measured: 

 Press the Occupied BW % Power soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

4 Set the frequency range over which the instrument will sweep: 
 Press the Span soft key. a
 Enter a span frequency value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

5 Set the number of measurements to be averaged: 
 Press the Average soft key. a
 Enter a value between 1 and 100. b
 Press the Enter soft key. c

 

Setting limit 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Occupied BW soft key to set the limit parameters. 
3 Toggle the Test Limits soft key between On and Off to enable or disable the Pass/Fail indication. 
4 Set the upper threshold: 

 Press the High Limit soft key. a
 Enter a value for the upper limit. b
 Select the unit: MHz, kHz, or Hz. c

5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 32 for more information. 

 

Measurement example 

The Occupied Bandwidth measurement shows both of power across the band and power bandwidth in 
a user specified percentage to determine the amount of spectrum used by a modulated signal. 
Occupied bandwidth is typically calculated as the bandwidth containing 99% of the transmitted power. 
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Figure 11 Occupied bandwidth measurement with spectrum analyzer 

 
 

Spectrum emission mask (SEM) 

The Spectrum Emission Mask (SEM) measurement is to identify and determine the power level of out-
of-band spurious emission outside the necessary channel bandwidth and modulated signal. It 
measures the power ratio between in-band and adjacent channels. The JD700B series indicates either 
Pass or Fail based on the specified limit of the signal. 
 

Setting measure setup 

After configuring test parameters, you can set the measure setup to continue your measurement. The 
measurement settings can be saved and recalled as a file. You can also use JDViewer, PC application 
software to configure a measure setup, save as a file, and load the file on to the instrument. 
 

Procedure 

1 Configure test parameters as described in the “Configuring test parameters” on page 54. 
2 Press the MEASURE SETUP hot key. 
3 Set the main channel bandwidth to be measured: 

 Press the Main Channel BW soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: MHz, kHz, or Hz. c

4 Set the frequency range over which the instrument will sweep: 
 Press the Span soft key. a
 Enter a span frequency value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

5 Set the number of measurements to be averaged: 
 Press the Average soft key. a
 Enter a value between 1 and 100. b
 Press the Enter soft key. c

6 To configure an offset, up to five, complete the following steps: 
 Press the Offset/Limit soft key. a

The Offset/Limit screen menu bar appears. 
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 Press the Offset soft key, and then select the number for the active offset to configure. b
 Toggle the Offset soft key and select On to display or Off to hide the active offset. c
 Press the Offset Frequency soft key to set the center frequency of the offset. d
 Enter a value by using the numeric keys. You can also use the rotary knob. e
 Select the unit: MHz, kHz, or Hz. f
 Press the Measurement Bandwidth soft key to set the bandwidth for the selected offset. g
 Enter a value by using the numeric keys. You can also use the rotary knob. h

 Select the unit: MHz, kHz, or Hz. i
 Toggle the Reference soft key between Relative and Absolute and select Relative or j

Absolute depending on how to use the reference. 
7 To define the selected offset’s limits for Pass/Fail indication, complete the following steps: 

 Press the Start Offset Limit soft key to set the threshold for the power difference between a
the main channel bandwidth and the selected offset bandwidth on the left. 

 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the dB soft key. c
 Press the Stop Offset Limit soft key to set the threshold for the power difference between d

the main channel bandwidth and the selected offset bandwidth on the right. 
 Enter a value by using the numeric keys. You can also use the rotary knob. e
 Select the dB soft key. f

 

Setting limit 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Spectrum Emission Mask soft key. 
3 Toggle the Test Limits soft key between On and Off to enable or disable the Pass/Fail 

indication. 
4 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 

See “Using save” on page 32 for more information. 

 

Measurement example 

Figure 12 Spectrum emission mask measurement with spectrum analyzer 
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Adjacent channel power (ACP) 

The Adjacent Channel Power (ACP) is the power contained in a specified frequency channel 
bandwidth relative to the total carrier power. It may also be expressed as a ratio of power spectral 
densities between the carrier and the specified offset frequency band. 
 

Setting measure setup 

After configuring test parameters, you can set the measure setup to continue your measurement. The 
measurement settings can be saved and recalled as a file. You can also use JDViewer, PC application 
software to configure a measure setup, save as a file, and load the file on to the instrument. 
 

Procedure 

1 Configure test parameters as described in the “Configuring test parameters” on page 54. 
2 Press the MEASURE SETUP hot key. 
3 Set the main channel bandwidth to be measured: 

 Press the Main Channel BW soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: MHz, kHz, or Hz. c

4 Set the frequency range over which the instrument will sweep: 
 Press the Span soft key. a
 Enter a span frequency value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

5 Set the number of measurements to be averaged: 
 Press the Average soft key. a
 Enter a value between 1 and 100. b
 Press the Enter soft key. c

6 To configure an offset, up to five, complete the following steps: 
 Press the Offset/Limit soft key. a

The Offset/Limit screen menu bar appears. 
 Press the Offset soft key, and then select the number for the active offset to configure. b
 Toggle the Offset soft key and select On to display or Off to hide the active offset. c
 Press the Offset Frequency soft key to set the center frequency of the offset. d
 Enter a value by using the numeric keys. You can also use the rotary knob. e
 Select the unit: MHz, kHz, or Hz. f
 Press the Integration Bandwidth soft key to set the bandwidth for the selected offset. g
 Enter a value by using the numeric keys. You can also use the rotary knob. h

 Select the unit: MHz, kHz, or Hz. i
7 To define the selected offset’s limits for Pass/Fail indication, complete the following steps: 

 Press the Lower soft key to set the threshold for the power difference between the main a
channel bandwidth and the selected offset bandwidth on the left. 

 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the dBc soft key. c
 Press the Upper soft key to set the threshold for the power difference between the main d

channel bandwidth and the selected offset bandwidth on the right. 
 Enter a value by using the numeric keys. You can also use the rotary knob. e
 Select the dBc soft key. f
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Setting limit 

Procedure 

1 Press the LIMIT hot key. 
2 Press the ACP soft key. 
3 Toggle the Test Limits soft key between On and Off to enable or disable the Pass/Fail 

indication. 
4 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 

See “Using save” on page 32 for more information. 

 

Measurement example 

Figure 13 Adjacent channel power measurement with spectrum analyzer 

 
 

Multi-ACP 

The Multi-ACP measurement is used to do multi-channel ACP testing. It helps you to measure ACP in 
multi-channel transmitting base station environment. 
 

Setting measure setup 

After configuring test parameters as described in “Configuring test parameters” on page 54, you can 
set the measure setup to continue your measurement. The measurement settings can be saved and 
recalled as a file. You can also use JDViewer, PC application software to configure a measure setup, 
save as a file, and load the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the Unit soft key and select Freq or Channel. 

–  For the frequency setting, complete the following steps: 
 Press the Lowest Frequency soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c
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 Press the Highest Frequency soft key. d
 Enter a value by using the numeric keys. You can also use the rotary knob. e
 Select the unit: GHz, MHz, kHz, or Hz. f

–  For the channel setting, complete the following steps: 
 Press the Channel Std soft key. The standard channel window appears. a
 Select the band to be measured by using the rotary knob or the Page p/Page Down b

soft keys. 
 Press the Select soft key or the rotary knob to confirm the selection. c
 Toggle the Link soft key to select the sweep direction and select Fwd or Rev as d

needed. 
 Press the Lowest Channel soft key. e
 Enter a value by using the numeric keys. f
 Press the Enter soft key or ENTER hard key to complete the entry. g

The instrument automatically displays the corresponding center frequency value for the 
selected channel number. 

 Press the Highest Channel soft key. h
 Enter a value by using the numeric keys. i
 Press the Enter soft key or ENTER hard key to complete the entry. j

The instrument automatically displays the corresponding center frequency value for the 
selected channel number. 

3 To set up ACP setting, press the ACP Settings soft key and then complete the following steps: 
 Press the Main Channel BW soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: MHz, kHz, or Hz. c
 Press the Span soft key to set the frequency range over which the instrument will sweep. d
 Enter a span frequency value by using the numeric keys. You can also use the rotary knob. e
 Select the unit: GHz, MHz, kHz, or Hz. f
 Press the Average soft key to set the number of measurement to be averaged: g
 Enter a value between 1 and 100. h

 Press the Enter soft key. i
4 To configure an offset, up to five, complete the following steps: 

 Press the Offset/Limit soft key. The Offset/Limit screen menu bar appears. a
 Press the Offset soft key, and then select the number for the active offset to configure. b
 Toggle the Offset soft key and select On to display or Off to hide the active offset. c
 Press the Offset Frequency soft key to set the offset frequency. d
 Enter a value by using the numeric keys. You can also use the rotary knob. e
 Select the unit: MHz, kHz, or Hz. f
 Press the Integration Bandwidth soft key. g
 Enter a value by using the numeric keys. You can also use the rotary knob. h

 Select the unit: MHz, kHz, or Hz. i
5 To define the selected offset’s limits for Pass/Fail indication, complete the following steps: 

 Press the Lower soft key to set the threshold for the power difference between the main a
channel bandwidth and the selected offset bandwidth on the left. 

 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the dBc soft key. c
 Press the Upper soft key to set the threshold for the power difference between the main d

channel bandwidth and the selected offset bandwidth on the right. 
 Enter a value by using the numeric keys. You can also use the rotary knob. e
 Select the dBc soft key. f
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Setting limit 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Multi-ACP soft key. 
3 Toggle the Test Limits soft key between On and Off to enable or disable the Pass/Fail 

indication. 
4 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 

See “Using save” on page 32 for more information. 

 

Measurement example 

Figure 14 Multi-ACP measurement with spectrum analyzer 

 
 

Spurious emissions 

The Spurious Emissions measurement is to identify or determine the power level of in-band or out-of-
band spurious emissions within the necessary channel bandwidth and modulated signal. The JD700B 
series indicates either Pass or Fail based on the specified limit of the signal. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 54, you 
can set the measure setup to continue your measurement. The measurement settings can be saved 
and recalled as a file. You can also use JDViewer, PC application software to configure a measure 
setup, save as a file, and load the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set up the range table, complete the following steps: 

 Press the Range Table soft key. a
 Press the Range soft key, and then enter the range number to add a new range or change b

an existing one. 
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 Press the Enter soft key. c
 Press the Start Frequency soft key to set up the frequency range. d
 Enter a value by using the numeric keys. You can also use the rotary knob. e
 Select the unit: GHz, MHz, kHz, or Hz. f
 Press the Stop Frequency soft key to set up the frequency range. g
 Enter a value by using the numeric keys. You can also use the rotary knob. h

 Select the unit: GHz, MHz, kHz, or Hz. i
3 Toggle the Range soft key between On and Off to display or hide the selected range. 
4 To set up the test limits for Pass/Fail indication, complete the following steps: 

 Press the Start Limit soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the dBm soft key. c
 Press the Stop Limit soft key. d
 Enter a value by using the numeric keys. You can also use the rotary knob. e
 Select the dBm soft key. f

5 To set up the other parameters, complete the following steps: 
 Select More (1/2) > Attenuation to set up the attenuation value. a
 Enter a value in the multiple of five. b
 Press the dB soft key or the ENTER hard key. c
 Press the RBW soft key. d
 Enter a value by using the numeric keys. e
 Select the unit: GHz, MHz, kHz, or Hz. f
 Press the VBW soft key. g
 Enter a value by using the numeric keys. h

 Select the unit: GHz, MHz, kHz, or Hz. i
6 Toggle the Measure Type soft key between Examine and Full to select the measurement type. 

 

 NOTE 
The Examine mode displays only the selected range while the Full mode lets the 
instrument automatically changes the selected range from one another. 

 

7 Set the number of measurements to be averaged: 
 Press the Average soft key. a
 Enter a value between 1 and 100. b
 Press the Enter soft key. c

 

Setting limit 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Spurious Emissions soft key. 
3 Toggle the Test Limits soft key between On and Off to enable or disable the Pass/Fail indication. 
4 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 

See “Using save” on page 32 for more information. 
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Measurement example 

Figure 15 Spurious emissions measurement with spectrum analyzer 

 
 

AM/FM audio demodulation 

The AM/FM Audio Demodulator operates using the power received from radio waves and it serves as 
an alternative to identify interfering signals easily. The instrument sounds demodulated signals that 
can be heard through the built-in speaker or plugged-in headphones. You can hear the sound and 
identify interfering signals easily. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 54, you 
can set the measure setup to continue your measurement. The measurement settings can be saved 
and recalled as a file. You can also use JDViewer, PC application software to configure a measure 
setup, save as a file, and load the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the Audio Demod soft key between On and Off to turn the AM/FM audio demodulation 

on and off. 
3 Press the Demod at soft key, and then select the marker number for the frequency to be 

demodulated. 
 

 NOTE 
You must set the marker(s) first by using the MARKER hard key as the AM/FM 
demodulator uses the marker position to demodulate. See “Using marker” on page 49 for 
more information. 

 

4 Press the Demod Mode soft key, and then select the demodulation mode: AM, FM and CW. 
5 Press the Dwell Time soft key, and then turn the rotary knob to set the demodulation interval 

between 1 and 20. 
6 Press the Volume soft key, and then turn the rotary knob to set the speaker volume. 
7 Toggle the Auto Gain soft key between On and Off to enable or disable the automatic gain 

feature to adjust the interval gain of the demodulator. 
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8 Optional. You can use the Save On Event soft key to let the instrument automatically save 
measurement screen or result that falls outside the defined limit settings or the Fail indicator is 
on. You can also set to save the first event and hold the measurement or to save all the events 
continuously. See “Using save” on page 32 for more information. 

 

Setting limit 

You can show or hide the display line on the screen that is used as a visual reference only. 
 

Procedure 

To view the display line: 
1 Press the LIMIT hot key. 
2 Press the Display Line soft key. 
3 Enter a value, and then press the dBm unit soft key. 
4 Toggle the Display Line On/Off soft key and select On. 

The straight line appears on the screen. 
 
To dismiss the display line: 

1 Press the LIMIT hot key. 
2 Toggle the Display Line On/Off soft key and select Off. 

 
You can use the multiple segment limit line to set up different limits for different frequency ranges for 
Pass/Fail indication. 
 

Procedure 

To display the multiple segment line: 
1 Press the LIMIT hot key. 
2 Press the Multi Segment Line soft key. 
3 Toggle the Limit soft key between Upper and Lower to select the one to be displayed. 
4 Set the number of segments for the selected upper or lower limit line. You can set up to 50 

segments. 
 Press the # of Line soft key. a
 Enter a value between 1 and 50 by using the numeric keys. b
 Press the Enter soft key. c

5 Press the Autoset soft key to let the instrument set the limit for each segment and display the 
line. 

6 Optional. To move the limit line, complete the following steps: 
 Select Limit Up/Down or Limit Left/Right. a
 Turn the rotary knob to move the line as desired. You can also manually enter a value. b

7 Optional. To edit the segment properties, complete the following steps: 
 Press the Edit Limit soft key. a
 Press the Move soft key and then turn the rotary knob to select the segment to edit. b
 Select the menu option, from the following choices: c

–  To hide the line for the selected segment, toggle the Line soft key and select Off. 

–  To add a new point, press the Add Point soft key. 

–  To delete the selected point, press the Delete Point soft key. 

–  To change the position, press the Frequency or Amplitude soft key, and then turn the 
rotary knob to change the value as desired. 

8 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
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See “Using save” on page 32 for more information. 

 

Measurement example 

Figure 16 AM/FM audio demodulation with spectrum analyzer 

 
 

Field strength meter 

The Field Strength Meter measures the field strength over the frequency range of a connected 
antenna, which is known with its specific bandwidth and gain characteristics. A standard or user-
defined antenna can be selected from the antenna list in the JD700B series. 
 

Setting measure setup 

Procedure 

1 Connect an antenna to be used with your instrument. 
2 Configure test parameters as described in the “Configuring test parameters” on page 54. 
3 Press the MEASURE SETUP hot key, and then do one of the following: 

–  To select the connected antenna from the list stored in the instrument: 
 Press the Antenna List soft key to view the standard and custom antennas. a

The antenna list window appears. 
 Select an antenna to be used for the field strength measurement by using the rotary b

knob, the arrow keys, or Page Up/Page Down soft keys. 
 Press the Select soft key. c

 

 NOTE 
You can use the JDViewer to edit or define a custom antenna and add to this list. 

 

–  To edit the properties of the connected antenna: 
 Press the Antenna Start Frequency soft key. a
 Enter a value by using the numeric keys, and then select the unit: GHz, MHz, kHz, or b

Hz. You can also use the rotary knob. 
 Press the Antenna Stop Frequency soft key. c
 Enter a value by using the numeric keys, and then select the unit: GHz, MHz, kHz, or d
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Hz. You can also use the rotary knob. 
 Press the Gain soft key to enter the gain information for the antenna. e
 Enter a value by using the numeric keys, and then select the Enter soft key. f

 

Setting limit 

You can show or hide the display line on the screen that is used as a visual reference only. 
 

Procedure 

To view the display line: 
1 Press the LIMIT hot key. 
2 Press the Display Line soft key. 
3 Enter a value, and then press the dBm unit soft key. 
4 Toggle the Display Line On/Off soft key and select On. 

The straight line appears on the screen. 
 
To dismiss the display line: 

1 Press the LIMIT hot key. 
2 Toggle the Display Line On/Off soft key and select Off. 

 
You can use the multiple segment limit line to set up different limits for different frequency ranges for 
Pass/Fail indication. 
 

Procedure 

To display the multiple segment line: 
1 Press the LIMIT hot key. 
2 Press the Multi Segment Line soft key. 
3 Toggle the Limit soft key between Upper and Lower to select the one to be displayed. 
4 Set the number of segments for the selected upper or lower limit line. You can set up to 50 

segments. 
 Press the # of Line soft key. a
 Enter a value between 1 and 50 by using the numeric keys. b
 Press the Enter soft key. c

5 Press the Autoset soft key to set and display the limit line for each segment automatically.. 
6 Optional. To move the limit line, complete the following steps: 

 Select Limit Up/Down or Limit Left/Right. a
 Turn the rotary knob to move the line as desired. You can also manually enter a value. b

7 Optional. To edit the segment properties, complete the following steps: 
 Press the Edit Limit soft key. a
 Press the Move soft key and then turn the rotary knob to select the segment to edit. b
 Select the menu option, from the following choices: c

–  To hide the line for the selected segment, toggle the Line soft key and select Off. 

–  To add a new point, press the Add Point soft key. 

–  To delete the selected point, press the Delete Point soft key. 

–  To change the position, press the Frequency or Amplitude soft key, and then turn the 
rotary knob to change the value as desired. 

8 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 32 for more information. 
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Measurement example 

Figure 17 Field strength measurement with spectrum analyzer 

  
 

Route map 

The JD700B Series provides indoor and outdoor mapping function that allows a user to collect data of 
points in an indoor or outdoor environment and track the received signals and coverage of RF 
transmitters plotting real time directly on top of a loaded floor plan or a map. 
 

Setting measure setup 

Procedure 

1 If required, connect a GPS receiver to your JD700B series for outdoor mapping. 
Indoor mapping does not necessarily need a GPS antenna. 

2 Configure test parameters as described in the “Configuring test parameters” on page 54. 
3 To load your map file, complete the following steps: 

 Plug in your USB drive that has a floor map or .mcf file type created in JDMapCreator. a
 

 NOTE 
The JDMapCreator converts and resizes any scanned floor plan or layout to fit onto your 
instrument’s display. You must save your map file (.mcf) into the “SavedMap” folder of 
your USB drive so that you can load them onto your instrument. 

 

 Press SAVE/LOAD hot key, and then select Load > Load Map. See “Using load” on page b
34 for more information. 

4 Press the MEASURE SETUP hot key. 
5 Press the Plot Point soft key, and then select the plot point option from the following choices: 

–  To collect data/plot points automatically as you move around in a vehicle or outside, select 
GPS and then toggle the Screen Mode soft key between Map and Full. 

 

 NOTE 
With the Map setting, you can view only the collected points that can be seen within the 
boundary of the loaded map. If a point is off the map, the instrument displays an arrow to 
indicate the direction of the current location on the map and the distance from the center 
to the location at the top of the screen. 
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With the Full setting, you can view all the collected points of the route without the loaded 
map. 

 

–  To collect data/plot points manually without a GPS antenna, select Position. 

–  To collect data/plot points based on time, select Time. 
You do not need a GPS antenna as you would usually use this option indoor. 

6 Press the Plot Item soft key, and then select the measurement option: RSSI or ACP. 
7 Optional. If ACP is selected, set the Main Channel BW and Offset/Limit : 

 Press the Main Channel BW soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: MHz, kHz, or Hz. c
 Press the Offset/Limit soft key. d
 Toggle the Offset soft key and select On to display or Off to hide the offset. e
 Press the Integration Bandwidth soft key. f
 Enter a value by using the numeric keys. You can also use the rotary knob. g
 Select the unit: MHz, kHz, or Hz. h

 Press the Offset Frequency soft key to set the offset frequency. i
 Enter a value by using the numeric keys. You can also use the rotary knob. j
 Select the unit: MHz, kHz, or Hz. k

 Press the Offset Limit soft key to set the offset limit. l
 Enter a value by using the numeric keys. You can also use the rotary knob. m

 Select the dB soft key. n
8 Toggle the Plot soft key and select Start. 
9 Touch directly on the screen or press the ENTER hard key to collect data and plot points on the 

loaded map for the Position or Time setting. 
 

 NOTE 
For the Position setting, you can change the direction of the route with screen touch or 
the arrow keys and the distance with the rotary knob. For the Time setting, the instrument 
interpolates points in between two enters on a straight dotted line. You can change the 
direction of the route with the arrow keys and the distance with the rotary knob. 

 

10 Toggle the Plot soft key and select Stop to stop plotting. 
11 Press the SAVE/LOAD hot key to save the result. See “Using save” on page 32 for more 

information. 
 

 NOTE 
The instrument does not automatically save the collected data. It is recommended that 
you save the result. Otherwise, you will lose all the collected data. 

 

 

Setting limit 

You can set the thresholds for the four different color indicators. 
 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Excellent soft key to set its threshold. 
3 Enter a value, and then press the dBm soft key. You can also use the rotary knob. 
4 Press the Very Good soft key to set its threshold. 
5 Enter a value, and then press the dBm soft key. You can also use the rotary knob. 
6 Press the Good soft key to set its threshold. 
7 Enter a value, and then press the dBm soft key. You can also use the rotary knob. 
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8 Press the Poor soft key to set its threshold. 
9 Enter a value, and then press the dBm soft key. You can also use the rotary knob. 
10 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 

See “Using save” on page 32 for more information. 

 

Measurement example 

Figure 18 Route map measurement screen with GPS 

  
 

Dual spectrum 

The Dual Spectrum feature lets you view two spectrum measurements, both the Uplink and Downlink 
spectrum, simultaneously eliminating the need to swap between two screens back and forth. 
 

Setting measure setup 

Procedure 

1 Configure test parameters as described in the “Configuring test parameters” on page 54. 
2 Press the MEASURE SETUP hot key. 
3 Toggle the Active Window soft key between Top and Bottom to select the measurement 

window to configure or work on. 
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Measurement example 

Figure 19 Dual spectrum measurement with spectrum analyzer 

 
 

PIM detection (single and multiple carriers) 

The Passive Intermodulation (PIM) Detection allows you to detect Uplink PIM across the full spectrum 
for any technology. When PIM is detected, the normal repair mode is to replace the offending cable 
and what you need to do is replacing the whole cable irrespective of the location of the fault. 
 

Setting measure setup 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Connect cables as instructed on the screen. 
3 Optional. To check any possibility of PIM existence in red color by calculation, complete the 

following steps: 
 Press the Calculated PIM soft key. a
 Press the Radio Band soft key for single carrier. b

There are Radio 1 Band and Radio 2 Band soft keys for multiple carriers. 
 Highlight a desired band and then press the Select soft key. c
 Press the Return soft key. d

4 To set the uplink frequency to be measured, do one of the following: 
–  To set the center frequency and span, complete the following steps: 

 Toggle the Unit soft key and select Freq. a
 Press the Uplink Center Frequency soft key. b
 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Select the unit: GHz, MHz, kHz, or Hz. d
 Press the Uplink Span soft key. e
 Enter a value by using the numeric keys. You can also use the rotary knob. f
 Select the unit: GHz, MHz, kHz, or Hz. g

–  To set the channel number and span, complete the following steps: 
 Toggle the Unit soft key and select Channel. a
 Press the Channel Std soft key and select a desired band. b
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 Press the Channel Number soft key. c
 Enter a value by using the numeric keys and then press the Enter soft key. d

The instrument automatically displays the corresponding center frequency value for the 
selected channel number. 

 Press the Uplink Span soft key. e
 Enter a value by using the numeric keys. You can also use the rotary knob. f
 Select the unit: GHz, MHz, kHz, or Hz. g

5 Press the Continue soft key and follow the instructions on the screen. 

 

Measurement example 

Figure 20 PIM detection for single carrier 

 
 

Figure 21 PIM detection for multiple carriers 
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Chapter 5 Using Interference Analyzer 

This chapter provides instructions for using the Interference Analyzer function (option 011). Topics 
discussed in this chapter are as follows: 
 

 Introduction ................................................................................................................................ 84 

 Display overview ........................................................................................................................ 84 

 Connecting a cable .................................................................................................................... 85 

 Selecting measurement mode ................................................................................................... 86 

 Configuring test parameters ...................................................................................................... 86 

 Conducting spectrum measurements ........................................................................................ 92 

 Conducting interference measurements ................................................................................... 94 

 Setting limit for interference analyzer ...................................................................................... 101 
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Introduction 

Interference is becoming more prevalent in the wireless community with the increasing number of 
transmitters coming on the air. Wireless service providers have traditionally used spectrum analyzers 
to monitor service channels, frequencies, and adjacent spectrum and to locate sources of interference. 
A spectrum analyzer can only show you an interfering signal and you require determining the source of 
the interference. To solve interference problems, you must understand the RF environment, know 
adjacent operating transmitters, and identify any new or unlicensed emitters. 
 
Once a potential interfering signal is identified in the Spectrum Analyzer mode, you can monitor the 
signal further in the Interference Analyzer mode. JD700B series provides two different methodologies 
to identify and determine interference signals: Spectrogram and Received Signal Strength Indicator 
(RSSI). Locating the source of interference signal can be done with geographical information received 
from built-in GPS receiver. 
 
The JD700B series is extremely effective for locating and identifying periodic or intermittent RF 
interference. Interference signals derive from several kinds of licensed or unlicensed transmitters that 
cause dropped calls and poor service quality.  
 
The JD700B series provides following measurements for interference analysis: 
 

 Spectrum 

 Spectrogram (Single/Dual) 

 RSSI (Received Signal Strength Indicator) 

 Interference Finder 

 Spectrum Replayer 
 

Display overview 

Figure 22 provides descriptions for each segment of the measurement screen. 
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Figure 22 Interference measurement screen 

 

 

Connecting a cable 

Procedure 

1 Connect an Omni/directional RF antenna to the Spectrum Analyzer RF In port of the JD700B 
series. 

2 Connect a GPS antenna to the GPS port of the JD700B series. 

 
Figure 23 Interference measurement connection 

 
JD785B/JD786B/JD745B/JD746B 

 
JD788B/JD748B 
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CAUTION 
If the input signal level to be measured is less than 0 dBm, set it to 0 dB attenuation or 
turn on the preamp to have better dynamic range for the testing. 

 

Selecting measurement mode 

Procedure 

1 Press the MODE hard key. 
2 Press the Interference Analyzer soft key. The Spectrum mode is selected by default. 
3 To change the mode, press the MEASURE hot key and then select the measurement mode: 

Spectrogram, Dual Spectrogram, RSSI, Interference Finder, or Spectrum Replayer. 

 
 NOTE 

If the Dual Spectrogram is selected, you can select the left or right measurement pane 
under MEASURE SETUP to configure measurement parameters for the selected 
spectrogram. 

 

Configuring test parameters 

Setting frequency  

You need to set the frequency range to be measured with either the center frequency/span or the 
start/stop frequencies. You can also set the frequency with the channel number and span. 
 

Procedure 

To set the center frequency and span: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Freq. 
3 Press the Center Frequency soft key. 
4 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 
5 Select the unit: GHz, MHz, kHz, or Hz. 
6 Press the Span soft key, and then do one of the following: 

–  To set the span manually, select Span, enter a value, and then select the unit. 

–  To set the span automatically, select Full Span, Zero Span, or Last Span as needed. 
 

 NOTE 
The Zero Span option is available only in the Spectrum mode. If you have selected Zero 
Span, select TRIGGER > Free Run, External, GPS, Video, or Display Position. 

 
To set the start and stop frequencies: 

1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Freq. 
3 Press the Start Frequency soft key. 
4 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 
5 Select the unit: GHz, MHz, kHz, or Hz. 
6 Press the Stop Frequency soft key. 
7 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 
8 Select the unit: GHz, MHz, kHz, or Hz. 
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To set the channel number and span: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Channel. 
3 To select the standard channel, complete the following steps: 

 Press the Channel Std soft key. The standard channel window appears. a
See “Appendix C – Band, frequency & channel standard” on page 530 for more information. 

 Highlight the band to be measured by using the rotary knob, the arrow keys, or the Page b
Up/Page Down soft keys. 

 Press the Select soft key or the rotary knob to confirm the selection. c
4 Toggle the Link soft key to select the sweep direction and select Fwd for forward or Rev for 

reverse. 
5 To set the channel number, complete the following steps: 

 Press the Channel Number soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key or ENTER hard key to complete the entry. c

The instrument automatically displays the corresponding center frequency value for the 
selected channel number. 

6 To set the span, complete the following steps: 
 Press the Span soft key. a
 Select the span option, from the following choices: b

–  To set the span manually, select Span, enter a value, and then select the unit. 

–  To set the span automatically, select Full Span, Zero Span, or Last Span as needed. 
 

 NOTE 
The Zero Span option is available only in the Spectrum mode. If you have selected Zero 
Span, select TRIGGER > Free Run, External, GPS, Video, or Display Position. 

 
Optional. To define the amount of frequency increment for the rotary knob: 

1 Press the Frequency Step soft key, if the Freq is selected. 
2 Enter a value by using the numeric keys. 
3 Press the unit: GHz, MHz, kHz, or Hz. 

 
Optional. To define the amount of channel increment for the rotary knob: 

1 Press the Channel Step soft key, if the Channel is selected. 
2 Enter a value by using the numeric keys. 
3 Press the Enter soft key. 

 

Setting amplitude 

Reference level and attenuation 

You can set the reference and attenuation levels automatically or manually to optimize the display of 
the traces measured, as you desire. 
 

Procedure 

To automatically set the reference and attenuation level: 
1 Press the AMP/SCALE hard key. 
2 Press the Auto Scale soft key. 

Each time you press this key, both of the Y-axis scale and input attenuation level change to be 
optimized with some margin. 

 
To set the reference or attenuation level manually: 
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1 Press the AMP/SCALE hard key. 
2 To set the maximum reference value on the Y-axis manually, complete the following steps: 

 Press the Reference Level soft key. a
 Enter a value by using the numeric keys or the rotary knob with 10 dB increments. b
 Press the dBm soft key or the ENTER hard key. c

This unit key name changes according to the setting in the Units menu. 
3 To set the attenuation option, select one from the following choices: 

–  To set the input attenuator’s level automatically, select Attenuation > Auto. 
 

 NOTE 
It is recommended that you set the Attenuation to Auto in most situations so that the 
level of the input attenuator can be set automatically according to your input signal level. 

 
–  To set the input attenuation manually up to 55 dB for JD780B series or 50 dB for JD740B 

series to optimize S/N, complete the following steps: 
 Select Attenuation > Manual. a
 Press the Attenuation Value soft key to set the level. b
 Enter a value in fives by using the numeric keys. c
 Press the dB soft key or the ENTER hard key. d

–  To couple the input attenuator’s level with your reference level setting, select Attenuation > 
Couple. 
As you increase the reference setting, the attenuation level also increases acoordingly. 

 
Optional. To change the scale unit: 

1 Select More (1/2) > Units. 
2 Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W. 

The scale unit on the screen changes accordingly. 

 

Scale per division 

You can use the Scale/Div feature available for the spectrum measurement screen. It represents the 
value of one division on the horizontal scale. The default setting is 10 dB per division and the 
maximum value can be set up to 20 dB. 
 

Procedure 

To set the scale per division: 
1 Press the AMP/SCALE hard key. 
2 Select More (1/2) > Scale/Div. 
3 Enter a value between 1 and 20 by using the numeric keys. 
4 Press the dB soft key to complete the entry. 

 

Pre-amplifier 

You can turn the internal pre-amplifier on to correct and compensate for the gain of the preamp so that 
amplitude readings show the value at the input connector. 
 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Toggle the Preamp soft key and select On or Off as needed. 
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 NOTE 
You can turn the Preamp on when the input attenuation range is from 0 dB to 10 dB. If 
the attenuation value is manually set to greater than 10 dB, the instrument will 
automatically turn off the pre-amplifier to display low-level signal properly on the chart. 

 

External offset 

You can turn the External Offset on and manually set the external offset value. An offset consists of a 
cable loss and a user offset and the measurement result shows the value reflecting both offset values. 
When the external offset value is set at 40 dB in the Spectrum mode, the measurement result 
compensates 40 dB at both the Spectrum Analyzer and Signal Analyzer modes 
 

Procedure 

To set the external offset: 
1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select On. 
3 Enter a value by using the numeric keys. 
4 Press the dB soft key to complete the entry. 

 
To turn the external offset off: 

1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select Off. 

 

Setting bandwidth 

VBW based on the designated RBW. Selecting Auto changes the value to correspond to your 
frequency span setting for RBW and to the current RBW and VBW/RBW settings for VBW. 
 

Procedure 

To automatically set the RBW and VBW to your selected VBW/RBW ratio: 
1 Press the BW/AVG hard key. 
2 Press the VBW/RBW soft key to set the proportional VBW based on the designated RBW. 

Table 9 shows the ratio example for 30 kHz RBW. 
3 Select the ratio: 1, 0.3, 0.1, 0.03, 0.01, or 0.003. 
4 Toggle the RBW soft key and select Auto. 
5 Toggle the VBW soft key and select Auto. 

The RBW or VBW value on the screen changes accordingly based on the span. 
 
To manually set the RBW or VBW to your selected VBW/RBW ratio: 

1 Press the BW/AVG hard key. 
2 Press the RBW soft key. 
3 Enter a value between 1 Hz to 3 MHz in 1-3 sequence by using the numeric keys. 
4 Select the unit: MHz, kHz, or Hz. 

The RBW setting automatically changes to Manual. 
5 Press the VBW soft key. 
6 Enter a value by using the numeric keys. 
7 Select the unit: MHz, kHz, or Hz. 

The VBW setting automatically changes to Manual. 
The RBW or VBW value on the screen changes accordingly. 
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Table 10 VBW/RBW ratio example 

RBW Ratio (VBW/RBW) VBW 

30 kHz 1:1 30 kHz 

 1:0.3 10 kHz 

 1:0.1 3 kHz 

 1:0.03 1 kHz 

 1:0.01 300 Hz 

 1:0.003 100 Hz 

 

Setting average 

You can set the number of measurements to be averaged for the trace presentation. A maximum of 
100 times of averaging can be set. When the averaging reaches to your setting, a new measurement 
value replaces the measurement value in sequence from the earliest. 
 

Procedure 

1 Press the BW/AVG hard key. 
2 Press the Average soft key. 
3 Enter a value between 1 and 100 as needed by using the numeric keys. 
4 Press the Enter soft key. 

 

Setting sweep 

The SWEEP hot key is used to set and control the sweep time, sweep mode, gated sweep settings, 
and gated sweep on or off. 
 

Sweep time 

You can set the sweep time automatically or manually. Manual setting allows you to set the sweep time 
beyond an automatic setting. 
 

Procedure 

1 Press the SWEEP hot key. 
2 Select the sweep time option, from the following choices: 

–  To automatically set, toggle the Sweep Time soft key and select Auto. 

–  To manually set, complete the following steps: 
 Press the Sweep Time soft key. a
 Enter a value by using the numeric keys. b
 Select the unit: Sec, mSec, or µSec. c

The sweep time mode automatically changes to Manual. 

 

Sweep mode 

The default settings of the sweep mode are Continue and Normal to sweep continuously at a normal 
speed for most on-going measurements. If you want to hold the measurement or get a single sweep, 
you can change the sweep mode. 
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Procedure 

To select the single sweep mode: 
1 Press the SWEEP hot key. 
2 Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key. 

The letter HOLD in red appears and the sweeping is paused. 
3 Optional. Press the Sweep Once soft key to get a new measurement. 

 
To return to the continuous sweep mode: 

1 Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key. 
The letter HOLD in red disappears and the sweeping resumes. 

 
 NOTE 

Selecting Sweep Mode > Fast may reduce the measurement accuracy, but you can use 
this fast sweep mode to identify the existence of interfering signals. 

 

Gated sweep 

You can configure the gated sweep settings with an internal or external trigger source. If you select 
Gated Sweep Settings, you can view the signal in time domain. 
 

Procedure 

1 Press the SWEEP hot key. 
2 Press the Gated Sweep Settings soft key. 
3 Optional. Adjust sweep time to allow enough time for a cycle by completing the following steps: 

 Press the Zero Span Time soft key. a
 Enter a value by using the numeric keys. b
 Select the unit: Sec, mSec, or µSec. c

4 Set the period, if using the internal trigger source, by doing one of the following: 
–  To select the preset period, complete the following steps: 

 Toggle the Period soft key and select StdSignal. a
 Press the StdSignal soft key, and then select the period from the choices:  b

GSM (4.615 ms), WCDMA (10 ms), LTE (10 ms), EV-DO (5 ms), TD-SCDMA (5 ms), 
and WiMAX (10 ms). 

–  To manually set the period, complete the following steps: 
 Toggle the Period soft key and select Manual. a
 Press the Period soft key to enter the amount of time. b
 Enter a value by using the numeric keys. c
 Select the unit: Sec, mSec, or µSec. d

5 Press the TRIGGER hot key, and then do one of the following: 
–  Select External for an external trigger source. 

–  Select Video or Display Position for the internal trigger source. 

6 Press the PREV hard key to continue setting the gated sweep. 
7 Set the gate delay by completing the following steps: 

 Press the Gate Delay soft key. a
 Enter a value by using the numeric keys. b
 Select the unit: Sec, mSec, or µSec. c

8 Set the gate length by completing the following steps: 
 Press the Gate Length soft key. a
 Enter a value by using the numeric keys. b
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 Select the unit: Sec, mSec, or µSec. c
9 Press the PREV hard key to enable gated sweeping. 
10 Toggle the Gated Sweep soft key and select On. 

 
 NOTE 

This setting is not used in the Spectrum Replayer mode. 
 

Conducting spectrum measurements 

The spectrum measurement with an audible indicator is especially useful for locating interferer sources 
with a directional antenna. 
 

Setting trace 

You can display up to six traces on the measurement chart simultaneously. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6. 

The legend shape of the selected trace changes from square to round to indicate that the trace is 
the active one now. 

3 Toggle the Trace View soft key and select On. 
4 Do one of the following: 

 

To Select Trace Legend 

Clear current data and display with new 
measurements 

Clear Write W 

Display the input signal’s maximum response only 
(unlimited or for a certain amount of time) 

Max Hold M 

Display the input signal’s minimum response only 
(unlimited or for a certain amount of time) 

Min Hold m 

Capture the selected trace and compare traces Capture C 

Load a saved trace More (1/2) > Load L 

Hide the selected trace Trace View > Off F 

Remove all the traces and initialize the trace 
settings 

More (1/2) > Trace 
Clear All 

 

 
 NOTE 

For the Max Hold and Min Hold, your instrument compares newly acquired data with the 
active trace and displays larger maximum values or smaller minimum values on the 
screen. You can set it to Unlimited to hold and view maximum or minimum data or 
specify a certain amount of time up to 60 seconds by using numeric keys or the rotary 
knob. 

 

5 To select the detection option, press the More (1/2) > Detectors, and then do one of the 
following: 
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To display Select 

Random noise better than the peak without missing signals Normal 

The highest value in each data point Peak 

The root mean squared average power across the spectrum RMS 

The lowest value in each data point Negative Peak 

The center value in each data point Sample 
 

6 Optional. Press the More (1/2) > Trace Info soft key, and then select the trace number to view 
the trace’s parameter setting information stored at the time of the measurement or None to hide 
the information display. 

7 Optional. If you have the two traces T1 and T2, you can perform trace math. To view the power 
difference between the traces, press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key. 
The result is overlaid on the screen along with the second Y-axis. 

 
 NOTE 

To be able to load a trace, the trace to be overlaid must be saved in the same 
measurement mode and frequency setting as the current measurement. 

 

Sound indicator 

You can use the Sound Indicator to help you identify interfering signals by sounding an alarm. 
 

Procedure 

1 Configure test parameters as described in the “Configuring test parameters” on page 86. 
2 Press the MEASURE SETUP hot key. 
3 Press the Sound Indicator soft key. 
4 Toggle the Sound soft key between On and Off to enable and disable the alarm sound. 
5 Select the alarm reference option from the following choices: 

–  To set the active marker position as the alarm reference, toggle the Alarm Reference soft 
key and select Marker. 

–  To set the limit as the alarm reference, complete the following steps: 
 Toggle the Alarm Reference soft key and select Line. a

The Limit Line menu becomes activated to be set. 
 Press the Limit Line soft key to define a threshold for the limit line. b
 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Press the dBm soft key. d

6 Optional. To adjust the volume for alarm sound, press the Volume soft key and then turn the 
rotary knob clockwise or counter clockwise. 

7 Optional. You can save logging data automatically so that you can load the measurement data 
and replay in the Spectrum Replayer mode. See “Using save” on page 32 for more information. 

 

AM/FM audio demodulation 

You can use the AM/FM Audio Demodulation to identify if the interfering signal is nth harmonics of 
AM/FM audio. The instrument sounds demodulated signals that you can hear through the speaker or 
headphones. 
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Procedure 

1 Configure test parameters as described in the “Configuring test parameters” on page 86. 
2 Press the MEASURE SETUP hot key. 
3 Toggle the Audio Demod soft key between On and Off to turn the AM/FM audio demodulation 

on and off. 
4 Press the Demod at soft key, and then select the marker number for the frequency to be 

demodulated. 
 

 NOTE 
You must set the marker(s) first by using the MARKER hard key as the AM/FM 
demodulator uses the marker position to demodulate. See “Using marker” on page 49 for 
more information. 

5 Press the Demod Mode soft key, and then select the demodulation mode: AM, FM and CW. 
6 Press the Dwell Time soft key, and then turn the rotary knob to set the demodulation interval 

between 1 and 20. 
7 Press the Volume soft key, and then turn the rotary knob to set the speaker volume. 
8 Toggle the Auto Gain soft key between On and Off to enable or disable the automatic gain 

feature to adjust the interval gain of the demodulator. 
9 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 32 for more information. 

 

Interference ID 

The Interference ID automatically classifies interfering signals over a designated spectrum and 
displays the list of possible signal types corresponding to the selected signal. 
 

Procedure 

1 Configure test parameters as described in the “Configuring test parameters” on page 86. 
2 Press the MEASURE SETUP hot key. 
3 Toggle the Interference ID soft key between On and Off to turn the Interference ID on and off. 
4 To set the threshold level manually, complete the following steps: 

 Press the Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the dBm soft key. c

5 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 32 for more information. 

 
 NOTE 

You can use the LIMIT hot key to analyze your measurements with the display line, multi-
segment line, and channel limit. See “Setting limit for interference analyzer” on page 101 
for more information. 

 

Conducting interference measurements 

Spectrogram 

The Spectrogram is particularly useful when attempting to identify periodic or intermittent signals as it 
captures spectrum activity over time and uses various colors to differentiate spectrum power levels. 
When the directional antenna is used to receive the signal, you will see a change in the amplitude of 
the tracked signal as you change the direction of the antenna and see a change in the Spectrogram 
colors. The source of the signal is located in the direction that results in the highest signal strength. 
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Setting measure setup 

Procedure 

1 Configure test parameters as described in the “Configuring test parameters” on page 86. 
2 Press the MEASURE SETUP hot key. 
3 To set the amount of time between each trace measurement: 

 Press the Time Interval soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Sec soft key. c

4 To set the time cursor on a specific trace position, complete the following steps: 
 Toggle the Time Cursor soft key and select On. a
 Turn the rotary knob to move the time cursor. You can also enter a value and then press the b

Enter soft key. 
 

 NOTE 
Enabling the time cursor puts the measurement on hold and you can make post-
processing analysis for each measurement over time using the time cursor. 

 

5 To start a new measurement, press the Reset/Restart soft key. 
6 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 32 for more information. 

 

Measurement example 

The spectrogram shows a vertical line on the chart when the marker is enabled on the screen. 
 

Figure 24 Interference measurement in spectrogram 

 
 

 The horizontal line or X-axis of the spectrogram is frequency. 

 The vertical line or Y-axis is time. 

 The color identification (Spectrogram) indicates power level of the tracked signal. As the signal 
strength increases, the color on the spectrogram changes accordingly. 
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Figure 25 Interference measurement in spectrogram with gated sweep on 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the display line, multi-
segment line, and channel limit. See “Setting limit for interference analyzer” on page 101 
for more information. 

 

Dual spectrogram 

The Dual Spectrogram mode is useful to compare two spectrograms displayed simultaneously on the 
screen. 
 

Setting measure setup 

Procedure 

1 Configure test parameters as described in the “Configuring test parameters” on page 86. 
2 Press the MEASURE SETUP hot key. 
3 Toggle the Active Window soft key and select Left or Right spectrogram to be set up. 
4 To set the amount of time between each trace measurement: 

 Press the Time Interval soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Sec soft key. c

5 To set the time cursor on a specific trace position, complete the following steps: 
 Toggle the Time Cursor soft key and select On. a
 Turn the rotary knob to move the time cursor. You can also enter a value and then press the b

Enter soft key. 
 

 NOTE 
Enabling the time cursor puts the measurement on hold and you can make post-
processing analysis for each measurement over time using the time cursor. 

 

6 To start a new measurement, press the Reset/Restart soft key. 
7 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 32 for more information. 
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Measurement example 

Figure 26 Interference measurement in dual spectrogram view 

 
 

RSSI 

The Received Signal Strength Indicator (RSSI) is a multi-signal tracking metric that is particularly 
useful for measuring power-level variations over time. The RSSI measurement lets you assign power 
limit line for audible alarms and increase alarm counters every time a signal exceeds a defined limit 
line. For long-term analysis, the spectrogram and RSSI measurements can be automatically saved 
into an external USB memory. Post-analysis can be performed with JDViewer application software. 
 

Setting measure setup 

Procedure 

1 Configure test parameters as described in the “Configuring test parameters” on page 86. 
2 Press the MEASURE SETUP hot key. 
3 To set up the alarm parameters, complete the following steps: 

 Press the Alarm soft key. a
 Press the Alarm at soft key and select the marker number: M1 to M6. b
 Press the Limit Line soft key to set a threshold for the alarm. c
 Enter a value by using the numeric keys. You can also use the rotary knob. d
 Press the dBm soft key. e
 Toggle the Alarm soft key between On and Off to turn the alarm feature on or off. f
 Optional. Press the Volume soft key and adjust the volume. g

4 To set up the AM/FM audio demodulation, complete the following steps: 
 Press the AM/FM Audio Demod soft key. a
 Toggle the Audio Demod soft key between On and Off to turn the AM/FM audio b

demodulation on or off. 
 Press the Demod at soft key, and then select the marker number for the frequency to be c

demodulated. 
 

 NOTE 
For the alarm and AM/FM audio demodulation, you must set the marker(s) first by using 
the MARKER hard key as these features use the marker position to sound alarm or 
demodulate. See “Using marker” on page 49 for more information. 
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 Press the Demod Mode soft key, and then select the demodulation mode: AM, FM, and CW. d
 Press the Dwell Time soft key, and then turn the rotary knob to set the demodulation e

interval between 1 and 20. 
 Toggle the Auto Gain soft key between On and Off to enable or disable the automatic gain f

feature to adjust the interval gain of the demodulator. 
 Optional. Press the Volume soft key and adjust the volume. g

5 To start a new measurement, press the Reset/Restart soft key. 
6 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 32 for more information. 

 

Measurement example 

Figure 27 Interference measurement in RSSI 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the display line, multi-
segment line, and channel limit. See “Setting limit for interference analyzer” on page 101 
for more information. 

 

Interference finder 

The Interference Finder is an automatic triangulation algorithm that uses GPS coordinates to locate 
possible interference sources based on three measurements. The interference finder calculates 
possible interference locations using its inscribed circle or circumscribed circle based on measured 
intersection points. You can plot up to seven measurement points and select three that are more 
representative for triangulation. JD700B series automatically logs measurement positions not to lose 
them while changing measurement modes. 
 

Setting measure setup 

Procedure 

1 Configure test parameters as described in the “Configuring test parameters” on page 86. 
2 To load your map file, complete the following steps: 
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 Plug in your USB drive that has a map file in .mcf file type created in JDMapCreator. a
 

 NOTE 
The JDMapCreator converts and resizes a map to fit onto your instrument’s display. You 
must save your map file (.mcf) into the “SavedMap” folder of your USB drive so that you 
can load them onto your instrument. 

 

 Press SAVE/LOAD hot key, and then select Load > Load Map. See “Using load” on page b
34 for more information. 

3 Press the MEASURE SETUP hot key. 
4 Press the Location Setup soft key. 
5 Press the Location soft key. 
6 Press the Point 1 soft key, and then do one of the following option: 

–  To automatically get the selected point’s positioning information with GPS locked, press the 
Get GPS Position. 
The instrument displays the latitude and logitude information of the signal received by a 
Yagi antenna. 

–  To manually determine positioning for the selected point, complete the following steps: 
 Press the Latitude soft key, and then set the properties: North/South, Degree, a

Minute, and Second. 
 Press the Longitude soft key, and then set the properties: East/West, Degree, b

Minute, and Second. 
 

 

 

 

 

 

 
 

7 Press the Azimuth soft key to set an azimuth, and then do one of the following: 
–  Without using a compass, turn the rotary knob to align the straight line on the loaded map 

with the direction of the connected Yagi antenna. 
The instrument calculates the azimuth and the angle appears on the screen. 

–  Measure an azimuth by using a compass, enter the measured angle, and then press the 
Enter soft key. 

8 Optional. To save a defined position, press the Save Position soft key and then select one of the 
soft keys to which you want to save the position information. You can use the Load Position soft 
key to load any saved positions. 

9 Press the Point 2 soft key, and then repeat steps 6-7. 
10 Press the Point 3 soft key, and then repeat steps 6-7. 
11 Press the Display Setup soft key. 
12 Press the Display Mode soft key, and then select the display mode: Circum, Inscribed, or 

Double. 
 

 NOTE 
Change the display to different mode options and check possible location of the 
interfering signal. 
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Circumscribed 

 

 

Inscribed 

 

 

Double 

 

 
 

13 Toggle the Screen Mode soft key and select the display option: Map or Full. 
–  Map: Displays points on the loaded map. 

–  Full: Displays points without the map. 

 

Measurement example 

Figure 28 Interference finder measurement in map view 

 
 

Spectrum Replayer 

The Spectrum Replayer lets you retrieve and replay recorded spectrum analyzer traces in interference 
analysis mode. These traces can be played back in the spectrogram or RSSI. You can configure the 
limit line to create failure points when signals exceed it. The failure points are clearly displayed on the 
trace timeline for quick access during playback. 
 

Setting measure setup 

Procedure 

1 Press the MEASURE hot key. 
2 Press the Spectrum Replayer soft key. 

The file manager window appears. 
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3 Select a file to be loaded, and then press the Load soft key. 
The Measure Setup screen menus appear. 

4 Toggle the Replay Direction soft key between FWD and REV to change play direction to forward 
or reverse. 

5 Press the Replay Speed soft key, and then select the speed option: x1, x2, x3, and x4. 
6 Press the Play soft key to start playing. 
7 Press the Pause soft key to pause or stop playing data. 
8 To move to a particular failure position directly and play from there, complete the following steps: 

 Press the Jump to Fail Index soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

9 Optional. Toggle the Time Cursor soft key between On and Off to display or dismiss the time 
cursor on the screen. This key becomes activated when you play logged data in the Spectrogram 
mode. 

 
 NOTE 

If you connected a USB drive, do not remove it while playing. Doing so may freeze the 
USB port, which will require you to restart the instrument to get a USB drive recognized 
again. 

 

Setting display 

You can select the display option. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Select the display option: Spectrum, Spectrogram, or RSSI. 

 
 NOTE 

You can use the LIMIT hot key to analyze your measurements with the display line, multi-
segment line, and channel limit. See “Setting limit for interference analyzer” on page 101 
for more information. 

 

Setting limit for interference analyzer 

Procedure 

To use the display line: 
1 Press the LIMIT hot key. 
2 Press the Display Line soft key for a reference line. 
3 Enter a value, and then press the dBm unit soft key. 
4 Toggle the Display Line soft key between On and Off to display and dismiss the reference line. 

The straight line appears across the screen to be used as a visual reference only. 
 
To display the multiple segment line: 

1 Press the LIMIT hot key. 
2 Press the Multi Segment Line soft key for Pass/Fail indication. 
3 Toggle the Limit soft key between Upper and Lower to select the one to be displayed. 
4 Set the number of segments for the selected upper or lower limit line. You can set up to 50 

segments. 
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 Press the # of Line soft key. a
 Enter a value between 1 and 50 by using the numeric keys. b
 Press the Enter soft key. c

5 Press the Autoset soft key to let the instrument set the limit for each segment and display the 
line. 

6 Optional. To move the limit line, complete the following steps: 
 Select Limit Up/Down or Limit Left/Right. a
 Turn the rotary knob to move the line as desired. You can also manually enter a value. b

7 Optional. To edit the segment properties, complete the following steps: 
 Press the Edit Limit soft key. a
 Press the Move soft key and then turn the rotary knob to select the segment to edit. b
 Select the menu option, from the following choices: c

–  To hide the line for the selected segment, toggle the Line soft key and select Off. 

–  To add a new point, press the Add Point soft key. 

–  To delete the selected point, press the Delete Point soft key. 

–  To change the position, press the Frequency or Amplitude soft key, and then turn the 
rotary knob to change the value as desired. 

 
To define the channel limit: 

1 Press the LIMIT hot key. 
2 Press the Channel Limit soft key. 
3 To define the index table, complete the following steps: 

 Toggle the Table soft key between On and Off to display and hide the channel index table a
on the screen. 

 Press the Index soft key. b
 Enter an index number to be set between 1 and 10 by using the numeric keys. c
 Press the Enter soft key. d
 Press the Start Frequency or Center Frequency soft key depending on your prior e

frequency setting. 
 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow f

keys. 
 Select the unit: GHz, MHz, kHz, or Hz. g
 Press the Stop Frequency or Span Width soft key depending on your prior frequency h

setting. 
 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow i

keys. 
 Select the unit: GHz, MHz, kHz, or Hz. j

4 To set the limits for Pass/Fail indication, complete the following steps: 
 Toggle the Limit soft key between On and Off to enable and disable the limit. a
 Press the High Limit soft key. b
 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow c

keys. 
 Press the dBm soft key. d
 Press the Low Limit soft key. e
 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow f

keys. 
 Press the dBm soft key. g

5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 32 for more information. 
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Introduction 

The Global System for Mobile Communications (GSM) is a digital cellular standard that uses Time 
Division Multiple Access (TDMA) multiplexing scheme and Gaussian Minimum Shift Keying (GMSK) 
modulation. The Enhanced Data Rates for GSM Evolution (EDGE) is an enhancement to GSM that 
promises to deliver multimedia and other broadband applications. It uses TDMA and 3π/8 8PSK 
(phase shift keying) modulation. 
 
This instrument performs measurements using the methods and limits as defined in the 3GPP TS 
51.021 Base Station System (BSS) equipment specification: Radio Aspects V8.9.0 (2003-06). The 
Pass/Fail indictor helps you to determine base station performance easily. 
 
This instrument provides the following measurement tools for GSM/GPRS/EDGE system: 
 

 Spectrum Analysis 

 RF Analysis 
- Channel Power 
- Occupied Bandwidth 
- Spectrum Emission Mask (SEM) 
- Spurious Emissions 

 Power vs. Time 
- Power vs. Time (Slot) 
- Power vs. Time (Frame) 

 Modulation Analysis 
- Constellation 

 Auto Measure 

 Over The Air (OTA) 
- Channel Scanner 
- Frequency Scanner 
- Multipath Profile 
- Modulation Analyzer 

 

Display overview 

Figure 29 provides descriptions for each segment of the measurement screen. 
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Figure 29 GSM signal analyzer measurement screen 

 

 

Connecting a cable 

Direct connection 

Procedure 

1 Connect the Spectrum Analyzer RF In port of the JD700B series and the power amplifier output 
port of BTS. 

 
Figure 30 Direct connection 

 
JD785B/JD745B 

 
JD788B/JD748B 

 

Indirect connection 

Procedure 

1 Connect the Spectrum Analyzer RF In port of the JD700B series and the monitor (test) port of 
BTS. 
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Figure 31 Indirect connection 

 
JD785B/JD745B 

 
JD788B/JD748B 

 

 

CAUTION 
The maximum power for the Spectrum Analyzer RF In port is +25 dBm (0.316 W) for 
JD780B series and +20 dBm (0.1 W) for JD740B series. If the level of the input signal to 
be measured is greater than this, use a High Power Attenuator to prevent damage 
when you directly connect the signal to the instrument or connect the signal from the 
coupling port of a directional coupler. 

 

Over the air (OTA) 

Procedure 

1 Connect an Omni/directional RF antenna to the Spectrum Analyzer RF In port of the JD700B 
series. 

2 Connect a GPS antenna to the GPS port of the JD700B series. 

 
Figure 32 OTA connection 

 
JD785B/JD745B 

 
JD788B/JD748B 

 

 

CAUTION 
If the input signal level to be measured is less than 0 dBm, set 0 dB attenuation or turn on 
the preamp to have better dynamic range for the OTA testing. 
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Selecting measurement mode 

Procedure 

1 Press the MODE hard key. 
2 Press the Signal Analyzer soft key. 
3 Press the GSM soft key. The Spectrum mode is set by default. 
4 Press the MEASURE hot key, and then select the measurement mode option from the following 

choices: 
–  Spectrum 

–  RF Analysis > Channel Power, Occupied BW, Spectrum Emission Mask, or 
Spurious Emissions 

–  Power vs Time > Power vs Time (Slot) or Power vs Time (Frame) 

–  Constellation 

–  Auto Measure 

–  OTA > Channel Scanner, Frequency Scanner, Multipath Profile, or 
Modulation Analyzer 

 

Configuring test parameters 

Setting frequency 

You can set the frequency with either frequency or channel number. If a frequency to be set matches 
to the frequency corresponding to the selected channel standard, the instrument calculates its channel 
number and updates the screen with it automatically. 
 

Procedure 

To set the center frequency: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Freq. 
3 Press the Center Frequency soft key. 
4 Enter a value by using the numeric keys. You can also use the rotary knob. 
5 Select the unit: GHz, MHz, kHz, or Hz. 
6 Optional. To define the amount of frequency increment for the rotary knob, complete the following 

steps: 
 Press the Frequency Step soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the unit: GHz, MHz, kHz, or Hz. c

 
To set the channel number: 

1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Channel. 
3 To select the standard channel, complete the following steps: 

 Press the Channel Std soft key. The standard channel window appears. a
See “Appendix C – Band, frequency & channel standard” on page 530 for more information. 

 Highlight the band to be measured by using the rotary knob, the arrow keys, or the Page b
Up/Page Down soft keys. 

 Press the Select soft key or the rotary knob to confirm the selection. c
4 Press the Channel Number soft key. 
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5 Enter a value by using the numeric keys. You can also use the rotary knob. 
6 Press the Enter soft key. 
7 The instrument automatically displays the corresponding center frequency value for the selected 

channel number. 
8 Optional. To define the amount of channel increment for the rotary knob, complete the following 

steps: 
 Press the Channel Step soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

 
 NOTE 

This frequency setting is not used in the Spurious Emissions mode. 
 

Setting amplitude 

Reference level and attenuation 

You can set the reference and attenuation levels automatically or manually to optimize the display of 
the traces measured, as you desire. 
 

Procedure 

To automatically set the reference and attenuation level: 
1 Press the AMP/SCALE hard key. 
2 Press the Auto Scale soft key. 

Each time you press this key, both of the Y-axis scale and input attenuation level change to be 
optimized with some margin. 

 
To set the reference or attenuation level manually: 

1 Press the AMP/SCALE hard key. 
2 To set the maximum reference value on the Y-axis manually, complete the following steps: 

 Press the Reference Level soft key. a
 Enter a value by using the numeric keys or the rotary knob with 10 dB increments. b
 Press the dBm soft key or the ENTER hard key. c

This unit key name changes according to the setting in the Units menu. 
3 To set the attenuation option, select one from the following choices: 

–  To set the input attenuator’s level automatically, select Attenuation > Auto. 
 

 NOTE 
It is recommended that you set the Attenuation to Auto in most situations so that the 
level of the input attenuator can be set automatically according to your input signal level. 

 

–  To set the input attenuation manually up to 55 dB for JD780B series or 50 dB for JD740B 
series to optimize S/N, complete the following steps: 

 Select Attenuation > Manual. a
 Press the Attenuation Value soft key to set the level. b
 Enter a value in fives by using the numeric keys. c
 Press the dB soft key or the ENTER hard key. d

–  To couple the input attenuator’s level with your reference level setting, select Attenuation > 
Couple. 
As you increase the reference setting, the attenuation level also increases acoordingly. 

 
Optional. To change the scale unit: 

1 Select More (1/2) > Units. 
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2 Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W. 
The scale unit on the screen changes accordingly. 

 

 NOTE 
This Units menu is available in the Spectrum and RF Analysis modes. 

 

 

Scale per division 

You can use the Scale/Div feature available for the spectrum and RF analysis. It represents the value 
of one division on the horizontal scale. The default setting is 10 dB per division and the maximum 
value can be set up to 20 dB. 
 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Select More (1/2) > Scale/Div. 
3 Enter a value between 1 and 20 by using the numeric keys. 
4 Press the dB soft key to complete the entry. 

 

Pre-amplifier 

You can turn the internal pre-amplifier on to correct and compensate for the gain of the preamp so that 
amplitude readings show the value at the input connector. 
 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Toggle the Preamp soft key and select On or Off as needed. 

 
 NOTE 

You can turn the Preamp on when the input attenuation range is from 0 dB to 10 dB. If 
the attenuation value is manually set to greater than 10 dB, the instrument will 
automatically turn off the pre-amplifier to display low-level signal properly on the chart. 

 

External offset 

You can turn the External Offset on and manually set the external offset value. An offset consists of a 
cable loss and a user offset and the measurement result shows the value reflecting both offset values. 
When the external offset value is set at 40 dB in the Spectrum mode, the measurement result 
compensates 40 dB at both the Spectrum Analyzer and Signal Analyzer modes 
 

Procedure 

To set the external offset: 
1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select On. 
3 Enter a value by using the numeric keys. 
4 Press the dB soft key to complete the entry. 

 
To turn the external offset off: 

1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select Off. 
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Setting average 

You can set the number of measurements to be averaged for the trace presentation. A maximum of 
100 times of averaging can be set. When the averaging reaches to your setting, a new measurement 
value replaces the measurement value in sequence from the earliest. 
 

Procedure 

1 Press the BW/AVG hard key. 
2 Press the Average soft key. 
3 Enter a value between 1 and 100 as needed by using the numeric keys. 
4 Press the Enter soft key. 

 

Setting sweep mode 

The default setting is Continue to sweep continuously for most on-going measurements. If you want to 
hold the measurement or get a single sweep, you can change the sweep mode. 
 

Procedure 

To select the single sweep mode: 
1 Press the SWEEP hot key. 
2 Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key. 

The letter HOLD in red appears and the sweeping is paused. 
3 Optional. Press the Sweep Once soft key to get a new measurement. 

 
To return to the continuous sweep mode: 

1 Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key. 
The letter HOLD in red disappears and the sweeping resumes. 

 

Setting trigger source 

You can set the trigger source option for your measurements. 

Procedure 

1 Press the TRIGGER hot key. 
2 Select the trigger source option from the following choices: 

 

To set the trigger level Select 

When using the RF burst (wideband) trigger RF Burst 

To free burst if there is a frequency burst signal Internal FB 

To training sequence code RF Burst & TS 

To external trigger reference External 

To the free trigger Free 
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Conducting spectrum measurements 

If you have configured test parameters as described in the “Configuring test parameters” on page 107, 
your measurement result is displayed on the screen as like the following example, Figure 33. 
 

Figure 33 Spectrum measurement screen with GSM signal analyzer 

 
 

Setting measure setup 

Procedure 

Optional. To set the delay, complete the following steps: 
1 Press the MEASURE SETUP hot key. 
2 Press the Miscellaneous soft key. 
3 Press the Delay soft key to set the amount of delay in µs. 
4 Enter a value by using the numeric keys. You can also use the rotary knob. 
5 Press the µs soft key. 

 
 NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 
 

Setting trace 

You can display up to six traces on the measurement chart simultaneously. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6. 

The legend shape of the selected trace changes from square to round to indicate that the trace is 
the active one now. 

3 Toggle the Trace View soft key and select On. 
4 Do one of the following: 
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To Select Trace Legend 

Clear current data and display with new 
measurements 

Clear Write W 

Display the input signal’s maximum response only 
(unlimited or for a certain amount of time) 

Max Hold M 

Display the input signal’s minimum response only 
(unlimited or for a certain amount of time) 

Min Hold m 

Capture the selected trace and compare traces Capture C 

Load a saved trace More (1/2) > Load L 

Hide the selected trace Trace View > Off F 

Remove all the traces and initialize the trace 
settings 

More (1/2) > Trace 
Clear All 

 

 

 NOTE 
For the Max Hold and Min Hold, your instrument compares newly acquired data with the 
active trace and displays larger maximum values or smaller minimum values on the 
screen. You can set it to Unlimited to hold and view maximum or minimum data or 
specify a certain amount of time up to 60 seconds by using numeric keys or the rotary 
knob. 

5 Optional. Press the More (1/2) > Trace Info soft key, and then select the trace number to view 
the trace’s parameter setting information stored at the time of the measurement or None to hide 
the information display. 

6 Optional. If you have the two traces T1 and T2, you can perform trace math. To view the power 
difference between the traces, press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key. 
The result is overlaid on the screen along with the second Y-axis. 

 

Conducting RF measurements 

Channel power 

The Channel Power measures in-channel power for GSM/GPRS and EDGE systems, which use 
dynamic power control to ensure that each link is maintained with minimum power. It gives two 
fundamental benefits of keeping overall system interference to a minimum level and of maximizing 
battery life in the case of mobile stations. It determines the power delivered to the antenna system on 
the RF channel under test. The instrument acquires a GSM/GPRS or EDGE signal in the time domain. 
The average power level above the threshold is then computed and displayed. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 107, you 
can continue your measurement. 
 

Procedure 

Optional. To set the delay, complete the following steps: 
1 Press the MEASURE SETUP hot key. 
2 Press the Miscellaneous soft key. 
3 Press the Delay soft key to set the amount of delay in µs. 
4 Enter a value by using the numeric keys. You can also use the rotary knob. 
5 Press the µs soft key. 
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 NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 
 

Measurement example 

Figure 34 Channel power measurement with GSM signal analyzer 

 
 
Channel power measurement result shows channel power and spectrum density in a user specified 
channel bandwidth. The peak to average ratio (PAR) is shown at the bottom of the screen as well. The 
shaded area on the display indicates the channel bandwidth. 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 117 for more 
information. 

 

Occupied bandwidth 

The Occupied Bandwidth measures the spectrum shape of the carrier. It is defined as the bandwidth, 
which includes 99% of the transmitted power among total transmitted power. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 107, you 
can continue your measurement. 
 

Procedure 

Optional. To set the delay, complete the following steps: 
1 Press the MEASURE SETUP hot key. 
2 Press the Miscellaneous soft key. 
3 Press the Delay soft key to set the amount of delay in µs. 
4 Enter a value by using the numeric keys. You can also use the rotary knob. 
5 Press the µs soft key. 
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 NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 
 

Measurement example 

The Occupied Bandwidth measurement shows both of power across the band and power bandwidth in 
a user specified percentage to determine the amount of spectrum used by a modulated signal. 
Occupied bandwidth is typically calculated as the bandwidth containing 99% of the transmitted power. 
 

Figure 35 Occupied bandwidth measurement with GSM signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 117 for more 
information. 

 

Spectrum emission mask (SEM) 

The Spectrum Emission Mask (SEM) measurement is to identify and determine the power level of out-
of-band spurious emission outside the necessary channel bandwidth and modulated signal. It 
measures the power ratio between in-band and adjacent channels. The JD700B series indicates either 
Pass or Fail based on the specified limit of the signal. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 107, you 
can continue your measurement. 
 

Procedure 

Optional. To set the delay, complete the following steps: 
1 Press the MEASURE SETUP hot key. 
2 Press the Miscellaneous soft key. 
3 Press the Delay soft key to set the amount of delay in µs. 
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4 Enter a value by using the numeric keys. You can also use the rotary knob. 
5 Press the µs soft key. 

 
 NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 
 

Measurement example 

Figure 36 SEM measurement with GSM signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 117 for more 
information. 

 

Spurious emissions 

Out-of-band emissions are unwanted emissions immediately outside the channel bandwidth resulting 
from the modulation process and non-linearity in the transmitter but excluding spurious emissions. The 
Spurious Emissions measurement is to identify and determine the power level of out-of-band spurious 
emission within the necessary channel bandwidth and modulated signal measured at the RF port of 
the Base Station. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 107, you 
can continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set up the range table and frequency range, press the Range Table soft key and then 

complete the following steps: 
 Press the Range soft key, and then enter the range number to add a new range or change a

an existing one. 
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 Press the Enter soft key. b
 Press the Start Frequency soft key to set up the frequency range. c
 Enter a value by using the numeric keys. You can also use the rotary knob. d
 Select the unit: GHz, MHz, kHz, or Hz. e
 Press the Stop Frequency soft key to set up the frequency range. f
 Enter a value by using the numeric keys. You can also use the rotary knob. g
 Select the unit: GHz, MHz, kHz, or Hz. h

3 Toggle the Range soft key between On and Off to display or hide the selected range. 
4 To set up the test limits for Pass/Fail indication, complete the following steps: 

 Press the Start Limit soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the dBm soft key. c
 Press the Stop Limit soft key. d
 Enter a value by using the numeric keys. You can also use the rotary knob. e
 Select the dBm soft key. f

5 To set up the other parameters, complete the following steps: 
 Select More (1/2) > Attenuation to set up the attenuation value. a
 Enter a value in the multiple of five. b
 Press the dB soft key or the ENTER hard key. c
 Press the RBW soft key. d
 Enter a value by using the numeric keys. e
 Select the unit: GHz, MHz, kHz, or Hz. f
 Press the VBW soft key. g
 Enter a value by using the numeric keys. h

 Select the unit: GHz, MHz, kHz, or Hz. i
6 Press the PREV hard key. 
7 Toggle the Measure Type soft key between Examine and Full to select the measurement type. 

 

 NOTE 
The Examine mode displays only the selected range while the Full mode lets the 
instrument automatically changes the selected range from one another. 

 

8 Set the number of measurements to be averaged: 
 Press the Average soft key. a
 Enter a value between 1 and 100. b
 Press the Enter soft key. c
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Measurement example 

Figure 37 Spurious emissions measurement with GSM signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 117 for more 
information. 

 

Setting limit for RF tests 

By default, test limits specified in the standard are set for you. You can change thresholds if you desire. 
 

Procedure 

1 Press the LIMIT hot key. 
2 Press the RF Test Limits soft key. 
3 Select the test item(s) and set the limit(s) depending on your selected measurement mode: 

 

To set the limit for Select Set 

Channel power Channel Power High Limit, Low Limit 

Occupied bandwidth Occupied BW High Limit 

Spectrum emission mask Spectrum Emission Mask (On/Off only) 

ACLR ACLR (On/Off only) 

Multi-ACLR Multi-ACLR (On/Off only) 

Spurious emissions Spurious Emissions (On/Off only) 
 

4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 32 for more information. 
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Conducting power vs. time measurements 

The Power vs. Time measurement measures the mean transmission power during the useful part of 
GSM bursts and verifies that the power ramp fits within the defined mask. It also lets you view the rise, 
fall, and useful part of the GSM burst. 
 
This measurement provides masks for both of Base Transceiver Station (BTS) and Mobile Station 
(MS). The timing masks are referenced to the transition from the bit 13 to the bit 14 of the mid-amble 
training sequence. For GMSK measurements, the 0 dB reference is determined by measuring the 
mean transmitted power during the useful part of the burst. 
 

Power vs. time (slot) 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 107, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Detect Mode soft key, and then select the signal standard option: Auto, GSM, or EDGE. 

Auto is set by default. The instrument applies a mask automatically based on the selected mode. 
3 Optional. To set the delay, complete the following steps: 

 Press the Miscellaneous soft key. a
 Press the Delay soft key to set the amount of delay in µs. b
 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Press the µs soft key. d

 
 NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 
 

Setting limit for burst power 

Procedure 

1 Press the LIMIT hot key. 
2 Press the PvsT Test Limits soft key. 
3 Press the Burst Power soft key to set the limit in the Power vs. Time (Slot) measurement. 
4 Toggle the Test Limits soft key between On and Off to enable or disable the Pass/Fail indication. 
5 Set the upper threshold: 

 Press the High Limit soft key. a
 Enter a value for the upper limit, and then press the dBm unit soft key. b

6 Set the lower threshold: 
 Press the Low Limit soft key. a
 Enter a value for the lower limit, and then press the dBm unit soft key. b

7 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

8 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 32 for more information. 
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Measurement example 

Figure 38 Power vs. time (slot) measurement with GSM signal analyzer 

 
 

Figure 39 Power vs. time (slot) measurement with GSM signal analyzer 

 
 

Power vs. time (frame) 

Setting measure setup  

After configuring test parameters as described in the “Configuring test parameters” on page 107, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Detect Mode soft key, and then select the signal standard option: Auto, GSM, or EDGE. 

Auto is set by default. The instrument applies a mask automatically based on the selected mode. 
3 Optional. To set the delay, complete the following steps: 
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 Press the Miscellaneous soft key. a
 Press the Delay soft key to set the amount of delay in µs. b
 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Press the µs soft key. d

 
 NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 
 

Setting limit for frame average power 

Procedure 

1 Press the LIMIT hot key. 
2 Press the PvsT Test Limits soft key. 
3 Press the Frame Avg Power soft key to set the limit in the Power vs. Time (Frame) 

measurement. 
4 Toggle the Test Limits soft key between On and Off to enable or disable the Pass/Fail indication. 
5 Set the upper threshold: 

 Press the High Limit soft key. a
 Enter a value for the upper limit. b
 Press the dBm unit soft key. c

6 Set the lower threshold: 
 Press the Low Limit soft key. a
 Enter a value for the lower limit. b
 Press the dBm unit soft key. c

7 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

8 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 32 for more information. 

 

Measurement example 

Figure 40 Power vs. time (frame) measurement with GSM signal analyzer 
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Conducting constellation measurements 

The Constellation is used to observe some aspects of modulation accuracy and can reveal certain 
fault mechanisms such as I/Q amplitude imbalance or quadrature imbalance. It displays constellation 
diagram by modulation types. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 107, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Detect Mode soft key, and then select the signal standard option: Auto, GSM, or EDGE. 

Auto is set by default. The instrument applies a mask automatically based on the selected mode. 
3 Toggle the PSK Constellation soft key between On and Off to enable or disable the PSK 

constellation observation. 
 

 NOTE 
The PSK constellation must be turned on to analyze EDGE signals. 

 

4 Optional. To set the delay, complete the following steps: 
 Press the Miscellaneous soft key. a
 Press the Delay soft key to set the amount of delay in µs. b
 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Press the µs soft key. d

 
 NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 
 

Setting limit for constellation 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Modulation Test Limits soft key to set the limits in the Constellation measurement. 
3 Select the test item(s) and set the limit(s) depending on your selected measurement mode: 

 

To set the limit for Select Set 

Frequency error Frequency Error High Limit, Low Limit 

Phase error rms Phase Error RMS High Limit, Low Limit 

Phase error peak Phase Error Peak High Limit, Low Limit 

Error vector magnitude rms EVM RMS High Limit 

Error vector magnitude peak EVM Peak High Limit 

I/Q origin offset of the I and Q error 
(magnitude squared) offset from the origin 

IQ Origin Offset High Limit 

Carrier to interference (C/I) ratio C/I Low Limit 
 

4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
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Toggle the Beep soft key between On and Off to enable or disable the beep sound. 
5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 

See “Using save” on page 32 for more information. 

 

Measurement example 

Figure 41 Constellation measurement (PSK off) with GSM signal analyzer 

 
 

Figure 42 Constellation measurement (PSK on) with GSM signal analyzer 

 
 

 NOTE 
Measurement items such as IQ Origin Offset, C/I, EVM RMS/Peak and EVM 95th 
are applicable only to EDGE signal measurements. 
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Performing auto measurements 

The Auto Measure function of the JD700B series allows a complete signal profiling covering RF 
characterization and modulation quality parameters of up to 10 different carriers, particularly useful on 
an overlay architecture where base stations are transmitting in different frequencies. 
 
The Auto Measure can be easily executed either by selecting a menu in the instrument or by running a 
programmed scenario in the PC-based application so that the instrument automatically configure and 
perform tests on every aspect of all the carriers. 
 

Setting limit for auto measure 

You can set test limits for test item(s) in the auto measurement. 

Procedure 

1 Press the LIMIT hot key. 
2 Press the RF Test Limits soft key, and then enable test limits as desired. 
3 Press the PvsT Test Limits soft key, and then enable test limits as desired. 
4 Press the Modulation Test Limits soft key, and then enable test limits as desired. 
5 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 

Toggle the Beep soft key between On and Off to enable or disable the beep sound. 
6 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 

See “Using save” on page 32 for more information. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 107, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the Configuration soft key and select the configuration option: 

–  Current: Lets the instrumnet use current frequency (single carrier) and determine pass or 
fail based on the instrument’s limit settings in Auto Measure. 

–  Scenario: Runs a test with a programmed scenario in JDViewer. 
The Scenario menu becomes activated. 

3 To load a scenario, press the Scenario soft key, and then select a scenario file to load. 
4 Toggle the Test Time soft key and select the test time option: 

–  Now: Lets the instrument run a test only once. 

–  Schedule: Lets the instrument repeat tests as defined in the Set Timing. 
The Set Timing menu becomes activated. 

5 To define a schedule for an auto measurement, complete the following steps: 
 Press the Set Timing soft key. a
 Press the Start Time (HH:MM) soft key. b
 Enter the time in the HH:MM format, and then press the Enter soft key. c
 Press the Stop Time (HH:MM) soft key. d
 Enter the time in the HH:MM format, and then press the Enter soft key. e
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 Press the Time Interval soft key. f
 Enter the amount of time in minutes, and then press the Enter soft key. g

6 To set external offset, complete the following steps: 
 Toggle the External Offset soft key and select On. a
 Enter a value by using the numeric keys, and then press the dB soft key. b

7 To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you 
desire. See “Using save” on page 32 for more information. 

8 Press the Run Test soft key to start to run a test. 
The Auto Measure Results window appears at the end of the test. 

9 To stop running the test, press the Abort soft key. 
10 To change the view on the screen during the test, press the Display and then select the view 

option from the following choices: 
–  Screen: You can view each measurement screen as the test progresses. 

–  Results: You can view a measurement result table as the test progresses. 

–  Settings: You can view a measurement setting table as the test progresses. 

 

Setting display 

After completion of the auto measurement, the screen menu changes to Trace/Display so that you can 
view the results in different forms. 
 

Procedure 

1 Toggle the Display soft key and select the display option: 
–  Result:: You can view the result table. The Display Result menu becomes activated. 

–  Settings: You can view the measurement settings for the auto measurement. 

2 Toggle the Display Result soft key and select the display result option: 
–  Full: You can view detailed measurement readings with the pass/fail indication. 

–  Quick: You can view only the Pass/Fail results. 

3 To view the measurement results for a different carrier, press the View Carrier soft key and then 
select the carrier number to view. 

 

Conducting GSM OTA measurements 

This Over-The-Air (OTA) measurement has channel scanner, frequency scanner, multipath profile, and 
modulation analyzer screens. The GSM OTA has a function to display channel power and related 
information up to 128 GSM down link signals. This channel scanner can quickly identifies improper 
power levels that affect network performance. The transmitter performance can be made on a base 
station from the convenience of your vehicle without taking the base station out of service. It helps you 
to determine testing area's RF environmental condition with the multipath profile. 
 

Channel scanner 

Setting channel 

Procedure 

1 Press the FREQ/DIST hard key. 
2 To select the standard channel, complete the following steps: 
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 Press the Channel Std soft key. The standard channel window appears. a
See “Appendix C – Band, frequency & channel standard” on page 530 for more information. 

 Highlight the band to be measured by using the rotary knob, the arrow keys, or the  b
Page Up/Page Down soft keys. 

 Press the Select soft key or the rotary knob to confirm the selection. c
3 To set the starting channel to be scanned, complete the following steps: 

 Press the Channel Number soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

4 To set the amount of channel increment in scanning channels, complete the following steps: 
 Press the Channel Step soft key. a
 Enter a value by suing the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

5 To set the number of channels to be displayed, complete the following steps: 
 Press the # of Channels soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

 

Setting zoom position 

You can set the starting channel for the Zoom In Window. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Zoom Position soft key. 
3 Enter a value by using the numeric keys. You can also use the rotary knob. 
4 Press the Enter soft key. 

 

Setting limit for OTA channel scanner 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Limit Line soft key to set a threshold for the limit line and Pass/Fail indication. 
3 Enter a value, and then press the dBm unit soft key. 
4 Toggle the Limit Line soft key between On and Off to display or dismiss the limit line. 
5 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 

Toggle the Beep soft key between On and Off to enable or disable the beep sound. 
6 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 32 for more information. 
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Measurement example 

Figure 43 Channel scanner measurement with GSM OTA signal analyzer 

 
 

Frequency scanner 

Setting frequency 

Procedure 

1 Press the FREQ/DIST hard key. 
2 To set the starting frequency to be scanned, complete the following steps: 

 Press the Start Frequency soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

3 To set the amount of frequency increment in scanning frequencies, complete the following steps: 
 Press the Frequency Step soft key. a
 Enter a value by suing the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

4 To set the number of frequencies to be displayed, complete the following steps: 
 Press the # of Frequencies soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

 

Setting zoom position 

You can set the starting channel for the Zoom Window. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Zoom Position soft key. 
3 Enter a value by using the numeric keys. You can also use the rotary knob. 
4 Press the Enter soft key. 

 



Chapter 6 Using GSM/GPRS/EDGE Signal Analyzer 

 JD700B Series User’s Guide 127 

Setting limit for OTA frequency scanner 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Limit Line soft key to set a threshold for the limit line and Pass/Fail indication. 
3 Enter a value, and then press the dBm unit soft key. 
4 Toggle the Limit Line soft key between On and Off to display or dismiss the limit line. 
5 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 

Toggle the Beep soft key between On and Off to enable or disable the beep sound. 
6 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 

See “Using save” on page 32 for more information. 

 

Measurement example 

Figure 44 Frequency scanner measurement with GSM OTA signal analyzer 

 
 

Multipath profile 

The Multipath Profile let you determine RF environmental conditions of testing area. The multipath 
profile is the result of portions of the original broadcast signal arriving at the receiving antenna out of 
phase. This can be caused by the signal being reflected off objects such as buildings, or being 
refracted through the atmosphere differently from the main signal. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 107, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Detect Mode soft key, and then select the signal standard option: Auto, GSM, or EDGE. 

Auto is set by default. The instrument applies a mask automatically based on the selected mode. 
3 Optional. To set the delay, complete the following steps: 
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 Press the Miscellaneous soft key. a
 Press the Delay soft key to set the amount of delay in µs. b
 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Press the µs soft key. d

4 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 32 for more information. 

 
 NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 
 

Measurement example 

Figure 45 Multipath profile measurement with GSM OTA signal analyzer 

 
 

Modulation analyzer 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 107, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Detect Mode soft key, and then select the signal standard option: Auto, GSM, or EDGE. 

Auto is set by default. The instrument applies a mask automatically based on the selected mode. 
3 Optional. To set the delay, complete the following steps: 

 Press the Miscellaneous soft key. a
 Press the Delay soft key to set the amount of delay in µs. b
 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Press the µs soft key. d

4 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 32 for more information. 

 
 NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 
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Setting limit for modulation analyzer 

Procedure 

1 Press the LIMIT hot key. 
2 Select the test item(s) and set the limit(s): 

 

To set the limit for Select Set 

Frame average power Frame Average Power High Limit, Low Limit 

Frequency error Frequency Error High Limit, Low Limit 

Burst power Burst Power High Limit, Low Limit 

ACLR ACLR (On/Off only) 

Multi-ACLR Multi-ACLR (On/Off only) 

Spurious emissions Spurious Emissions (On/Off only) 
 

3 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

4 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 32 for more information. 

 

Measurement example 

Figure 46 Modulation analyzer measurement with GSM OTA signal analyzer 
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Analyzer 

This chapter provides instructions for using the WCDMA/HSPA+ Signal Analyzer function (option 023) 
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Introduction 

This WCDMA/HSPA+ Signal Analyzer can be used to test a WCDMA transmitter including 
HSDPA/HSPA+ signals to check the base station’s compliance with following standards documentation. 
 

 3GPP TS 25.104 Base Station radio transmission and reception 

 3GPP TS 25.141 Base Station (BS) conformance test 

 3GPP TS 25.211 Physical channel and mapping of transport channels onto physical channels 

 3GPP TS 25.212 Multiplexing and channel coding 

 3GPP TS 25.213 Spreading and modulation 
 
The instrument automatically makes standard defined measurements using the measurement 
methods and limits as defined in the standards. Detailed measurement results allow you to analyze 
WCDMA and HSPA+ system performance. You may alter the measurement parameters for specialized 
analysis. Pass/Fail testing with standard defined or user defined upper and lower limits and the 
Pass/Fail indictor help you to determine base station performance easily. 
 
This instrument provides the following measurement tools for WCDMA/HSPA+ system: 
 

 Spectrum Analysis 

 RF Analysis 
- Channel Power 
- Occupied Bandwidth 
- Spectrum Emission Mask (SEM) 
- Adjacent Channel Leakage power Ratio (ACLR) 
- Multi-ACLR 
- Spurious Emissions 

 Modulation Analysis 
- Constellation 
- Code Domain Power 
- Relative Code Domain Error 
- Codogram 
- Received Code Strength Indicator (RCSI) 
- CDP Table 

 Auto Measure 

 Power Statistics CCDF 

 Over The Air (OTA) 
- Channel Scanner 
- Scramble Scanner 
- Multipath Profile 
- Code Domain Power 
- Route Map 

 

Display overview 

Figure 47 provides descriptions for each segment of the measurement screen. 
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Figure 47 WCDMA/HSPA+ signal analyzer measurement screen 

 

 

Connecting a cable 

Direct connection 

Procedure 

1 Connect the Spectrum Analyzer RF In port of the JD700B series and the power amplifier output 
port of BTS. 

 
Figure 48 Direct connection 

 
JD785B/JD745B 

 
JD788B/JD748B 

 

Indirect connection 

Procedure 

1 Connect the Spectrum Analyzer RF In port of the JD700B series and the monitor (test) port of 
BTS. 
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Figure 49 Indirect connection 

 
JD785B/JD745B 

 
JD788B/JD748B 

 

 

CAUTION 
The maximum power for the Spectrum Analyzer RF In port is +25 dBm (0.316 W) for 
JD780B series and +20 dBm (0.1 W) for JD740B series. If the level of the input signal to 
be measured is greater than this, use a High Power Attenuator to prevent damage 
when you directly connect the signal to the instrument or connect the signal from the 
coupling port of a directional coupler. 

 

Over the air (OTA) 

Procedure 

1 Connect an Omni/directional RF antenna to the Spectrum Analyzer RF In port of the JD700B 
series. 

2 Connect a GPS antenna to the GPS port of the JD700B series. 

 
Figure 50 OTA connection 

 
JD785B/JD745B 

 
JD788B/JD748B 

 

 

CAUTION 
If the input signal level to be measured is less than 0 dBm, set 0 dB attenuation or turn on 
the preamp to have better dynamic range for the OTA testing. 
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Selecting measurement mode 

Procedure 

1 Press the MODE hard key. 
2 Press the Signal Analyzer soft key. 
3 Press the WCDMA soft key. The Spectrum mode is set by default. 
4 Press the MEASURE hot key, and then select the measurement mode option from the following 

choices: 
–  Spectrum 

–  RF Analysis > Channel Power, Occupied BW, Spectrum Emission Mask, ACLR,  
Multi-ACLR, or Spurious Emissions 

–  Modulation > Constellation, Code Domain Power, Relative Code Domain Error,  
Codogram, RCSI, or CDP Table 

–  Auto Measure 

–  Power Statistics CCDF 

–  OTA > Channel Scanner, Scramble Scanner, Multipath Profile, Code Domain Power, 
or Route Map 

 

Configuring test parameters 

Setting frequency 

You can set the frequency with either frequency or channel number. If a frequency to be set matches 
to the frequency corresponding to the selected channel standard, the instrument calculates its channel 
number and updates the screen with it automatically. 
 

Procedure 

To set the center frequency: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Freq. 
3 Press the Center Frequency soft key. 
4 Enter a value by using the numeric keys. You can also use the rotary knob. 
5 Select the unit: GHz, MHz, kHz, or Hz. 
6 Optional. To define the amount of frequency increment for the rotary knob, complete the following 

steps: 
 Press the Frequency Step soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the unit: GHz, MHz, kHz, or Hz. c

 
To set the channel number: 

1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Channel. 
3 To select the standard channel, complete the following steps: 

 Press the Channel Std soft key. The standard channel window appears. a
See “Appendix C – Band, frequency & channel standard” on page 530 for more information. 

 Highlight the band to be measured by using the rotary knob, the arrow keys, or the Page b
Up/Page Down soft keys. 

 Press the Select soft key or the rotary knob to confirm the selection. c
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4 Press the Channel Number soft key. 
5 Enter a value by using the numeric keys. You can also use the rotary knob. 
6 Press the Enter soft key. 
7 The instrument automatically displays the corresponding center frequency value for the selected 

channel number. 
8 Optional. To define the amount of channel increment for the rotary knob, complete the following 

steps: 
 Press the Channel Step soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

 
 NOTE 

This frequency setting is not used in the Multi-ACLR and Spurious Emissions modes. 
 

Setting amplitude 

Reference level and attenuation 

You can set the reference and attenuation levels automatically or manually to optimize the display of 
the traces measured, as you desire. 
 

Procedure 

To automatically set the reference and attenuation level: 
1 Press the AMP/SCALE hard key. 
2 Press the Auto Scale soft key. 

Each time you press this key, both of the Y-axis scale and input attenuation level change to be 
optimized with some margin. 

 
To set the reference or attenuation level manually: 

1 Press the AMP/SCALE hard key. 
2 To set the maximum reference value on the Y-axis manually, complete the following steps: 

 Press the Reference Level soft key. a
 Enter a value by using the numeric keys or the rotary knob with 10 dB increments. b
 Press the dBm soft key or the ENTER hard key. c

This unit key name changes according to the setting in the Units menu. 
 

 NOTE 
In the measurements such as Code Domain Power, Codogram, and RCSI, you may 
need to select the reference option between Relative and Absolute before setting the 
reference level. 

3 To set the attenuation option, select one from the following choices: 
–  To set the input attenuator’s level automatically, select Attenuation > Auto. 

 

 NOTE 
It is recommended that you set the Attenuation to Auto in most situations so that the 
level of the input attenuator can be set automatically according to your input signal level. 

 

–  To set the input attenuation manually up to 55 dB for JD780B series or 50 dB for JD740B 
series to optimize S/N, complete the following steps: 

 Select Attenuation > Manual. a
 Press the Attenuation Value soft key to set the level. b
 Enter a value in fives by using the numeric keys. c
 Press the dB soft key or the ENTER hard key. d

–  To couple the input attenuator’s level with your reference level setting, select Attenuation > 
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Couple. 
As you increase the reference setting, the attenuation level also increases acoordingly. 

 
Optional. To change the scale unit: 

1 Select More (1/2) > Units. 
2 Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W. 

The scale unit on the screen changes accordingly. 
 

 NOTE 
This Units menu is available in the Spectrum and RF Analysis modes. 

 

 

Scale per division 

You can use the Scale/Div feature available for the spectrum and RF analysis. It represents the value 
of one division on the horizontal scale. The default setting is 10 dB per division and the maximum 
value can be set up to 20 dB. 
 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Select More (1/2) > Scale/Div. 
3 Enter a value between 1 and 20 by using the numeric keys. 
4 Press the dB soft key to complete the entry. 

 

Pre-amplifier 

You can turn the internal pre-amplifier on to correct and compensate for the gain of the preamp so that 
amplitude readings show the value at the input connector. 
 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Toggle the Preamp soft key and select On or Off as needed. 

 
 NOTE 

You can turn the Preamp on when the input attenuation range is from 0 dB to 10 dB. If 
the attenuation value is manually set to greater than 10 dB, the instrument will 
automatically turn off the pre-amplifier to display low-level signal properly on the chart. 

 

External offset 

You can turn the External Offset on and manually set the external offset value. An offset consists of a 
cable loss and a user offset and the measurement result shows the value reflecting both offset values. 
When the external offset value is set at 40 dB in the Spectrum mode, the measurement result 
compensates 40 dB at both the Spectrum Analyzer and Signal Analyzer modes. 
 

Procedure 

To set the external offset: 
1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select On. 
3 Enter a value by using the numeric keys. 
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4 Press the dB soft key to complete the entry. 
 
To turn the external offset off: 

1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select Off. 

 

Setting average 

You can set the number of measurements to be averaged for the trace presentation. A maximum of 
100 times of averaging can be set. When the averaging reaches to your setting, a new measurement 
value replaces the measurement value in sequence from the earliest. 
 

Procedure 

1 Press the BW/AVG hard key. 
2 Press the Average soft key. 
3 Enter a value between 1 and 100 as needed by using the numeric keys. 
4 Press the Enter soft key. 

 

Setting sweep mode 

The default setting is Continue to sweep continuously for most on-going measurements. If you want to 
hold the measurement or get a single sweep, you can change the sweep mode. 
 

Procedure 

To select the single sweep mode: 
1 Press the SWEEP hot key. 
2 Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key. 

The letter HOLD in red appears and the sweeping is paused. 
3 Optional. Press the Sweep Once soft key to get a new measurement. 

 
To return to the continuous sweep mode: 

1 Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key. 
The letter HOLD in red disappears and the sweeping resumes. 

 

Setting trigger source 

You can set the trigger source option for your measurements. 

Procedure 

1 Press the TRIGGER hot key. 
2 Select the trigger source option from the choices: Internal, External, and GPS. 

 

Setting external clock 

To enhance the reliability of modulation analysis measurements the JD700B series must be 
synchronized with a base station. When an external clock is not supplied, the instrument works with its 
built-in internal high-accuracy time base and some measurement results may exhibit inaccurate values. 
Therefore, it is highly recommended that you use the same reference clock as the signal source. You 
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can use the TRIGGER hot key to set the external clock. 
 

Table 11 Standards of external clock operation 

Clock Type Reference Port Switching Standard 

External 
Reference 

Internal Internal 10 MHz  Default 

 External External Ref Clock Ext Ref (SMA) Manual switching 
(Input signal level >-3 dBm) 

 GPS GPS Clock GPS (SMA) Automatic switching 
(GPS signal received) 

Trigger Internal Internal Trigger  Default 

 External External Trigger Trigger (SMA) Manual switching 

 GPS GPS GPS (SMA) Manual switching 

 
Figure 51 Connection ports for external reference clock 

 
 

Procedure 

1 Connect an external reference or a GPS antenna to the JD700B series. 
2 Press the SYSTEM hot key. 
3 Press the Freq Reference soft key, and then select the reference option from the choices: 

Internal, External 10 MHz, External 13 MHz, External 15 MHz, and GPS. 

 
 NOTE 

When a GPS antenna is connected and locked, GPS coordinates (longitude and latitude) 
are displayed on the screen and frequency reference is automatically set to GPS in the 
System > Freq Reference. 

 
Table 12 External reference indicators 

Type Indicator Description 

Internal  (green) The green INT icon indicates that the instrument uses the built-in 
internal time base. 

External  (green) The green EXT icon indicates that an external reference is connected 
and locked and that the instrument uses the same reference clock as 
the signal source. 

External  (red) The red EXT icon indicates that an external reference is connect but not 
locked. 

GPS      (green) The green GPS antenna icon indicates that a GPS antenna is 
connected and locked. 
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GPS      (yellow) The yellow GPS antenna icon indicates that a GPS antenna is 
connected and locking is in progress. 

GPS      (grey) The grey GPS antenna icon indicates that a GPS antenna is not 
connected, failed, or unable to be locked. 

 

Conducting spectrum measurements 

If you have configured test parameters as described in the “Configuring test parameters” on page 134, 
your measurement result is displayed on the screen as like the following example, Figure 52. 
 

Figure 52 Spectrum measurement screen with WCDMA signal analyzer 

 
 

Setting trace 

You can display up to six traces on the measurement chart simultaneously. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6. 

The legend shape of the selected trace changes from square to round to indicate that the trace is 
the active one now. 

3 Toggle the Trace View soft key and select On. 
4 Do one of the following: 

 

To Select Trace Legend 

Clear current data and display with new 
measurements 

Clear Write W 

Display the input signal’s maximum response only 
(unlimited or for a certain amount of time) 

Max Hold M 

Display the input signal’s minimum response only 
(unlimited or for a certain amount of time) 

Min Hold m 
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Capture the selected trace and compare traces Capture C 

Load a saved trace More (1/2) > Load L 

Hide the selected trace Trace View > Off F 

Remove all the traces and initialize the trace 
settings 

More (1/2) > Trace 
Clear All 

 

 

 NOTE 
For the Max Hold and Min Hold, your instrument compares newly acquired data with the 
active trace and displays larger maximum values or smaller minimum values on the 
screen. You can set it to Unlimited to hold and view maximum or minimum data or 
specify a certain amount of time up to 60 seconds by using numeric keys or the rotary 
knob. 

5 To select the detection option, press the More (1/2) > Detectors, and then do one of the 
following: 

 

To display Select 

Random noise better than the peak without missing signals Normal 

The highest value in each data point Peak 

The root mean squared average power across the spectrum RMS 

The lowest value in each data point Negative Peak 

The center value in each data point Sample 
 

6 Optional. Press the More (1/2) > Trace Info soft key, and then select the trace number to view 
the trace’s parameter setting information stored at the time of the measurement or None to hide 
the information display. 

7 Optional. If you have the two traces T1 and T2, you can perform trace math. To view the power 
difference between the traces, press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key. 
The result is overlaid on the screen along with the second Y-axis. 

 

Conducting RF measurements 

Channel power 

The Channel Power measurement is a common test used in the wireless industry to measure the total 
transmitted power of a radio within a defined frequency channel. This procedure measures the total 
power within the defined channel for WCDMA. This measurement is applied to design, characterize, 
evaluate, and verify transmitters and their components or devices for base stations and mobile stations. 
 
The channel power measurement identifies the channel power within a specified bandwidth (default is 
5 MHz, as per the 3GPP WCDMA technical specifications) and the power spectral density (PSD) in 
dBm/Hz. 
 
After configuring test parameters as described in the “Configuring test parameters” on page 134, your 
measurement result is displayed on the screen as like the following example, Figure 53. 
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Figure 53 Channel power measurement with WCDMA/HSPA+ signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 147 for more 
information. 

 

Occupied bandwidth 

The 3GPP specifications require the occupied bandwidth (OBW) of a transmitted WCDMA signal to be 
less than 5 MHz, where occupied bandwidth is defined as the bandwidth containing 99% of the total 
channel power. In this measurement, the total power of the displayed span is measured. Then the 
power is measured inward from the right and left extremes until 0.5% of the power is accounted for 
each of the upper and lower part of the span and the calculated difference is the occupied bandwidth. 
 
The spectrum shape of a WCDMA signal can give a useful qualitative insight into the transmitter’s 
operation. Any distortion to the spectrum shape might be an indication of degradation of the 
transmitter's performance. 
 
After configuring test parameters as described in the “Configuring test parameters” on page 134, your 
measurement result is displayed on the screen as like the following example, Figure 54. 
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Figure 54 Occupied bandwidth measurement with WCDMA/HSPA+ signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 147 for more 
information. 

 

Spectrum emission mask (SEM) 

The Spectrum Emission Mask (SEM) measurement required by 3GPP specifications encompasses 
different power limits and different measurement bandwidths (resolution bandwidths) at various 
frequency offsets. It may be expressed as a ratio of power spectral densities between the carrier and 
the specified offset frequency band. It provides useful figures-of-merit for the spectral re-growth and 
emissions produced by components and circuit blocks, without the rigor of performing a full SEM 
measurement. 
 
The SEM measures spurious signal levels in up to five pairs of offset or region frequencies and relates 
them to the carrier power. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 134, you 
can set the mask type according to the output power of the base station be tested. Your measurement 
result is displayed on the screen as like the following example, Figure 55. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Mask Type soft key. 
3 Select the mask type option: – 31 dBm, 31 – 39 dBm, 39 – 43 dBm, or 49 dBm –. 
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Figure 55 SEM measurement with WCDMA/HSPA+ signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 147 for more 
information. 

 

ACLR 

The Adjacent Channel Power Ratio (ACPR), designated by the 3GPP WCDMA specifications as the 
Adjacent Channel Leakage power Ratio (ACLR), is the power contained in a specified frequency 
channel bandwidth relative to the total carrier power. It may also be expressed as a ratio of power 
spectral densities between the carrier and the specified offset frequency band. 
 
After configuring test parameters as described in the “Configuring test parameters” on page 134, your 
measurement result is displayed on the screen as like the following example, Figure 56. 
 

Figure 56 ACLR measurement with WCDMA/HSPA+ signal analyzer 
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 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 147 for more 
information. 

 

Multi-ACLR 

The Multi-ACLR measurement is used to perform multi-channel ACLR measurements with as many 
channels as possible. It helps you to measure ACLR in multi-channel transmitting Base Station 
environment. 
 

Setting frequency for Multi-ACLR 

You can set the frequency with either frequency or channel number. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the frequency, do one of the following: 

–  To set the center frequency, complete the following steps: 
 Toggle the Unit soft key and select Freq. a
 Press the Lowest Frequency soft key to set the starting center frequency. b
 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Select the unit: GHz, MHz, kHz, or Hz. d
 Press the Highest Frequency soft key to set the stopping center frequency. e
 Enter a value by using the numeric keys. You can also use the rotary knob. f
 Select the unit: GHz, MHz, kHz, or Hz. g

–  To set the channel number, complete the following steps: 
 Toggle the Unit soft key and select Channel. a
 To select the standard channel, press the Channel Std soft key and then select the b

band to be measured. 
 Press the Lowest Channel soft key to set the starting channel. c
 Enter a value by using the numeric keys. You can also use the rotary knob. d
 Press the Enter soft key. e
 Press the Highest Channel soft key to set the stopping channel. f
 Enter a value by using the numeric keys. You can also use the rotary knob. g
 Press the Enter soft key. h

 
After configuring test parameters, your measurement result is displayed on the screen as like the 
following example, Figure 57. 
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Figure 57 Multi-ACLR measurement with WCDMA/HSPA+ signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 147 for more 
information. 

 

Spurious emissions 

Out-of-band emissions are unwanted emissions immediately outside the channel bandwidth resulting 
from the modulation process and non-linearity in the transmitter but excluding spurious emissions. The 
Spurious Emissions measurement is to identify and determine the power level of out-of-band spurious 
emission within the necessary channel bandwidth and modulated signal measured at the RF port of 
the Base Station. 
 

Setting measure setup 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set up the range table and frequency range, press the Range Table soft key and then 

complete the following steps: 
 Press the Range soft key, and then enter the range number to add a new range or change a

an existing one. 
 Press the Enter soft key. b
 Press the Start Frequency soft key to set up the frequency range. c
 Enter a value by using the numeric keys. You can also use the rotary knob. d
 Select the unit: GHz, MHz, kHz, or Hz. e
 Press the Stop Frequency soft key to set up the frequency range. f
 Enter a value by using the numeric keys. You can also use the rotary knob. g
 Select the unit: GHz, MHz, kHz, or Hz. h

3 Toggle the Range soft key between On and Off to display or hide the selected range. 
4 To set up the test limits for Pass/Fail indication, complete the following steps: 

 Press the Start Limit soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
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 Select the dBm soft key. c
 Press the Stop Limit soft key. d
 Enter a value by using the numeric keys. You can also use the rotary knob. e
 Select the dBm soft key. f

5 To set up the other parameters, complete the following steps: 
 Select More (1/2) > Attenuation to set up the attenuation value. a
 Enter a value in the multiple of five. b
 Press the dB soft key or the ENTER hard key. c
 Press the RBW soft key. d
 Enter a value by using the numeric keys. e
 Select the unit: GHz, MHz, kHz, or Hz. f
 Press the VBW soft key. g
 Enter a value by using the numeric keys. h

 Select the unit: GHz, MHz, kHz, or Hz. i
6 Press the PREV hard key. 
7 Toggle the Measure Type soft key between Examine and Full to select the measurement type. 

 

 NOTE 
The Examine mode displays only the selected range while the Full mode lets the 
instrument automatically changes the selected range from one another. 

 

8 Set the number of measurements to be averaged: 
 Press the Average soft key. a
 Enter a value between 1 and 100. b
 Press the Enter soft key. c

 
After configuring test parameters as described in the “Configuring test parameters” on page 134, your 
measurement result is displayed on the screen as like the following example, Figure 58. 
 

Figure 58 Spurious emissions measurement with WCDMA/HSPA+ signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 147 for more 
information. 
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Setting limit for RF tests 

By default, test limits specified in the standard are set for you. You can change thresholds if you desire. 
 

Procedure 

1 Press the LIMIT hot key. 
2 Press the RF Test Limits soft key. 
3 Select the test item(s) and set the limit(s) depending on your selected measurement mode: 

 

To set the limit for Select Set 

Channel power Channel Power High Limit, Low Limit 

Occupied bandwidth Occupied BW High Limit 

Spectrum emission mask Spectrum Emission Mask (On/Off only) 

ACLR ACLR (On/Off only) 

Multi-ACLR Multi-ACLR (On/Off only) 

Spurious emissions Spurious Emissions (On/Off only) 
 

4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 32 for more information. 

 

Conducting modulation measurements 

Constellation 

The Constellation is used to observe some aspects of modulation accuracy and can reveal certain 
fault mechanisms such as I/Q amplitude imbalance or quadrature imbalance. It displays constellation 
diagram by modulation types. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 134, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the scramble code, complete the following steps: 

 Toggle the Scramble soft key between Auto and Manual. a
 Enter a value by using the numeric keys to set manually. b
 Press the Enter soft key. c

3 Press the Detect Mode soft key, and then select the signal standard option: WCDMA, HSDPA, 
or HSPA+. HSDPA is set by default. 

4 To set the threshold, complete the following steps: 
 Press the Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c
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Measurement example 

Figure 59 Constellation measurement with WCDMA/HSPA+ signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 158 for 
more information. 

 

Code domain power 

The Code Domain Power (CDP) measures the distribution of power across the set of code channels, 
normalized to the total power. It helps to verify that each code channel is operating at its proper level 
and to identify problems throughout the transmitter design from coding to the RF section. System 
imperfections such as amplifier non-linearity will present themselves as an undesired distribution of 
power in the code domain. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 134, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Optional. To set the scramble code, complete the following steps: 

 Toggle the Scramble soft key between Auto and Manual. a
 Enter a value by using the numeric keys to set manually. b
 Press the Enter soft key. c

3 Optional. Press the Detect Mode soft key, and then select the signal standard option: WCDMA, 
HSDPA, or HSPA+. HSDPA is set by default. 

4 To set the S-CCPCH information of the system to be tested, complete the following steps: 
 Press the S-CCPCH soft key. a
 Toggle the S-CCPCH soft key between On and Off to enable or disable the S-CCPCH. b
 Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64, c
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128, or 256. 
 Press the Spread Code soft key to set the spread code. d
 Enter a value by using the numeric keys. e
 Press the Enter soft key. f

5 To set the PICH information of the system to be tested, complete the following steps: 
 Press the PICH soft key. a
 Toggle the PICH soft key between On and Off to enable or disable the PICH. b
 Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64, c

128, or 256. 
 Press the Spread Code soft key to set the spread code. d
 Enter a value by using the numeric keys. e
 Press the Enter soft key. f

6 Optional. To set the threshold, complete the following steps: 
 Press the Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

 

Measurement example 

Figure 60 Code domain power measurement with WCDMA/HSPA+ signal analyzer 

1) Full screen 
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2) Full screen with constellation 

 

3) Zoomed screen (Width 64) 

 

4) Zoomed screen with constellation (Width 64) 
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 NOTE 

You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 158 for 
more information. 

 

Setting display 

You can view your measurement results in a different view option. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Toggle the View soft key and select the display option: 

–  Zoom: You can view the result in detail with zoom-in window. 
The Position and Width menus become activated. 

–  Full: You can view the full measurement result. 

3 To define the zoom start position and width, complete the following steps: 
 Press the Position soft key. a
 Enter a value of the position by using the numeric keys. b
 Press the Enter soft key. c
 Press the Width soft key, and then select the Walsh code option: 32, 64, 128, or 256. d

4 Toggle the Constellation soft key between On and Off to enable or disable the constellation 
chart on the Code Domain Power screen. 

5 Toggle the Control Channel soft key and select the control channel mode option: 
–  Normal: You can view the relative ratio of each control channel vs. total power. 

–  Delta: You can view the relative ratio of each control channel vs. CPICH channel. 

 

Relative code domain power 

The Relative Code Domain Error (RCDE) measurement provides relative code domain error analysis 
that is particularly required by HSPA+. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 134, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Optional. To set the scramble code, complete the following steps: 

 Toggle the Scramble soft key between Auto and Manual. a
 Enter a value by using the numeric keys to set manually. b
 Press the Enter soft key. c

3 Optional. Press the Detect Mode soft key, and then select the signal standard option: WCDMA, 
HSDPA, or HSPA+. HSDPA is set by default. 

 

 NOTE 
It is recommended that you select HSPA+ for RCDE testing. 
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4 To set the S-CCPCH information of the system to be tested, complete the following steps: 
 Press the S-CCPCH soft key. a
 Toggle the S-CCPCH soft key between On and Off to enable or disable the S-CCPCH. b
 Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64, c

128, or 256. 
 Press the Spread Code soft key to set the spread code. d
 Enter a value by using the numeric keys. e
 Press the Enter soft key. f

5 To set the PICH information of the system to be tested, complete the following steps: 
 Press the PICH soft key. a
 Toggle the PICH soft key between On and Off to enable or disable the PICH. b
 Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64, c

128, or 256. 
 Press the Spread Code soft key to set the spread code. d
 Enter a value by using the numeric keys. e
 Press the Enter soft key. f

6 Optional. To set the threshold, complete the following steps: 
 Press the Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

7 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 32 for more information. 

 

Measurement example 

Figure 61 Relative code domain error with WCDMA/HSPA+ signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 158 for 
more information. 

 

Setting display 

You can view your measurement results in a different view option. 
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Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Toggle the View soft key and select the display option: 

–  Zoom: You can view the result in detail with zoom-in window. 
The Position and Width menus become activated. 

–  Full: You can view the full measurement result. 

3 To define the zoom start position and width, complete the following steps: 
 Press the Position soft key. a
 Enter a value of the position by using the numeric keys. b
 Press the Enter soft key. c
 Press the Width soft key, and then select the Walsh code option: 32, 64, 128, or 256. d

4 Toggle the Constellation soft key between On and Off to enable or disable the constellation 
chart on the Code Domain Power screen. 

5 Toggle the Control Channel soft key and select the control channel mode option: 
–  Normal: You can view the relative ratio of each control channel vs. total power. 

–  Delta: You can view the relative ratio of each control channel vs. CPICH channel. 

 

Codogram 

The Codogram displays how the code level is changing over time and makes it easier for you to view 
traffic channels as they initiate and terminate and to track traffic channels call levels over time. The 
Codogram measurements can be saved into an external USB memory so that a post-analysis can be 
done with the application software JDViewer. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 134, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Optional. To set the scramble code, complete the following steps: 

 Toggle the Scramble soft key between Auto and Manual. a
 Enter a value by using the numeric keys to set manually. b
 Press the Enter soft key. c

3 Optional. Press the Detect Mode soft key, and then select the signal standard option: WCDMA, 
HSDPA, or HSPA+. HSDPA is set by default. 

4 To set the S-CCPCH information of the system to be tested, complete the following steps: 
 Press the S-CCPCH soft key. a
 Toggle the S-CCPCH soft key between On and Off to enable or disable the S-CCPCH. b
 Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64, c

128, or 256. 
 Press the Spread Code soft key to set the spread code. d
 Enter a value by using the numeric keys. e
 Press the Enter soft key. f

5 To set the PICH information of the system to be tested, complete the following steps: 



Chapter 7 Using WCDMA/HSPA+ Signal Analyzer 

154 JD700B Series User’s Guide 

 Press the PICH soft key. a
 Toggle the PICH soft key between On and Off to enable or disable the PICH. b
 Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64, c

128, or 256. 
 Press the Spread Code soft key to set the spread code. d
 Enter a value by using the numeric keys. e
 Press the Enter soft key. f

6 Optional. To set the threshold, complete the following steps: 
 Press the Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

7 To set the time interval, complete the following steps: 
 Press the Time Interval soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

8 To place the time cursor to analyze your measurements, complete the following steps: 
 Toggle the Time Cursor soft key between On and Off to enable or disable the time cursor. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

 

 NOTE 
When the time cursor is enabled, the measurement is put on hold and information about 
the time cursor is displayed. 

 

9 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 32 for more information. 

 

Measurement example 

Figure 62 Codogram in full view with WCDMA/HSPA+ signal analyzer 

 
 

Setting display 

You can view your measurement results in a different view option. 
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Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Toggle the View soft key and select the display option: 

–  Zoom: You can view the result in detail with zoom-in window. 
The Position and Width menus become activated. 

–  Full: You can view the full measurement result. 

3 To define the zoom start position and width, complete the following steps: 
 Press the Position soft key. a
 Enter a value of the position by using the numeric keys. b
 Press the Enter soft key. c
 Press the Width soft key, and then select the Walsh code option: 32, 64, 128, or 256. d

 

RCSI 

The Received Code Strength indicator (RCSI) is used to track the code channels such as CPICH, P-
CCPCH, S-CCPCH, PICH, P-SCH, and S-SCH. It is particularly useful to observe signal fluctuations of 
the dedicated control channels over the time. The RCSI measurements can be saved into an external 
USB memory so that a post-analysis can be done with the application software JDViewer. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 134, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Optional. To set the scramble code, complete the following steps: 

 Toggle the Scramble soft key between Auto and Manual. a
 Enter a value by using the numeric keys to set manually. b
 Press the Enter soft key. c

3 Optional. Press the Detect Mode soft key, and then select the signal standard option: WCDMA, 
HSDPA, or HSPA+. HSDPA is set by default. 

4 To set the S-CCPCH information of the system to be tested, complete the following steps: 
 Press the S-CCPCH soft key. a
 Toggle the S-CCPCH soft key between On and Off to enable or disable the S-CCPCH. b

Setting this on makes the S-CCPCH in the Alarm Code menu activated. 
 Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64, c

128, or 256. 
 Press the Spread Code soft key to set the spread code. d
 Enter a value by using the numeric keys. e
 Press the Enter soft key. f

5 To set the PICH information of the system to be tested, complete the following steps: 
 Press the PICH soft key. a
 Toggle the PICH soft key between On and Off to enable or disable the PICH. b

Setting this on makes the PICH in the Alarm Code menu activated. 
 Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64, c

128, or 256. 
 Press the Spread Code soft key to set the spread code. d
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 Enter a value by using the numeric keys. e
 Press the Enter soft key. f

6 Optional. To set the threshold, complete the following steps: 
 Press the Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

7 Press the Alarm Code soft key, and then select the alarm code option: None, CPICH, P-
CCPCH, S-CCPCH, PICH, P-SCH, or S-SCH. 

 

 NOTE 
The alarm codes S-CCPCH and PICH become activated in case that you have enabled 
the S-CCPCH and PICH respectively. 

 

8 To set the alarm mask, complete the following steps: 
 Press the Set Mask soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

9 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 32 for more information. 

 

Measurement example 

Figure 63 RCSI measurement with WCDMA/HSPA+ signal analyzer 

 
 

Setting display 

You can view your measurement results in a different view option. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Toggle the View soft key and select the display option: 

–  Zoom: You can view the result in detail with zoom-in window. 
The Position and Width menus become activated. 

–  Full: You can view the full measurement result. 
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3 To define the zoom start position and width, complete the following steps: 
 Press the Position soft key. a
 Enter a value of the position by using the numeric keys. b
 Press the Enter soft key. c
 Press the Width soft key, and then select the Walsh code option: 32, 64, 128, or 256. d

 

CDP Table 

The CDP Table is used to look at a numeric and textual description of all the active code channels in 
the signal. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 134, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Optional. To set the scramble code, complete the following steps: 

 Toggle the Scramble soft key between Auto and Manual. a
 Enter a value by using the numeric keys to set manually. b
 Press the Enter soft key. c

3 Optional. Press the Detect Mode soft key, and then select the signal standard option: WCDMA, 
HSDPA, or HSPA+. HSDPA is set by default. 

4 To set the S-CCPCH information of the system to be tested, complete the following steps: 
 Press the S-CCPCH soft key. a
 Toggle the S-CCPCH soft key between On and Off to enable or disable the S-CCPCH. b
 Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64, c

128, or 256. 
 Press the Spread Code soft key to set the spread code. d
 Enter a value by using the numeric keys. e
 Press the Enter soft key. f

5 To set the PICH information of the system to be tested, complete the following steps: 
 Press the PICH soft key. a
 Toggle the PICH soft key between On and Off to enable or disable the PICH. b
 Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64, c

128, or 256. 
 Press the Spread Code soft key to set the spread code. d
 Enter a value by using the numeric keys. e
 Press the Enter soft key. f

6 Optional. To set the threshold, complete the following steps: 
 Press the Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c
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Measurement example 

Figure 64 CDP Table measurement with WCDMA/HSPA+ signal analyzer 

 
 

Setting display 

If the CDP table spans over to the next page(s), you can change pages up and down to view your 
measurement results. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Select Page Up or Page Down as needed. 

 

Setting limit for modulation tests 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Modulation Test Limits soft key to set the limits. 
3 Select the test item(s) and set the limit(s) depending on your selected measurement mode: 

 

To set the limit for Select Set 

Frequency error Frequency Error High Limit 
Low Limit 

Error vector magnitude EVM High Limit 

Peak code domain error PCDE High Limit 

Carrier feed through Carrier Feed Through High Limit 

Correlated power in coded channel CPICH High Limit [Abs|Rel] 
Low Limit [Abs|Rel] 

Highest level among inactive channels Max Inactive High Limit 

Relative code domain error RCDE High Limit (QPSK) 
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High Limit (16 QAM) 
High Limit (64 QAM) 

 

4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 32 for more information. 

 
 NOTE 

The Carrier Feed Through is a result of the RF carrier signal feeding through the I/Q 
modulator and riding on the output circuitry without being modulated. 

 

Performing auto measurements 

The Auto Measure function of the JD700B series allows a complete signal profiling covering RF 
characterization and modulation quality parameters of up to 10 different carriers, particularly useful on 
an overlay architecture where base stations are transmitting in different frequencies. 
 
The Auto Measure can be easily executed either by selecting a menu in the instrument or by running a 
programmed scenario in the PC-based application so that the instrument automatically configure and 
perform tests on every aspect of all the carriers. 
 

Setting limit for auto measure 

You can set test limits for test item(s) in the auto measurement. 

Procedure 

1 Press the LIMIT hot key. 
2 Press the RF Test Limits soft key, and then enable test limits as desired. 
3 Press the Modulation Test Limits soft key, and then enable test limits as desired. 
4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 

Toggle the Beep soft key between On and Off to enable or disable the beep sound. 
5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 

See “Using save” on page 32 for more information. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 134, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the Configuration soft key and select the configuration option: 

–  Current: Lets the instrumnet use current frequency (single carrier) and determine pass or 
fail based on the instrument’s limit settings in Auto Measure. 

–  Scenario: Runs a test with a programmed scenario in JDViewer. 
The Scenario menu becomes activated. 
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3 To load a scenario, press the Scenario soft key, and then select a scenario file to load. 
4 Toggle the Test Time soft key and select the test time option: 

–  Now: Lets the instrument run a test only once. 

–  Schedule: Lets the instrument repeat tests as defined in the Set Timing. 
The Set Timing menu becomes activated. 

5 To define a schedule for an auto measurement, complete the following steps: 
 Press the Set Timing soft key. a
 Press the Start Time (HH:MM) soft key. b
 Enter the time in the HH:MM format, and then press the Enter soft key. c
 Press the Stop Time (HH:MM) soft key. d
 Enter the time in the HH:MM format, and then press the Enter soft key. e
 Press the Time Interval soft key. f
 Enter the amount of time in minutes, and then press the Enter soft key. g

6 To set external offset, complete the following steps: 
 Toggle the External Offset soft key and select On. a
 Enter a value by using the numeric keys, and then press the dB soft key. b

7 To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you 
desire. See “Using save” on page 32 for more information. 

8 Press the Run Test soft key to start to run a test. 
The Auto Measure Results window appears at the end of the test. 

9 To stop running the test, press the Abort soft key. 
10 To change the view on the screen during the test, press the Display and then select the view 

option from the following choices: 
–  Screen: You can view each measurement screen as the test progresses. 

–  Results: You can view a measurement result table as the test progresses. 

–  Settings: You can view a measurement setting table as the test progresses. 

 

Setting display 

After completion of the auto measurement, the screen menu changes to Trace/Display so that you can 
view the results in different forms. 
 

Procedure 

1 Toggle the Display soft key and select the display option: 
–  Result: You can view the result table. 

The Display Result menu becomes activated. 

–  Settings: You can view the measurement settings for the auto measurement. 

2 Toggle the Display Result soft key and select the display result option: 
–  Full: You can view detailed measurement readings with the pass/fail indication. 

–  Quick: You can view only the Pass/Fail results. 

3 To view the measurement results for a different carrier, press the View Carrier soft key and then 
select the carrier number to view. 

 

Performing power statistics CCDF measurement 

The Power Statistics Complementary Cumulative Distribution Function (CCDF) measurement 
characterizes the power statistics of the input signal. It provides PAR (Peak to Average power Ratio) 
versus different probabilities. 
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Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 134, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the CCDF Length soft key to set the length of the CCDF. 
3 Enter a value between 1 and 100 by using the numeric keys. You can also use the rotary knob. 
4 Press the Enter soft key. 

 

Measurement example 

Figure 65 CCDF measurement with WCDMA/HSPA+ signal analyzer 

 
 

Conducting WCDMA/HSPA+ OTA measurements 

This Over The Air (OTA) measurement has channel scanner, scramble scanner, multipath profile, code 
domain power, and route map screens. Scramble scanner displays six scrambling codes and powers 
to inform neighbor cells existence and its power. The multipath profile graph helps you to determine 
testing area's RF environmental condition. The code domain power shows not only modulation 
performance metric but also amplifier capacity and code utilization metric. The amplifier capacity (code 
utilization) measurement is an estimate of the amount of power amplifier capacity (code utilization) that 
is being used expressed in percent of maximum. 
 



Chapter 7 Using WCDMA/HSPA+ Signal Analyzer 

162 JD700B Series User’s Guide 

Channel scanner 

Setting channel/frequency 

Procedure 

To set the channels to be scanned: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Channel. 
3 Press the Index soft key, and then enter an index number by turning the rotary knob or using the 

numeric keys. 
4 To select the standard channel, complete the following steps: 

 Press the Channel Std soft key. The standard channel window appears. a
See “Appendix C – Band, frequency & channel standard” on page 530 for more information. 

 Highlight the band to be measured by using the rotary knob, the arrow keys, or the Page b
Up/Page Down soft keys. 

 Press the Select soft key or the rotary knob to confirm the selection. c
5 To set the channel number for the selected index, complete the following steps: 

 Press the Channel Number soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

6 The instrument displays a corresponding center frequency for the channel number. 
7 To set the integration bandwidth for the selected index, complete the following steps: 

 Press the Integration Bandwidth soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

8 To add more channels to be scanned, repeat steps 3-6. 
9 Press the ESC hard key to dismiss the channel list window and view the scanning result. 

 
To set the frequencies to be scanned: 

1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Freq. 
3 Press the Index soft key, and then enter an index number by turning the rotary knob or using the 

numeric keys. 
4 To set the center frequency for the selected index, complete the following steps: 

 Press the Center Frequency soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

5 To set the integration bandwidth for the selected index, complete the following steps: 
 Press the Integration Bandwidth soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

6 To add more channels to be scanned, repeat steps 3-5. 
7 Press the ESC hard key to dismiss the channel list window and view the scanning result. 

 

Setting limit for OTA channel scanner 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Limit Line soft key to set a threshold for the limit line and Pass/Fail indication. 
3 Enter a value, and then press the dBm unit soft key. 
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4 Toggle the Limit Line soft key between On and Off to display or dismiss the limit line. 
5 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 

Toggle the Beep soft key between On and Off to enable or disable the beep sound. 
6 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 

See “Using save” on page 32 for more information. 

 

Measurement example 

Figure 66 Channel scanner measurement with WCDMA/HSPA+ OTA signal analyzer 

 
 

Scramble scanner 

The WCDMA/HSPA+ mobile receives signals from multiple base stations that all of these signals share 
the same spectrum and are present at the same time. Each base station has a unique scrambling code 
assigned to the particular base station and it differentiates its signal from other base stations in the area. 
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Measurement example 

Figure 67 Scramble scanner measurement with WCDMA/HSPA+ OTA signal analyzer 

 
 

Multipath profile 

The Multipath Profile enables you to determine RF environmental conditions of testing area. It 
indicates the amount of power of the dominant pilot signal that is dispersed outside the main 
correlation peak due to multipath echoes that are expressed in dB. This value should be very small 
ideally. 
 
The multipath profile is the result of portions of the original broadcast signal arriving at the receiving 
antenna out of phase. This can be caused by the signal being reflected off objects such as buildings, 
or being refracted through the atmosphere differently from the main signal. 
 

Measurement example 

Figure 68 Multipath profile measurement with WCDMA/HSPA+ OTA signal analyzer 
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Code domain power 

Channels with high correlation factors are determined to be active channels and are indicated as such 
on the display. Once the channels are decoded, the analyzer determines the power of each channel 
relative to the total signal power. 
 
This measurement helps to verify that each code channel is operating at its proper level and helps to 
identify problems throughout the transmitter design from the coding to the RF section. System 
imperfections, such as the non-linearity of amplifiers, will present themselves as an undesired 
distribution of power in the code domain. 
 

Setting measure setup 

After configuring test parameters, you can set the measure setup to continue your measurement. The 
measurement settings can be saved and recalled as a file. You can also use JDViewer, PC application 
software to configure a measure setup, save as a file, and load the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the scramble code, complete the following steps: 

 Toggle the Scramble soft key between Auto and Manual. a
 Enter a value by using the numeric keys to set manually. b
 Press the Enter soft key. c

3 Press the Detect Mode soft key, and then select the signal standard option: WCDMA, HSDPA, 
or HSPA+. HSDPA is set by default. 

4 To set the threshold, complete the following steps: 
 Press the Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

5 To set the S-CCPCH information of the system to be tested, complete the following steps: 
 Press the S-CCPCH soft key. a
 Toggle the S-CCPCH soft key between On and Off to enable or disable the S-CCPCH. b
 Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64, c

128, or 256. 
 Press the Spread Code soft key to set the spread code. d
 Enter a value by using the numeric keys. e
 Press the Enter soft key. f

6 To set the PICH information of the system to be tested, complete the following steps: 
 Press the PICH soft key. a
 Toggle the PICH soft key between On and Off to enable or disable the PICH. b
 Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64, c

128, or 256. 
 Press the Spread Code soft key to set the spread code. d
 Enter a value by using the numeric keys. e
 Press the Enter soft key. f

7 To set the maximum amplifier power, complete the following steps: 
 Press the Max Amplifier Power soft key. a
 Enter a value by using the numeric keys. b
 Press the dBm soft key. c

8 To set the CPICH power, complete the following steps: 
 Press the More (1/2) soft key. a



Chapter 7 Using WCDMA/HSPA+ Signal Analyzer 

166 JD700B Series User’s Guide 

 Press the CPICH soft key. b
 Enter a value by using the numeric keys. c
 Press the dBm soft key. d

9 To set the threshold for CPICH dominance, complete the following steps: 
 Press the CPICH Dominance > soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

 

 NOTE 
Recommended value is 10. Color of the CPICH Dominance indicator on the screen 
bases on this setting. 

 

10 To set the threshold for multipath power, complete the following steps: 
 Press the Multipath Power < soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

 

 NOTE 
Recommended value is one. Color of the multipath power indicator on the screen bases 
on this setting. 

 

11 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 32 for more information. 

 

Measurement example 

Figure 69 Code domain power measurement with WCDMA/HSPA+ OTA signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. 

 

Route map 

The JD700B Series provides indoor and outdoor mapping function that allows a user to collect data of 
points in an indoor or outdoor environment and track the received signals and coverage of RF 
transmitters plotting real time directly on top of a loaded floor plan or a map. 
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Setting measure setup 

Procedure 

1 If required, connect a GPS receiver to your JD700B series for outdoor mapping. 
Indoor mapping does not necessarily need a GPS antenna. 

2 Configure test parameters as described in the “Configuring test parameters” on page 134. 
3 To load your map file, complete the following steps: 

 Plug in your USB drive that has a floor map or .mcf file type created in JDMapCreator. a
 

 NOTE 
The JDMapCreator converts and resizes any scanned floor plan or layout to fit onto your 
instrument’s display. You must save your map file (.mcf) into the “SavedMap” folder of 
your USB drive so that you can load them onto your instrument. 

 

 Press SAVE/LOAD hot key, and then select Load > Load Map. b
See “Using load” on page 34 for more information. 

4 Press the MEASURE SETUP hot key. 
5 Press the Plot Point soft key, and then select the plot point option from the following choices: 

–  To collect data/plot points automatically as you move around in a vehicle or outside, press 
the GPS soft key and then toggle the Screen Mode soft key between Map and Full. 

 

 NOTE 
With the Map setting, you can view only the collected points that can be seen within the 
boundary of the loaded map. If a point is off the map, the instrument displays an arrow to 
indicate the direction of the current location on the map and the distance from the center 
to the location at the top of the screen. 
 
With the Full setting, you can view all the collected points of the route without the loaded 
map. 

 

–  To collect data/plot points manually without a GPS antenna in an indoor environment, press 
the Position soft key. 

6 Press the Plot Item soft key, and then select the measurement option: CPICH Power or Ec/Io. 
7 Toggle the Plot soft key and select Start. 
8 Touch directly on the screen or press the ENTER hard key to collect data and plot points on the 

loaded map for the Position setting. 
 

 NOTE 
For the Position setting, you can change the direction of the route with the arrow keys 
and the distance with the rotary knob. 

 

9 Toggle the Plot soft key and select Stop to stop plotting. 
10 Press the SAVE/LOAD hot key to save the result. 

See “Using save” on page 32 for more information. 
 

 NOTE 
The instrument does not automatically save the collected data. It is recommended that 
you save the result. Otherwise, you will lose all the collected data. 

 

 

Setting limit 

You can set the thresholds for the four different color indicators for CPICH power or Ec/Io. 
 

Procedure 

1 Press the LIMIT hot key. 
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2 Select the plot items and set the limits as needed: 
 

To set the limit for Select Set 

CPICH Power CPICH Power Excellent, Very Good, Good, Fair, Poor (dBm) 

CPICH Ec/Io Ec/Io Good, Fair, Poor (dB) 
 

3 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 32 for more information. 

 

Measurement example 

Figure 70 Route map measurement with WCDMA/HSPA+ OTA signal analyzer 

1) CPICH Power 

 

2) CPICH Ec/Io 

 
 
 



 
 

8 
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Introduction 

The LTE (Long-Term Evolution) Signal Analyzer of the JD700B series performs power and spectrum 
measurements as well as modulation analysis to test the proper transmitter performance of FDD LTE 
systems. It performs conformance testing according to the following standards providing a simple 
Pass/Fail indication on each test. 
 

 3GPP TS 36.104. Evolved Universal Terrestrial Radio Access (E-UTRA); Base Station (BS) 
Radio Transmission and Reception 

 3GPP TS 36.141. Evolved Universal Terrestrial Radio Access (E-UTRA); Base Station (BS) 
Conformance Testing 

 3GPP TS 36.211. Evolved Universal Terrestrial Radio Access (E-UTRA); Physical Channels 
and Modulation 

 3GPP TS 36.212. Evolved Universal Terrestrial Radio Access (E-UTRA); Multiplexing and 
Channel Coding 

 3GPP TS 36.213 V8.2.0. Evolved Universal Terrestrial Radio Access (E-UTRA); Physical 
Layer Procedures 

 
This instrument provides the following measurement tools for FDD LTE system: 
 

 Spectrum Analysis 

 RF Analysis 

- Channel Power 

- Occupied Bandwidth 

- Spectrum Emission Mask 

- Adjacent Channel Leakage power Ratio (ACLR) 

- Multi-ACLR 

- Spurious Emissions 

 Power vs. Time (Frame) 

 Modulation Analysis 

- Constellation 

- Data Channel 

- Control Channel 

- Subframe 

- Frame 

- Time Alignment Error 

- Data Allocation Map 

 Auto Measure: 

- Conformance Test 

- Maintenance Test 

- Signal Performance Test 

- DAS Test 
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 Power Statistics CCDF 

 Carrier Aggregation 

 Over The Air (OTA) 

- Channel Scanner 

- ID Scanner 

- Multipath Profile 

- Control Channel 

- Datagram 

- Route Map 
 

Display overview 

Figure 71 provides descriptions for each segment of the measurement screen. 
 

Figure 71 LTE - FDD signal analyzer measurement screen 

 

 

Connecting a cable 

Direct connection 

Procedure 

1 Connect the Spectrum Analyzer RF In port of the JD700B series and the Power amplifier output 
port of BTS. 
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Figure 72 Direct connection 

 
JD785B/JD745B 

 
JD788B/JD748B 

 

Indirect connection 

Procedure 

1 Connect the Spectrum Analyzer RF In port of the JD700B series and the monitor (test) port of 
BTS. 

 
Figure 73 Indirect connection 

 
JD785B/JD745B 

 
JD788B/JD748B 

 

 

CAUTION 
The maximum power for the Spectrum Analyzer RF In port is +25 dBm (0.316 W) for 
JD780B series and +20 dBm (0.1 W) for JD740B series. If the level of the input signal to 
be measured is greater than this, use a High Power Attenuator to prevent damage 
when you directly connect the signal to the instrument or connect the signal from the 
coupling port of a directional coupler. 

 

Over the air (OTA) 

Procedure 

1 Connect an Omni/directional RF antenna to the Spectrum Analyzer RF In port of the JD700B 
series. 

2 Connect a GPS antenna to the GPS port of the JD700B series. 
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Figure 74 OTA connection 

 
JD785B/JD745B 

 
JD788B/JD748B 

 

 

CAUTION 
If the input signal level to be measured is less than 0 dBm, set 0 dB attenuation or turn on 
the preamp to have better dynamic range for the OTA testing. 

 

Selecting measurement mode 

Procedure 

1 Press the MODE hard key. 
2 Press the Signal Analyzer soft key. 
3 Press the LTE - FDD soft key. The Spectrum mode is set by default. 
4 Press the MEASURE hot key, and then select the measurement mode option from the following 

choices: 
–  Spectrum 

–  RF Analysis > Channel Power, Occupied BW, Spectrum Emission Mask, ACLR,  
Multi-ACLR, or Spurious Emissions 

–  Power vs Time (Frame) 

–  Modulation Analysis > Constellation, Data Channel, Control Channel, Subframe, 
Frame, Time Alignement Error, or Data Allocation Map 

–  Auto Measure > Conformance Test, Maintenance Test, Signal Perfomance,  
or DAS Test 

–  Power Statistics CCDF 

–  More (1/2) > Carrier Aggregation 

–  More (1/2) > OTA > Channel Scanner, ID Scanner, Multipath Profile, Control Channel, 
Datagram, or Route Map 

 
 NOTE 

The Carrier Aggregation soft key is activated if the license for the option 030 LTE-
Advanced FDD is installed. 
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Configuring test parameters 

Setting frequency 

You can set the frequency with either frequency or channel number. If a frequency to be set matches 
to the frequency corresponding to the selected channel standard, the instrument calculates its channel 
number and updates the screen with it automatically. 
 

Procedure 

To set the center frequency: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Freq. 
3 Press the Center Frequency soft key. 
4 Enter a value by using the numeric keys. You can also use the rotary knob. 
5 Select the unit: GHz, MHz, kHz, or Hz. 
6 Optional. To define the amount of frequency increment for the rotary knob, complete the following 

steps: 
 Press the Frequency Step soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the unit: GHz, MHz, kHz, or Hz. c

 
To set the channel number: 

1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Channel. 

 

 NOTE 
Selecting Channel sets the standard channel to Band Global automatically so that you 
can set the Channel Number without choosing a standard channel band from the list. 

 

3 Press the Channel Number soft key. 
4 Enter a value by using the numeric keys. You can also use the rotary knob. 
5 Press the Enter soft key. 
6 The instrument automatically displays the corresponding center frequency value for the selected 

channel number. 
7 Optional. To define the amount of channel increment for the rotary knob, complete the following 

steps: 
 Press the Channel Step soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

 
 NOTE 

This frequency setting is not used in the Multi-ACLR and Spurious Emissions modes. 
 

Setting amplitude 

Reference level and attenuation 

You can set the reference and attenuation levels automatically or manually to optimize the display of 
the traces measured, as you desire. 
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Procedure 

To automatically set the reference and attenuation level: 
1 Press the AMP/SCALE hard key. 
2 Press the Auto Scale soft key. 

Each time you press this key, both of the Y-axis scale and input attenuation level change to be 
optimized with some margin. 

 
To set the reference or attenuation level manually: 

1 Press the AMP/SCALE hard key. 
2 To set the maximum reference value on the Y-axis manually, complete the following steps: 

 Press the Reference Level soft key. a
 Enter a value by using the numeric keys or the rotary knob with 10 dB increments. b
 Press the dBm soft key or the ENTER hard key. c

 

 NOTE 
In the measurements such as Control Channel, Subframe, and Frame, you may need 
to select the reference option between Relative and Absolute before setting the 
reference level. 

 

3 To set the attenuation option, select one from the following choices: 
–  To set the input attenuator’s level automatically, select Attenuation > Auto. 

 

 NOTE 
It is recommended that you set the Attenuation to Auto in most situations so that the 
level of the input attenuator can be set automatically according to your input signal level. 

 

–  To set the input attenuation manually up to 55 dB for JD780B series or 50 dB for JD740B 
series to optimize S/N, complete the following steps: 

 Select Attenuation > Manual. a
 Press the Attenuation Value soft key to set the level. b
 Enter a value in fives by using the numeric keys. c
 Press the dB soft key or the ENTER hard key. d

–  To couple the input attenuator’s level with your reference level setting, select Attenuation > 
Couple. As you increase the reference setting, the attenuation level also increases 
acoordingly. 

 
Optional. To change the scale unit: 

1 Select More (1/2) > Units. 
2 Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W. 

The scale unit on the screen changes accordingly. 
 

 NOTE 
This Units menu is available in the Spectrum and RF Analysis modes. 

 

 

Scale per division 

You can use the Scale/Div feature available for the spectrum and RF analysis. It represents the value 
of one division on the horizontal scale. The default setting is 10 dB per division and the maximum 
value can be set up to 20 dB. 
 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Select More (1/2) > Scale/Div. 
3 Enter a value between 1 and 20 by using the numeric keys. 
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4 Press the dB soft key to complete the entry. 

 

Pre-amplifier 

You can turn the internal pre-amplifier on to correct and compensate for the gain of the preamp so that 
amplitude readings show the value at the input connector. 
 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Toggle the Preamp soft key and select On or Off as needed. 

 
 NOTE 

You can turn the Preamp on when the input attenuation range is from 0 dB to 10 dB. If 
the attenuation value is manually set to greater than 10 dB, the instrument will 
automatically turn off the pre-amplifier to display low-level signal properly on the chart. 

 

External offset 

You can turn the External Offset on and manually set the external offset value. An offset consists of a 
cable loss and a user offset and the measurement result shows the value reflecting both offset values. 
When the external offset value is set at 40 dB in the Spectrum mode, the measurement result 
compensates 40 dB at both the Spectrum Analyzer and Signal Analyzer modes 
 

Procedure 

To set the external offset: 
1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select On. 
3 Enter a value by using the numeric keys. 
4 Press the dB soft key to complete the entry. 

 
To turn the external offset off: 

1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select Off. 

 

Setting average 

You can set the number of measurements to be averaged for the trace presentation. A maximum of 
100 times of averaging can be set. When the averaging reaches to your setting, a new measurement 
value replaces the measurement value in sequence from the earliest. 
 

Procedure 

1 Press the BW/AVG hard key. 
2 Press the Average soft key. 
3 Enter a value between 1 and 100 as needed by using the numeric keys. 
4 Press the Enter soft key. 
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Setting sweep mode 

The default setting is Continue to sweep continuously for most on-going measurements. If you want to 
hold the measurement or get a single sweep, you can change the sweep mode. 
 

Procedure 

To select the single sweep mode: 
1 Press the SWEEP hot key. 
2 Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key. 

The letter HOLD in red appears and the sweeping is paused. 
3 Optional. Press the Sweep Once soft key to get a new measurement. 

 
To return to the continuous sweep mode: 

1 Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key. 
The letter HOLD in red disappears and the sweeping resumes. 

 

Setting trigger source 

You can set the trigger source option for your measurements. 

Procedure 

1 Press the TRIGGER hot key. 
2 Select the trigger source option from the choices: Internal, External, and GPS. 

 

Setting external clock 

To enhance the reliability of modulation analysis measurements the JD700B series must be 
synchronized with a base station. When an external clock is not supplied, the instrument works with its 
built-in internal high-accuracy time base and some measurement results may exhibit inaccurate values. 
Therefore, it is highly recommended that you use the same reference clock as the signal source. You 
can use the TRIGGER hot key to set the external clock. 
 

Figure 75 Connection ports for external reference clock 

 
 

Procedure 

1 Connect an external reference or a GPS antenna to the JD700B series. 
2 Press the SYSTEM hot key. 
3 Press the Freq Reference soft key, and then select the reference option from the choices: 

Internal, External 10 MHz, External 13 MHz, External 15 MHz, and GPS. 

 



Chapter 8 Using LTE - FDD Signal Analyzer 

178 JD700B Series User’s Guide 

Table 13 External reference indicators 

Type Indicator Description 

Internal  (green) The green INT icon indicates that the instrument uses the built-in 
internal time base. 

External  (green) The green EXT icon indicates that an external reference is connected 
and locked and that the instrument uses the same reference clock as 
the signal source. 

External  (red) The red EXT icon indicates that an external reference is connect but not 
locked. 

GPS      (green) The green GPS antenna icon indicates that a GPS antenna is 
connected and locked. 

GPS      (yellow) The yellow GPS antenna icon indicates that a GPS antenna is 
connected and locking is in progress. 

GPS      (grey) The grey GPS antenna icon indicates that a GPS antenna is not 
connected, failed, or unable to be locked. 

 

Conducting spectrum measurements 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 173, you 
can continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Bandwidth soft key. 
3 Select the nominal channel bandwidth to be measured, from the choices: 1.4 MHz, 3 MHz,  

5 MHz, 10 MHz, 15 MHz, and 20 MHz. 

 
Your measurement result is displayed on the screen as like the following example, Figure 76. 
 

Figure 76 Spectrum measurement screen with LTE - FDD signal analyzer 
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Setting trace 

You can display up to six traces on the measurement chart simultaneously. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6. 

The legend shape of the selected trace changes from square to round to indicate that the trace is 
the active one now. 

3 Toggle the Trace View soft key and select On. 
4 Do one of the following: 

 

To Select Trace Legend 

Clear current data and display with new 
measurements 

Clear Write W 

Display the input signal’s maximum response only 
(unlimited or for a certain amount of time) 

Max Hold M 

Display the input signal’s minimum response only 
(unlimited or for a certain amount of time) 

Min Hold m 

Capture the selected trace and compare traces Capture C 

Load a saved trace More (1/2) > Load L 

Hide the selected trace Trace View > Off F 

Remove all the traces and initialize the trace 
settings 

More (1/2) > Trace 
Clear All 

 

 

 NOTE 
For the Max Hold and Min Hold, your instrument compares newly acquired data with the 
active trace and displays larger maximum values or smaller minimum values on the 
screen. You can set it to Unlimited to hold and view maximum or minimum data or 
specify a certain amount of time up to 60 seconds by using numeric keys or the rotary 
knob. 

5 Optional. Press the More (1/2) > Trace Info soft key, and then select the trace number to view 
the trace’s parameter setting information stored at the time of the measurement or None to hide 
the information display. 

6 Optional. If you have the two traces T1 and T2, you can perform trace math. To view the power 
difference between the traces, press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key. 
The result is overlaid on the screen along with the second Y-axis. 

 

Conducting RF measurements 

Channel power 

The Channel Power measurement is a common test used in the wireless industry to measure the total 
transmitted power of a radio within a defined frequency channel. It acquires a number of points 
representing the input signal in the time domain, transforms this information into the frequency domain 
using Fast Fourier Transform (FFT), and then calculates the channel power. The effective resolution 
bandwidth of the frequency domain trace is proportional to the number of points acquired for the FFT. 
 
The channel power measurement identifies the total RF power and power spectral density (PSD) of 
the signal in the LTE channel bandwidth. 
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Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 173, you 
can continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Bandwidth soft key. 
3 Select the nominal channel bandwidth to be measured, from the choices: 1.4 MHz, 3 MHz,  

5 MHz, 10 MHz, 15 MHz, and 20 MHz. 

 

Measurement example 

Figure 77 Channel power measurement with LTE - FDD signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 186 for more 
information. 

 

Occupied bandwidth 

The Occupied Bandwidth measures the spectrum shape of the carrier. It is defined as the bandwidth, 
which includes 99% of the transmitted power among total transmitted power. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 173, you 
can continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Bandwidth soft key. 
3 Select the nominal channel bandwidth to be measured, from the choices: 1.4 MHz, 3 MHz,  
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5 MHz, 10 MHz, 15 MHz, and 20 MHz. 

 

Measurement example 

Figure 78 Occupied bandwidth measurement with LTE - FDD signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 186 for more 
information. 

 

Spectrum emission mask (SEM) 

The Spectrum Emission Mask (SEM) measurement required by 3GPP specifications encompasses 
different power limits and different measurement bandwidths (resolution bandwidths) at various 
frequency offsets. It may be expressed as a ratio of power spectral densities between the carrier and 
the specified offset frequency band. It provides useful figures-of-merit for the spectral re-growth and 
emissions produced by components and circuit blocks, without the rigor of performing a full SEM 
measurement. 
 
The SEM measures spurious signal levels in up to five pairs of offset or region frequencies and relates 
them to the carrier power. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 173, you 
can continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, b

and 20 MHz. 
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3 To select the mask type, complete the following steps: 
 Press the Mask Type soft key. a
 Select the mask type option, from the following choices: b

–  Wide Area BS Category A 

–  Wide Area BS Category B 

–  Local Area BS 

–  Home BS 

 

Measurement example 

Figure 79 SEM measurement with LTE - FDD signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 186 for more 
information. 

 

ACLR 

The Adjacent Channel Leakage power Ratio (ACLR) measures the amount of interference or power in 
an adjacent frequency channel according to the standards. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 173, you 
can continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Bandwidth soft key. 
3 Select the nominal channel bandwidth to be measured, from the following choices: 1.4 MHz,  

3 MHz, 5 MHz, 10 MHz, 15 MHz, and 20 MHz. 
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Measurement example 

Figure 80 ACLR measurement with LTE - FDD signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 186 for more 
information. 

 

Multi-ACLR 

The Multi-ACLR measurement is used to perform multi-channel ACLR measurements with as many 
channels as possible. It helps you to measure ACLR in multi-channel transmitting Base Station 
environment. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 173, you 
can continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz,  b

and 20 MHz. 
3 To set the frequency, do one of the following: 

–  To set the center frequency, complete the following steps: 
 Toggle the Unit soft key and select Freq. a
 Press the Lowest Frequency soft key to set the starting center frequency. b
 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Select the unit: GHz, MHz, kHz, or Hz. d
 Press the Highest Frequency soft key to set the stopping center frequency. e
 Enter a value by using the numeric keys. You can also use the rotary knob. f
 Select the unit: GHz, MHz, kHz, or Hz. g
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–  To set the channel number, complete the following steps: 
 Toggle the Unit soft key and select Channel. a

 

 NOTE 
Selecting Channel sets the standard channel to Band Global automatically so that you 
can set the Channel Number without choosing a standard channel band from the list. 

 

 Press the Lowest Channel soft key to set the starting channel. b
 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Press the Enter soft key. d
 Press the Highest Channel soft key to set the stopping channel. e
 Enter a value by using the numeric keys. You can also use the rotary knob. f
 Press the Enter soft key. g

 

Measurement example 

Figure 81 Multi-ACLR measurement with LTE - FDD signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 186 for more 
information. 

 

Spurious emissions 

Out-of-band emissions are unwanted emissions immediately outside the channel bandwidth resulting 
from the modulation process and non-linearity in the transmitter but excluding spurious emissions. The 
Spurious Emissions measurement is to identify and determine the power level of out-of-band spurious 
emission within the necessary channel bandwidth and modulated signal measured at the RF port of 
the Base Station. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 173, you 
can continue your measurement. 
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Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set up the range table and frequency range, press the Range Table soft key and then 

complete the following steps: 
 Press the Range soft key, and then enter the range number to add a new range or change a

an existing one. 
 Press the Enter soft key. b
 Press the Start Frequency soft key to set up the frequency range. c
 Enter a value by using the numeric keys. You can also use the rotary knob. d
 Select the unit: GHz, MHz, kHz, or Hz. e
 Press the Stop Frequency soft key to set up the frequency range. f
 Enter a value by using the numeric keys. You can also use the rotary knob. g
 Select the unit: GHz, MHz, kHz, or Hz. h

3 Toggle the Range soft key between On and Off to display or hide the selected range. 
4 To set up the test limits for Pass/Fail indication, complete the following steps: 

 Press the Start Limit soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the dBm soft key. c
 Press the Stop Limit soft key. d
 Enter a value by using the numeric keys. You can also use the rotary knob. e
 Select the dBm soft key. f

5 To set up the other parameters, complete the following steps: 
 Select More (1/2) > Attenuation to set up the attenuation value. a
 Enter a value in the multiple of five. b
 Press the dB soft key or the ENTER hard key. c
 Press the RBW soft key. d
 Enter a value by using the numeric keys. e
 Select the unit: GHz, MHz, kHz, or Hz. f
 Press the VBW soft key. g
 Enter a value by using the numeric keys. h

 Select the unit: GHz, MHz, kHz, or Hz. i
6 Press the PREV hard key. 
7 Toggle the Measure Type soft key between Examine and Full to select the measurement type. 

 

 NOTE 
The Examine mode displays only the selected range while the Full mode lets the 
instrument automatically changes the selected range from one another. 

 

8 Set the number of measurements to be averaged: 
 Press the Average soft key. a
 Enter a value between 1 and 100. b
 Press the Enter soft key. c
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Measurement example 

Figure 82 Spurious emissions measurement with LTE - FDD signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 186 for more 
information. 

 

Setting limit for RF tests 

By default, test limits specified in the standard are set for you. You can change thresholds if you desire. 
 

Procedure 

1 Press the LIMIT hot key. 
2 Press the RF Test Limits soft key. 
3 Select the test item(s) and set the limit(s) depending on your selected measurement mode: 

 

To set the limit for Select Set 

Channel power Channel Power High Limit 
Low Limit 

Occupied bandwidth Occupied BW High Limit 

Spectrum emission mask Spectrum Emission Mask (On/Off only) 

ACLR ACLR (On/Off only) 

Multi-ACLR Multi-ACLR (On/Off only) 

Spurious emissions Spurious Emissions (On/Off only) 
 

4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 32 for more information. 
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Conducting power vs. time (frame) measurements 

The Power vs. Time (Frame) measures the modulation envelope in the time domain, showing the 
power of each time slot in an LTE signal. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 173, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, b

and 20 MHz. 
3 To select the subframe number to be measured, complete the following steps: 

 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

4 Toggle the Cell ID soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

5 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 030 LTE-Advanced FDD is not 
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 534 for OFDM parameter details 
by different bandwidth. 
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Measurement example 

Figure 83 Power vs. time (frame) measurement with LTE – FDD signal analyzer 

 
 

Conducting modulation measurements 

Constellation 

The Constellation is used to observe some aspects of modulation accuracy and can reveal certain 
fault mechanisms such as I/Q amplitude imbalance or quadrature imbalance. It displays constellation 
diagram by modulation types. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 173, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, b

and 20 MHz. 
3 To select the subframe number to be measured, complete the following steps: 

 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b

 

 NOTE 
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

 

 Press the Enter soft key. c
4 Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 
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–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

5 Optional. Toggle the CFI soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument set the number of OFDM symbols used for transmitting PDCCHs 

in a subframe. 

–  Manual: Sets the number of OFDM symbols manually. The set of OFDM symbols that can 
be used for PDCCH in a subframe is given by 0, 2, 3 or 4 in 1.4 MHz bandwidth and 1, 2, or 
3 in other bandwidths. 

6 Optional. Press the PHICH Ng soft key, and then select the option for the number of PHICH 
groups (Ng): 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2. 

7 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 030 LTE-Advanced FDD is not 
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the 
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the 
Subframe No with the same PMCH subframe number. If this setting is on, either PMCH or 
PDSCH appears on the screen depending on the detected channel. 

–  To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically 
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 534 for OFDM parameter details 
by different bandwidth. 

–  Press the PDSCH Modulation Type soft key, and then select the modulation type option: 
Auto, QPSK, 16 QAM, 64 QAM, E-TM3.3, E-TM3.2, E-TM3.1, E-TM2, E-TM1.2, and E-
TM1.1. If two or more modulation types are used in a frame, select Auto. If the PDSCH 
uses the same modulation type in a frame or in a subframe, select a specific modulation 
type to get more accurate EVM. 

–  To set the threshold for PDSCH, complete the following steps: 
 Press the PDSCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the dB soft key. c

–  Toggle the PDSCH Precoding soft key between On and Off to enable or disable the 
PDSCH precoding. 
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Measurement example 

Figure 84 Constellation measurement with LTE - FDD signal analyzer 

 
 

Figure 85 Constellation measurement with LTE - FDD signal analyzer (MBMS On) 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 206 for 
more information. 

 

Data channel 

The Data Channel measures the constellation for the specified resource block as well as the 
modulation accuracy of each PDSCH at the specified subframe. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 173, you 
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can continue your measurement. The measurement settings can be saved and recalled as a file. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz,  b

and 20 MHz. 
3 To select the subframe number to be measured, complete the following steps: 

 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b

 

 NOTE 
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

 

 Press the Enter soft key. c
4 Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

5 Optional. Toggle the CFI soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument set the number of OFDM symbols used for transmitting PDCCHs 

in a subframe. 

–  Manual: Sets the number of OFDM symbols manually. The set of OFDM symbols that can 
be used for PDCCH in a subframe is given by 0, 2, 3 or 4 in 1.4 MHz bandwidth and 1, 2, or 
3 in other bandwidths. 

6 Optional. Press the PHICH Ng soft key, and then select the option for the number of PHICH 
groups (Ng): 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2. 

7 Toggle the Event Hold soft key between On and Off to enable or disable the event hold feature. 
When enabled, the display line for the PDSCH threshold appears. 
When an event occurs, the measurement is put on hold until you press the HOLD hot key. 

8 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 030 LTE-Advanced FDD is not 
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the 
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the 
Subframe No with the same PMCH subframe number. If this setting is on, either PMCH or 
PDSCH appears on the screen depending on the detected channel. 

–  To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically 
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 534 for OFDM parameter details 
by different bandwidth. 

–  Press the PDSCH Modulation Type soft key, and then select the modulation type option: 
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Auto, QPSK, 16 QAM, 64 QAM, E-TM3.3, E-TM3.2, E-TM3.1, E-TM2, E-TM1.2, and E-
TM1.1. If two or more modulation types are used in a frame, select Auto. If the PDSCH 
uses the same modulation type in a frame or in a subframe, select a specific modulation 
type to get more accurate EVM. 

–  To set the threshold for PDSCH, complete the following steps: 
 Press the PDSCH Threshold soft key. a
 Enter a value by using the numeric keys, and then press the dB soft key. b

–  Toggle the PDSCH Precoding soft key between On and Off to enable or disable the 
PDSCH precoding. 

 

Measurement example 

Figure 86 Data channel measurement with LTE - FDD signal analyzer 

 
 

Figure 87 Data channel measurement with LTE - FDD signal analyzer (MBMS On) 
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 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 206 for 
more information. 

 

Using marker 

You can use the MARKER hard key to place a marker on a resource block and display the IQ diagram 
for the selected resource block. 
 

Procedure 

1 Press the MARKER hard key. 
2 Press the RB Number soft key to select the resource block to be marked. 
3 Enter the resource block number by using the numeric keys. 
4 Press the Enter soft key. 

The marker appears on the selected resource block. 
5 Toggle the Marker View soft key between On and Off to display or dismiss the result of the 

selected resource block. 

 

Control channel 

The Control Channel measures the constellation for the specified control channel as well as 
modulation accuracy of the control channel at the specified subframe. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 173, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, b

and 20 MHz. 
3 To select the subframe number to be measured, complete the following steps: 

 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b

 

 NOTE 
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

 

 Press the Enter soft key. c
4 Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

5 Optional. Toggle the CFI soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument set the number of OFDM symbols used for transmitting PDCCHs 
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in a subframe. 

–  Manual: Sets the number of OFDM symbols manually. The set of OFDM symbols that can 
be used for PDCCH in a subframe is given by 0, 2, 3 or 4 in 1.4 MHz bandwidth and 1, 2, or 
3 in other bandwidths. 

6 Optional. Press the PHICH Ng soft key, and then select the option for the number of PHICH 
groups (Ng): 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2. 

7 Toggle the EVM Detection Mode soft key and select Single or Combine as desired: 
–  Single: Testing on one single antenna connected to your JD700B series with a cable. 

–  Combine: Testing on multiple antennas connected to your JD700B series with a 2x1 or 4x1 
combiner or an antenna. 

8 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 030 LTE-Advanced FDD is not 
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the 
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the 
Subframe No with the same PMCH subframe number. If this setting is on, the 
measurement item “MBSFN RS” appears in the result table. 

–  To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically 
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 534 for OFDM parameter details 
by different bandwidth. 

–  To set the threshold for PDCCH, complete the following steps: 
 Press the PDCCH Threshold soft key. a
 Enter a value by using the numeric keys. a
 Press the dB soft key. b

–  Toggle the PDCCH Mode soft key and select REG to calculate EVM based on Resource 
Element Group or Avg to calculate EVM after adding up all the PDCCH signals from one 
subframe. 
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Measurement example 

Figure 88 Control channel measurement with LTE - FDD signal analyzer 

 
 

Figure 89 Control channel measurement with LTE - FDD signal analyzer (MBMS On) 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 206 for 
more information. 

 

Using marker 

You can use the MARKER hard key to place a marker on a control channel and display the IQ 
diagram for the selected channel. 
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Procedure 

1 Press the MARKER hard key. 
2 Press the Channel soft key to select the channel to be displayed in the IQ diagram. 

The channel P-SS is selected by default. 
3 Turn the rotary knob to move the highlight from one to another in the channel summary table. 
4 Toggle the Marker View soft key between On and Off to display or dismiss the result of the 

selected channel. 

 

Subframe 

The Subframe measures the modulation accuracy of all the data and control channels at the specified 
subframe (1 ms). 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 173, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, b

and 20 MHz. 
3 To select the subframe number to be measured, complete the following steps: 

 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b

 

 NOTE 
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

 

 Press the Enter soft key. c
4 Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

5 Optional. Toggle the CFI soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument set the number of OFDM symbols used for transmitting PDCCHs 

in a subframe. 

–  Manual: Sets the number of OFDM symbols manually. The set of OFDM symbols that can 
be used for PDCCH in a subframe is given by 0, 2, 3 or 4 in 1.4 MHz bandwidth and 1, 2, or 
3 in other bandwidths. 

6 Optional. Press the PHICH Ng soft key, and then select the option for the number of PHICH 
groups (Ng): 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2. 

7 Toggle the EVM Detection Mode soft key and select Single or Combine as desired: 
–  Single: Testing on one single antenna connected to your JD700B series with a cable. 

–  Combine: Testing on multiple antennas connected to your JD700B series with a 2x1 or 4x1 
combiner or an antenna. 
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8 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 030 LTE-Advanced FDD is not 
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the 
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the 
Subframe No with the same PMCH subframe number. If this setting is on, the 
measurement item “MBSFN RS” appears in the result table and either PMCH or PDSCH 
appears as well depending on the detected channel. 

–  To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically 
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 534 for OFDM parameter details 
by different bandwidth. 

–  Press the PDSCH Modulation Type soft key, and then select the modulation type option: 
Auto, QPSK, 16 QAM, 64 QAM, E-TM3.3, E-TM3.2, E-TM3.1, E-TM2, E-TM1.2, and E-
TM1.1. If two or more modulation types are used in a frame, select Auto. If the PDSCH 
uses the same modulation type in a frame or in a subframe, select a specific modulation 
type to get more accurate EVM. 

–  To set the threshold for PDSCH, complete the following steps: 
 Press the PDSCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the dB soft key. c

–  To set the threshold for PDCCH, complete the following steps: 
 Press the PDCCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the dB soft key. c

–  Toggle the PDCCH Mode soft key and select REG to calculate EVM based on Resource 
Element Group or Avg to calculate EVM after adding up all the PDCCH signals from one 
subframe. 

–  Toggle the PDSCH Precoding soft key between On and Off to enable or disable the 
PDSCH precoding. 
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Measurement example 

Figure 90 Subframe measurement with LTE - FDD signal analyzer 

1) Regular view 

 

2) Chart view 
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Figure 91 Subframe measurement with LTE - FDD signal analyzer (MBMS On) 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 206 for 
more information. 

 

Setting display 

You can use the TRACE/DISPLAY hard key to view the RE and RS power at the symbol. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Toggle the Chart soft key between On and Off to display or dismiss the chart.  

If this setting is on, the MARKER hard key is activated. 

 

Using marker 

If you turn the Chart view on, you can use the MARKER hard key to place the marker at a specific 
symbol. 
 

Procedure 

1 Press the MARKER hard key. 
2 Toggle the Marker View soft key between On and Off to display or dismiss the marker on the 

chart. 
3 Press the Symbol soft key to select the symbol number, to which the marker is placed. 
4 Enter a value by using the numeric keys. 
5 Press the Enter soft key. 

 

Frame 

The Frame measures the modulation accuracy of all the data and control channels at the frame (10 
ms). 
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Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 173, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, b

and 20 MHz. 
3 Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

4 Optional. Toggle the CFI soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument set the number of OFDM symbols used for transmitting PDCCHs 

in a subframe. 

–  Manual: Sets the number of OFDM symbols manually. The set of OFDM symbols that can 
be used for PDCCH in a subframe is given by 0, 2, 3 or 4 in 1.4 MHz bandwidth and 1, 2, or 
3 in other bandwidths. 

5 Optional. Press the PHICH Ng soft key, and then select the option for the number of PHICH 
groups (Ng): 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2. 

6 Toggle the EVM Detection Mode soft key and select Single or Combine as desired: 
–  Single: Testing on one single antenna connected to your JD700B series with a cable. 

–  Combine: Testing on multiple antennas connected to your JD700B series with a 2x1 or 4x1 
combiner or an antenna. 

7 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 030 LTE-Advanced FDD is not 
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the 
MBMS soft key and select On or Off. If this setting is on, the measurement items MBSFN 
RS, PMCH QPSK, PMCH 16 QAM, and PMCH 64 QAM appear in the result table. 

–  To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically 
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 534 for OFDM parameter details 
by different bandwidth. 

–  Press the PDSCH Modulation Type soft key, and then select the modulation type option: 
Auto, QPSK, 16 QAM, 64 QAM, E-TM3.3, E-TM3.2, E-TM3.1, E-TM2, E-TM1.2, and E-
TM1.1. If two or more modulation types are used in a frame, select Auto. If the PDSCH 
uses the same modulation type in a frame or in a subframe, select a specific modulation 
type to get more accurate EVM. 
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–  To set the threshold for PDSCH, complete the following steps: 
 Press the PDSCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the dB soft key. c

–  To set the threshold for PDCCH, complete the following steps: 
 Press the PDCCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the dB soft key. c

–  Toggle the PDCCH Mode soft key and select REG to calculate EVM based on Resource 
Element Group or Avg to calculate EVM after adding up all the PDCCH signals from one 
subframe. 

–  Toggle the PDSCH Precoding soft key between On and Off to enable or disable the 
PDSCH precoding. 

 

Measurement example 

Figure 92 Frame measurement with LTE - FDD signal analyzer 

 
 



Chapter 8 Using LTE - FDD Signal Analyzer 

202 JD700B Series User’s Guide 

Figure 93 Frame measurement with LTE - FDD signal analyzer (MBMS On) 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 206 for 
more information. 

 

Time alignment error 

In eNode B supporting Tx Diversity transmission, signals are transmitted from two or more antennas. 
These signals shall be aligned. The time alignment error in Tx diversity is specified as the delay 
between the signals from two antennas at the antenna ports. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 173, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz,  b

and 20 MHz. 
3 Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

4 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 



Chapter 8 Using LTE - FDD Signal Analyzer 

 JD700B Series User’s Guide 203 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 030 LTE-Advanced FDD is not 
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 534 for OFDM parameter details 
by different bandwidth. 

 

Measurement example 

Figure 94 Time alignment error measurement with LTE - FDD signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 206 for 
more information. 

 

Data allocation map 

The Data Allocation Map function represents data allocation as a frame. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 173, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz,  b

and 20 MHz. 
3 To select the subframe number to be measured, complete the following steps: 
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 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b

 

 NOTE 
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

 

 Press the Enter soft key. c
4 To set the threshold for PDSCH, complete the following steps: 

 Press the PDSCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the dB soft key. c

5 Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

6 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 030 LTE-Advanced FDD is not 
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the 
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the 
Subframe No with the same PMCH subframe number. If this setting is on, either PMCH or 
PDSCH appears on the screen depending on the detected channel. 

–  To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically 
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 534 for OFDM parameter details 
by different bandwidth. 
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Measurement example 

Figure 95 Data allocation map measurement with LTE - FDD signal analyzer 

 
 

Figure 96 Data allocation map measurement with LTE - FDD signal analyzer (MBMS On) 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 206 for 
more information. 

 

Using marker 

You can use the MARKER hard key to place the marker at a specific resource block and subframe. 
 

Procedure 

1 Press the MARKER hard key. 
2 Toggle the Marker View soft key between On and Off to display or dismiss the marker on the 
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chart. 
3 To select the resource block number, complete the following steps: 

 Press the RB Number soft key. a
 Enter the resource block number to select by using the numeric keys. You can also use the b

rotary knob to move the marker side by side. 
 Press the Enter soft key. c

4 To select the subframe block number, complete the following steps: 
 Press the Subframe No soft key. a
 Enter the subframe number to select by using the numeric keys. You can also use the b

rotary knob to move the marker up and down. 
 Press the Enter soft key. c

 

Setting limit for modulation tests 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Modulation Test Limits soft key to set the limits. 
3 Select the test item(s) and set the limit(s) depending on your selected measurement mode: 

 

To set the limit for Select Set 

Frequency error Frequency Error High Limit 
Low Limit 

PDSCH error vector 
magnitude if MBMS is off 

EVM > PDSCH EVM High Limit (QPSK) 
High Limit (16 QAM) 
High Limit (64 QAM) 

PMCH error vector magnitude 
if MBMS is on and a PMCH is 
detected 

EVM > PMCH EVM High Limit (QPSK) 
High Limit (16 QAM) 
High Limit (64 QAM) 

RMS for data error vector 
magnitude 

EVM > Data EVM RMS High Limit 

Peak for data error vector 
magnitude 

EVM> Data EVM Peak High Limit 

RS error vector magnitude EVM > RS EVM High Limit 

P-SS error vector magnitude EVM > P-SS EVM High Limit 

S-SS error vector magnitude EVM > S-SS EVM High Limit 

Downlink RS power Power > DL RS Power High Limit 
Low Limit 

P-SS power Power > P-SS Power High Limit 
Low Limit 

S-SS power Power > S-SS Power High Limit 
Low Limit 

PBCH power Power > PBCH Power High Limit 
Low Limit 

Subframe power Power > Subframe Power High Limit 
Low Limit 

OFDM symbol power Power > OFDM Symbol Power High Limit 
Low Limit 
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Frame average power Power > Frame Avg Power High Limit 
Low Limit 

Time alignment error for MIMO Time Alignment Error > MIMO High Limit 

Time alignment error for 
aggregation of component 
carriers (intra-band 
contiguous, intra-band non-
contiguous, and inter-band) 

Time Alignment Error > Carrier 
Aggregation 

Intra Cont 
Intra Non-cont 
Inter Band 

Time error Time Error High Limit 
Low Limit 

I-Q origin offset IQ Origin Offset High Limit 
 

4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 32 for more information. 

 

Performing auto measurements 

Conformance test 

The Conformance Test is to test if eNode-B meets some specified standards that have been 
developed for verification. Its test procedure and test setups have been developed by 3GPP. Test 
results can be saved as a .csv file type. 
 

Setting limit for conformance test 

You can set test limits for test item(s) in the auto measurement. Turning the test limit on for a test item 
makes the test item included in the conformance test. 
 

Procedure 

1 Press the LIMIT hot key. 
2 To set the limit for BTS output power, complete the following steps: 

 Press the BTS Output Power soft key. a
 Toggle the Test Limits soft key between On and Off to enable or disable the limit. b
 Press the High Limit soft key. c
 Enter a value for the upper limit. d
 Press the dBm unit soft key. e
 Press the Low Limit soft key. f
 Enter a value for the lower limit. g
 Press the dBm unit soft key. h

3 To set the limit for total power dynamic, complete the following steps: 
 Press the Total Power Dynamic soft key. a
 Toggle the Test Limits soft key between On and Off to enable or disable the limit. b
 Press the Low Limit soft key. c
 Enter a value for the lower limit. d
 Press the dBm unit soft key. e

4 To verify signal quality, press the Signal Quality soft key, and then do the following as needed: 
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To set the limit for Select Set 

Frequency error Frequency Error > Test Limits 
[E-TM2|E-TM3.1|E-TM3.2|E-
TM3.3] 

High Limit 
Low Limit 

Error vector magnitude EVM > Test Limits [E-TM2|E-
TM3.1|E-TM3.2|E-TM3.3] 

High Limit (QPSK) 
High Limit (16 QAM) 
High Limit (64 QAM) 

Time alignment error Time Alignment Error High Limit 

RS power RS Power High Limit 
Low Limit 

 

5 To verify unwanted emissions, press the Unwanted Emissions soft key, and then do the 
following as needed: 

 

To set the limit for Select Set 

Occupied bandwidth Occupied BW High Limit 

Adjacent channel power ratio ACLR  

Spectrum emission mask SEM Mask Type 

Spurious emissions Spurious Emissions Range Table 
 

6 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

7 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 32 for more information. 

 

Setting measure setup 

After setting frequency as described in the “Configuring test parameters” on page 173, you can 
continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Bandwidth soft key. 
3 Select the nominal channel bandwidth to be measured, from the choices: 1.4 MHz, 3 MHz,  

5 MHz, 10 MHz, 15 MHz, and 20 MHz. 
4 Press the Sector soft key, and then select the sector option: Alpha, Beta, or Gamma. 
5 To set external offset, complete the following steps: 

 Toggle the External Offset soft key and select On. a
 Enter a value by using the numeric keys. b
 Press the dB soft key. c

6 To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you 
desire. See “Using save” on page 32 for more information. 

7 Press the Run Test soft key to start to run a test. 
The Auto Measure Results window appears at the end of the test. 

8 When prompted on the screen, connect the cable from the Spectrum Analyzer RF In port of the 
instrument either to Antenna Port 0 or Antenna Port 1 of the eNode-B, and then change the TM 
mode on the eNode-B side. 

9 Press the Continue soft key to continue testing. 
10 Repeat the steps 8-9 until completion of the test. 



Chapter 8 Using LTE - FDD Signal Analyzer 

 JD700B Series User’s Guide 209 

A conformance test report appears at the end of the test. 
11 Optional. To stop running the test, press the Abort soft key. 

 

Maintenance test 

The Auto Measure function of the JD700B series allows a complete signal profiling covering RF 
characterization and modulation quality parameters of up to 20 different carriers, particularly useful on 
an overlay architecture where base stations are transmitting in different frequencies. 
 
Following settings are required only when you run the Auto Measure Maintenance Test on the 
instrument using “Current” configuration setting. Additional settings are not required when you run Auto 
Measure using a scenario generated in the PC application software, JDViewer. 
 

Setting limit for maintenance test 

You can set test limits for test item(s) in the auto measurement. 

Procedure 

1 Press the LIMIT hot key. 
2 Press the RF Test Limits soft key, and then enable test limits as desired. 
3 Press the Modulation Test Limits soft key, and then enable test limits as desired. 
4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 

Toggle the Beep soft key between On and Off to enable or disable the beep sound. 
5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 

See “Using save” on page 32 for more information. 

 
 NOTE 

You can use the Allowed % Change soft key for each test item to compare two 
measurement values displayed in the result table. This requires setting the Display mode 
to Compare in advance. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 173, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the Configuration soft key and select the configuration option: 

–  Current: Lets the instrumnet use current frequency (single carrier) and determine pass or 
fail based on the instrument’s limit settings in Auto Measure. 

–  Scenario: Runs a test with a programmed scenario in JDViewer. 
The Scenario menu becomes activated. 

3 To load a scenario, press the Scenario soft key, and then select a scenario file to load. 
4 Toggle the Test Time soft key and select the test time option: 

–  Now: Lets the instrument run a test only once. 

–  Schedule: Lets the instrument repeat tests as defined in the Set Timing. 
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The Set Timing menu becomes activated. 

5 To define a schedule for an auto measurement, complete the following steps: 
 Press the Set Timing soft key. a
 Press the Start Time (HH:MM) soft key. b
 Enter the time in the HH:MM format, and then press the Enter soft key. c
 Press the Stop Time (HH:MM) soft key. d
 Enter the time in the HH:MM format, and then press the Enter soft key. e
 Press the Time Interval soft key. f
 Enter the amount of time in minutes, and then press the Enter soft key. g

6 Press the Settings soft key, and then set the following as needed: 
 Press the Bandwidth soft key, and then select the nominal channel bandwidth to be a

measured, from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, and 20 MHz. 
 Toggle the Cell ID soft key and select Auto or Manual as desired: b

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

 Press the MIMO soft key, and then select the antenna number option: 2x2 or 4x4. c
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

 Press the Antenna Port soft key, and then select the option: Auto, 0, 1, 2, or 3. d
If the option 030 LTE-Advanced FDD is not installed or if the MIMO is set to 2x2, the 
antenna ports 2 and 3 are disabled. 

 Toggle the External Offset soft key and select On. e
 Enter a value by using the numeric keys, and then press the dB soft key. f
 To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the g

MBMS soft key and select On or Off. For proper MBMS testing, you need to set the 
Subframe No with the same PMCH subframe number. 

 To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically h
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

7 To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you 
desire. See “Using save” on page 32 for more information. 

8 Press the Run Test soft key to start to run a test. 
The Auto Measure Results window appears at the end of the test. 

9 To stop running the test, press the Abort soft key. 
10 To change the view on the screen during the test, press the Display and then select the view 

option from the following choices: 
–  Screen: You can view each measurement screen as the test progresses. 

–  Results: You can view a measurement result table as the test progresses. 

–  Settings: You can view a measurement setting table as the test progresses. 

 

Setting display 

After completion of the auto measurement, the screen menu changes to Trace/Display so that you can 
view the results in different forms. 
 

Procedure 

1 Toggle the Display soft key and select the display option: 
–  Result: You can view the result table. 

The Display Result menu becomes activated. 
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–  Settings: You can view the measurement settings for the auto measurement. 

2 Toggle the Display Result soft key and select the display result option: 
–  Full: You can view detailed measurement readings with the pass/fail indication. 

–  Quick: You can view only the Pass/Fail results. 

–  Compare: You can compare two measurement values for each test time with the 
Allowed % Change setting on. You can view results vs. factory-defined or user-defined 
references. 

3 To view the measurement results for a different carrier, press the View Carrier soft key and then 
select the carrier number to view. 

4 Press the Replace Reference soft key to replace existing reference values for comparison with 
new measurement data. 

5 Press the Load From soft key to select the location from which references file to be loaded. 

 

Signal performance test 

Unlike the other auto measurement tests, the Signal Performance Test runs measurements 
continuously. 
 

Setting limit for signal performance test 

You can set test limits for test item(s) in the auto measurement. 

Procedure 

1 Press the LIMIT hot key. 
2 Press the RF Test Limits > Channel Power soft key, and then set the limits for the channel 

power. Other RF test items are not used in the signal performance test. 
3 Press the Modulation Test Limits soft key, and then enable test limits as desired. 
4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 

Toggle the Beep soft key between On and Off to enable or disable the beep sound. 
5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 

See “Using save” on page 32 for more information. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 173, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

3 Press the MIMO soft key, and then select the antenna number option: 2x2 or 4x4. 
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 2x2 by 
default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO channels. 
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4 Press the Antenna Port soft key, and then select the option: Auto, 0, 1, 2, or 3. 
If the option 030 LTE-Advanced FDD is not installed or if the MIMO is set to 2x2, the antenna 
ports 2 and 3 are disabled. 

5 Press the Bandwidth soft key, and then select the nominal channel bandwidth to be measured, 
from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, and 20 MHz. 

6 Toggle the RF Profile soft key between On and Off to turn on or off the RF profiling such as 
channel power and subframe frequency error. 

7 Toggle the Modulation Profile soft key between On and Off to turn on or off the modulation 
profiling such as P-SS, S-SS, Data - QPSK, Data – 16 QAM, and Data – 64 QAM. 

8 Toggle the MIMO Profile soft key between On and Off to turn on or off the MIMO profiling such 
as TX1 - RS0, TX2 - RS1, and time alignment error. 

9 Toggle the External Offset soft key and select On to set the external offset value. 
10 To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you 

desire. See “Using save” on page 32 for more information. 

 

DAS test 

The Distributed Antenna System (DAS) testing enables you to check the degradation of performance 
in the signal transmission from a radio band to antennas distributed from it. You can save 
measurement values at both the radio band and antennas and then compare results with percentage 
of changes. You can also save test results in the .csv file format for ease of analysis. 
 

Setting measure setup 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Settings soft key and then set the following; 

 Press the Bandwidth soft key and then select the nominal channel bandwidth to be a
measured from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, and 20 MHz. 

 Press the MIMO soft key, and then select the antenna number option: 2x2 or 4x4. b
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

 Toggle the Cell ID soft key and select Auto or Manual as desired: c
–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

 Press the Antenna Port soft key, and then select the option: Auto, 0, 1, 2, or 3. d
If the option 030 LTE-Advanced FDD is not installed or if the MIMO is set to 2x2, the 
antenna ports 2 and 3 are disabled. 

 Toggle the External Offset soft key and select On to set the external offset value. e
 To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the f

MBMS soft key and select On or Off. 
 To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically g

or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

3 To save your settings, go to SAVE/LOAD > Save > Save Setup and then perform functions as 
you desire. See “Using save” on page 32 for more information. 

4 Press the Continue soft key to do the reference test first or press the Skip Reference Test soft 
key if you already saved test results from the radio band under test. 

5 Press the FREQ/DIST hard key and then set the frequency to be measured. See “Setting 
frequency” on page 235 for more information. 



Chapter 8 Using LTE - FDD Signal Analyzer 

 JD700B Series User’s Guide 213 

6 Press the PREV hard key. 
7 Press the Limit soft key and then set the limits and allowed percentage change for each test 

item. See “Maintenance test” on page 271 for more information on setting limits. 
8 Keep pressing the PREV hard key until you see the Run Test soft key. 
9 Press the Run Test soft key. 

The instrument runs specified tests to gather reference measurement values. The measurement 
table appears when the reference test is done. 

10 Press the Continue soft key to run the testing on an antenna (Ant 1). 
11 Optional. To change the settings such as External Offset, press the Settings and then change 

the settings as needed. 
12 Press the Continue soft key. 

The instrument runs the testing on Ant 1. The Ant 1 tab appears with the updated result table 
when the test is done. 

13 To run the testing on the next antenna (Ant 2), press the Run Test soft key and then repeat the 
steps 11-12. You can do the testing on up to 10 distributed antennas for one radio band. 

14 To view test results for each antenna, press the Select Antenna soft key and then select the 
antenna tab number to display on the screen. 

15 Optional. Press the Delete Test soft key to delete the selected antenna tab. 
16 Optional. Press the Retest Reference soft key to obtain reference measurement values again. 
17 Optional. To save your measurement results, go to SAVE/LOAD > Save and then perform 

functions as you desire. See “Using save” on page 32 for more information. 

 

Measurement Example 

Figure 97 DAS measurement with LTE - FDD signal analyzer 

 
 

Performing power statistics CCDF measurements 

The Power Statistics Complementary Cumulative Distribution Function (CCDF) measurement 
characterizes the power statistics of the input signal. It provides PAR (Peak to Average power Ratio) 
versus different probabilities. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 173, you 
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can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the CCDF Length soft key to set the length of the CCDF. 
3 Enter a value between 1 and 100 by using the numeric keys. You can also use the rotary knob. 
4 Press the Enter soft key. 

 

Measurement example 

Figure 98 CCDF measurement with LTE - FDD signal analyzer 

 
 

Performing carrier aggregation measurements 

Carrier aggregation enables a maximum of five multiple LTE carriers to be used together in order to 
provide high data rate required for LTE-Advanced. Component carriers to be aggregated can be intra-
band contiguous, intra-band non-contiguous, or inter-band. The JD700B series provides carrier 
aggregation measurements supporting for all the different modes with carrier aggregation bands 
added to the channel standard. This functionality is activated if the license for the option 030 LTE-
Advanced FDD is installed. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 173, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
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Procedure 

1 Press the MEASURE SETUP hot key. 
2 To configure parameters for up to 5 component carriers, complete the following steps: 

 Press the CA Configuration soft key. a
The component carrier configuration window appears. 

 Press the CA Range soft key. b
 Enter the number of the component carrier to be set between one and five. c
 Press the Enter soft key. d
 Toggle the Turn On soft key and then select On to set parameters and view the results for e

the selected component carrier on the screen or Off to turn it off. 
 Set the following parameters as needed: f

–  Center Frequency, Channel, Bandwidth, Cell ID, CFI, PHICH Ng, Antenna Port, 
MBMS On/Off, Cyclic Prefix, and PDSCH Modulation Type 

 To set more component carriers, repeat the steps c-f. g
3 Press the MEASURE SETUP hot key again 
4 Toggle the EVM Detection Mode soft key and select Single or Combine as desired: 

–  Single: Testing on one single antenna connected to your JD700B series with a cable. 

–  Combine: Testing on multiple antennas connected to your JD700B series with a 2x1 or 4x1 
combiner or an antenna. 

5 To select the subframe number to be measured, do one of the following: 
–  If the EVM Detection Mode is set to Single, press the Subframe No soft key and then set 

the subframe number. 
 

 NOTE 
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

 

–  If the EVM Detection Mode is set to Combine, toggle the Subframe No soft key, and then 
select 0 or 5. 

6 To set the threshold for PDSCH, complete the following steps: 
 Press the PDSCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the dB soft key. c

7 Toggle the PDSCH Precoding soft key between On and Off to enable or disable the PDSCH 
precoding. 

8 To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 2x2 by 
default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO channels. 

 

Setting display 

You can use the TRACE/DISPLAY hard key to select modulation analysis or spectrum analysis. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Toggle the Display soft key and select MA for modulation analysis or SA for spectrum analysis. 

The screen changes according to the selected option. 
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Measurement example 

Figure 99 Carrier aggregation measurement with LTE - FDD signal analyzer (MA) 

 
 

Figure 100 Carrier aggregation measurement with LTE - FDD signal analyzer (SA) 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 206 for 
more information. 

 

Using marker 

You can use the MARKER hard key to place the marker at a specific channel. 
 

Procedure 

1 Press the MARKER hard key. 
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2 Toggle the IQ Diagram soft key between On and Off to display or dismiss data on the IQ 
diagram for each component carrier. 

3 Press the Channel soft key to select the channel to be displayed on the IQ diagram. 
4 Use the rotary knob to move and select an item under EVM. 

 

Conducting LTE - FDD OTA measurements 

The FDD LTE Over The Air (OTA) measurement has Channel Scanner, ID Scanner, Multipath Profile, 
Datagram, and Control Channel screens. The ID Scanner displays key parameters such as RSRP, 
RSRQ, RS-SINR, and S-SS RSSI. The Multipath Profile enables you to determine RF environmental 
conditions of testing area. The OTA Control Channel provides summary of all control channels 
including RS power variation over time. 
 

Channel scanner 

The Channel Scanner is a radio receiver that can automatically tune or scan two or more discrete 
frequencies and multi-channels, indicating when it finds a signal on one of them and then continuing 
scanning when that frequency goes silent. 
 

Setting channel/frequency 

Procedure 

To set the channels to be scanned: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Channel. 
3 Press the Index soft key, and then enter an index number between one and six by turning the 

rotary knob or using the numeric keys. 
4 To select the standard channel, complete the following steps: 

 Press the Channel Std soft key. The standard channel window appears. a
See “Appendix C – Band, frequency & channel standard” on page 530 for more information. 

 Highlight the band to be measured by using the rotary knob, the arrow keys, or the Page b
Up/Page Down soft keys. 

 Press the Select soft key or the rotary knob to confirm the selection. c
5 To set the channel number for the selected index, complete the following steps: 

 Press the Channel Number soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

6 The instrument displays a corresponding center frequency for the channel number. 
7 To set the integration bandwidth for the selected index, complete the following steps: 

 Press the Integration Bandwidth soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

8 To add more channels to be scanned, repeat steps 3-6. 
9 Press the ESC hard key to dismiss the channel list window and view the scanning result. 

 
To set the frequencies to be scanned: 

1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Freq. 
3 Press the Index soft key, and then enter an index number between one and six by turning the 

rotary knob or using the numeric keys. 
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4 To set the center frequency for the selected index, complete the following steps: 
 Press the Center Frequency soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

5 To set the integration bandwidth for the selected index, complete the following steps: 
 Press the Integration Bandwidth soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

6 To add more channels to be scanned, repeat steps 3-5. 
7 Press the ESC hard key to dismiss the channel list window and view the scanning result. 

 

Setting number of antenna ports 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 2x2 by 
default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO channels. 

 

Measurement example 

Figure 101 Channel scanner measurement with LTE - FDD OTA signal analyzer 

 
 

ID scanner 

The LTE mobile receives signals from multiple base stations that all of these signals share the same 
spectrum and are present at the same time. Each base station has unique scrambling code assigned 
to the particular base station and it differentiates its signal from other base stations in the area. 
 
The ID Scanner shows key parameters such as RSRP (Reference Signal Received Power) and RSRQ 
(Reference Signal Received Quality) that predict the downlink coverage quickly. 

 RSRPs from entire cells help to rank between the different cells as input for handover and cell 
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reselection decisions. 

 RSRQ provides additional information when RSRP is not sufficient to make a reliable 
handover or cell reselection decision. 

 
All of the parameters for OTA ID scanner can be plotted on map data such as Google Maps and 
Google Earth by using JDViewer. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 173, you 
can continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz,  b

and 20 MHz. 
3 Optional. Press the Miscellaneous soft key, and then do the following as needed: 

–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 534 for OFDM parameter details 
by different bandwidth. 

4 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 32 for more information. 

 

Measurement example 

Figure 102 ID scanner measurement with LTE - FDD OTA signal analyzer 
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Multipath profile 

The Multipath Profile enables you to determine RF environmental conditions of testing area. It 
indicates the amount of power of the dominant pilot signal that is dispersed outside the main 
correlation peak due to multipath echoes that are expressed in dB. This value should be very small 
ideally. 
 
The multipath profile is the result of portions of the original broadcast signal arriving at the receiving 
antenna out of phase. This can be caused by the signal being reflected off objects such as buildings, 
or being refracted through the atmosphere differently from the main signal. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 173, you 
can continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz,  b

and 20 MHz. 
3 Toggle the Display soft key and select RS or Sync. 

The RS Window soft key becomes activated if RS is selected. 
4 Press the RS Window soft key, if RS is selected, and then select the RS window option: 2 µs,  

4 µs, or 8 µs. 
5 Optional. Press the Miscellaneous soft key, and then do the following as needed: 

–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 534 for OFDM parameter details 
by different bandwidth. 

6 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 32 for more information. 
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Measurement example 

Figure 103 Multipath profile measurement with LTE - FDD OTA signal analyzer 

 
 

Control channel 

DL RS power is the resource element power of Downlink Reference Symbol. The absolute DL RS 
power is indicated on the BCH. The absolute accuracy is defined as the maximum deviation between 
the DL RS power indicated on the BCH and the DL RS power at the BS antenna connector. 
 
The OTA Control Channel provides summary of all control channels including RS power trend over 
time. GPS coordinates (latitude and longitude) will be displayed on the screen if a GPS antenna is 
connected and locked to the GPS satellites. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 173, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz,  b

and 20 MHz. 
3 To select the subframe number to be measured, complete the following steps: 

 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b

 

 NOTE 
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 
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 Press the Enter soft key. c
4 Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

5 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 030 LTE-Advanced FDD is not 
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 534 for OFDM parameter details 
by different bandwidth. 

–  To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the 
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the 
Subframe No with the same PMCH subframe number. If this setting is on, the 
measurement item “MBSFN RS” appears in the result table. 

–  To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically 
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

6 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 32 for more information. 

 

Setting limit for OTA control channel 

Procedure 

1 Press the LIMIT hot key. 
2 Select the test item(s) and set the limit(s) as needed: 

 

To set the limit for Select Set 

P-SS error vector magnitude P-SS EVM High Limit 

S-SS error vector magnitude S-SS EVM High Limit 

RS error vector magnitude RS EVM > RS0 EVM 
RS EVM > RS1 EVM 
RS EVM > RS2 EVM 
RS EVM > RS3 EVM 

High Limit 

Frequency error Frequency Error High Limit 
Low Limit 

Time error Time Error High Limit 
Low Limit 

Time alignment error Time Alignment Error High Limit 
 

3 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 32 for more information. 
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Setting display 

You can use the TRACE/DISPLAY hard key to select the display option. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Toggle the Display soft key and select Power or EVM. 

The screen changes according to the selected option. 

 

Measurement example 

Figure 104 Control channel measurement with LTE - FDD OTA signal analyzer 

 
 

Datagram 

The OTA Datagram is a time-varying spectral representation that shows how the power of a signal 
varies with time. The power allocated to the specific resource block will be represented with an 
amplitude axis (in dBm) and the waterfall diagram will show the trend of past resource block power 
over certain period. Using a marker function facilitates analysis of accumulated resource block power 
for data utilization. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 173, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, b
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and 20 MHz. 
3 To select the subframe number to be measured, complete the following steps: 

 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

4 Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

5 Optional. To set the threshold for PDSCH, complete the following steps: 
 Press the PDSCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the dB soft key. c

6 To set the time cursor at a specific position, complete the following steps: 
 Toggle the Time Cursor soft key and select On. a
 Turn the rotary knob to move the time cursor. You can also enter a value and then press the b

Enter soft key. 
 

 NOTE 
Enabling the time cursor puts the measurement on hold and you can make post-
processing analysis for each measurement over time using the time cursor. 

 

7 To start a new measurement, press the Reset/Restart soft key. 
8 Optional. Press the Miscellaneous soft key, and then do the following as needed: 

–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 534 for OFDM parameter details 
by different bandwidth. 

9 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 32 for more information. 
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Measurement example 

Figure 105 Datagram measurement with LTE - FDD signal analyzer 

 
 

Route map 

The JD700B Series provides indoor and outdoor mapping function that allows a user to collect data of 
points in an indoor or outdoor environment and track the received signals and coverage of RF 
transmitters plotting real time directly on top of a loaded floor plan or a map. 
 

Setting measure setup 

Procedure 

1 If required, connect a GPS receiver to your JD700B series for outdoor mapping. 
Indoor mapping does not necessarily need a GPS antenna. 

2 Configure test parameters as described in the “Configuring test parameters” on page 173. 
3 To load your map file, complete the following steps: 

 Plug in your USB drive that has a floor map or .mcf file type created in JDMapCreator. a
 

 NOTE 
The JDMapCreator converts and resizes any scanned floor plan or layout to fit onto your 
instrument’s display. You must save your map file (.mcf) into the “SavedMap” folder of 
your USB drive so that you can load them onto your instrument. 

 

 Press SAVE/LOAD hot key, and then select Load > Load Map. b
See “Using load” on page 34 for more information. 

4 Press the MEASURE SETUP hot key. 
5 Press the Plot Point soft key, and then select the plot point option from the following choices: 

–  To collect data/plot points automatically as you move around in a vehicle or outside, press 
the GPS soft key and then toggle the Screen Mode soft key between Map and Full. 

 

 NOTE 
With the Map setting, you can view only the collected points that can be seen within the 
boundary of the loaded map. If a point is off the map, the instrument displays an arrow to 
indicate the direction of the current location on the map and the distance from the center 
to the location at the top of the screen. 
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With the Full setting, you can view all the collected points of the route without the loaded 
map. 

 

–  To collect data/plot points manually without a GPS antenna in an indoor environment, press 
the Position soft key. 

6 Press the Plot Item soft key, and then select the measurement option: RSRP, RSRQ, RS-SINR, 
S-SS RSSI, P-SS Power, S-SS Power, or S-SS Ec/Io. 

 

 NOTE 
The instrument collects the strongest Cell ID’s data to plot points. 

 

7 Press the Bandwidth soft key to set the nominal channel bandwidth to be measured, and then 
select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, and  
20 MHz. 

8 Toggle the Plot soft key and select Start to start plotting. 
9 Touch directly on the screen or press the ENTER hard key to collect data and plot points on the 

loaded map for the Position setting. 
 

 NOTE 
For the Position setting, you can change the direction of the route with the arrow keys 
and the distance with the rotary knob. 

 

10 Toggle the Plot soft key and select Stop to stop plotting. 
11 Press the SAVE/LOAD hot key to save the result. 

See “Using save” on page 32 for more information. 
 

 NOTE 
The instrument does not automatically save the collected data. It is recommended that 
you save the result. Otherwise, you will lose all the collected data. 

 

 

Setting limit for route map 

You can set the thresholds for each test item. 
 

Procedure 

1 Press the LIMIT hot key. 
2 Select the plot items and set the limits as needed: 

 

To set the limit for Select Set 

RSRP RSRP Excellent, Very Good, Good, Fair, Poor (dBm) 

RSRQ RSRQ Good, Fair, Poor (dB) 

RS-SINR RS-SINR Good, Fair, Poor (dB) 

S-SS RSSI S-SS RSSI Excellent, Very Good, Good, Fair, Poor (dBm) 

P-SS Power P-SS Power Excellent, Very Good, Good, Fair, Poor (dBm) 

S-SS Power S-SS Power Excellent, Very Good, Good, Fair, Poor (dBm) 

S-SS Ec/Io S-SS Ec/Io Good, Fair, Poor (dB) 
 

3 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 32 for more information. 
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Measurement example 

Figure 106 Route map measurement with LTE - FDD OTA signal analyzer 

1) RSRP 

 

2) RSRQ 

 
  



Chapter 8 Using LTE - FDD Signal Analyzer 

228 JD700B Series User’s Guide 

3) RS-SINR 

 

4) S-SS RSSI 

 

5) P-SS Power 
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6) S-SS Power 

 

7) S-SS Ec/Io 

 



 
 

9 

 

Chapter 9 Using LTE - TDD Signal Analyzer 

This chapter provides instructions for using the LTE - TDD Signal Analyzer (option 029) and LTE-
Advanced TDD Analyzer (option 031) with the LTE - TDD OTA Analyzer (option 049). Topics discussed 
in this chapter are as follows: 
 

 Introduction .............................................................................................................................. 231 

 Display overview ...................................................................................................................... 232 

 Connecting a cable .................................................................................................................. 232 

 Selecting measurement mode ................................................................................................. 234 

 Configuring test parameters .................................................................................................... 234 

 Conducting spectrum measurements ...................................................................................... 239 

 Conducting RF measurements ................................................................................................ 241 

 Conducting power vs. time measurements ............................................................................. 249 

 Conducting modulation measurements ................................................................................... 252 

 Performing auto measurements .............................................................................................. 270 

 Performing power statistics CCDF measurements ................................................................. 276 

 Performing carrier aggregation measurements ....................................................................... 277 

 Conducting LTE - TDD OTA measurements ............................................................................ 280 
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Introduction 

The LTE (Long-Term Evolution) Signal Analyzer of the JD700B series performs power and spectrum 
measurements as well as modulation analysis to test the proper transmitter performance of TDD LTE 
systems. It performs conformance testing according to the following standards providing a simple 
Pass/Fail indication on each test. 
 

 3GPP TS 36.104. Evolved Universal Terrestrial Radio Access (E-UTRA); Base Station (BS) 
Radio Transmission and Reception 

 3GPP TS 36.141. Evolved Universal Terrestrial Radio Access (E-UTRA); Base Station (BS) 
Conformance Testing 

 3GPP TS 36.211. Evolved Universal Terrestrial Radio Access (E-UTRA); Physical Channels 
and Modulation 

 3GPP TS 36.212. Evolved Universal Terrestrial Radio Access (E-UTRA); Multiplexing and 
Channel Coding 

 3GPP TS 36.213 V8.2.0. Evolved Universal Terrestrial Radio Access (E-UTRA); Physical 
Layer Procedures 

 
This instrument provides the following measurement tools for TDD LTE system: 
 

 Spectrum Analysis 

 RF Analysis 

- Channel Power 

- Occupied Bandwidth 

- Spectrum Emission Mask 

- Adjacent Channel Leakage power Ratio (ACLR) 

- Multi-ACLR 

- Spurious Emissions 

 Power vs. Time: Slot and Frame 

 Modulation Analysis 

- Constellation 

- Data Channel 

- Control Channel 

- Subframe 

- Time Alignment Error 

- Data Allocation Map 

 Auto Measure 

- Conformance Test 

- Maintenance Test 

- Signal Performance Test 

- DAS Test 

 Power Statistics CCDF 

 Carrier Aggregation 
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 Over The Air (OTA) 

- Channel Scanner 

- ID Scanner 

- Multipath Profile 

- Control Channel 

- Datagram 

- Route Map 
 

Display overview 

Figure 107 provides descriptions for each segment of the measurement screen. 
 

Figure 107 LTE - TDD signal analyzer measurement screen 

 

 

Connecting a cable 

Direct connection 

Procedure 

1 Connect the Spectrum Analyzer RF In port of the JD700B series and the Power amplifier output 
port of BTS. 
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Figure 108 Direct connection 

 
JD785B/JD745B 

 
JD788B/JD748B 

 

Indirect connection 

Procedure 

1 Connect the Spectrum Analyzer RF In port of the JD700B series and the monitor (test) port of 
BTS. 

 
Figure 109 Indirect connection 

 
JD785B/JD745B 

 
JD788B/JD748B 

 

 

CAUTION 
The maximum power for the Spectrum Analyzer RF In port is +25 dBm (0.316 W) for 
JD780B series and +20 dBm (0.1 W) for JD740B series. If the level of the input signal to 
be measured is greater than this, use a High Power Attenuator to prevent damage 
when you directly connect the signal to the instrument or connect the signal from the 
coupling port of a directional coupler. 

 

Over the air (OTA) 

Procedure 

1 Connect an Omni/directional RF antenna to the Spectrum Analyzer RF In port of the JD700B 
series. 

2 Connect a GPS antenna to the GPS port of the JD700B series. 
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Figure 110 OTA connection 

 
JD785B/JD745B 

 
JD788B/JD748B 

 

 

CAUTION 
If the input signal level to be measured is less than 0 dBm, set 0 dB attenuation or turn on 
the preamp to have better dynamic range for the OTA testing. 

 

Selecting measurement mode 

Procedure 

1 Press the MODE hard key. 
2 Press the Signal Analyzer soft key. 
3 Press the LTE - TDD soft key. The Spectrum mode is set by default. 
4 Press the MEASURE hot key, and then select the measurement mode option from the following 

choices: 
–  Spectrum 

–  RF Analysis > Channel Power, Occupied BW, Spectrum Emission Mask, ACLR,  
Multi-ACLR, or Spurious Emissions 

–  Power vs Time > Power vs Time (Slot) or Power vs Time (Frame) 

–  Modulation Analysis > Constellation, Data Channel, Control Channel, Subframe,  
Time Alignement Error, or Data Allocation Map 

–  Auto Measure > Conformance Test, Maintenance Test, Signal Perfomance,  
or DAS Test 

–  Power Statistics CCDF 

–  More (1/2) > Carrier Aggregation 

–  More (1/2) > OTA > Channel Scanner, ID Scanner, Multipath Profile, Control Channel, 
Datagram, or Route Map 

 
 NOTE 

The Carrier Aggregation soft key is activated if the license for the option 031 LTE-
Advanced TDD is installed. 
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Configuring test parameters 

Setting frequency 

You can set the frequency with either frequency or channel number. If a frequency to be set matches 
to the frequency corresponding to the selected channel standard, the instrument calculates its channel 
number and updates the screen with it automatically. 
 

Procedure 

To set the center frequency: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Freq. 
3 Press the Center Frequency soft key. 
4 Enter a value by using the numeric keys. You can also use the rotary knob. 
5 Select the unit: GHz, MHz, kHz, or Hz. 
6 To define the amount of frequency increment for the rotary knob, complete the following steps: 

 Press the Frequency Step soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the unit: GHz, MHz, kHz, or Hz. c

 
To set the channel number: 

1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Channel. 

 
 NOTE 

Selecting Channel sets the standard channel to Band Global automatically so that you 
can set the Channel Number without choosing a standard channel band from the list. 

3 Press the Channel Number soft key. 
4 Enter a value by using the numeric keys. You can also use the rotary knob. 
5 Press the Enter soft key. 
6 The instrument automatically displays the corresponding center frequency value for the selected 

channel number. 
7 To define the amount of channel increment for the rotary knob, complete the following steps: 

 Press the Channel Step soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

 
 NOTE 

This frequency setting is not used in the Multi-ACLR and Spurious Emissions modes. 
 

Setting amplitude 

Reference level and attenuation 

You can set the reference and attenuation levels automatically or manually to optimize the display of 
the traces measured, as you desire. 
 

Procedure 

To automatically set the reference and attenuation level: 
1 Press the AMP/SCALE hard key. 
2 Press the Auto Scale soft key. 
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Each time you press this key, both of the Y-axis scale and input attenuation level change to be 
optimized with some margin. 

 
To set the reference or attenuation level manually: 

1 Press the AMP/SCALE hard key. 
2 To set the maximum reference value on the Y-axis manually, complete the following steps: 

 Press the Reference Level soft key. a
 Enter a value by using the numeric keys or the rotary knob with 10 dB increments. b
 Press the dBm soft key or the ENTER hard key. c

This unit key name changes according to the setting in the Units menu. 
 

 NOTE 
In the measurements such as Control Channel, and Subframe, you may need to select 
the reference option between Relative and Absolute before setting the reference level. 

 

3 To set the attenuation option, select one from the following choices: 
–  To set the input attenuator’s level automatically, select Attenuation > Auto. 

 

 NOTE 
It is recommended that you set the Attenuation to Auto in most situations so that the 
level of the input attenuator can be set automatically according to your input signal level. 

 

–  To set the input attenuation manually up to 55 dB for JD780B series or 50 dB for JD740B 
series to optimize S/N, complete the following steps: 

 Select Attenuation > Manual. a
 Press the Attenuation Value soft key to set the level. b
 Enter a value in fives by using the numeric keys. c
 Press the dB soft key or the ENTER hard key. d

–  To couple the input attenuator’s level with your reference level setting, select Attenuation > 
Couple. 
As you increase the reference setting, the attenuation level also increases acoordingly. 

 
Optional. To change the scale unit: 

1 Select More (1/2) > Units. 
2 Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W. 

The scale unit on the screen changes accordingly. 
 

 NOTE 
This Units menu is available in the Spectrum and RF Analysis modes. 

 

 

Scale per division 

You can use the Scale/Div feature available for the spectrum and RF analysis. It represents the value 
of one division on the horizontal scale. The default setting is 10 dB per division and the maximum 
value can be set up to 20 dB. 
 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Select More (1/2) > Scale/Div. 
3 Enter a value between 1 and 20 by using the numeric keys. 
4 Press the dB soft key to complete the entry. 
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Pre-amplifier 

You can turn the internal pre-amplifier on to correct and compensate for the gain of the preamp so that 
amplitude readings show the value at the input connector. 
 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Toggle the Preamp soft key and select On or Off as needed. 

 
 NOTE 

You can turn the Preamp on when the input attenuation range is from 0 dB to 10 dB. If 
the attenuation value is manually set to greater than 10 dB, the instrument will 
automatically turn off the pre-amplifier to display low-level signal properly on the chart. 

 

External offset 

You can turn the External Offset on and manually set the external offset value. An offset consists of a 
cable loss and a user offset and the measurement result shows the value reflecting both offset values. 
When the external offset value is set at 40 dB in the Spectrum mode, the measurement result 
compensates 40 dB at both the Spectrum Analyzer and Signal Analyzer modes 
 

Procedure 

To set the external offset: 
1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select On. 
3 Enter a value by using the numeric keys. 
4 Press the dB soft key to complete the entry. 

 
To turn the external offset off: 

1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select Off. 

 

Setting average 

You can set the number of measurements to be averaged for the trace presentation. A maximum of 
100 times of averaging can be set. When the averaging reaches to your setting, a new measurement 
value replaces the measurement value in sequence from the earliest. 
 

Procedure 

1 Press the BW/AVG hard key. 
2 Press the Average soft key. 
3 Enter a value between 1 and 100 as needed by using the numeric keys. 
4 Press the Enter soft key. 

 

Setting sweep mode 

The default setting is Continue to sweep continuously for most on-going measurements. If you want to 
hold the measurement or get a single sweep, you can change the sweep mode. 
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Procedure 

To select the single sweep mode: 
1 Press the SWEEP hot key. 
2 Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key. 

The letter HOLD in red appears and the sweeping is paused. 
3 Optional. Press the Sweep Once soft key to get a new measurement. 

 
To return to the continuous sweep mode: 

1 Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key. 
The letter HOLD in red disappears and the sweeping resumes. 

 

Setting trigger source 

You can set the trigger source option for your measurements. 

Procedure 

1 Press the TRIGGER hot key. 
2 Select the trigger source option from the choices: Internal, External, and GPS. 

 

Setting external clock 

To enhance the reliability of modulation analysis measurements the JD700B series must be 
synchronized with a base station. When an external clock is not supplied, the instrument works with its 
built-in internal high-accuracy time base and some measurement results may exhibit inaccurate values. 
Therefore, it is highly recommended that you use the same reference clock as the signal source. You 
can use the TRIGGER hot key to set the external clock. 
 

Figure 111 Connection ports for external reference clock 

 
 

Procedure 

1 Connect an external reference or a GPS antenna to the JD700B series. 
2 Press the SYSTEM hot key. 
3 Press the Freq Reference soft key, and then select the reference option: Internal, External 10 

MHz, External 13 MHz, External 15 MHz, or GPS. 

 
Table 14 External reference indicators 

Type Indicator Description 

Internal  (green) The green INT icon indicates that the instrument uses the built-in 
internal time base. 
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External  (green) The green EXT icon indicates that an external reference is connected 
and locked and that the instrument uses the same reference clock as 
the signal source. 

External  (red) The red EXT icon indicates that an external reference is connect but not 
locked. 

GPS      (green) The green GPS antenna icon indicates that a GPS antenna is 
connected and locked. 

GPS      (yellow) The yellow GPS antenna icon indicates that a GPS antenna is 
connected and locking is in progress. 

GPS      (grey) The grey GPS antenna icon indicates that a GPS antenna is not 
connected, failed, or unable to be locked. 

 

Conducting spectrum measurements 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 234, you 
can continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz,  b

and 20 MHz. 
3 To select the subframe number to be measured, complete the following steps: 

 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

4 Toggle the Cell ID soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

 
Your measurement result is displayed on the screen as like the following example, Figure 112. 
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Figure 112 Spectrum measurement screen with LTE - TDD signal analyzer 

 
 

Setting trace 

You can display up to six traces on the measurement chart simultaneously. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6. 

The legend shape of the selected trace changes from square to round to indicate that the trace is 
the active one now. 

3 Toggle the Trace View soft key and select On. 
4 Do one of the following: 

 

To Select Trace Legend 

Clear current data and display with new 
measurements 

Clear Write W 

Display the input signal’s maximum response only 
(unlimited or for a certain amount of time) 

Max Hold M 

Display the input signal’s minimum response only 
(unlimited or for a certain amount of time) 

Min Hold m 

Capture the selected trace and compare traces Capture C 

Load a saved trace More (1/2) > Load L 

Hide the selected trace Trace View > Off F 

Remove all the traces and initialize the trace settings More (1/2) > 
Trace Clear All 

 

 

 NOTE 
For the Max Hold and Min Hold, your instrument compares newly acquired data with the 
active trace and displays larger maximum values or smaller minimum values on the 
screen. You can set it to Unlimited to hold and view maximum or minimum data or 
specify a certain amount of time up to 60 seconds by using numeric keys or the rotary 
knob. 
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5 Optional. Press the More (1/2) > Trace Info soft key, and then select the trace number to view 
the trace’s parameter setting information stored at the time of the measurement or None to hide 
the information display. 

6 Optional. If you have the two traces T1 and T2, you can perform trace math. To view the power 
difference between the traces, press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key. 
The result is overlaid on the screen along with the second Y-axis. 

 

Conducting RF measurements 

Channel power 

The Channel Power measurement is a common test used in the wireless industry to measure the total 
transmitted power of a radio within a defined frequency channel. It acquires a number of points 
representing the input signal in the time domain, transforms this information into the frequency domain 
using Fast Fourier Transform (FFT), and then calculates the channel power. The effective resolution 
bandwidth of the frequency domain trace is proportional to the number of points acquired for the FFT. 
 
The channel power measurement identifies the total RF power and power spectral density (PSD) of 
the signal in the LTE channel bandwidth. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 234, you 
can continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz,  b

and 20 MHz. 
3 To select the subframe number to be measured, complete the following steps: 

 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

4 Toggle the Cell ID soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

 



Chapter 9 Using LTE - TDD Signal Analyzer 

242 JD700B Series User’s Guide 

Measurement example 

Figure 113 Channel power measurement with LTE - TDD signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 248 for more 
information. 

 

Occupied bandwidth 

The Occupied Bandwidth measures the spectrum shape of the carrier. It is defined as the bandwidth, 
which includes 99% of the transmitted power among total transmitted power. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 234, you 
can continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz,  b

and 20 MHz. 
3 To select the subframe number to be measured, complete the following steps: 

 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

4 Toggle the Cell ID soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 
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Measurement example 

Figure 114 Occupied bandwidth measurement with LTE - TDD signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 248 for more 
information. 

 

Spectrum emission mask (SEM) 

The Spectrum Emission Mask (SEM) measurement required by 3GPP specifications encompasses 
different power limits and different measurement bandwidths (resolution bandwidths) at various 
frequency offsets. It may be expressed as a ratio of power spectral densities between the carrier and 
the specified offset frequency band. It provides useful figures-of-merit for the spectral re-growth and 
emissions produced by components and circuit blocks, without the rigor of performing a full SEM 
measurement. 
 
The SEM measures spurious signal levels in up to five pairs of offset or region frequencies and relates 
them to the carrier power. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 234, you 
can continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz,  b

and 20 MHz. 
3 To select the mask type, complete the following steps: 

 Press the Mask Type soft key. a
 Select the mask type option, from the following choices: b
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–  Wide Area BS Category A 

–  Wide Area BS Category B 

–  Local Area BS 

–  Home BS 

4 To select the subframe number to be measured, complete the following steps: 
 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

5 Toggle the Cell ID soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

 

Measurement example 

Figure 115 SEM measurement with LTE - TDD signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 248 for more 
information. 

 

ACLR 

The Adjacent Channel Leakage power Ratio (ACLR) measures the amount of interference or power in 
an adjacent frequency channel according to the standards. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 234, you 
can continue your measurement. 
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Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz,  b

and 20 MHz. 
3 To select the subframe number to be measured, complete the following steps: 

 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

4 Toggle the Cell ID soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

 

Measurement example 

Figure 116 ACLR measurement with LTE - TDD signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 248 for more 
information. 

 

Multi-ACLR 

The Multi-ACLR measurement is used to perform multi-channel ACLR measurements with as many 
channels as possible. It helps you to measure ACLR in multi-channel transmitting Base Station 
environment. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 234, you 
can continue your measurement. 
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Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz,  b

and 20 MHz. 
3 To set the frequency, do one of the following: 

–  To set the center frequency, complete the following steps: 
 Toggle the Unit soft key and select Freq. a
 Press the Lowest Frequency soft key to set the starting center frequency. b
 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Select the unit: GHz, MHz, kHz, or Hz. d
 Press the Highest Frequency soft key to set the stopping center frequency. e
 Enter a value by using the numeric keys. You can also use the rotary knob. f
 Select the unit: GHz, MHz, kHz, or Hz. g

–  To set the channel number, complete the following steps: 
 Toggle the Unit soft key and select Channel. a

 

 NOTE 
Selecting Channel sets the standard channel to Band Global automatically so that you 
can set the Channel Number without choosing a standard channel band from the list. 

 

 Press the Lowest Channel soft key to set the starting channel. b
 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Press the Enter soft key. d
 Press the Highest Channel soft key to set the stopping channel. e
 Enter a value by using the numeric keys. You can also use the rotary knob. f
 Press the Enter soft key. g

 

Measurement example 

Figure 117 Multi-ACLR measurement with LTE - TDD signal analyzer 
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 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 248 for more 
information. 

 

Spurious emissions 

Out-of-band emissions are unwanted emissions immediately outside the channel bandwidth resulting 
from the modulation process and non-linearity in the transmitter but excluding spurious emissions. The 
Spurious Emissions measurement is to identify and determine the power level of out-of-band spurious 
emission within the necessary channel bandwidth and modulated signal measured at the RF port of 
the Base Station. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 234, you 
can continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set up the range table and frequency range, press the Range Table soft key and then 

complete the following steps: 
 Press the Range soft key, and then enter the range number to add a new range or change a

an existing one. 
 Press the Enter soft key. b
 Press the Start Frequency soft key to set up the frequency range. c
 Enter a value by using the numeric keys. You can also use the rotary knob. d
 Select the unit: GHz, MHz, kHz, or Hz. e
 Press the Stop Frequency soft key to set up the frequency range. f
 Enter a value by using the numeric keys. You can also use the rotary knob. g
 Select the unit: GHz, MHz, kHz, or Hz. h

3 Toggle the Range soft key between On and Off to display or hide the selected range. 
4 To set up the test limits for Pass/Fail indication, complete the following steps: 

 Press the Start Limit soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the dBm soft key. c
 Press the Stop Limit soft key. d
 Enter a value by using the numeric keys. You can also use the rotary knob. e
 Select the dBm soft key. f

5 To set up the other parameters, complete the following steps: 
 Select More (1/2) > Attenuation to set up the attenuation value. a
 Enter a value in the multiple of five. b
 Press the dB soft key or the ENTER hard key. c
 Press the RBW soft key. d
 Enter a value by using the numeric keys. e
 Select the unit: GHz, MHz, kHz, or Hz. f
 Press the VBW soft key. g
 Enter a value by using the numeric keys. h

 Select the unit: GHz, MHz, kHz, or Hz. i
6 Press the PREV hard key. 
7 Toggle the Measure Type soft key between Examine and Full to select the measurement type. 
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 NOTE 
The Examine mode displays only the selected range while the Full mode lets the 
instrument automatically changes the selected range from one another. 

 

8 Set the number of measurements to be averaged: 
 Press the Average soft key. a
 Enter a value between 1 and 100. b
 Press the Enter soft key. c

 

Measurement example 

Figure 118 Spurious emissions measurement with LTE - TDD signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 248 for more 
information. 

 

Setting limit for RF tests 

By default, test limits specified in the standard are set for you. You can change thresholds if you desire. 
 

Procedure 

1 Press the LIMIT hot key. 
2 Press the RF Test Limits soft key. 
3 Select the test item(s) and set the limit(s) depending on your selected measurement mode: 

 

To set the limit for Select Set 

Channel power Channel Power High Limit, Low Limit 

Occupied bandwidth Occupied BW High Limit 

Spectrum emission mask Spectrum Emission Mask (On/Off only) 

ACLR ACLR (On/Off only) 
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Multi-ACLR Multi-ACLR (On/Off only) 

Spurious emissions Spurious Emissions (On/Off only) 
 

4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 32 for more information. 

 

Conducting power vs. time measurements 

The Power vs. Time measurement measures the modulation envelope in the time domain, showing the 
signal rise and fall shape of LTE signal and the power of each time slot in an LTE signal. 
 

Power vs. time (slot) 

The Power vs. Time (Slot) in LTE - TDD Signal Analyzer measures the modulation envelope in the 
time domain, showing the signal rise and fall shapes of LTE signal. 
 

 NOTE 
In this measurement, desirable level of the input power is lower than -10 dBm. If the input 
power to be measured is -10 dBm or higher, it is highly recommended that you use an 
external attenuator. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 234, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz,  b

and 20 MHz. 
3 To select the slot number to be measured, complete the following steps: 

 Press the Slot No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

4 Toggle the Cell ID soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

5 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. This 

MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 031 LTE-Advanced TDD is not 
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installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 534 for OFDM parameter details 
by different bandwidth. 

–  To set the delay, complete the following steps: 
 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 
 NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 
 

Setting limit for power vs. time tests 

Procedure 

1 Press the LIMIT hot key. 
2 Press the PvsT Test Limits soft key. 
3 Select the test item(s) and set the limit(s): 

 

To set the limit for Select Set 

Slot average power Slot Avg Power High Limit, Low Limit 

Off power Off Power High Limit 

Transition period Transition Period High Limit 
 

4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 32 for more information. 

 

Measurement example 

Figure 119 Power vs. time (slot) measurement with LTE – TDD signal analyzer 

1) Off to on 
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2) On to off 

 
 

Power vs. time (frame) 

The Power vs. Time (Frame) measures the modulation envelope in the time domain, showing the 
power of each time slot in an LTE signal. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 234, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz,  b

and 20 MHz. 
3 To select the subframe number to be measured, complete the following steps: 

 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

4 Toggle the Cell ID soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

5 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. This 

MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 031 LTE-Advanced TDD is not 
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installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 534 for OFDM parameter details 
by different bandwidth. 

–  To set the delay, complete the following steps: 
 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 
 NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 
 

Measurement example 

Figure 120 Power vs. time (frame) measurement with LTE – TDD signal analyzer 

 
 

Conducting modulation measurements 

Constellation 

The Constellation is used to observe some aspects of modulation accuracy and can reveal certain 
fault mechanisms such as I/Q amplitude imbalance or quadrature imbalance. It displays constellation 
diagram by modulation types. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 234, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
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Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz,  b

and 20 MHz. 
3 To select the subframe number to be measured, complete the following steps: 

 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b

 

 NOTE 
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

 

 Press the Enter soft key. c
4 Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

5 Optional. Toggle the CFI soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument set the number of OFDM symbols used for transmitting PDCCHs 

in a subframe. 

–  Manual: Sets the number of OFDM symbols manually. The set of OFDM symbols that can 
be used for PDCCH in a subframe is given by 0, 2, 3 or 4 in 1.4 MHz bandwidth and 1, 2, or 
3 in other bandwidths. 

6 Optional. Press the PHICH Ng soft key, and then select the option for the number of PHICH 
groups (Ng): 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2. 

7 Press the Uplink-Downlink Configuration soft key, and then select the number of 
uplink/downlink between one and six. 

8 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 031 LTE-Advanced TDD is not 
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the 
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the 
Subframe No with the same PMCH subframe number. If this setting is on, either PMCH or 
PDSCH appears on the screen depending on the detected channel. 

–  To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically 
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

–  To set the delay, complete the following steps: 
 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

 NOTE 
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The Delay setting is used only when there is a time offset in the signals to be measured. 
 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 534 for OFDM parameter details 
by different bandwidth. 

–  Press the PDSCH Modulation Type soft key, and then select the modulation type option: 
Auto, QPSK, 16 QAM, 64 QAM, E-TM3.3, E-TM3.2, E-TM3.1, E-TM2, E-TM1.2, and E-
TM1.1. If two or more modulation types are used in a frame, select Auto. If the PDSCH 
uses the same modulation type in a frame or in a subframe, select a specific modulation 
type to get more accurate EVM. 

–  To set the threshold for PDSCH, complete the following steps: 
 Press the PDSCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the dB soft key. c

–  Toggle the PDSCH Precoding soft key between On and Off to enable or disable the 
PDSCH precoding. 

 

Measurement example 

Figure 121 Constellation measurement with LTE - TDD signal analyzer 
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Figure 122 Constellation measurement with LTE - TDD signal analyzer (MBMS On) 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 268 for 
more information. 

 

Data channel 

The Data Channel measures the constellation for the specified resource block as well as the 
modulation accuracy of each PDSCH at the specified subframe. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 234, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz,  b

and 20 MHz. 
3 To select the subframe number to be measured, complete the following steps: 

 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b

 

 NOTE 
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

 

 Press the Enter soft key. c
4 Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 
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–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

5 Optional. Toggle the CFI soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument set the number of OFDM symbols used for transmitting PDCCHs 

in a subframe. 

–  Manual: Sets the number of OFDM symbols manually. The set of OFDM symbols that can 
be used for PDCCH in a subframe is given by 0, 2, 3 or 4 in 1.4 MHz bandwidth and 1, 2, or 
3 in other bandwidths. 

6 Optional. Press the PHICH Ng soft key, and then select the option for the number of PHICH 
groups (Ng): 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2. 

7 Toggle the Event Hold soft key between On and Off to enable or disable the event hold feature. 
When enabled, the display line for the PDSCH threshold appears. 
When an event occurs, the measurement is put on hold until you press the HOLD hot key. 

 

 NOTE 
You can view detailed current resource block on the I-Q diagram, particularly in a 
dynamic field environment. 

 

8 Press the More (1/2) > Uplink-Downlink Configuration soft key, and then select the number of 
uplink/downlink between one and six. 

9 Optional. Press the More (1/2) > Miscellaneous soft key, and then do the following as needed: 
–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 031 LTE-Advanced TDD is not 
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the 
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the 
Subframe No with the same PMCH subframe number. If this setting is on, either PMCH or 
PDSCH appears on the screen depending on the detected channel. 

–  To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically 
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

–  To set the delay, complete the following steps: 
 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

 NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 534 for OFDM parameter details 
by different bandwidth. 

–  Press the PDSCH Modulation Type soft key, and then select the modulation type option: 
Auto, QPSK, 16 QAM, 64 QAM, E-TM3.3, E-TM3.2, E-TM3.1, E-TM2, E-TM1.2, and E-
TM1.1. If two or more modulation types are used in a frame, select Auto. If the PDSCH 
uses the same modulation type in a frame or in a subframe, select a specific modulation 
type to get more accurate EVM. 

–  To set the threshold for PDSCH, complete the following steps: 
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 Press the PDSCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the dB soft key. c

–  Toggle the PDSCH Precoding soft key between On and Off to enable or disable the 
PDSCH precoding. 

 

Measurement example 

Figure 123 Data channel measurement with LTE - TDD signal analyzer 

 
 

Figure 124 Data channel measurement with LTE - TDD signal analyzer (MBMS On) 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 268 for 
more information. 
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Using marker 

You can use the MARKER hard key to place a marker on a resource block and display the IQ diagram 
for the selected resource block. 
 

Procedure 

1 Press the MARKER hard key. 
2 Press the RB Number soft key to select the resource block to be marked. 
3 Enter the resource block number by using the numeric keys. 
4 Press the Enter soft key. 

The marker appears on the selected resource block. 
5 Toggle the Marker View soft key between On and Off to display or dismiss the result of the 

selected resource block. 

 

Control channel 

The Control Channel measures the constellation for the specified control channel as well as 
modulation accuracy of the control channel at the specified subframe. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 234, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz,  b

and 20 MHz. 
3 To select the subframe number to be measured, complete the following steps: 

 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b

 

 NOTE 
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

 

 Press the Enter soft key. c
4 Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

5 Optional. Toggle the CFI soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument set the number of OFDM symbols used for transmitting PDCCHs 

in a subframe. 

–  Manual: Sets the number of OFDM symbols manually. The set of OFDM symbols that can 
be used for PDCCH in a subframe is given by 0, 2, 3 or 4 in 1.4 MHz bandwidth and 1, 2, or 
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3 in other bandwidths. 

6 Optional. Press the PHICH Ng soft key, and then select the option for the number of PHICH 
groups (Ng): 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2. 

7 Toggle the EVM Detection Mode soft key and select Single or Combine as desired: 
–  Single: Testing on one single antenna connected to your JD700B series with a cable. 

–  Combine: Testing on multiple antennas connected to your JD700B series with a 2x1 or 4x1 
combiner or an antenna. 

8 Press the Uplink-Downlink Configuration soft key, and then select the number of 
uplink/downlink between one and six. 

9 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 031 LTE-Advanced TDD is not 
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the 
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the 
Subframe No with the same PMCH subframe number. If this setting is on, the 
measurement item “MBSFN RS” appears in the result table. 

–  To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically 
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

–  To set the delay, complete the following steps: 
 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

 NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 534 for OFDM parameter details 
by different bandwidth. 

–  To set the threshold for PDCCH, complete the following steps: 
 Press the PDCCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the dB soft key. c

–  Toggle the PDCCH Mode soft key and select REG to calculate EVM based on Resource 
Element Group or Avg to calculate EVM after adding up all the PDCCH signals from one 
subframe. 
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Measurement example 

Figure 125 Control channel measurement with LTE - TDD signal analyzer 

 
 

Figure 126 Control channel measurement with LTE - TDD signal analyzer (MBMS On) 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 268 for 
more information. 

 

Using marker 

You can use the MARKER hard key to place a marker on a resource block and display the IQ diagram 
for the selected resource block. 
 

Procedure 

1 Press the MARKER hard key. 
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2 Press the Channel soft key to select the channel to be displayed in the IQ diagram. 
The channel P-SS is selected by default. 

3 Turn the rotary knob to move the highlight from one to another in the channel summary table. 
4 Toggle the Marker View soft key between On and Off to display or dismiss the result of the 

selected channel. 

 

Subframe 

The Subframe measures the modulation accuracy of all the data and control channels at the specified 
subframe (1 ms). 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 234, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, b

and 20 MHz. 
3 To select the subframe number to be measured, complete the following steps: 

 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b

 

 NOTE 
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

 

 Press the Enter soft key. c
4 Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

5 Optional. Toggle the CFI soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument set the number of OFDM symbols used for transmitting PDCCHs 

in a subframe. 

–  Manual: Sets the number of OFDM symbols manually. The set of OFDM symbols that can 
be used for PDCCH in a subframe is given by 0, 2, 3 or 4 in 1.4 MHz bandwidth and 1, 2, or 
3 in other bandwidths. 

6 Optional. Press the PHICH Ng soft key, and then select the option for the number of PHICH 
groups (Ng): 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2. 

7 Toggle the EVM Detection Mode soft key and select Single or Combine as desired: 
–  Single: Testing on one single antenna connected to your JD700B series with a cable. 

–  Combine: Testing on multiple antennas connected to your JD700B series with a 2x1 or 4x1 
combiner or an antenna. 

8 Press the Uplink-Downlink Configuration soft key, and then select the number of 
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uplink/downlink between one and six. 
9 Optional. Press the Miscellaneous soft key, and then do the following as needed: 

–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 031 LTE-Advanced TDD is not 
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the 
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the 
Subframe No with the same PMCH subframe number. If this setting is on, the 
measurement item “MBSFN RS” appears in the result table and either PMCH or PDSCH 
appears as well depending on the detected channel. 

–  To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically 
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

–  To set the delay, complete the following steps: 
 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

 NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 534 for OFDM parameter details 
by different bandwidth. 

–  Press the PDSCH Modulation Type soft key, and then select the modulation type option: 
Auto, QPSK, 16 QAM, 64 QAM, E-TM3.3, E-TM3.2, E-TM3.1, E-TM2, E-TM1.2, and E-
TM1.1. If two or more modulation types are used in a frame, select Auto. If the PDSCH 
uses the same modulation type in a frame or in a subframe, select a specific modulation 
type to get more accurate EVM. 

–  To set the threshold for PDSCH, complete the following steps: 
 Press the PDSCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the dB soft key. c

–  To set the threshold for PDCCH, complete the following steps: 
 Press the PDCCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the dB soft key. c

–  Toggle the PDCCH Mode soft key and select REG to calculate EVM based on Resource 
Element Group or Avg to calculate EVM after adding up all the PDCCH signals from one 
subframe. 

–  Toggle the PDSCH Precoding soft key between On and Off to enable or disable the 
PDSCH precoding. 
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Measurement example 

Figure 127 Subframe measurement with LTE - TDD signal analyzer 

1) Regular view 

 

2) Chart view 
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Figure 128 Subframe measurement with LTE - TDD signal analyzer (MBMS On) 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 268 for 
more information. 

 

Setting display 

You can use the TRACE/DISPLAY hard key to view your measurement result with the chart. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Toggle the Chart soft key between On and Off to display or dismiss the chart. If this setting is on, 

the MARKER hard key is activated. 

 

Using marker 

If you turn the Chart view on, you can use the MARKER hard key to place the marker at a specific 
symbol. 
 

Procedure 

1 Press the MARKER hard key. 
2 Toggle the Marker View soft key between On and Off to display or dismiss the marker on the 

chart. 
3 Press the Symbol soft key to select the symbol number, to which the marker is placed. 
4 Enter a value by using the numeric keys. 
5 Press the Enter soft key. 

 

Time alignment error 

In eNode B supporting Tx Diversity transmission, signals are transmitted from two or more antennas. 
These signals shall be aligned. The time alignment error in Tx diversity is specified as the delay 
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between the signals from two antennas at the antenna ports. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 234, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, b

and 20 MHz. 
3 Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

4 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 031 LTE-Advanced TDD is not 
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To set the delay, complete the following steps: 
 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

 NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 534 for OFDM parameter details 
by different bandwidth. 
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Measurement example 

Figure 129 Time alignment error measurement with LTE - TDD signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 268 for 
more information. 

 

Data allocation map 

The Data Allocation Map function represents data allocation as a mapping. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 234, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, b

and 20 MHz. 
3 To select the subframe number to be measured, complete the following steps: 

 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b

 

 NOTE 
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

 

 Press the Enter soft key. c
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4 To set the threshold for PDSCH, complete the following steps: 
 Press the PDSCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the dB soft key. c

5 Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

6 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 031 LTE-Advanced TDD is not 
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the 
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the 
Subframe No with the same PMCH subframe number. If this setting is on, either PMCH or 
PDSCH appears on the screen depending on the detected channel. 

–  To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically 
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 534 for OFDM parameter details 
by different bandwidth. 

 

Measurement example 

Figure 130 Data allocation map measurement with LTE - TDD signal analyzer 
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Figure 131 Data allocation map measurement with LTE - TDD signal analyzer (MBMS On) 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 268 for 
more information. 

 

Using marker 

You can use the MARKER hard key to place the marker at a specific resource block and subframe. 
 

Procedure 

1 Press the MARKER hard key. 
2 Toggle the Marker View soft key between On and Off to display or dismiss the marker on the 

chart. 
3 To select the resource block number, complete the following steps: 

 Press the RB Number soft key. a
 Enter the resource block number to select by using the numeric keys. You can also use the b

rotary knob to move the marker side by side. 
 Press the Enter soft key. c

4 To select the subframe block number, complete the following steps: 
 Press the Subframe No soft key. a
 Enter the subframe number to select by using the numeric keys. You can also use the b

rotary knob to move the marker up and down. 
 Press the Enter soft key. c

 

Setting limit for modulation tests 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Modulation Test Limits soft key to set the limits. 
3 Select the test item(s) and set the limit(s) depending on your selected measurement mode: 
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To set the limit for Select Set 

Frequency error Frequency Error High Limit 
Low Limit 

PDSCH error vector 
magnitude if MBMS is off 

EVM > PDSCH EVM High Limit (QPSK) 
High Limit (16 QAM) 
High Limit (64 QAM) 

PMCH error vector magnitude 
if MBMS is on and a PMCH is 
detected 

EVM > PMCH EVM High Limit (QPSK) 
High Limit (16 QAM) 
High Limit (64 QAM) 

RMS for data error vector 
magnitude 

EVM > Data EVM RMS High Limit 

Peak for data error vector 
magnitude 

EVM> Data EVM Peak High Limit 

RS error vector magnitude EVM > RS EVM High Limit 

P-SS error vector magnitude EVM > P-SS EVM High Limit 

S-SS error vector magnitude EVM > S-SS EVM High Limit 

Downlink RS power Power > DL RS Power High Limit 
Low Limit 

P-SS power Power > P-SS Power High Limit 
Low Limit 

S-SS power Power > S-SS Power High Limit 
Low Limit 

PBCH power Power > PBCH Power High Limit 
Low Limit 

Subframe power Power > Subframe Power High Limit 
Low Limit 

OFDM symbol power Power > OFDM Symbol Power High Limit 
Low Limit 

Time alignment error for 
MIMO 

Time Alignment Error > MIMO High Limit 

Time alignment error for 
aggregation of component 
carriers (intra-band 
contiguous, intra-band non-
contiguous, and inter-band) 

Time Alignment Error > Carrier 
Aggregation 

Intra Cont 
Intra Non-cont 
Inter Band 

Time error Time Error High Limit 
Low Limit 

I-Q origin offset IQ Origin Offset High Limit 
 

4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 32 for more information. 
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Performing auto measurements 

Conformance test 

The Conformance Test is to test if eNode-B meets some specified standards that have been 
developed for verification. Its test procedure and test setups have been developed by 3GPP. Test 
results can be saved as a .csv file type. 
 

Setting limit for conformance test 

You can set test limits for test item(s) in the auto measurement. Turning the test limit on for a test item 
makes the test item included in the conformance test. 
 

Procedure 

1 Press the LIMIT hot key. 
2 To set the limit for BTS output power, complete the following steps: 

 Press the BTS Output Power soft key. a
 Toggle the Test Limits soft key between On and Off to enable or disable the limit. b
 Press the High Limit soft key. c
 Enter a value for the upper limit. d
 Press the dBm unit soft key. e
 Press the Low Limit soft key. f
 Enter a value for the lower limit. g
 Press the dBm unit soft key. h

3 To set the limit for total power dynamic, complete the following steps: 
 Press the Total Power Dynamic soft key. a
 Toggle the Test Limits soft key between On and Off to enable or disable the limit. b
 Press the Low Limit soft key. c
 Enter a value for the lower limit. d
 Press the dBm unit soft key. e

4 To set the limit for on/off power, press the On/Off Power soft key, and then do the following as 
needed: 

 

To set the limit for Select Set 

Off power Off Power High Limit 

Transition period Transition Period High Limit 
 

5 To verify signal quality, press the Signal Quality soft key, and then do the following as needed: 
 

To set the limit for Select Set 

Frequency error Frequency Error High Limit 
Low Limit 

Error vector magnitude EVM High Limit (QPSK) 
High Limit (16 QAM) 
High Limit (64 QAM) 

Time alignment error Time Alignment Error High Limit 

RS power RS Power High Limit 
Low Limit 

 

6 To verify unwanted emissions, press the Unwanted Emissions soft key, and then do the 
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following as needed: 
 

To set the limit for Select Set 

Occupied bandwidth Occupied BW High Limit 

Adjacent channel power ratio ACLR  

Spectrum emission mask SEM Mask Type 

Spurious emissions Spurious Emissions Range Table 
 

7 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

8 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 32 for more information. 

 

Setting measure setup 

After setting frequency as described in the “Configuring test parameters” on page 234, you can 
continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Bandwidth soft key. 
3 Select the nominal channel bandwidth to be measured, from the choices: 1.4 MHz, 3 MHz,  

5 MHz, 10 MHz, 15 MHz, and 20 MHz. 
4 Press the Sector soft key, and then select the sector option: Alpha, Beta, or Gamma. 
5 To set external offset, complete the following steps: 

 Toggle the External Offset soft key and select On. a
 Enter a value by using the numeric keys. b
 Press the dB soft key. c

6 To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you 
desire. See “Using save” on page 32 for more information. 

7 Press the Run Test soft key to start to run a test. 
The Auto Measure Results window appears at the end of the test. 

8 When prompted on the screen, connect the cable from the Spectrum Analyzer RF In port of the 
instrument either to Antenna Port 0 or Antenna Port 1 of the eNode-B, and then change the TM 
mode on the eNode-B side. 

9 Press the Continue soft key to continue testing. 
10 Repeat the steps 8-9 until completion of the test. 

A conformance test report appears at the end of the test. 
11 Optional. To stop running the test, press the Abort soft key. 

 

Maintenance test 

The Auto Measure function of the JD700B series allows a complete signal profiling covering RF 
characterization and modulation quality parameters of up to 20 different carriers, particularly useful on 
an overlay architecture where base stations are transmitting in different frequencies. 
 
Following settings are required only when you run the Auto Measure Maintenance Test on the 
instrument using “Current” configuration setting. Additional settings are not required when you run Auto 
Measure using a scenario generated in the PC application software, JDViewer. 
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Setting limit for maintenance test 

You can set test limits for test item(s) in the auto measurement. 

Procedure 

1 Press the LIMIT hot key. 
2 Press the RF Test Limits soft key, and then enable test limits as desired. 
3 Press the PvsT Test Limits soft key, and then enable test limits as desired. 
4 Press the Modulation Test Limits soft key, and then enable test limits as desired. 
5 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 

Toggle the Beep soft key between On and Off to enable or disable the beep sound. 
6 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 

See “Using save” on page 32 for more information. 

 
 NOTE 

You can use the Allowed % Change soft key for each test item to compare two 
measurement values displayed in the result table. This requires setting the Display mode 
to Compare in advance. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 234, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the Configuration soft key and select the configuration option: 

–  Current: Lets the instrumnet use current frequency (single carrier) and determine pass or 
fail based on the instrument’s limit settings in Auto Measure. 

–  Scenario: Runs a test with a programmed scenario in JDViewer. 
The Scenario menu becomes activated. 

3 To load a scenario, press the Scenario soft key, and then select a scenario file to load. 
4 Toggle the Test Time soft key and select the test time option: 

–  Now: Lets the instrument run a test only once. 

–  Schedule: Lets the instrument repeat tests as defined in the Set Timing. 
The Set Timing menu becomes activated. 

5 To define a schedule for an auto measurement, complete the following steps: 
 Press the Set Timing soft key. a
 Press the Start Time (HH:MM) soft key. b
 Enter the time in the HH:MM format, and then press the Enter soft key. c
 Press the Stop Time (HH:MM) soft key. d
 Enter the time in the HH:MM format, and then press the Enter soft key. e
 Press the Time Interval soft key. f
 Enter the amount of time in minutes, and then press the Enter soft key. g

6 Press the Settings soft key, and then set the following: 
 Press the Bandwidth soft key, and then select the nominal channel bandwidth to be a

measured, from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, and 20 MHz. 
 Toggle the Cell ID soft key and select Auto or Manual as desired: b
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–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

 Press the MIMO soft key, and then select the antenna number option: 2x2 or 4x4. c
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

 Press the Antenna Port soft key, and then select the option: Auto, 0, 1, 2, or 3. d
If the option 031 LTE-Advanced TDD is not installed or if the MIMO is set to 2x2, the 
antenna ports 2 and 3 are disabled. 

 Toggle the External Offset soft key and select On. e
 Enter a value by using the numeric keys, and then press the dB soft key. f
 To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the g

MBMS soft key and select On or Off. For proper MBMS testing, you need to set the 
Subframe No with the same PMCH subframe number. 

 To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically h
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

7 To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you 
desire. See “Using save” on page 32 for more information. 

8 Press the Run Test soft key to start to run a test. 
The Auto Measure Results window appears at the end of the test. 

9 To stop running the test, press the Abort soft key. 
10 To change the view on the screen during the test, press the Display and then select the view 

option from the following choices: 
–  Screen: You can view each measurement screen as the test progresses. 

–  Results: You can view a measurement result table as the test progresses. 

–  Settings: You can view a measurement setting table as the test progresses. 

 

Setting display 

After completion of the auto measurement, the screen menu changes to Trace/Display so that you can 
view the results in different forms. 
 

Procedure 

1 Toggle the Display soft key and select the display option: 
–  Result: You can view the result table. The Display Result menu becomes activated. 

–  Settings: You can view the measurement settings for the auto measurement. 

2 Toggle the Display Result soft key and select the display result option: 
–  Full: You can view detailed measurement readings with the pass/fail indication. 

–  Quick: You can view only the Pass/Fail results. 

–  Compare: You can compare two measurement values for each test time with the 
Allowed % Change setting on. You can view results vs. factory-defined or user-defined 
references. 

3 To view the measurement results for a different carrier, press the View Carrier soft key and then 
select the carrier number to view. 

4 Press the Replace Reference soft key to replace existing reference values for comparison with 
new measurement data. 

5 Press the Load From soft key to select the location from which references file to be loaded. 
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Signal performance test 

Unlike the other auto measurement tests, the Signal Performance Test runs measurements 
continuously. 
 

Setting limit for signal performance test 

You can set test limits for test item(s) in the auto measurement. 

Procedure 

1 Press the LIMIT hot key. 
2 Press the RF Test Limits > Channel Power soft key, and then set the limits for the channel 

power. Other RF test items are not used in the signal performance test. 
3 Press the Modulation Test Limits soft key, and then enable test limits as desired. 
4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 

Toggle the Beep soft key between On and Off to enable or disable the beep sound. 
5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 

See “Using save” on page 32 for more information. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 234, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

3 Press the MIMO soft key, and then select the antenna number option: 2x2 or 4x4. 
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 2x2 by 
default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO channels. 

4 Press the Antenna Port soft key, and then select the option: Auto, 0, 1, 2, or 3. 
If the option 031 LTE-Advanced TDD is not installed or if the MIMO is set to 2x2, the antenna 
ports 2 and 3 are disabled. 

5 Press the Bandwidth soft key, and then select the nominal channel bandwidth to be measured, 
from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, and 20 MHz. 

6 Toggle the RF Profile soft key between On and Off to turn on or off the RF profiling such as 
channel power and subframe frequency error. 

7 Toggle the Modulation Profile soft key between On and Off to turn on or off the modulation 
profiling such as P-SS, S-SS, Data - QPSK, Data – 16 QAM, and Data – 64 QAM. 

8 Toggle the MIMO Profile soft key between On and Off to turn on or off the MIMO profiling such 
as TX1 - RS0, TX2 - RS1, and time alignment error. 

9 Toggle the External Offset soft key and select On to set the external offset value. 
10 To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you 

desire. See “Using save” on page 32 for more information. 
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DAS test 

The Distributed Antenna System (DAS) testing enables you to check the degradation of performance 
in the signal transmission from a radio band to antennas distributed from it. You can save 
measurement values at both the radio band and antennas and then compare results with percentage 
of changes. You can also save test results in the .csv file format for ease of analysis. 
 

Setting measure setup 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Settings soft key and then set the following; 

 Press the Bandwidth soft key and then select the nominal channel bandwidth to be a
measured from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, and 20 MHz. 

 Press the MIMO soft key, and then select the antenna number option: 2x2 or 4x4. b
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

 Toggle the Cell ID soft key and select Auto or Manual as desired: c
–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

 Press the Antenna Port soft key, and then select the option: Auto, 0, 1, 2, or 3. d
If the option 031 LTE-Advanced TDD is not installed or if the MIMO is set to 2x2, the 
antenna ports 2 and 3 are disabled. 

 Toggle the External Offset soft key and select On to set the external offset value. e
 To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the f

MBMS soft key and select On or Off. 
 To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically g

or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

3 To save your settings, go to SAVE/LOAD > Save > Save Setup and then perform functions as 
you desire. See “Using save” on page 32 for more information. 

4 Press the Continue soft key to do the reference test first or press the Skip Reference Test soft 
key if you already saved test results from the radio band under test. 

5 Press the FREQ/DIST hard key and then set the frequency to be measured. See “Setting 
frequency” on page 235 for more information. 

6 Press the PREV hard key. 
7 Press the Limit soft key and then set the limits and allowed percentage change for each test 

item. See “Maintenance test” on page 271 for more information on setting limits. 
8 Keep pressing the PREV hard key until you see the Run Test soft key. 
9 Press the Run Test soft key. 

The instrument runs specified tests to gather reference measurement values. The measurement 
table appears when the reference test is done. 

10 Press the Continue soft key to run the testing on an antenna (Ant 1). 
11 Optional. To change the settings such as External Offset, press the Settings and then change 

the settings as needed. 
12 Press the Continue soft key. 

The instrument runs the testing on Ant 1. The Ant 1 tab appears with the updated result table 
when the test is done. 

13 To run the testing on the next antenna (Ant 2), press the Run Test soft key and then repeat the 
steps 11-12. You can do the testing on up to 10 distributed antennas for one radio band. 

14 To view test results for each antenna, press the Select Antenna soft key and then select the 
antenna tab number to display on the screen. 
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15 Optional. Press the Delete Test soft key to delete the selected antenna tab. 
16 Optional. Press the Retest Reference soft key to obtain reference measurement values again. 
17 Optional. To save your measurement results, go to SAVE/LOAD > Save and then perform 

functions as you desire. See “Using save” on page 32 for more information. 

 

Measurement example 

Figure 132 DAS measurement with LTE - TDD signal analyzer 

 
 

Performing power statistics CCDF measurements 

The Power Statistics Complementary Cumulative Distribution Function (CCDF) measurement 
characterizes the power statistics of the input signal. It provides PAR (Peak to Average power Ratio) 
versus different probabilities. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 234, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the CCDF Length soft key to set the length of the CCDF. 
3 Enter a value between 1 and 100 by using the numeric keys. You can also use the rotary knob. 
4 Press the Enter soft key. 
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Measurement example 

Figure 133 CCDF measurement with LTE - TDD signal analyzer 

 
 

Performing carrier aggregation measurements 

Carrier aggregation enables a maximum of five multiple LTE carriers to be used together in order to 
provide high data rate required for LTE-Advanced. Component carriers to be aggregated can be intra-
band contiguous, intra-band non-contiguous, or inter-band. The JD700B series provides carrier 
aggregation measurements supporting for all the different modes with carrier aggregation bands 
added to the channel standard. This functionality is activated if the license for the option 031 LTE-
Advanced TDD is installed. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 234, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To configure parameters for up to 5 component carriers, complete the following steps: 

 Press the CA Configuration soft key. a
The component carrier configuration window appears. 

 Press the CA Range soft key. b
 Enter the number of the component carrier to be set between one and five. c
 Press the Enter soft key. d
 Toggle the Turn On soft key and then select On to set parameters and view the results for e

the selected component carrier on the screen or Off to turn it off. 
 Set the following parameters as needed: f

–  Center Frequency, Channel, Bandwidth, Cell ID, CFI, PHICH Ng, Antenna Port, 
MBMS On/Off, Cyclic Prefix, and PDSCH Modulation Type 
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 To set more component carriers, repeat the steps c-f. g
3 Press the MEASURE SETUP hot key again. 
4 Toggle the EVM Detection Mode soft key and select Single or Combine as desired: 

–  Single: Testing on one single antenna connected to your JD700B series with a cable. 

–  Combine: Testing on multiple antennas connected to your JD700B series with a 2x1 or 4x1 
combiner or an antenna. 

5 To select the subframe number to be measured, do one of the following: 
–  If the EVM Detection Mode is set to Single, press the Subframe No soft key and then set 

the subframe number. 
 

 NOTE 
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

 

–  If the EVM Detection Mode is set to Combine, toggle the Subframe No soft key and then 
select 0 or 5. 

6 To set the threshold for PDSCH, complete the following steps: 
 Press the PDSCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the dB soft key. c

7 Toggle the PDSCH Precoding soft key between On and Off to enable or disable the PDSCH 
precoding. 

8 To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 2x2 by 
default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO channels. 

 

Setting display 

You can use the TRACE/DISPLAY hard key to select modulation analysis or spectrum analysis. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Toggle the Display soft key and select MA for modulation analysis or SA for spectrum analysis. 

The screen changes according to the selected option. 
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Measurement example 

Figure 134 Carrier aggregation measurement with LTE - TDD signal analyzer (MA) 

 
 

Figure 135 Carrier aggregation measurement with LTE - TDD signal analyzer (SA) 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 268 for 
more information. 

 

Using marker 

You can use the MARKER hard key to place the marker at a specific channel. 
 

Procedure 

1 Press the MARKER hard key. 
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2 Toggle the Marker View soft key between On and Off to display or dismiss the marker. 
3 Press the Channel soft key to select the channel to be displayed on the IQ diagram. 
4 Use the rotary knob to move and select an item under EVM. 

 

Conducting LTE - TDD OTA measurements 

The TDD LTE Over The Air (OTA) measurement has Channel Scanner, ID Scanner, Multipath Profile, 
Datagram, and Control Channel screens. The ID Scanner displays key parameters such as RSRP, 
RSRQ, RS-SINR, and S-SS RSSI. The Multipath Profile enables you to determine RF environmental 
conditions of testing area. The OTA Control Channel provides summary of all control channels 
including RS power variation over time. 
 

Channel scanner 

The Channel Scanner is a radio receiver that can automatically tune or scan two or more discrete 
frequencies and multi-channels, indicating when it finds a signal on one of them and then continuing 
scanning when that frequency goes silent. 
 

Setting channel/frequency 

Procedure 

To set the channels to be scanned: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Channel. 
3 Press the Index soft key, and then enter an index number between one and six by turning the 

rotary knob or using the numeric keys. 
4 To select the standard channel, complete the following steps: 

 Press the Channel Std soft key. The standard channel window appears. a
See “Appendix C – Band, frequency & channel standard” on page 530 for more information. 

 Highlight the band to be measured by using the rotary knob, the arrow keys, or the Page b
Up/Page Down soft keys. 

 Press the Select soft key or the rotary knob to confirm the selection. c
5 To set the channel number for the selected index, complete the following steps: 

 Press the Channel Number soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

6 The instrument displays a corresponding center frequency for the channel number. 
7 To set the integration bandwidth for the selected index, complete the following steps: 

 Press the Integration Bandwidth soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

8 To add more channels to be scanned, repeat steps 3-6. 
9 Press the ESC hard key to dismiss the channel list window and view the scanning result. 

 
To set the frequencies to be scanned: 

1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Freq. 
3 Press the Index soft key, and then enter an index number between one and six by turning the 

rotary knob or using the numeric keys. 
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4 To set the center frequency for the selected index, complete the following steps: 
 Press the Center Frequency soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

5 To set the integration bandwidth for the selected index, complete the following steps: 
 Press the Integration Bandwidth soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

6 To add more channels to be scanned, repeat steps 3-5. 
7 Press the ESC hard key to dismiss the channel list window and view the scanning result. 

 

Setting number of antenna ports 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 2x2 by 
default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO channels. 

 

Measurement example 

Figure 136 Channel scanner measurement with LTE - TDD OTA signal analyzer 

 
 

ID scanner 

The LTE mobile receives signals from multiple base stations that all of these signals share the same 
spectrum and are present at the same time. Each base station has unique scrambling code assigned 
to the particular base station and it differentiates its signal from other base stations in the area. 
 
The ID Scanner shows key parameters such as RSRP (Reference Signal Received Power) and RSRQ 
(Reference Signal Received Quality) that predict the downlink coverage quickly. 

 RSRPs from entire cells help to rank between the different cells as input for handover and cell 
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reselection decisions. 

 RSRQ provides additional information when RSRP is not sufficient to make a reliable 
handover or cell reselection decision. 

 
All of the parameters for OTA ID scanner can be plotted on map data such as Google Maps and 
Google Earth by using JDViewer. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 234, you 
can continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, b

and 20 MHz. 
3 Optional. Press the Miscellaneous soft key, and then do the following as needed: 

–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 534 for OFDM parameter details 
by different bandwidth. 

4 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 32 for more information. 

 

Measurement example 

Figure 137 ID scanner measurement with LTE - TDD OTA signal analyzer 
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Multipath profile 

The Multipath Profile enables you to determine RF environmental conditions of testing area. It 
indicates the amount of power of the dominant pilot signal that is dispersed outside the main 
correlation peak due to multipath echoes that are expressed in dB. This value should be very small 
ideally. 
 
The multipath profile is the result of portions of the original broadcast signal arriving at the receiving 
antenna out of phase. This can be caused by the signal being reflected off objects such as buildings, 
or being refracted through the atmosphere differently from the main signal. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 234, you 
can continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, b

and 20 MHz. 
3 Toggle the Display soft key and select RS or Sync. 

The RS Window soft key becomes activated if RS is selected. 
4 Press the RS Window soft key, if RS is selected, and then select the RS window option: 2 µs,  

4 µs, or 8 µs. 
5 Optional. Press the Miscellaneous soft key, and then do the following as needed: 

–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 534 for OFDM parameter details 
by different bandwidth. 

6 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 32 for more information. 
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Measurement example 

Figure 138 Multipath profile measurement with LTE - TDD OTA signal analyzer 

 
 

Control channel 

DL RS power is the resource element power of Downlink Reference Symbol. The absolute DL RS 
power is indicated on the BCH. The absolute accuracy is defined as the maximum deviation between 
the DL RS power indicated on the BCH and the DL RS power at the BS antenna connector. 
 
The OTA Control Channel provides summary of all control channels including RS power trend over 
time. GPS coordinates (latitude and longitude) will be displayed on the screen if a GPS antenna is 
connected and locked to the GPS satellites. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 234, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, b

and 20 MHz. 
3 To select the subframe number to be measured, complete the following steps: 

 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b

 

 NOTE 
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 
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 Press the Enter soft key. c
4 Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

5 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to test on MIMO channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 031 LTE-Advanced TDD is not 
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 534 for OFDM parameter details 
by different bandwidth. 

–  To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the 
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the 
Subframe No with the same PMCH subframe number. If this setting is on, the 
measurement item “MBSFN RS” appears in the result table. 

–  To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically 
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 
automatically detected or manually entered MBSFN ID appears on the screen. 

6 Go to SAVE/LOAD > Save, and then select the save option from the choices available for your 
measurement mode. See “Using save” on page 32 for more information. 

 

Setting limit for OTA control channel 

Procedure 

1 Press the LIMIT hot key. 
2 Select the test item(s) and set the limit(s) as needed: 

 

To set the limit for Select Set 

P-SS error vector magnitude P-SS EVM High Limit 

S-SS error vector magnitude S-SS EVM High Limit 

RS error vector magnitude RS EVM > RS0 EVM 
RS EVM > RS1 EVM 
RS EVM > RS2 EVM 
RS EVM > RS3 EVM 

High Limit 

Frequency error Frequency Error High Limit 
Low Limit 

Time error Time Error High Limit 
Low Limit 

Time alignment error Time Alignment Error High Limit 

 
3 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 

See “Using save” on page 32 for more information. 

 



Chapter 9 Using LTE - TDD Signal Analyzer 

286 JD700B Series User’s Guide 

Setting display 

You can use the TRACE/DISPLAY hard key to select the display option. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Toggle the Display soft key and select Power or EVM. 

The screen changes according to the selected option. 

 

Measurement example 

Figure 139 Control channel measurement with LTE - TDD OTA signal analyzer 

 
 

Datagram 

The OTA Datagram is a time-varying spectral representation that shows how the power of a signal 
varies with time. The power allocated to the specific resource block will be represented with an 
amplitude axis (in dBm) and the waterfall diagram will show the trend of past resource block power 
over certain period. Using a marker function facilitates analysis of accumulated resource block power 
for data utilization. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 234, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the nominal channel bandwidth to be measured, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, b
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and 20 MHz. 
3 To select the subframe number to be measured, complete the following steps: 

 Press the Subframe No soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

4 Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 
–  Auto: Lets the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: Sets a specific Cell ID for the LTE signal manually in order to speed up the 
synchronization with a BTS. 

5 Optional. To set the threshold for PDSCH, complete the following steps: 
 Press the PDSCH Threshold soft key. a
 Enter a value by using the numeric keys. b
 Press the dB soft key. c

6 To set the time cursor at a specific position, complete the following steps: 
 Toggle the Time Cursor soft key and select On. a
 Turn the rotary knob to move the time cursor. You can also enter a value and then press the b

Enter soft key. 
 

 NOTE 
Enabling the time cursor puts the measurement on hold and you can make post-
processing analysis for each measurement over time using the time cursor. 

 

7 To start a new measurement, press the Reset/Restart soft key. 
8 Optional. Press the Miscellaneous soft key, and then do the following as needed: 

–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 534 for OFDM parameter details 
by different bandwidth. 

9 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 32 for more information. 
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Measurement example 

Figure 140 Datagram measurement with LTE - TDD signal analyzer 

 
 

Route map 

The JD700B Series provides indoor and outdoor mapping function that allows a user to collect data of 
points in an indoor or outdoor environment and track the received signals and coverage of RF 
transmitters plotting real time directly on top of a loaded floor plan or a map. 
 

Setting measure setup 

Procedure 

1 If required, connect a GPS receiver to your JD700B series for outdoor mapping. 
Indoor mapping does not necessarily need a GPS antenna. 

2 Configure test parameters as described in the “Configuring test parameters” on page 234. 
3 To load your map file, complete the following steps: 

 Plug in your USB drive that has a floor map or .mcf file type created in JDMapCreator. a
 

 NOTE 
The JDMapCreator converts and resizes any scanned floor plan or layout to fit onto your 
instrument’s display. You must save your map file (.mcf) into the “SavedMap” folder of 
your USB drive so that you can load them onto your instrument. 

 

 Press SAVE/LOAD hot key, and then select Load > Load Map. b
See “Using load” on page 34 for more information. 

4 Press the MEASURE SETUP hot key. 
5 Press the Plot Point soft key, and then select the plot point option from the following choices: 

–  To collect data/plot points automatically as you move around in a vehicle or outside, press 
the GPS soft key and then toggle the Screen Mode soft key between Map and Full. 

 

 NOTE 
With the Map setting, you can view only the collected points that can be seen within the 
boundary of the loaded map. If a point is off the map, the instrument displays an arrow to 
indicate the direction of the current location on the map and the distance from the center 
to the location at the top of the screen. 
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With the Full setting, you can view all the collected points of the route without the loaded 
map. 

 

–  To collect data/plot points manually without a GPS antenna in an indoor environment, press 
the Position soft key. 

6 Press the Plot Item soft key, and then select the measurement option: RSRP, RSRQ, RS-SINR, 
S-SS RSSI, P-SS Power, S-SS Power, or S-SS Ec/Io. 

 

 NOTE 
The instrument collects the strongest Cell ID’s data to plot points. 

 

7 Press the Bandwidth soft key to set the nominal channel bandwidth to be measured, and then 
select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, and  
20 MHz. 

8 Toggle the Plot soft key and select Start to start plotting. 
9 Touch directly on the screen or press the ENTER hard key to collect data and plot points on the 

loaded map for the Position setting. 
 

 NOTE 
For the Position setting, you can change the direction of the route with the arrow keys 
and the distance with the rotary knob. 

 

10 Toggle the Plot soft key and select Stop to stop plotting. 
11 Press the SAVE/LOAD hot key to save the result. 

See “Using save” on page 32 for more information. 
 

 NOTE 
The instrument does not automatically save the collected data. It is recommended that 
you save the result. Otherwise, you will lose all the collected data. 

 

 

Setting limit for route map 

You can set the thresholds for each test item. 
 

Procedure 

1 Press the LIMIT hot key. 
2 Select the plot items and set the limits as needed: 

 

To set the limit for Select Set 

RSRP RSRP Excellent, Very Good, Good, Fair, Poor (dBm) 

RSRQ RSRQ Good, Fair, Poor (dB) 

RS-SINR RS-SINR Good, Fair, Poor (dB) 

S-SS RSSI S-SS RSSI Excellent, Very Good, Good, Fair, Poor (dBm) 

P-SS Power P-SS Power Excellent, Very Good, Good, Fair, Poor (dBm) 

S-SS Power S-SS Power Excellent, Very Good, Good, Fair, Poor (dBm) 

S-SS Ec/Io S-SS Ec/Io Good, Fair, Poor (dB) 
 

3 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 32 for more information. 
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Measurement example 

Figure 141 Route map measurement with LTE - TDD OTA signal analyzer 

1) RSRP 

 

2) RSRQ 
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3) RS-SINR 

 

4) S-SS RSSI 

 

5) P-SS Power 
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6) S-SS Power 

 

7) S-SS Ec/Io 

 
 
 
 



 
 

10 

 

Chapter 10 Using CDMA Signal Analyzer 

This chapter provides instructions for using the CDMA Signal Analyzer function (option 020) with the 
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Introduction 

This CDMA Signal Analyzer can be used to test a CDMA transmitter including cdmaOne and 
cdma2000 signals to check the base station’s compliance with following standards documentation. 
 

 3GPP2 C.S0002 Physical Layer Standard for cdma2000 Spread Spectrum Systems 

 3GPP2 C.S0010 Recommended Minimum Performance Standards for cdma2000 Spread 
Spectrum Base Station 

 
This instrument automatically makes standard defined measurements using the measurement 
methods and limits as defined in the standards. Detailed measurement results allow you to analyze 
cdmaOne and cdma2000 system performance. 
 

 cdmaOne uses dual BPSK (Binary Phase-Shifting Key) for the forward link and OQPSK 
(Offset Quadrature Phase Shift Keying) for the reverse link. 

 cdma2000 uses QPSK (Quadrature Phase Shift Keying) modulation for the forward link and 
QPSK modulation with HPSK spreading for the reverse link. Both forward and reverse links 
may have several channels, and individual characteristics for each channel. The chip rate 
depends on the mode selected. 

 
You may alter the measurement parameters for specialized analysis. Pass/Fail testing with standard 
defined or user defined upper and lower limits and the Pass/Fail indictor help you to determine base 
station performance easily. 
 
This instrument provides the following measurement tools for CDMA system: 
 

 Spectrum Analysis 

 RF Analysis 
- Channel Power 
- Occupied Bandwidth 
- Spectrum Emission Mask (SEM) 
- Adjacent Channel Power Ratio (ACPR) 
- Multi-ACPR 
- Spurious Emissions 

 Modulation Analysis 
- Constellation 
- Code Domain Power 
- Codogram 
- Received Code Strength Indicator (RCSI) 
- CDP Table 

 Auto Measure 

 Power Statistics CCDF 

 Over The Air (OTA) 
- Channel Scanner 
- PN Scanner 
- Multipath Profile 
- Code Domain Power 
- Route Map 
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Display overview 

Figure 142 provides descriptions for each segment of the measurement screen. 
 

Figure 142 CDMA signal analyzer measurement screen 

 

 

Connecting a cable 

Direct connection 

Procedure 

1 Connect the Spectrum Analyzer RF In port of the JD700B series and the Power amplifier output 
port of BTS. 

 
Figure 143 Direct connection 

 
JD785B/JD745B 

 
JD788B/JD748B 
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Indirect connection 

Procedure 

1 Connect the Spectrum Analyzer RF In port of the JD700B series and the monitor (test) port of 
BTS. 

 
Figure 144 Indirect connection 

 
JD785B/JD745B 

 
JD788B/JD748B 

 

 

CAUTION 
The maximum power for the Spectrum Analyzer RF In port is +25 dBm (0.316 W) for 
JD780B series and +20 dBm (0.1 W) for JD740B series. If the level of the input signal to 
be measured is greater than this, use a High Power Attenuator to prevent damage 
when you directly connect the signal to the instrument or connect the signal from the 
coupling port of a directional coupler. 

 
 NOTE 

For accurate PN Offset and Time Offset measurements with the CDMA Signal Analyzer 
function, a PP2S should be connected to the External Trigger. Without a GPS connection, 
measurement results could be invalid numbers. 

 

Over the air (OTA) 

Procedure 

1 Connect an Omni/directional RF antenna to the Spectrum Analyzer RF In port of the JD700B 
series. 

2 Connect a GPS antenna to the GPS port of the JD700B series. 

 

 

CAUTION 
If the input signal level to be measured is less than 0 dBm, set 0 dB attenuation or turn on 
the preamp to have better dynamic range for the OTA testing. 
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Figure 145 OTA connection 

 
JD785B/JD745B 

 
JD788B/JD748B 

 

Selecting measurement mode 

Procedure 

1 Press the MODE hard key. 
2 Press the Signal Analyzer soft key. 
3 Press the CDMA soft key. The Spectrum mode is set by default. 
4 Press the MEASURE hot key, and then select the measurement mode option from the following 

choices: 
–  Spectrum 

–  RF Analysis > Channel Power, Occupied BW, Spectrum Emission Mask, ACPR,  
Multi-ACPR, or Spurious Emissions 

–  Modulation > Constellation, Code Domain Power, Codogram, RCSI, or CDP Table 

–  Auto Measure 

–  Power Statistics CCDF 

–  OTA > Channel Scanner, PN Scanner, Multipath Profile, Code Domain Power, 
or Route Map 

 

Configuring test parameters 

Setting frequency 

You can set the frequency with either frequency or channel number. If a frequency to be set matches 
to the frequency corresponding to the selected channel standard, the instrument calculates its channel 
number and updates the screen with it automatically. 
 

Procedure 

To set the center frequency: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Freq. 
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3 Press the Center Frequency soft key. 
4 Enter a value by using the numeric keys. You can also use the rotary knob. 
5 Select the unit: GHz, MHz, kHz, or Hz. 
6 Optional. To define the amount of frequency increment for the rotary knob, complete the following 

steps: 
 Press the Frequency Step soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the unit: GHz, MHz, kHz, or Hz. c

 
To set the channel number: 

1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Channel. 
3 To select the standard channel, complete the following steps: 

 Press the Channel Std soft key. The standard channel window appears. a
See “Appendix C – Band, frequency & channel standard”” on page 530 for more 
information. 

 Highlight the band to be measured by using the rotary knob, the arrow keys, or the Page b
Up/Page Down soft keys. 

 Press the Select soft key or the rotary knob to confirm the selection. c
4 Press the Channel Number soft key. 
5 Enter a value by using the numeric keys. You can also use the rotary knob. 
6 Press the Enter soft key. 
7 The instrument automatically displays the corresponding center frequency value for the selected 

channel number. 
8 Optional. To define the amount of channel increment for the rotary knob, complete the following 

steps: 
 Press the Channel Step soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

 
 NOTE 

This frequency setting is not used in the Multi-ACLR and Spurious Emissions modes. 
 

Setting amplitude 

Reference level and attenuation 

You can set the reference and attenuation levels automatically or manually to optimize the display of 
the traces measured, as you desire. 
 

Procedure 

To automatically set the reference and attenuation level: 
1 Press the AMP/SCALE hard key. 
2 Press the Auto Scale soft key. 

Each time you press this key, both of the Y-axis scale and input attenuation level change to be 
optimized with some margin. 

 
To set the reference or attenuation level manually: 

1 Press the AMP/SCALE hard key. 
2 To set the maximum reference value on the Y-axis manually, complete the following steps: 

 Press the Reference Level soft key. a
 Enter a value by using the numeric keys or the rotary knob with 10 dB increments. b
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 Press the dBm soft key or the ENTER hard key. c
This unit key name changes according to the setting in the Units menu. 

 

 NOTE 
In the measurements such as Code Domain Power, Codogram, and RCSI, you may 
need to select the reference option between Relative and Absolute before setting the 
reference level. 

 

3 To set the attenuation option, select one from the following choices: 
–  To set the input attenuator’s level automatically, select Attenuation > Auto. 

 

 NOTE 
It is recommended that you set the Attenuation to Auto in most situations so that the 
level of the input attenuator can be set automatically according to your input signal level. 

 

–  To set the input attenuation manually up to 55 dB for JD780B series or 50 dB for JD740B 
series to optimize S/N, complete the following steps: 

 Select Attenuation > Manual. a
 Press the Attenuation Value soft key to set the level. b
 Enter a value in fives by using the numeric keys. c
 Press the dB soft key or the ENTER hard key. d

–  To couple the input attenuator’s level with your reference level setting, select Attenuation > 
Couple. 
As you increase the reference setting, the attenuation level also increases acoordingly. 

 
Optional. To change the scale unit: 

1 Select More (1/2) > Units. 
2 Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W. 

The scale unit on the screen changes accordingly. 
 

 NOTE 
This Units menu is available in the Spectrum and RF Analysis modes. 

 

 

Scale per division 

You can use the Scale/Div feature available for the spectrum and RF analysis. It represents the value 
of one division on the horizontal scale. The default setting is 10 dB per division and the maximum 
value can be set up to 20 dB. 
 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Select More (1/2) > Scale/Div. 
3 Enter a value between 1 and 20 by using the numeric keys. 
4 Press the dB soft key to complete the entry. 

 

Pre-amplifier 

You can turn the internal pre-amplifier on to correct and compensate for the gain of the preamp so that 
amplitude readings show the value at the input connector. 
 

Procedure 

1 Press the AMP/SCALE hard key. 
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2 Toggle the Preamp soft key and select On or Off as needed. 

 
 NOTE 

You can turn the Preamp on when the input attenuation range is from 0 dB to 10 dB. If 
the attenuation value is manually set to greater than 10 dB, the instrument will 
automatically turn off the pre-amplifier to display low-level signal properly on the chart. 

 

External offset 

You can turn the External Offset on and manually set the external offset value. An offset consists of a 
cable loss and a user offset and the measurement result shows the value reflecting both offset values. 
When the external offset value is set at 40 dB in the Spectrum mode, the measurement result 
compensates 40 dB at both the Spectrum Analyzer and Signal Analyzer modes 
 

Procedure 

To set the external offset: 
1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select On. 
3 Enter a value by using the numeric keys. 
4 Press the dB soft key to complete the entry. 

 
To turn the external offset off: 

1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select Off. 

 

Setting average 

You can set the number of measurements to be averaged for the trace presentation. A maximum of 
100 times of averaging can be set. When the averaging reaches to your setting, a new measurement 
value replaces the measurement value in sequence from the earliest. 
 

Procedure 

1 Press the BW/AVG hard key. 
2 Press the Average soft key. 
3 Enter a value between 1 and 100 as needed by using the numeric keys. 
4 Press the Enter soft key. 

 

Setting sweep mode 

The default setting is Continue to sweep continuously for most on-going measurements. If you want to 
hold the measurement or get a single sweep, you can change the sweep mode. 
 

Procedure 

To select the single sweep mode: 
1 Press the SWEEP hot key. 
2 Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key. 

The letter HOLD in red appears and the sweeping is paused. 
3 Optional. Press the Sweep Once soft key to get a new measurement. 
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To return to the continuous sweep mode: 

1 Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key. 
The letter HOLD in red disappears and the sweeping resumes. 

 

Setting trigger source 

You can set the trigger source option for your measurements. Connecting an external trigger is 
necessary for accurate modulation measurements on CDMA systems. 

Procedure 

1 Press the TRIGGER hot key. 
2 Select the trigger source option from the choices: Internal, External, and GPS. 

 

Setting external clock 

To enhance the reliability of modulation analysis measurements the JD700B series must be 
synchronized with a base station. When an external clock is not supplied, the instrument works with its 
built-in internal high-accuracy time base and some measurement results may exhibit inaccurate values. 
Therefore, it is highly recommended that you use the same reference clock as the signal source. You 
can use the TRIGGER hot key to set the external clock. 
 

Table 15 Standards of external clock operation 

Clock Type Reference Port Switching Standard 

External Reference Internal Internal 10 MHz  Default 

 External External Ref Clock Ext Ref (SMA) Manual switching 
(Input signal level >-3 dBm) 

 GPS GPS Clock GPS (SMA) Automatic switching 
(GPS signal received) 

Trigger Internal Internal Trigger  Default 

 External External Trigger Trigger (SMA) Manual switching 

 GPS GPS GPS (SMA) Manual switching 

 
Figure 146 Connection ports for external reference clock 

 
 

Procedure 

1 Connect an external reference or a GPS antenna to the JD700B series. 
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2 Press the SYSTEM hot key. 
3 Press the Freq Reference soft key, and then select the reference option: Internal, External 10 

MHz, External 13 MHz, External 15 MHz, or GPS. 

 
 NOTE 

When a GPS antenna is connected and locked, GPS coordinates (longitude and latitude) 
are displayed on the screen and frequency reference is automatically set to GPS in the 
System > Freq Reference. 

 
Table 16 External reference indicators 

Type Indicator Description 

Internal  (green) The green INT icon indicates that the instrument uses the built-in 
internal time base. 

External  (green) The green EXT icon indicates that an external reference is connected 
and locked and that the instrument uses the same reference clock as 
the signal source. 

External  (red) The red EXT icon indicates that an external reference is connect but not 
locked. 

GPS      (green) The green GPS antenna icon indicates that a GPS antenna is 
connected and locked. 

GPS      (yellow) The yellow GPS antenna icon indicates that a GPS antenna is 
connected and locking is in progress. 

GPS      (grey) The grey GPS antenna icon indicates that a GPS antenna is not 
connected, failed, or unable to be locked. 

 

Conducting spectrum measurements 

If you have configured test parameters as described in the “Configuring test parameters” on page 297, 
your measurement result is displayed on the screen as like the following example, Figure 147. 
 

Figure 147 Spectrum measurement screen with CDMA signal analyzer 
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Setting trace 

You can display up to six traces on the measurement chart simultaneously. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6. 

The legend shape of the selected trace changes from square to round to indicate that the trace is 
the active one now. 

3 Toggle the Trace View soft key and select On. 
4 Do one of the following: 

 

To Select Trace Legend 

Clear current data and display with new 
measurements 

Clear Write W 

Display the input signal’s maximum response only 
(unlimited or for a certain amount of time) 

Max Hold M 

Display the input signal’s minimum response only 
(unlimited or for a certain amount of time) 

Min Hold m 

Capture the selected trace and compare traces Capture C 

Load a saved trace More (1/2) > Load L 

Hide the selected trace Trace View > Off F 

Remove all the traces and initialize the trace 
settings 

More (1/2) > Trace 
Clear All 

 

 

 NOTE 
For the Max Hold and Min Hold, your instrument compares newly acquired data with the 
active trace and displays larger maximum values or smaller minimum values on the 
screen. You can set it to Unlimited to hold and view maximum or minimum data or 
specify a certain amount of time up to 60 seconds by using numeric keys or the rotary 
knob. 

5 To select the detection option, press the More (1/2) > Detectors, and then do one of the 
following: 

 

To display Select 

Random noise better than the peak without missing signals Normal 

The highest value in each data point Peak 

The root mean squared average power across the spectrum RMS 

The lowest value in each data point Negative Peak 

The center value in each data point Sample 
 

6 Optional. Press the More (1/2) > Trace Info soft key, and then select the trace number to view 
the trace’s parameter setting information stored at the time of the measurement or None to hide 
the information display. 

7 Optional. If you have the two traces T1 and T2, you can perform trace math. To view the power 
difference between the traces, press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key. 
The result is overlaid on the screen along with the second Y-axis. 
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Conducting RF measurements 

Channel power 

The Channel Power measurement is a common test used in the wireless industry to measure the total 
transmitted power of a radio within a defined frequency channel. It acquires a number of points 
representing the input signal in the time domain, transforms this information into the frequency domain 
using Fast Fourier Transform (FFT), and then calculates the channel power. The effective resolution 
bandwidth of the frequency domain trace is proportional to the number of points acquired for the FFT. 
 
The channel power measurement identifies the total RF power, power spectral density (PSD) and peak 
to average ratio (PAR) of the signal within the channel bandwidth (1.23 MHz for cdmaOne). 
 
After configuring test parameters as described in the “Configuring test parameters” on page 297, your 
measurement result is displayed on the screen as like the following example, Figure 148. 
 

Figure 148 Channel power measurement with CDMA signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 310 for more 
information. 

 

Occupied bandwidth 

The Occupied Bandwidth measures the spectrum shape of the carrier. It is defined as the bandwidth, 
which includes 99% of the transmitted power among total transmitted power. 
 
After configuring test parameters as described in the “Configuring test parameters” on page 297, your 
measurement result is displayed on the screen as like the following example, Figure 149. 
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Figure 149 Occupied bandwidth measurement with CDMA signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 310 for more 
information. 

 

Spectrum emission mask (SEM) 

The Spectrum Emission Mask (SEM) measurement required by 3GPP2 specifications encompasses 
different power limits and different measurement bandwidths (resolution bandwidths) at various 
frequency offsets. It may be expressed as a ratio of power spectral densities between the carrier and 
the specified offset frequency band. It provides useful figures-of-merit for the spectral re-growth and 
emissions produced by components and circuit blocks, without the rigor of performing a full SEM 
measurement. 
 
The SEM measures spurious signal levels in up to five pairs of offset or region frequencies and relates 
them to the carrier power. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 297, your 
measurement result is displayed on the screen as like the following example, Figure 150. 
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Figure 150 SEM measurement with CDMA signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 310 for more 
information. 

 

ACPR 

The Adjacent Channel Power Ratio (ACPR) is defined as the ratio of the average power in the 
adjacent frequency channel (or offset) to the average power in the transmitted frequency channel. It 
may be expressed as the ratio of the integrated signal power in the adjacent channel to the integrated 
signal power in the main channel. 
 
After configuring test parameters as described in the “Configuring test parameters” on page 297, your 
measurement result is displayed on the screen as like the following example, Figure 151. 
 

Figure 151 ACPR measurement with CDMA signal analyzer 
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 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 310 for more 
information. 

 

Multi-ACPR 

The Multi-ACPR measurement is used to perform multi-channel ACPR measurements with as many 
channels as possible. It helps you to measure ACPR in multi-channel transmitting base station 
environment. 
 

Setting frequency for Multi-ACPR 

You can set the frequency with either frequency or channel number. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the frequency, do one of the following: 

–  To set the center frequency, complete the following steps: 
 Toggle the Unit soft key and select Freq. a
 Press the Lowest Frequency soft key to set the starting center frequency. b
 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Select the unit: GHz, MHz, kHz, or Hz. d
 Press the Highest Frequency soft key to set the stopping center frequency. e
 Enter a value by using the numeric keys. You can also use the rotary knob. f
 Select the unit: GHz, MHz, kHz, or Hz. g

–  To set the channel number, complete the following steps: 
 Toggle the Unit soft key and select Channel. a
 To select the standard channel, press the Channel Std soft key and then select the b

band to be measured. 
 Press the Lowest Channel soft key to set the starting channel. c
 Enter a value by using the numeric keys. You can also use the rotary knob. d
 Press the Enter soft key. e
 Press the Highest Channel soft key to set the stopping channel. f
 Enter a value by using the numeric keys. You can also use the rotary knob. g
 Press the Enter soft key. h

 
After configuring test parameters, your measurement result is displayed on the screen as like the 
following example, Figure 152. 
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Figure 152 Multi-ACPR measurement with CDMA signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 310 for more 
information. 

 

Spurious emissions 

Out-of-band emissions are unwanted emissions immediately outside the channel bandwidth resulting 
from the modulation process and non-linearity in the transmitter but excluding spurious emissions. The 
Spurious Emissions measurement is to identify and determine the power level of out-of-band spurious 
emission within the necessary channel bandwidth and modulated signal measured at the RF port of 
the Base Station. 
 

Setting measure setup 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set up the range table and frequency range, press the Range Table soft key and then 

complete the following steps: 
 Press the Range soft key, and then enter the range number to add a new range or change a

an existing one. 
 Press the Enter soft key. b
 Press the Start Frequency soft key to set up the frequency range. c
 Enter a value by using the numeric keys. You can also use the rotary knob. d
 Select the unit: GHz, MHz, kHz, or Hz. e
 Press the Stop Frequency soft key to set up the frequency range. f
 Enter a value by using the numeric keys. You can also use the rotary knob. g
 Select the unit: GHz, MHz, kHz, or Hz. h

3 Toggle the Range soft key between On and Off to display or hide the selected range. 
4 To set up the test limits for Pass/Fail indication, complete the following steps: 

 Press the Start Limit soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
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 Select the dBm soft key. c
 Press the Stop Limit soft key. d
 Enter a value by using the numeric keys. You can also use the rotary knob. e
 Select the dBm soft key. f

5 To set up the other parameters, complete the following steps: 
 Select More (1/2) > Attenuation to set up the attenuation value. a
 Enter a value in the multiple of five. b
 Press the dB soft key or the ENTER hard key. c
 Press the RBW soft key. d
 Enter a value by using the numeric keys. e
 Select the unit: GHz, MHz, kHz, or Hz. f
 Press the VBW soft key. g
 Enter a value by using the numeric keys. h

 Select the unit: GHz, MHz, kHz, or Hz. i
6 Press the PREV hard key. 
7 Toggle the Measure Type soft key between Examine and Full to select the measurement type. 

 

 NOTE 
The Examine mode displays only the selected range while the Full mode lets the 
instrument automatically changes the selected range from one another. 

 

8 Set the number of measurements to be averaged: 
 Press the Average soft key. a
 Enter a value between 1 and 100. b
 Press the Enter soft key. c

 
After configuring test parameters as described in the “Configuring test parameters” on page 297, your 
measurement result is displayed on the screen as like the following example, Figure 153. 
 

Figure 153 Spurious emissions measurement with CDMA signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 310 for more 
information. 

 



Chapter 10 Using CDMA Signal Analyzer 

310 JD700B Series User’s Guide 

Setting limit for RF tests 

By default, test limits specified in the standard are set for you. You can change thresholds if you desire. 
 

Procedure 

1 Press the LIMIT hot key. 
2 Press the RF Test Limits soft key. 
3 Select the test item(s) and set the limit(s) depending on your selected measurement mode: 

 

To set the limit for Select Set 

Channel power Channel Power High Limit 
Low Limit 

Occupied bandwidth Occupied BW High Limit 

Spectrum emission mask Spectrum Emission Mask (On/Off only) 

ACPR ACPR (On/Off only) 

Multi-ACPR Multi-ACPR (On/Off only) 

Spurious emissions Spurious Emissions (On/Off only) 
 

4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 32 for more information. 

 

Conducting modulation measurements 

In order to make accurate measurements of time offset and PN, you must connect an external trigger 
before making a modulation measurement. 
 

Constellation 

The Constellation is used to observe some aspects of modulation accuracy and can reveal certain 
fault mechanisms such as I/Q amplitude imbalance or quadrature imbalance. It displays constellation 
diagram by modulation types. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 297, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the Pseudo-Noise (PN) offset, complete the following steps: 

 Toggle the PN Offset soft key between Auto and Manual. a
 Enter a value by using the numeric keys to set manually. b
 Press the Enter soft key. c
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3 To set the incremental step for the PN offset, complete the following steps: 
 Press the PN Increment soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

4 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 32 for more information. 

 

Measurement example 

Figure 154 Constellation measurement with CDMA signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 317 for 
more information. 

 

Code domain power 

The Code Domain Power (CDP) measures the distribution of power across the set of code channels, 
normalized to the total power. It helps to verify that each code channel is operating at its proper level 
and to identify problems throughout the transmitter design from coding to the RF section. System 
imperfections such as amplifier non-linearity will present themselves as an undesired distribution of 
power in the code domain. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 297, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the Pseudo-Noise (PN) offset, complete the following steps: 
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 Toggle the PN Offset soft key between Auto and Manual. a
 Enter a value by using the numeric keys to set manually. b
 Press the Enter soft key. c

3 To set the incremental step for the PN offset, complete the following steps: 
 Press the PN Increment soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

4 To set the threshold between Auto and Manual, complete the following steps: 
 Press the Threshold soft key. Its default setting is -27 dB. a
 Enter a value between -50 and zero by using the numeric keys to change the value in the b

Manual mode. 
 Press the Enter soft key. c

5 Toggle the Q-Paging soft key between On and Off to enable or disable the quick page channel 
that indicates the power of Quick Page Walsh code 80. 

6 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 32 for more information. 

 

Measurement example 

Figure 155 Code domain power measurement with CDMA signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 317 for 
more information. 

 

Setting display 

You can view your measurement results in a different view option. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Code Order soft key, and then select the code order option from the following choices: 

–  Hadamard: To assign the number based on Walsh code order and display the measured 
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code power according to the assigned number in sequence. 

–  Bit Reverse: Code number in binary bit is reversed relative to the Hadamard method. 

3 Toggle the Base Code Length soft key and select the base Walsh code number: 64 or 128. 

 

Codogram 

The Codogram displays how the code level is changing over time and makes it easier for you to view 
traffic channels as they initiate and terminate and to track traffic channels call levels over time. The 
Codogram measurements can be saved into an external USB memory so that a post-analysis can be 
done with the application software JDViewer. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 297, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the Pseudo-Noise (PN) offset, complete the following steps: 

 Toggle the PN Offset soft key between Auto and Manual. a
 Enter a value by using the numeric keys to set manually. b
 Press the Enter soft key. c

3 To set the incremental step for the PN offset, complete the following steps: 
 Press the PN Increment soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

4 To set the threshold between Auto and Manual, complete the following steps: 
 Press the More (1/2) > Threshold soft key. Its default setting is -27 dB. a
 Enter a value between -50 and zero by using the numeric keys to change the value in the b

Manual mode. 
 Press the Enter soft key. c

5 Toggle the More (1/2) > Q-Paging soft key between On and Off to enable or disable the quick 
page channel that indicates the power of Quick Page Walsh code 80. 

6 To set the time interval, complete the following steps: 
 Press the Time Interval soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

7 To place the time cursor to analyze your measurements, complete the following steps: 
 Toggle the Time Cursor soft key between On and Off to enable or disable the time cursor. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

 

 NOTE 
When the time cursor is enabled, the measurement is put on hold and information about 
the time cursor is displayed. 

 

8 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 32 for more information. 
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Measurement example 

Figure 156 Codogram in full view with CDMA signal analyzer 

 
 

Setting display 

You can view your measurement results in a different view option. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Code Order soft key, and then select the code order option from the following choices: 

–  Hadamard: To assign the number based on Walsh code order and display the measured 
code power according to the assigned number in sequence. 

–  Bit Reverse: Code number in binary bit is reversed relative to the Hadamard method. 

3 Toggle the Base Code Length soft key and select the base Walsh code number: 64 or 128. 

 

RCSI 

The Received Code Strength Indicator (RCSI) is used to track the power variation of cdmaOne or 
cdma2000 control channels such as Pilot, Paging, Sync, and Q-Paging over time. The RCSI 
measurements can be saved into an external USB memory so that a post-analysis can be done with 
the application software JDViewer. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 297, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
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2 To set the Pseudo-Noise (PN) offset, complete the following steps: 
 Toggle the PN Offset soft key between Auto and Manual. a
 Enter a value by using the numeric keys to set manually. b
 Press the Enter soft key. c

3 To set the incremental step for the PN offset, complete the following steps: 
 Press the PN Increment soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

4 To set the threshold between Auto and Manual, complete the following steps: 
 Press the Threshold soft key. Its default setting is -27 dB. a
 Enter a value between -50 and zero by using the numeric keys to change the value in the b

Manual mode. 
 Press the Enter soft key. c

5 Toggle the Q-Paging soft key between On and Off to enable or disable the quick page channel 
that indicates the power of Quick Page Walsh code 80. 

6 Press the Alarm Code soft key, and then select the alarm code option: None, Pilot, Page, Sync, 
or Quick Page. 

7 To set the alarm mask, complete the following steps: 
 Press the Set Mask soft key. a
 Enter a value by using the numeric keys. b
 Press the [dB|dBm] soft key. c

8 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 32 for more information. 

 

Measurement example 

Figure 157 RCSI measurement with CDMA signal analyzer 

 
 

Setting display 

You can view your measurement results in a different view option. 
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Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Code Order soft key, and then select the code order option from the following choices: 

–  Hadamard: To assign the number based on Walsh code order and display the measured 
code power according to the assigned number in sequence. 

–  Bit Reverse: Code number in binary bit is reversed relative to the Hadamard method. 

3 Toggle the Base Code Length soft key and select the base Walsh code number: 64 or 128. 

 

CDP Table 

The CDP Table is used to look at a numeric and textual description of all the active code channels in 
the signal. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 297, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the Pseudo-Noise (PN) offset, complete the following steps: 

 Toggle the PN Offset soft key between Auto and Manual. a
 Enter a value by using the numeric keys to set manually. b
 Press the Enter soft key. c

3 To set the incremental step for the PN offset, complete the following steps: 
 Press the PN Increment soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

4 To set the threshold between Auto and Manual, complete the following steps: 
 Press the Threshold soft key. Its default setting is -27 dB. a
 Enter a value between -50 and zero by using the numeric keys to change the value in the b

Manual mode. 
 Press the Enter soft key. c

5 Toggle the Q-Paging soft key between On and Off to enable or disable the quick page channel 
that indicates the power of Quick Page Walsh code 80. 
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Measurement example 

Figure 158 CDP Table measurement with CDMA signal analyzer 

 
 

Setting display 

If the CDP table spans over to the next page(s), you can change pages up and down to view your 
measurement results. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Code Order soft key, and then select the code order option from the following choices: 

–  Hadamard: To assign the number based on Walsh code order and display the measured 
code power according to the assigned number in sequence. 

–  Bit Reverse: Code number in binary bit is reversed relative to the Hadamard method. 

3 Toggle the Base Code Length soft key and select the base Walsh code number: 64 or 128. 
4 Select Page Up or Page Down as needed to scroll the screen up and down. 

 

Setting limit for modulation tests 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Modulation Test Limits soft key. 
3 Select the test item(s) and set the limit(s) depending on your selected measurement mode: 

 

To set the limit for Select Set 

Frequency error Frequency Error High Limit 
Low Limit 

Time offset Time Offset High Limit 
Low Limit 

Waveform quality (Rho) Rho Low Limit 
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Carrier feed through Carrier Feed Through High Limit 

Pilot power Pilot Power High Limit [Abs|Rel] 
Low Limit [Abs|Rel] 

Highest level among inactive channels Max Inactive High Limit 
 

4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 32 for more information. 

 
 NOTE 

The Time Offset compares the PN offset timing with the overall system time and the 
instrument checks the start of PN offset in comparison to either the GPS signal or the 
even second clock signal. 

 
 NOTE 

The Rho measures the modulation quality for a CDMA transmitter along with EVM and 
Walsh Channel Power. It includes all errors occurred along the transmitter chain such as 
base band filtering, abnormality of I/Q modulator and distortion in power amplifier. A 
perfect Rho value is 1.0 indicating that all of the power is being transmitted correctly. 

 
 NOTE 

The Carrier Feed Through is a result of the RF carrier signal feeding through the I/Q 
modulator and riding on the output circuitry without being modulated. 

 

Performing auto measurements 

The Auto Measure function of the JD700B series allows a complete signal profiling covering RF 
characterization and modulation quality parameters of up to 10 different carriers, particularly useful on 
an overlay architecture where base stations are transmitting in different frequencies. 
 
The Auto Measure can be easily executed either by selecting a menu in the instrument or by running a 
programmed scenario in the PC-based application so that the instrument automatically configure and 
perform tests on every aspect of all the carriers. 
 

Setting limit for auto measure 

You can set test limits for test item(s) in the auto measurement. 

Procedure 

1 Press the LIMIT hot key. 
2 Press the RF Test Limits soft key, and then enable test limits as desired. 
3 Press the Modulation Test Limits soft key, and then enable test limits as desired. 
4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 

Toggle the Beep soft key between On and Off to enable or disable the beep sound. 
5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 

See “Using save” on page 32 for more information. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 297, you 
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can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the Configuration soft key and select the configuration option: 

–  Current: Lets the instrumnet use current frequency (single carrier) and determine pass or 
fail based on the instrument’s limit settings in Auto Measure. 

–  Scenario: Runs a test with a programmed scenario in JDViewer. 
The Scenario menu becomes activated. 

3 To load a scenario, press the Scenario soft key, and then select a scenario file to load. 
4 Toggle the Test Time soft key and select the test time option: 

–  Now: Lets the instrument run a test only once. 

–  Schedule: Lets the instrument repeat tests as defined in the Set Timing. 
The Set Timing menu becomes activated. 

5 To define a schedule for an auto measurement, complete the following steps: 
 Press the Set Timing soft key. a
 Press the Start Time (HH:MM) soft key. b
 Enter the time in the HH:MM format, and then press the Enter soft key. c
 Press the Stop Time (HH:MM) soft key. d
 Enter the time in the HH:MM format, and then press the Enter soft key. e
 Press the Time Interval soft key. f
 Enter the amount of time in minutes, and then press the Enter soft key. g

6 To set external offset, complete the following steps: 
 Toggle the External Offset soft key and select On. a
 Enter a value by using the numeric keys, and then press the dB soft key. b

7 To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you 
desire. See “Using save” on page 32 for more information. 

8 Press the Run Test soft key to start to run a test. 
The Auto Measure Results window appears at the end of the test. 

9 To stop running the test, press the Abort soft key. 
10 To change the view on the screen during the test, press the Display and then select the view 

option from the following choices: 
–  Screen: You can view each measurement screen as the test progresses. 

–  Results: You can view a measurement result table as the test progresses. 

–  Settings: You can view a measurement setting table as the test progresses. 

 

Setting display 

After completion of the auto measurement, the screen menu changes to Trace/Display so that you can 
view the results in different forms. 
 

Procedure 

1 Toggle the Display soft key and select the display option: 
–  Result: You can view the result table. 

The Display Result menu becomes activated. 

–  Settings: You can view the measurement settings for the auto measurement. 
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2 Toggle the Display Result soft key and select the display result option: 
–  Full: You can view detailed measurement readings with the pass/fail indication. 

–  Quick: You can view only the Pass/Fail results. 

3 To view the measurement results for a different carrier, press the View Carrier soft key and then 
select the carrier number to view. 

 

Performing power statistics CCDF measurements 

The Power Statistics Complementary Cumulative Distribution Function (CCDF) measurement 
characterizes the power statistics of the input signal. It provides PAR (Peak to Average power Ratio) 
versus different probabilities. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 297, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the CCDF Length soft key to set the length of the CCDF. 
3 Enter a value between 1 and 100 by using the numeric keys. You can also use the rotary knob. 
4 Press the Enter soft key. 

 

Measurement example 

Figure 159 CCDF measurement with CDMA signal analyzer 
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Conducting CDMA OTA measurements 

This Over The Air (OTA) measurement has channel scanner, PN scanner, multipath profile, and Code 
Domain power screens. It is used to verify CDMA transmitter performance at any location providing 
reflective measurements and identifying signals providing from different sites. The Code Domain 
power shows not only modulation performance metric but also amplifier capacity and code utilization 
metric. The Amplifier capacity (code utilization) measurement is an estimate of the amount of power 
amplifier capacity (code utilization) that is being used expressed in percent of maximum. 
 

Channel scanner 

Setting channel/frequency 

Procedure 

To set the channels to be scanned: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Channel. 
3 Press the Index soft key, and then enter an index number between one and six by turning the 

rotary knob or using the numeric keys. 
4 To select the standard channel, complete the following steps: 

 Press the Channel Std soft key. The standard channel window appears. a
See “Appendix C – Band, frequency & channel standard” on page 530 for more information. 

 Highlight the band to be measured by using the rotary knob, the arrow keys, or the Page b
Up/Page Down soft keys. 

 Press the Select soft key or the rotary knob to confirm the selection. c
5 To set the channel number for the selected index, complete the following steps: 

 Press the Channel Number soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

6 The instrument displays a corresponding center frequency for the channel number. 
7 To set the integration bandwidth for the selected index, complete the following steps: 

 Press the Integration Bandwidth soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

8 To add more channels to be scanned, repeat steps 3-6. 
9 Press the ESC hard key to dismiss the channel list window and view the scanning result. 

 
To set the frequencies to be scanned: 

1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Freq. 
3 Press the Index soft key, and then enter an index number between one and six by turning the 

rotary knob or using the numeric keys. 
4 To set the center frequency for the selected index, complete the following steps: 

 Press the Center Frequency soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

5 To set the integration bandwidth for the selected index, complete the following steps: 
 Press the Integration Bandwidth soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

6 To add more channels to be scanned, repeat steps 3-5. 
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7 Press the ESC hard key to dismiss the channel list window and view the scanning result. 

 

Setting measure setup 

After configuring other test parameters as described in the “Configuring test parameters” on page 297, 
you can continue your measurement. The measurement settings can be saved and recalled as a file. 
You can also use JDViewer, PC application software to configure a measure setup, save as a file, and 
load the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the incremental step for the PN offset, complete the following steps: 

 Press the PN Increment soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

3 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 32 for more information. 

 

Setting limit for OTA channel scanner 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Limit Line soft key to set a threshold for the limit line and Pass/Fail indication. 
3 Enter a value, and then press the dBm unit soft key. 
4 Toggle the Limit Line soft key between On and Off to display or dismiss the limit line. 
5 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 

Toggle the Beep soft key between On and Off to enable or disable the beep sound. 
6 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 

See “Using save” on page 32 for more information. 
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Measurement example 

Figure 160 Channel scanner measurement with CDMA OTA signal analyzer 

 
 

PN scanner 

Each access network sector has a unique PN offset. The PN Scanner is used to identify all the active 
PNs in an area. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 297, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the incremental step for the PN offset, complete the following steps: 

 Press the PN Increment soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

3 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 32 for more information. 
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Measurement example 

Figure 161 PN scanner measurement with CDMA OTA signal analyzer 

 
 

Multipath profile 

The Multipath Profile enables you to determine RF environmental conditions of testing area. It 
indicates the amount of power of the dominant pilot signal that is dispersed outside the main 
correlation peak due to multipath echoes that are expressed in dB. This value should be very small 
ideally. 
 
The multipath profile is the result of portions of the original broadcast signal arriving at the receiving 
antenna out of phase. This can be caused by the signal being reflected off objects such as buildings, 
or being refracted through the atmosphere differently from the main signal. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 297, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the incremental step for the PN offset, complete the following steps: 

 Press the PN Increment soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

3 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 32 for more information. 
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Measurement example 

Figure 162 Multipath profile measurement with CDMA OTA signal analyzer 

 
 

Code domain power 

Channels with high correlation factors are determined to be active channels and are indicated as such 
on the display. Once the channels are decoded, the analyzer determines the power of each channel 
relative to the total signal power. 
 
This measurement helps to verify that each code channel is operating at its proper level and helps to 
identify problems throughout the transmitter design from the coding to the RF section. System 
imperfections, such as the non-linearity of amplifiers, will present themselves as an undesired 
distribution of power in the code domain. 
 

Setting measure setup 

After configuring test parameters as described in “Configuring test parameters” on page 297, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can 
also use JDViewer, PC application software to configure a measure setup, save as a file, and load the 
file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the Pseudo-Noise (PN) offset, complete the following steps: 

 Toggle the PN Offset soft key between Auto and Manual. a
 Enter a value by using the numeric keys to set manually. b
 Press the Enter soft key. c

3 To set the incremental step for the PN offset, complete the following steps: 
 Press the PN Increment soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

4 To set the threshold between Auto and Manual, complete the following steps: 
 Press the Threshold soft key. Its default setting is -27 dB. a
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 Enter a value between -50 and zero by using the numeric keys to change the value in the b
Manual mode. 

 Press the Enter soft key. c
5 Toggle the Q-Paging soft key between On and Off to enable or disable the quick page channel 

that indicates the power of Quick Page Walsh code 80. 
6 To set the maximum amplifier power, complete the following steps: 

 Press the Max Amplifier Power soft key. a
 Enter a value by using the numeric keys. b
 Press the dBm soft key. c

7 To set the pilot power, complete the following steps: 
 Press the Pilot Power soft key. a
 Enter a value by using the numeric keys. b
 Press the dBm soft key. c

8 To set the threshold for pilot dominance, complete the following steps: 
 Press the More (1/2) > Pilot Dominance > soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

 

 NOTE 
Recommended value is 10. Color of the Pilot Dominance indicator on the screen bases 
on this setting. 

 

9 To set the threshold for multipath power, complete the following steps: 
 Press the More (1/2) > Multipath Power < soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

 

 NOTE 
Recommended value is one. Color of the multipath power indicator on the screen bases 
on this setting. 

 

10 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 32 for more information. 
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Measurement example 

Figure 163 Code domain power measurement with CDMA OTA signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. 

 

Setting display 

You can view your measurement results in a different view option. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Code Order soft key, and then select the code order option from the following choices: 

–  Hadamard: To assign the number based on Walsh code order and display the measured 
code power according to the assigned number in sequence. 

–  Bit Reverse: Code number in binary bit is reversed relative to the Hadamard method. 

3 Toggle the Base Code Length soft key and select the base Walsh code number: 64 or 128. 

 

Route map 

The JD700B Series provides indoor and outdoor mapping function that allows a user to collect data of 
points in an indoor or outdoor environment and track the received signals and coverage of RF 
transmitters plotting real time directly on top of a loaded floor plan or a map. 
 

Setting measure setup 

Procedure 

1 If required, connect a GPS receiver to your JD700B series for outdoor mapping. 
Indoor mapping does not necessarily need a GPS antenna. 

2 Configure test parameters as described in the “Configuring test parameters” on page 297. 
3 To load your map file, complete the following steps: 
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 Plug in your USB drive that has a floor map or .mcf file type created in JDMapCreator. a
 

 NOTE 
The JDMapCreator converts and resizes any scanned floor plan or layout to fit onto your 
instrument’s display. You must save your map file (.mcf) into the “SavedMap” folder of 
your USB drive so that you can load them onto your instrument. 

 

 Press SAVE/LOAD hot key, and then select Load > Load Map. b
See “Using load” on page 34 for more information. 

4 Press the MEASURE SETUP hot key. 
5 Press the Plot Point soft key, and then select the plot point option from the following choices: 

–  To collect data/plot points automatically as you move around in a vehicle or outside, press 
the GPS soft key and then toggle the Screen Mode soft key between Map and Full. 

 

 NOTE 
With the Map setting, you can view only the collected points that can be seen within the 
boundary of the loaded map. If a point is off the map, the instrument displays an arrow to 
indicate the direction of the current location on the map and the distance from the center 
to the location at the top of the screen. With the Full setting, you can view all the 
collected points of the route without the loaded map. 

 

–  To collect data/plot points manually without a GPS antenna in an indoor environment, press 
the Position soft key. 

6 Press the Plot Item soft key, and then select the measurement option: Pilot Power or Ec/Io. 
7 To set the incremental step for the PN offset, complete the following steps: 

 Press the PN Increment soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

8 Toggle the Plot soft key and select Start. 
9 Touch directly on the screen or press the ENTER hard key to collect data and plot points on the 

loaded map for the Position setting. 
 

 NOTE 
For the Position setting, you can change the direction of the route with the arrow keys 
and the distance with the rotary knob. 

 

10 Toggle the Plot soft key and select Stop to stop plotting. 
11 Press the SAVE/LOAD hot key to save the result. 

See “Using save” on page 32 for more information. 
 

 NOTE 
The instrument does not automatically save the collected data. It is recommended that 
you save the result. Otherwise, you will lose all the collected data. 

 

 

Setting limit 

You can set the thresholds for the four different color indicators for Pilot power or Ec/Io. 
 

Procedure 

1 Press the LIMIT hot key. 
2 To set the limits for pilot power if you have selected Pilot for the plot item, complete the following 

steps: 
 Press the Pilot Power soft key. a
 Press the Excellent soft key to set its threshold. a
 Enter a value, and then press the dBm soft key. You can also use the rotary knob. b
 Press the Very Good soft key to set its threshold. c
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 Enter a value, and then press the dBm soft key. You can also use the rotary knob. d
 Press the Good soft key to set its threshold. e
 Enter a value, and then press the dBm soft key. You can also use the rotary knob. f
 Press the Fair soft key to set its threshold. g
 Enter a value, and then press the dBm soft key. You can also use the rotary knob. h

 Press the Poor soft key to set its threshold. i
 Enter a value, and then press the dBm soft key. You can also use the rotary knob. j

3 To set the limits for Ec/Io if you have selected as for the plot item , complete the following steps: 
 Press the Ec/Io soft key. a
 Press the Good soft key to set its threshold. b
 Enter a value, and then press the Enter soft key. You can also use the rotary knob. c
 Press the Fair soft key to set its threshold. d
 Enter a value, and then press the Enter soft key. You can also use the rotary knob. e
 Press the Poor soft key to set its threshold. f
 Enter a value, and then press the Enter soft key. You can also use the rotary knob. g

4 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 32 for more information. 

 

Measurement example 

Figure 164 Route map measurement with CDMA OTA signal analyzer 

1) Pilot Power 
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2) Pilot Ec/Io 
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Introduction 

The EV-DO Signal Analyzer of the JD700B series performs power and spectrum measurements as 
well as modulation analysis to test the proper transmitter performance of EV-DO systems. It performs 
conformance testing according to the following standards providing a simple Pass/Fail indication on 
each test. 
 

 3GPP2 C.S0024-B. cdma2000 High Rate Packet Data Air Interface Specification 

 3GPP2 C.S0032-B. Recommended Minimum Performance Standards for cdma2000 High 
Rate Packet Data Access Network 

 
You may alter the measurement parameters for specialized analysis. Pass/Fail testing with standard 
defined or user defined upper and lower limits and the Pass/Fail indictor help you to determine base 
station performance easily. 
 
This instrument provides the following measurement tools for EV-DO system: 
 

 Spectrum Analysis 

 RF Analysis 
- Channel Power 
- Occupied Bandwidth 
- Spectrum Emission Mask (SEM) 
- Adjacent Channel Power Ratio (ACLR) 
- Multi-ACPR 
- Spurious Emissions 

 Power vs. Time: Idle Slot and Active Slot 

 Modulation Analysis 
- Constellation 
- Code Domain Power 
- MAC Codogram 
- Received Code Strength Indicator (RCSI) 
- MAC CDP Table 

 Auto Measure 

 Power Statistics CCDF 

 Over The Air (OTA) 
- Channel Scanner 
- PN Scanner 
- Multipath Profile 
- Code Domain Power 
- Route Map 

Display overview 

Figure 165 provides descriptions for each segment of the measurement screen. 
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Figure 165 EV-DO signal analyzer measurement screen 

 

 

Connecting a cable 

Direct connection 

Procedure 

1 Connect the Spectrum Analyzer RF In port of the JD700B series and the Power amplifier output 
port of BTS. 

 
Figure 166 Direct connection 

 
JD785B/JD745B 

 
JD788B/JD748B 

 

Indirect connection 

Procedure 

1 Connect the Spectrum Analyzer RF In port of the JD700B series and the monitor (test) port of 
BTS. 
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Figure 167 Indirect connection 

 
JD785B/JD745B 

 
JD788B/JD748B 

 

 

CAUTION 
The maximum power for the Spectrum Analyzer RF In port is +25 dBm (0.316 W) for 
JD780B series and +20 dBm (0.1 W) for JD740B series. If the level of the input signal to 
be measured is greater than this, use a High Power Attenuator to prevent damage 
when you directly connect the signal to the instrument or connect the signal from the 
coupling port of a directional coupler. 

 

Over the air (OTA) 

Procedure 

1 Connect an Omni/directional RF antenna to the Spectrum Analyzer RF In port of the JD700B 
series. 

2 Connect a GPS antenna to the GPS port of the JD700B series. 

 
Figure 168 OTA connection 

 
JD785B/JD745B 

 
JD788B/JD748B 

 

 

CAUTION 
If the input signal level to be measured is less than 0 dBm, set 0 dB attenuation or turn on 
the preamp to have better dynamic range for the OTA testing. 
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Selecting measurement mode 

Procedure 

1 Press the MODE hard key. 
2 Press the Signal Analyzer soft key. 
3 Press the EV-DO soft key. The Spectrum mode is set by default. 
4 Press the MEASURE hot key, and then select the measurement mode option from the following 

choices: 
–  Spectrum 

–  RF Analysis > Channel Power, Occupied BW, Spectrum Emission Mask, ACPR,  
Multi-ACPR, or Spurious Emissions 

–  Power vs Time > Power vs Time (Idle Slot) or Power vs Time (Active Slot) 

–  Modulation Analysis > Constellation > Composite 64, Composite 128, Pilot, MAC 64, 
MAC 128, or Data 

–  Modulation Analysis > Code Domain Power > Pilot, MAC 64, MAC 128, or Data 

–  Modulation Analysis > MAC Codogram, RCSI, or MAC CDP Table 

–  Auto Measure 

–  Power Statistics CCDF 

–  OTA > Channel Scanner, PN Scanner, Multipath Profile, Code Domain Power,  
or Route Map 

 

Configuring test parameters 

Setting frequency 

You can set the frequency with either frequency or channel number. If a frequency to be set matches 
to the frequency corresponding to the selected channel standard, the instrument calculates its channel 
number and updates the screen with it automatically. 
 

Procedure 

To set the center frequency: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Freq. 
3 Press the Center Frequency soft key. 
4 Enter a value by using the numeric keys. You can also use the rotary knob. 
5 Select the unit: GHz, MHz, kHz, or Hz. 
6 Optional. To define the amount of frequency increment for the rotary knob, complete the following 

steps: 
 Press the Frequency Step soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the unit: GHz, MHz, kHz, or Hz. c

 
To set the channel number: 

1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Channel. 
3 To select the standard channel, complete the following steps: 

 Press the Channel Std soft key. The standard channel window appears. a
See “Appendix C – Band, frequency & channel standard” on page 530 for more information. 
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 Highlight the band to be measured by using the rotary knob, the arrow keys, or the Page b
Up/Page Down soft keys. 

 Press the Select soft key or the rotary knob to confirm the selection. c
4 Press the Channel Number soft key. 
5 Enter a value by using the numeric keys. You can also use the rotary knob. 
6 Press the Enter soft key. 
7 The instrument automatically displays the corresponding center frequency value for the selected 

channel number. 
8 Optional. To define the amount of channel increment for the rotary knob, complete the following 

steps: 
 Press the Channel Step soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

 
 NOTE 

This frequency setting is not used in the Multi-ACLR and Spurious Emissions modes. 
 

Setting amplitude 

Reference level and attenuation 

You can set the reference and attenuation levels automatically or manually to optimize the display of 
the traces measured, as you desire. 
 

Procedure 

To automatically set the reference and attenuation level: 
1 Press the AMP/SCALE hard key. 
2 Press the Auto Scale soft key. 

Each time you press this key, both of the Y-axis scale and input attenuation level change to be 
optimized with some margin. 

 
To set the reference or attenuation level manually: 

1 Press the AMP/SCALE hard key. 
2 To set the maximum reference value on the Y-axis manually, complete the following steps: 

 Press the Reference Level soft key. a
 Enter a value by using the numeric keys or the rotary knob with 10 dB increments. b
 Press the dBm soft key or the ENTER hard key. c

This unit key name changes according to the setting in the Units menu. 
 

 NOTE 
In the measurements such as Code Domain Power and MAC Codogram, you may 
need to select the reference option between Relative and Absolute before setting the 
reference level. 

 

3 To set the attenuation option, select one from the following choices: 
–  To set the input attenuator’s level automatically, select Attenuation > Auto. 

 

 NOTE 
It is recommended that you set the Attenuation to Auto in most situations so that the 
level of the input attenuator can be set automatically according to your input signal level. 

 

–  To set the input attenuation manually up to 55 dB for JD780B series or 50 dB for JD740B 
series to optimize S/N, complete the following steps: 

 Select Attenuation > Manual. a
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 Press the Attenuation Value soft key to set the level. b
 Enter a value in fives by using the numeric keys. c
 Press the dB soft key or the ENTER hard key. d

–  To couple the input attenuator’s level with your reference level setting, select Attenuation > 
Couple. 
As you increase the reference setting, the attenuation level also increases acoordingly. 

 
Optional. To change the scale unit: 

1 Select More (1/2) > Units. 
2 Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W. 

The scale unit on the screen changes accordingly. 
 

 NOTE 
This Units menu is available in the Spectrum and RF Analysis modes. 

 

 

Scale per division 

You can use the Scale/Div feature available for the spectrum and RF analysis. It represents the value 
of one division on the horizontal scale. The default setting is 10 dB per division and the maximum 
value can be set up to 20 dB. 
 

Procedure 

To set the scale per division: 
1 Press the AMP/SCALE hard key. 
2 Select More (1/2) > Scale/Div. 
3 Enter a value between 1 and 20 by using the numeric keys. 
4 Press the dB soft key to complete the entry. 

 

Pre-amplifier 

You can turn the internal pre-amplifier on to correct and compensate for the gain of the preamp so that 
amplitude readings show the value at the input connector. 
 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Toggle the Preamp soft key and select On or Off as needed. 

 
 NOTE 

You can turn the Preamp on when the input attenuation range is from 0 dB to 10 dB. If 
the attenuation value is manually set to greater than 10 dB, the instrument will 
automatically turn off the pre-amplifier to display low-level signal properly on the chart. 

 

External offset 

You can turn the External Offset on and manually set the external offset value. An offset consists of a 
cable loss and a user offset and the measurement result shows the value reflecting both offset values. 
When the external offset value is set at 40 dB in the Spectrum mode, the measurement result 
compensates 40 dB at both the Spectrum Analyzer and Signal Analyzer modes 
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Procedure 

To set the external offset: 
1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select On. 
3 Enter a value by using the numeric keys. 
4 Press the dB soft key to complete the entry. 

 
To turn the external offset off: 

1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select Off. 

 

Setting average 

You can set the number of measurements to be averaged for the trace presentation. A maximum of 
100 times of averaging can be set. When the averaging reaches to your setting, a new measurement 
value replaces the measurement value in sequence from the earliest. 
 

Procedure 

1 Press the BW/AVG hard key. 
2 Press the Average soft key. 
3 Enter a value between 1 and 100 as needed by using the numeric keys. 
4 Press the Enter soft key. 

 

Setting sweep mode 

The default setting is Continue to sweep continuously for most on-going measurements. If you want to 
hold the measurement or get a single sweep, you can change the sweep mode. 
 

Procedure 

To select the single sweep mode: 
1 Press the SWEEP hot key. 
2 Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key. 

The letter HOLD in red appears and the sweeping is paused. 
3 Optional. Press the Sweep Once soft key to get a new measurement. 

 
To return to the continuous sweep mode: 

1 Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key. 
The letter HOLD in red disappears and the sweeping resumes. 

 

Setting trigger source 

You can set the trigger source option for your measurements. Connecting an external trigger is 
necessary for accurate modulation measurements on EV-DO systems. 

Procedure 

1 Press the TRIGGER hot key. 
2 Select the trigger source option from the choices: Internal, External, and GPS. 
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Setting external clock 

To enhance the reliability of modulation analysis measurements the JD700B series must be 
synchronized with a base station. When an external clock is not supplied, the instrument works with its 
built-in internal high-accuracy time base and some measurement results may exhibit inaccurate values. 
Therefore, it is highly recommended that you use the same reference clock as the signal source. You 
can use the TRIGGER hot key to set the external clock. 
 

Table 17 Standards of external clock operation 

Clock Type Reference Port Switching Standard 

External Reference Internal Internal 10 MHz  Default 

 External External Ref Clock Ext Ref (SMA) Manual switching 
(Input signal level >-3 dBm) 

 GPS GPS Clock GPS (SMA) Automatic switching 
(GPS signal received) 

Trigger Internal Internal Trigger  Default 

 External External Trigger Trigger (SMA) Manual switching 

 GPS GPS GPS (SMA) Manual switching 

 
Figure 169 Connection ports for external reference clock 

 
 

Procedure 

1 Connect an external reference or a GPS antenna to the JD700B series. 
2 Press the SYSTEM hot key. 
3 Press the Freq Reference soft key, and then select the reference option: Internal, External 10 

MHz, External 13 MHz, External 15 MHz, or GPS. 

 
 NOTE 

When a GPS antenna is connected and locked, GPS coordinates (longitude and latitude) 
are displayed on the screen and frequency reference is automatically set to GPS in the 
System > Freq Reference. 

 
Table 18 External reference indicators 

Type Indicator Description 

Internal  (green) The green INT icon indicates that the instrument uses the built-in 
internal time base. 
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External  (green) The green EXT icon indicates that an external reference is connected 
and locked and that the instrument uses the same reference clock as 
the signal source. 

External  (red) The red EXT icon indicates that an external reference is connect but not 
locked. 

GPS      (green) The green GPS antenna icon indicates that a GPS antenna is 
connected and locked. 

GPS      (yellow) The yellow GPS antenna icon indicates that a GPS antenna is 
connected and locking is in progress. 

GPS      (grey) The grey GPS antenna icon indicates that a GPS antenna is not 
connected, failed, or unable to be locked. 

 

Conducting spectrum measurements 

If you have configured test parameters as described in the “Configuring test parameters” on page 335, 
your measurement result is displayed on the screen as like the following example, Figure 170. 
 

Figure 170 Spectrum measurement screen with EV-DO signal analyzer 

 
 

Setting trace 

You can display up to six traces on the measurement chart simultaneously. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6. 

The legend shape of the selected trace changes from square to round to indicate that the trace is 
the active one now. 

3 Toggle the Trace View soft key and select On. 
4 Do one of the following: 
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To Select Trace Legend 

Clear current data and display with new 
measurements 

Clear Write W 

Display the input signal’s maximum response only 
(unlimited or for a certain amount of time) 

Max Hold M 

Display the input signal’s minimum response only 
(unlimited or for a certain amount of time) 

Min Hold m 

Capture the selected trace and compare traces Capture C 

Load a saved trace More (1/2) > Load L 

Hide the selected trace Trace View > Off F 

Remove all the traces and initialize the trace 
settings 

More (1/2) > Trace 
Clear All 

 

 

 NOTE 
For the Max Hold and Min Hold, your instrument compares newly acquired data with the 
active trace and displays larger maximum values or smaller minimum values on the 
screen. You can set it to Unlimited to hold and view maximum or minimum data or 
specify a certain amount of time up to 60 seconds by using numeric keys or the rotary 
knob. 

5 Optional. Press the More (1/2) > Trace Info soft key, and then select the trace number to view 
the trace’s parameter setting information stored at the time of the measurement or None to hide 
the information display. 

6 Optional. If you have the two traces T1 and T2, you can perform trace math. To view the power 
difference between the traces, press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key. 
The result is overlaid on the screen along with the second Y-axis. 

 

Conducting RF measurements 

Channel power 

The Channel Power measurement is a common test used in the wireless industry to measure the total 
transmitted power of a radio within a defined frequency channel. It acquires a number of points 
representing the input signal in the time domain, transforms this information into the frequency domain 
using Fast Fourier Transform (FFT), and then calculates the channel power. The effective resolution 
bandwidth of the frequency domain trace is proportional to the number of points acquired for the FFT. 
 
The channel power measurement identifies the total RF power, power spectral density (PSD) and peak 
to average ratio (PAR) of the signal in the EV-DO channel bandwidth (1.23 MHz). 
 
After configuring test parameters as described in the “Configuring test parameters” on page 335, your 
measurement result is displayed on the screen as like the following example, Figure 171. 
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Figure 171 Channel power measurement with EV-DO signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 347 for more 
information. 

 

Occupied bandwidth 

The Occupied Bandwidth measures the spectrum shape of the carrier. It is defined as the bandwidth, 
which includes 99% of the transmitted power among total transmitted power. 
 
After configuring test parameters as described in the “Configuring test parameters” on page 335, your 
measurement result is displayed on the screen as like the following example, Figure 172. 
 

Figure 172 Occupied bandwidth measurement with EV-DO signal analyzer 
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 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 347 for more 
information. 

 

Spectrum emission mask (SEM) 

The Spectrum Emission Mask (SEM) measurement required by 3GPP2 specifications encompasses 
different power limits and different measurement bandwidths (resolution bandwidths) at various 
frequency offsets. It may be expressed as a ratio of power spectral densities between the carrier and 
the specified offset frequency band. It provides useful figures-of-merit for the spectral re-growth and 
emissions produced by components and circuit blocks, without the rigor of performing a full SEM 
measurement. 
 
The SEM measures spurious signal levels in up to five pairs of offset or region frequencies and relates 
them to the carrier power. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 335, your 
measurement result is displayed on the screen as like the following example, Figure 173. 
 

Figure 173 SEM measurement with EV-DO signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 347 for more 
information. 

 

ACPR 

The Adjacent Channel Power Ratio (ACPR) is defined as the ratio of the average power in the 
adjacent frequency channel (or offset) to the average power in the transmitted frequency channel. It 
may be expressed as the ratio of the integrated signal power in the adjacent channel to the integrated 
signal power in the main channel. 
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After configuring test parameters as described in the “Configuring test parameters” on page 335, your 
measurement result is displayed on the screen as like the following example, Figure 174. 
 

Figure 174 ACPR measurement with EV-DO signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 347 for more 
information. 

 

Multi-ACPR 

The Multi-ACPR measurement is used to perform multi-channel ACPR measurements with as many 
channels as possible. It helps you to measure ACPR in multi-channel transmitting Base Station 
environment. 
 

Setting frequency for Multi-ACPR 

You can set the frequency with either frequency or channel number. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the frequency, do one of the following: 

–  To set the center frequency, complete the following steps: 
 Toggle the Unit soft key and select Freq. a
 Press the Lowest Frequency soft key to set the starting center frequency. b
 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Select the unit: GHz, MHz, kHz, or Hz. d
 Press the Highest Frequency soft key to set the stopping center frequency. e
 Enter a value by using the numeric keys. You can also use the rotary knob. f
 Select the unit: GHz, MHz, kHz, or Hz. g

–  To set the channel number, complete the following steps: 
 Toggle the Unit soft key and select Channel. a
 To select the standard channel, press the Channel Std soft key and then select the b
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band to be measured. 
 Press the Lowest Channel soft key to set the starting channel. c
 Enter a value by using the numeric keys. You can also use the rotary knob. d
 Press the Enter soft key. e
 Press the Highest Channel soft key to set the stopping channel. f
 Enter a value by using the numeric keys. You can also use the rotary knob. g
 Press the Enter soft key. h

 
After configuring the test parameters, your measurement result is displayed on the screen as like the 
following example, Figure 175. 
 

Figure 175 Multi-ACPR measurement with EV-DO signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 347 for more 
information. 

 

Spurious emissions 

Out-of-band emissions are unwanted emissions immediately outside the channel bandwidth resulting 
from the modulation process and non-linearity in the transmitter but excluding spurious emissions. The 
Spurious Emissions measurement is to identify and determine the power level of out-of-band spurious 
emission within the necessary channel bandwidth and modulated signal measured at the RF port of 
the Base Station. 
 

Setting measure setup 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set up the range table and frequency range, press the Range Table soft key and then 

complete the following steps: 
 Press the Range soft key, and then enter the range number to add a new range or change a

an existing one. 
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 Press the Enter soft key. b
 Press the Start Frequency soft key to set up the frequency range. c
 Enter a value by using the numeric keys. You can also use the rotary knob. d
 Select the unit: GHz, MHz, kHz, or Hz. e
 Press the Stop Frequency soft key to set up the frequency range. f
 Enter a value by using the numeric keys. You can also use the rotary knob. g
 Select the unit: GHz, MHz, kHz, or Hz. h

3 Toggle the Range soft key between On and Off to display or hide the selected range. 
4 To set up the test limits for Pass/Fail indication, complete the following steps: 

 Press the Start Limit soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the dBm soft key. c
 Press the Stop Limit soft key. d
 Enter a value by using the numeric keys. You can also use the rotary knob. e
 Select the dBm soft key. f

5 To set up the other parameters, complete the following steps: 
 Select More (1/2) > Attenuation to set up the attenuation value. a
 Enter a value in the multiple of five. b
 Press the dB soft key or the ENTER hard key. c
 Press the RBW soft key. d
 Enter a value by using the numeric keys. e
 Select the unit: GHz, MHz, kHz, or Hz. f
 Press the VBW soft key. g
 Enter a value by using the numeric keys. h

 Select the unit: GHz, MHz, kHz, or Hz. i
6 Press the PREV hard key. 
7 Toggle the Measure Type soft key between Examine and Full to select the measurement type. 

 

 NOTE 
The Examine mode displays only the selected range while the Full mode lets the 
instrument automatically changes the selected range from one another. 

 

8 Set the number of measurements to be averaged: 
 Press the Average soft key. a
 Enter a value between 1 and 100. b
 Press the Enter soft key. c

 
After configuring test parameters as described in the “Configuring test parameters” on page 335, your 
measurement result is displayed on the screen as like the following example, Figure 176. 
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Figure 176 Spurious emissions measurement with EV-DO signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 347 for more 
information. 

 

Setting limit for RF tests 

By default, test limits specified in the standard are set for you. You can change thresholds if you desire. 
 

Procedure 

1 Press the LIMIT hot key. 
2 Press the RF Test Limits soft key. 
3 Select the test item(s) and set the limit(s) depending on your selected measurement mode: 

 

To set the limit for Select Set 

Channel power Channel Power High Limit 
Low Limit 

Occupied bandwidth Occupied BW High Limit 

Spectrum emission mask Spectrum Emission Mask (On/Off only) 

ACPR ACPR (On/Off only) 

Multi-ACPR Multi-ACPR (On/Off only) 

Spurious emissions Spurious Emissions (On/Off only) 
 

4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 32 for more information. 
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Conducting power vs. time measurements 

The Power vs. Time (Idle Slot and Active Slot) in EV-DO Signal Analyzer verifies that the transmitter 
output power has correct amplitude, shape, and timing for the EV-DO format. 
 

 Idle Slot: Slot with no data in traffic channel. 

 Active Slot: Slot with the loaded data in traffic channel. 
 
Forward link of 1xEV-DO is a frame structure and each frame consists of 16 slots. The frame period for 
1xEV-DO is 26.667 ms, which is also the period of one pilot channel. Each frame is divided into 16 
slots of 1.666 ms. 1xEV-DO uses CDMA modulation scheme, but unlike its previous systems the Pilot, 
MAC (Media Access Control), and Data (Traffic) Channel are not transmitted simultaneously; instead 
they are transmitted in TDM (Time Division Multiplex). 
 

Power vs. time (idle slot) 

The Power vs. Time (Idle Slot) measurement provides the idle slot that includes the Pilot and MAC 
channels with the masks in all regions. 
 
After configuring test parameters as described in the “Configuring test parameters” on page 335, your 
measurement result is displayed on the screen as like the following example, Figure 177. 
 

Figure 177 Power vs. time (idle slot) measurement with EV-DO signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for power vs. time tests” on page 349 for 
more information. 

 

Power vs. time (active slot) 

The Power vs. Time (Active Slot) measurement includes the Pilot, MAC, and Data channels with the 
upper and lower masks. 
 
After configuring test parameters as described in the “Configuring test parameters” on page 335, your 
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measurement result is displayed on the screen as like the following example, Figure 178. 
 

Figure 178 Power vs. time (active slot) measurement with EV-DO signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for power vs. time tests” on page 349 for 
more information. 

 

Setting limit for power vs. time tests 

Procedure 

1 Press the LIMIT hot key. 
2 Press the PvsT Test Limits soft key. 
3 Select the test item(s) and set the limit(s): 

 

To set the limit for Select Set 

Pilot power Pilot Power High Limit 
Low Limit 

Medium access control power MAC Power High Limit 
Low Limit 

Data power during the data period Data Power High Limit 
Low Limit 

On/off power ratio of the pilot and MAC 
powers to the data power 

On/Off Ratio Low Limit 

 

4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 32 for more information. 
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Conducting modulation measurements 

In order to make accurate measurements of time offset and PN, you must connect an external trigger 
before making a modulation measurement. 
 

Constellation 

The Constellation is used to observe some aspects of modulation accuracy and can reveal certain 
fault mechanisms such as I/Q amplitude imbalance or quadrature imbalance. It displays constellation 
diagram by modulation types. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 335, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the Pseudo-Noise (PN) offset, complete the following steps: 

 Toggle the PN Offset soft key between Auto and Manual. a
 Enter a value by using the numeric keys to set manually. b
 Press the Enter soft key. c

3 To set the incremental step for the PN offset, complete the following steps: 
 Press the PN Increment soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

4 Press the Detect Mode soft key, and then select the detection mode option: Auto, QPSK, 8PSK, 
16 QAM, or 64 QAM. 

5 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 32 for more information. 

 
 NOTE 

You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 359 for 
more information. The Max Inactive is not used in the Constellation mode. 
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Measurement example 

Figure 179 Constellation measurement with EV-DO signal analyzer 

1) Composite 64 

 

2) Composite 128 
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3) Pilot 

 

4) MAC 64 

 

5) MAC 128 
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6) Data 

 
 

Code domain power 

The Code Domain Power (CDP) measures the distribution of power across the set of code channels, 
normalized to the total EV-DO power. It helps to verify that each code channel is operating at its proper 
level and to identify problems throughout the transmitter design from coding to the RF section. System 
imperfections such as amplifier non-linearity will present themselves as an undesired distribution of 
power in the code domain. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 335, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the Pseudo-Noise (PN) offset, complete the following steps: 

 Toggle the PN Offset soft key between Auto and Manual. a
 Enter a value by using the numeric keys to set manually. b
 Press the Enter soft key. c

3 To set the incremental step for the PN offset, complete the following steps: 
 Press the PN Increment soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

4 To set the threshold between Auto and Manual, complete the following steps: 
 Press the Threshold soft key. Its default setting is -27 dB. a
 Enter a value between -50 and zero by using the numeric keys to change the value in the b

Manual mode. 
 Press the Enter soft key. c

5 Press the Detect Mode soft key, and then select the detection mode option: Auto, QPSK, 8PSK, 
16 QAM, or 64 QAM. 

6 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
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for your measurement mode. See “Using save” on page 32 for more information. 

 
 NOTE 

You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication for the Max Inactive. See “Setting limit for modulation tests” 
on page 359 for more information. 

 

Measurement example 

Figure 180 Code domain power measurement with EV-DO signal analyzer 

1) Pilot 

 

2) MAC 64 
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3) MAC 128 

 

4) Data 

 
 

MAC Codogram 

The MAC Codogram displays the power variation for every code over time, presenting a clear view of 
the traffic load per channels at any given time. The MAC Codogram measurements can be saved into 
an external USB memory so that a post-analysis can be done with the application software JDViewer. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 335, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the Pseudo-Noise (PN) offset, complete the following steps: 
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 Toggle the PN Offset soft key between Auto and Manual. a
 Enter a value by using the numeric keys to set manually. b
 Press the Enter soft key. c

3 To set the incremental step for the PN offset, complete the following steps: 
 Press the PN Increment soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

4 To set the threshold between Auto and Manual, complete the following steps: 
 Press the Threshold soft key. Its default setting is -27 dB. a
 Enter a value between -50 and zero by using the numeric keys to change the value in the b

Manual mode. 
 Press the Enter soft key. c

5 Toggle the MAC soft key and select the MAC Walsh code option: 64 or 128. 
6 To set the time interval, complete the following steps: 

 Press the Time Interval soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

7 To place the time cursor to analyze your measurements, complete the following steps: 
 Toggle the Time Cursor soft key between On and Off to enable or disable the time cursor. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

 

 NOTE 
When the time cursor is enabled, the measurement is put on hold and information about 
the time cursor is displayed. 

 

8 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 32 for more information. 

 

Measurement example 

Figure 181 MAC Codogram in full view with EV-DO signal analyzer 

 
 

RCSI 

The Received Code Strength Indicator (RCSI) is used to track the power variation over time of EV-DO 
channels: Pilot, MAC, Data, and Slot. The RCSI measurements can be saved into an external USB 
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memory so that a post-analysis can be done with the application software JDViewer. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 335, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the Pseudo-Noise (PN) offset, complete the following steps: 

 Toggle the PN Offset soft key between Auto and Manual. a
 Enter a value by using the numeric keys to set manually. b
 Press the Enter soft key. c

3 To set the incremental step for the PN offset, complete the following steps: 
 Press the PN Increment soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

4 To set the threshold between Auto and Manual, complete the following steps: 
 Press the Threshold soft key. Its default setting is -27 dB. a
 Enter a value between -50 and zero by using the numeric keys to change the value in the b

Manual mode. 
 Press the Enter soft key. c

5 Toggle the MAC soft key and select the MAC Walsh code option: 64 or 128. 
6 Press the Alarm Code soft key, and then select the alarm code option: None, Pilot, MAC, Data, 

or Slot. 
7 To set the alarm mask, complete the following steps: 

 Press the Set Mask soft key. a
 Enter a value by using the numeric keys. b
 Press the [dB|dBm] soft key. c

8 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 32 for more information. 
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Measurement example 

Figure 182 RCSI measurement with EV-DO signal analyzer 

 
 

MAC CDP Table 

The MAC CDP Table is used for the user to look at a numeric and textual description of all the active 
control channels in the signal. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 335, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the Pseudo-Noise (PN) offset, complete the following steps: 

 Toggle the PN Offset soft key between Auto and Manual. a
 Enter a value by using the numeric keys to set manually. b
 Press the Enter soft key. c

3 To set the incremental step for the PN offset, complete the following steps: 
 Press the PN Increment soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

4 To set the threshold between Auto and Manual, complete the following steps: 
 Press the Threshold soft key. Its default setting is -27 dB. a
 Enter a value between -50 and zero by using the numeric keys to change the value in the b

Manual mode. 
 Press the Enter soft key. c

5 Toggle the MAC soft key and select the MAC Walsh code option: 64 or 128. 
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Measurement example 

Figure 183 MAC CDP Table measurement with EV-DO signal analyzer 

 
 

Setting display 

If the MAC CDP table spans over to the next page(s), you can change pages up and down to view 
your measurement results. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Select Page Up or Page Down as needed to scroll the screen up and down. 

 

Setting limit for modulation tests 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Modulation Test Limits soft key. 
3 Select the test item(s) and set the limit(s) depending on your selected measurement mode: 

 

To set the limit for Select Set 

Frequency error Frequency Error High Limit 
Low Limit 

Time offset Time Offset High Limit 
Low Limit 

Carrier feed through Carrier Feed Through High Limit 

Highest level among inactive channels Max Inactive High Limit 

Waveform quality (Rho) for pilot Pilot Rho Low Limit 

Waveform quality (Rho) for MAC MAC Rho Low Limit 

Waveform quality (Rho) for data Data Rho Low Limit 
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4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 32 for more information. 

 
 NOTE 

The Time Offset compares the PN offset timing with the overall system time and the 
instrument checks the start of PN offset in comparison to either the GPS signal or the 
even second clock signal. 

 
 NOTE 

The Carrier Feed Through is a result of the RF carrier signal feeding through the I/Q 
modulator and riding on the output circuitry without being modulated. 

 

Performing auto measurements 

The Auto Measure function of the JD700B series allows a complete signal profiling covering RF 
characterization and modulation quality parameters of up to 10 different carriers, particularly useful on 
an overlay architecture where base stations are transmitting in different frequencies. 
 
The Auto Measure can be easily executed either by selecting a menu in the instrument or by running a 
programmed scenario in the PC-based application so that the instrument automatically configure and 
perform tests on every aspect of all the carriers. 
 

Setting limit for auto measure 

You can set test limits for test item(s) in the auto measurement. 

Procedure 

1 Press the LIMIT hot key. 
2 Press the RF Test Limits soft key, and then enable test limits as desired. 
3 Press the PvsT Test Limits soft key, and then enable test limits as desired. 
4 Press the Modulation Test Limits soft key, and then enable test limits as desired. 
5 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 

Toggle the Beep soft key between On and Off to enable or disable the beep sound. 
6 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 

See “Using save” on page 32 for more information. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 335, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the Configuration soft key and select the configuration option: 

–  Current: Lets the instrumnet use current frequency (single carrier) and determine pass or 
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fail based on the instrument’s limit settings in Auto Measure. 

–  Scenario: Runs a test with a programmed scenario in JDViewer. 
The Scenario menu becomes activated. 

3 To load a scenario, press the Scenario soft key, and then select a scenario file to load. 
4 Toggle the Test Time soft key and select the test time option: 

–  Now: Lets the instrument run a test only once. 

–  Schedule: Lets the instrument repeat tests as defined in the Set Timing. 
The Set Timing menu becomes activated. 

5 To define a schedule for an auto measurement, complete the following steps: 
 Press the Set Timing soft key. a
 Press the Start Time (HH:MM) soft key. b
 Enter the time in the HH:MM format, and then press the Enter soft key. c
 Press the Stop Time (HH:MM) soft key. d
 Enter the time in the HH:MM format, and then press the Enter soft key. e
 Press the Time Interval soft key. f
 Enter the amount of time in minutes, and then press the Enter soft key. g

6 Press the Settings soft key, and then set the following: 
 Toggle the MAC soft key and select the MAC Walsh code option: 64 or 128. a
 Toggle the PvsT soft key and select the slot option: Idle or Active. b
 Toggle the External Offset soft key and select On. c
 Enter a value by using the numeric keys, and then press the dB soft key. d

7 To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you 
desire. See “Using save” on page 32 for more information. 

8 Press the Run Test soft key to start to run a test. 
The Auto Measure Results window appears at the end of the test. 

9 To stop running the test, press the Abort soft key. 
10 To change the view on the screen during the test, press the Display and then select the view 

option from the following choices: 
–  Screen: You can view each measurement screen as the test progresses. 

–  Results: You can view a measurement result table as the test progresses. 

–  Settings: You can view a measurement setting table as the test progresses. 

 

Setting display 

After completion of the auto measurement, the screen menu changes to Trace/Display so that you can 
view the results in different forms. 
 

Procedure 

1 Toggle the Display soft key and select the display option: 
–  Result: You can view the result table. 

The Display Result menu becomes activated. 

–  Settings: You can view the measurement settings for the auto measurement. 

2 Toggle the Display Result soft key and select the display result option: 
–  Full: You can view detailed measurement readings with the pass/fail indication. 

–  Quick: You can view only the Pass/Fail results. 

3 To view the measurement results for a different carrier, press the View Carrier soft key and then 
select the carrier number to view. 
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Performing power statistics CCDF measurements 

The Power Statistics Complementary Cumulative Distribution Function (CCDF) measurement 
characterizes the power statistics of the input signal. It provides PAR (Peak to Average power Ratio) 
versus different probabilities. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 335, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the CCDF Length soft key to set the length of the CCDF. 
3 Enter a value between 1 and 100 by using the numeric keys. You can also use the rotary knob. 
4 Press the Enter soft key. 

 

Measurement example 

Figure 184 CCDF measurement with EV-DO signal analyzer 
 

 
 

Conducting EV-DO OTA measurements 

This Over The Air (OTA) measurement has channel scanner, PN scanner, multipath profile, and Code 
Domain power screens. It is used to verify EV-DO transmitter performance at any location providing 
reflective measurements and identifying signals providing from different sites. The Code Domain 
power shows not only modulation performance metric but also amplifier capacity and code utilization 
metric. The Amplifier capacity (code utilization) measurement is an estimate of the amount of power 
amplifier capacity (code utilization) that is being used expressed in percent of maximum. 
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Channel scanner 

Setting channel/frequency 

Procedure 

To set the channels to be scanned: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Channel. 
3 Press the Index soft key, and then enter an index number between one and six by turning the 

rotary knob or using the numeric keys. 
4 To select the standard channel, complete the following steps: 

 Press the Channel Std soft key. The standard channel window appears. a
See “Appendix C – Band, frequency & channel standard” on page 530 for more information. 

 Highlight the band to be measured by using the rotary knob, the arrow keys, or the Page b
Up/Page Down soft keys. 

 Press the Select soft key or the rotary knob to confirm the selection. c
5 To set the channel number for the selected index, complete the following steps: 

 Press the Channel Number soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

6 The instrument displays a corresponding center frequency for the channel number. 
7 To set the integration bandwidth for the selected index, complete the following steps: 

 Press the Integration Bandwidth soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

8 To add more channels to be scanned, repeat steps 3-6. 
9 Press the ESC hard key to dismiss the channel list window and view the scanning result. 

 
To set the frequencies to be scanned: 

1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Freq. 
3 Press the Index soft key, and then enter an index number between one and six by turning the 

rotary knob or using the numeric keys. 
4 To set the center frequency for the selected index, complete the following steps: 

 Press the Center Frequency soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

5 To set the integration bandwidth for the selected index, complete the following steps: 
 Press the Integration Bandwidth soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

6 To add more channels to be scanned, repeat steps 3-5. 
7 Press the ESC hard key to dismiss the channel list window and view the scanning result. 

 

Setting measure setup 

After configuring other test parameters as described in the “Configuring test parameters” on page 335, 
you can continue your measurement. The measurement settings can be saved and recalled as a file. 
You can also use JDViewer, PC application software to configure a measure setup, save as a file, and 
load the file on to the instrument. 
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Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the incremental step for the PN offset, complete the following steps: 

 Press the PN Increment soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

3 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 32 for more information. 

 

Setting limit for OTA channel scanner 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Limit Line soft key to set a threshold for the limit line and Pass/Fail indication. 
3 Enter a value, and then press the dBm unit soft key. 
4 Toggle the Limit Line soft key between On and Off to display or dismiss the limit line. 
5 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 

Toggle the Beep soft key between On and Off to enable or disable the beep sound. 
6 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 

See “Using save” on page 32 for more information. 

 

Measurement example 

Figure 185 Channel scanner measurement with EV-DO OTA signal analyzer 

 
 

PN scanner 

Each access network sector has a unique PN offset. The PN Scanner is used to identify all the active 
PNs in an area. 
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Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 335, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the incremental step for the PN offset, complete the following steps: 

 Press the PN Increment soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

3 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 32 for more information. 

 

Measurement example 

Figure 186 PN scanner measurement with EV-DO OTA signal analyzer 

 
 

Multipath profile 

The Multipath Profile enables you to determine RF environmental conditions of testing area. It 
indicates the amount of power of the dominant pilot signal that is dispersed outside the main 
correlation peak due to multipath echoes that are expressed in dB. This value should be very small 
ideally. 
 
The multipath profile is the result of portions of the original broadcast signal arriving at the receiving 
antenna out of phase. This can be caused by the signal being reflected off objects such as buildings, 
or being refracted through the atmosphere differently from the main signal. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 335, you 
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can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the incremental step for the PN offset, complete the following steps: 

 Press the PN Increment soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

3 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 32 for more information. 

 

Measurement example 

Figure 187 Multipath profile measurement with EV-DO OTA signal analyzer 

 
 

Code domain power 

Channels with high correlation factors are determined to be active channels and are indicated as such 
on the display. Once the channels are decoded, the analyzer determines the power of each channel 
relative to the total signal power. 
 
This measurement helps to verify that each code channel is operating at its proper level and helps to 
identify problems throughout the transmitter design from the coding to the RF section. System 
imperfections, such as the non-linearity of amplifiers, will present themselves as an undesired 
distribution of power in the code domain. 
 

Setting measure setup 

After configuring test parameters as described in “Configuring test parameters” on page 335, you can 
continue your measurement. The measurement settings can be saved and recalled as a file. You can 
also use JDViewer, PC application software to configure a measure setup, save as a file, and load the 
file on to the instrument. 
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Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the Pseudo-Noise (PN) offset, complete the following steps: 

 Toggle the PN Offset soft key between Auto and Manual. a
 Enter a value by using the numeric keys to set manually. b
 Press the Enter soft key. c

3 To set the incremental step for the PN offset, complete the following steps: 
 Press the PN Increment soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

4 To set the threshold between Auto and Manual, complete the following steps: 
 Press the Threshold soft key. Its default setting is -27 dB. a
 Enter a value between -50 and zero by using the numeric keys to change the value in the b

Manual mode. 
 Press the Enter soft key. c

5 Toggle the MAC soft key and select the MAC Walsh code option: 64 or 128. 
6 Press the Detect Mode soft key, and then select the detection mode option: Auto, QPSK, 8PSK, 

16 QAM, or 64 QAM. 
7 To set the threshold for pilot dominance, complete the following steps: 

 Press the Pilot Dominance > soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

 

 NOTE 
Recommended value is 10. Color of the Pilot Dominance indicator on the screen bases 
on this setting. 

 

8 To set the threshold for multipath power, complete the following steps: 
 Press the Multipath Power < soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

 

 NOTE 
Recommended value is one. Color of the multipath power indicator on the screen bases 
on this setting. 

 

9 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 32 for more information. 
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Measurement example 

Figure 188 Code domain power measurement with EV-DO OTA signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. 

 

Route map 

The JD700B Series provides indoor and outdoor mapping function that allows a user to collect data of 
points in an indoor or outdoor environment and track the received signals and coverage of RF 
transmitters plotting real time directly on top of a loaded floor plan or a map. 
 

Setting measure setup 

Procedure 

1 If required, connect a GPS receiver to your JD700B series for outdoor mapping. 
Indoor mapping does not necessarily need a GPS antenna. 

2 Configure test parameters as described in the “Configuring test parameters” on page 335. 
3 To load your map file, complete the following steps: 

 Plug in your USB drive that has a floor map or .mcf file type created in JDMapCreator. a
 

 NOTE 
The JDMapCreator converts and resizes any scanned floor plan or layout to fit onto your 
instrument’s display. You must save your map file (.mcf) into the “SavedMap” folder of 
your USB drive so that you can load them onto your instrument. 

 

 Press SAVE/LOAD hot key, and then select Load > Load Map. b
See “Using load” on page 34 for more information. 

4 Press the MEASURE SETUP hot key. 
5 Press the Plot Point soft key, and then select the plot point option from the following choices: 

–  To collect data/plot points automatically as you move around in a vehicle or outside, press 
the GPS soft key and then toggle the Screen Mode soft key between Map and Full. 

 

 NOTE 
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With the Map setting, you can view only the collected points that can be seen within the 
boundary of the loaded map. If a point is off the map, the instrument displays an arrow to 
indicate the direction of the current location on the map and the distance from the center 
to the location at the top of the screen. 
 
With the Full setting, you can view all the collected points of the route without the loaded 
map. 

 

–  To collect data/plot points manually without a GPS antenna in an indoor environment, press 
the Position soft key. 

6 Press the Plot Item soft key, and then select the measurement option: Pilot Power or Ec/Io. 
7 To set the incremental step for the PN offset, complete the following steps: 

 Press the PN Increment soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

8 Toggle the Plot soft key and select Start. 
9 Touch directly on the screen or press the ENTER hard key to collect data and plot points on the 

loaded map for the Position setting. 
 

 NOTE 
For the Position setting, you can change the direction of the route with the arrow keys 
and the distance with the rotary knob. 

 

10 Toggle the Plot soft key and select Stop to stop plotting. 
11 Press the SAVE/LOAD hot key to save the result. 

See “Using save” on page 32 for more information. 
 

 NOTE 
The instrument does not automatically save the collected data. It is recommended that 
you save the result. Otherwise, you will lose all the collected data. 

 

 

Setting limit 

You can set the thresholds for the four different color indicators for Pilot power or Ec/Io. 
 

Procedure 

1 Press the LIMIT hot key. 
2 Select the plot items and set the limits as needed: 

 

To set the limit for Select Set 

Pilot Power Pilot Power Excellent, Very Good, Good, Fair, Poor (dBm) 

Ec/Io Ec/Io Good, Fair, Poor (dB) 
 

3 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 32 for more information. 
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Measurement example 

Figure 189 Route map measurement with EV-DO OTA signal analyzer 

1) Pilot Power 

 

2) Pilot Ec/Io 
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Analyzer 

This chapter provides instructions for using the TD-SCDMA Signal Analyzer function (option 025) with 
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Introduction 

The Time Division-Synchronous Code Division Multiple Access, also known as TD-SCDMA, is a 3G 
mobile telecommunications standard that is pursued by the Chinese Academy of Telecommunications 
Technology (CATT) in the People's Republic of China. The TD-SCDMA uses the TDD scheme while 
the WCDMA uses the FDD. 
 
This TD-SCDMA Signal Analyzer can be used for testing of TD-SCDMA systems, made according to 
the following standard documentation. 
 

 3GPP TS 25.105 Base Station radio transmission and reception (TDD) 

 3GPP TS 25.142 Base Station conformance testing (TDD) 

 3GPP TS 25.222 Multiplexing and channel coding (TDD) 

 3GPP TS 25.223 Spreading and modulation (TDD) 
 
The instrument automatically makes standard defined measurements using the measurement 
methods and limits as defined in the standard. The detailed results allow you to analyze TD-
SCDMA/HSDPA system performance. You may alter the measurement parameters for specialized 
analysis. Pass/Fail testing with standard defined or user defined upper and lower limits and the 
Pass/Fail indictor help you to determine base station performance easily. 
 
This instrument provides the following measurement tools for TD-SCDMA system: 
 

 Spectrum Analysis 

 RF Analysis 
- Channel Power 
- Occupied Bandwidth 
- Spectrum Emission Mask 
- Adjacent Channel Leakage power Ratio (ACLR) 
- Multi-ACLR 
- Spurious Emissions 

 Power vs. Time: 
- Power vs. Time (Slot) 
- Power vs. Time (Frame) 
- Power vs. Time (Mask) 
- Timogram 

 Modulation Analysis 
- Constellation 
- Midamble Power 
- Code Power 
- Code Error 

 Auto Measure 

 Over The Air (OTA) 
- Sync-DL ID Scanner 
- Sync-DL ID vs. Tau 
- Sync-DL ID Multipath 
- Sync-DL ID Analyzer 
- Route Map 
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Display overview 

Figure 190 provides descriptions for each segment of the measurement screen. 
 

Figure 190 TD-SCDMA signal analyzer measurement screen 

 

 

Connecting a cable 

Direct connection 

Procedure 

1 Connect the Spectrum Analyzer RF In port of the JD700B series and the Power amplifier output 
port of BTS. 

 
Figure 191 Direct connection 

 
JD785B/JD745B 

 
JD788B/JD748B 
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Indirect connection 

Procedure 

1 Connect the Spectrum Analyzer RF In port of the JD700B series and the monitor (test) port of 
BTS. 

 
Figure 192 Indirect connection 

 
JD785B/JD745B 

 
JD788B/JD748B 

 

 

CAUTION 
The maximum power for the Spectrum Analyzer RF In port is +25 dBm (0.316 W) for 
JD780B series and +20 dBm (0.1 W) for JD740B series. If the level of the input signal to 
be measured is greater than this, use a High Power Attenuator to prevent damage 
when you directly connect the signal to the instrument or connect the signal from the 
coupling port of a directional coupler. 

 

Over the air (OTA) 

Procedure 

1 Connect an Omni/directional RF antenna to the Spectrum Analyzer RF In port of the JD700B 
series. 

2 Connect a GPS antenna to the GPS port of the JD700B series. 

 
Figure 193 OTA connection 

 
JD785B/JD745B 

 
JD788B/JD748B 
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CAUTION 
If the input signal level to be measured is less than 0 dBm, set 0 dB attenuation or turn on 
the preamp to have better dynamic range for the OTA testing. 

 

Selecting measurement mode 

Procedure 

1 Press the MODE hard key. 
2 Press the Signal Analyzer soft key. 
3 Press the More (1/2) > TD-SCDMA soft key. The Spectrum mode is set by default. 
4 Press the MEASURE hot key, and then select the measurement mode option from the following 

choices: 
–  Spectrum 

–  RF Analysis > Channel Power, Occupied BW, Spectrum Emission Mask, ACLR,  
Multi-ACLR, or Spurious Emissions 

–  Power vs Time > Power vs Time (Slot), Power vs Time (Frame), 
Power vs Time (Frame), or Timogram 

–  Modulation Analysis > Constellation, Midamble Power, Code Power, or Code Error 

–  Auto Measure 

–  OTA > Sync-DL ID Scanner, Sync-DL ID vs Tau, Sync-DL ID Multipath,  
Sync-DL ID Analyzer, or Route Map 

 

Configuring test parameters 

Setting frequency 

You can set the frequency with either frequency or channel number. If a frequency to be set matches 
to the frequency corresponding to the selected channel standard, the instrument calculates its channel 
number and updates the screen with it automatically. 
 

Procedure 

To set the center frequency: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Freq. 
3 Press the Center Frequency soft key. 
4 Enter a value by using the numeric keys. You can also use the rotary knob. 
5 Select the unit: GHz, MHz, kHz, or Hz. 
6 Optional. To define the amount of frequency increment for the rotary knob, complete the following 

steps: 
 Press the Frequency Step soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the unit: GHz, MHz, kHz, or Hz. c

 
To set the channel number: 

1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Channel. 
3 To select the standard channel, complete the following steps: 

 Press the Channel Std soft key. The standard channel window appears. a
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See “Appendix C – Band, frequency & channel standard” on page 530 for more information. 
 Highlight the band to be measured by using the rotary knob, the arrow keys, or the Page b

Up/Page Down soft keys. 
 Press the Select soft key or the rotary knob to confirm the selection. c

4 Press the Channel Number soft key. 
5 Enter a value by using the numeric keys. You can also use the rotary knob. 
6 Press the Enter soft key. 
7 The instrument automatically displays the corresponding center frequency value for the selected 

channel number. 
8 Optional. To define the amount of channel increment for the rotary knob, complete the following 

steps: 
 Press the Channel Step soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

 
 NOTE 

This frequency setting is not used in the Multi-ACLR and Spurious Emissions modes. 
 

Setting amplitude 

Reference level and attenuation 

You can set the reference and attenuation levels automatically or manually to optimize the display of 
the traces measured, as you desire. 
 

Procedure 

To automatically set the reference and attenuation level: 
1 Press the AMP/SCALE hard key. 
2 Press the Auto Scale soft key. 

Each time you press this key, both of the Y-axis scale and input attenuation level change to be 
optimized with some margin. 

 
To set the reference or attenuation level manually: 

1 Press the AMP/SCALE hard key. 
2 To set the maximum reference value on the Y-axis manually, complete the following steps: 

 Press the Reference Level soft key. a
 Enter a value by using the numeric keys or the rotary knob with 10 dB increments. b
 Press the dBm soft key or the ENTER hard key. c

This unit key name changes according to the setting in the Units menu. 
 

 NOTE 
In the measurements such as Midamble Power, Code Power, and Code Error, you 
may need to select the reference option between Relative and Absolute before setting 
the reference level. 

 

3 To set the attenuation option, select one from the following choices: 
–  To set the input attenuator’s level automatically, select Attenuation > Auto. 

 

 NOTE 
It is recommended that you set the Attenuation to Auto in most situations so that the 
level of the input attenuator can be set automatically according to your input signal level. 

 

–  To set the input attenuation manually up to 55 dB for JD780B series or 50 dB for JD740B 
series to optimize S/N, complete the following steps: 



Chapter 12 Using TD-SCDMA Signal Analyzer 

 JD700B Series User’s Guide 377 

 Select Attenuation > Manual. a
 Press the Attenuation Value soft key to set the level. b
 Enter a value in fives by using the numeric keys. c
 Press the dB soft key or the ENTER hard key. d

–  To couple the input attenuator’s level with your reference level setting, select Attenuation > 
Couple. 
As you increase the reference setting, the attenuation level also increases acoordingly. 

 
Optional. To change the scale unit: 

1 Select More (1/2) > Units. 
2 Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W. 

The scale unit on the screen changes accordingly. 
 

 NOTE 
This Units menu is available in the Spectrum and RF Analysis modes. 

 

 

Scale per division 

You can use the Scale/Div feature available for the spectrum and RF analysis. It represents the value 
of one division on the horizontal scale. The default setting is 10 dB per division and the maximum 
value can be set up to 20 dB. 
 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Select More (1/2) > Scale/Div. 
3 Enter a value between 1 and 20 by using the numeric keys. 
4 Press the dB soft key to complete the entry. 

 

Pre-amplifier 

You can turn the internal pre-amplifier on to correct and compensate for the gain of the preamp so that 
amplitude readings show the value at the input connector. 
 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Toggle the Preamp soft key and select On or Off as needed. 

 
 NOTE 

You can turn the Preamp on when the input attenuation range is from 0 dB to 10 dB. If 
the attenuation value is manually set to greater than 10 dB, the instrument will 
automatically turn off the pre-amplifier to display low-level signal properly on the chart. 

 

External offset 

You can turn the External Offset on and manually set the external offset value. An offset consists of a 
cable loss and a user offset and the measurement result shows the value reflecting both offset values. 
When the external offset value is set at 40 dB in the Spectrum mode, the measurement result 
compensates 40 dB at both the Spectrum Analyzer and Signal Analyzer modes 
 

Procedure 
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To set the external offset: 
1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select On. 
3 Enter a value by using the numeric keys. 
4 Press the dB soft key to complete the entry. 

 
To turn the external offset off: 

1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select Off. 

 

Setting average 

You can set the number of measurements to be averaged for the trace presentation in the spectrum 
and RF analysis. A maximum of 100 times of averaging can be set. When the averaging reaches to 
your setting, a new measurement value replaces the measurement value in sequence from the earliest. 
 

Procedure 

1 Press the BW/AVG hard key. 
2 Press the Average soft key. 
3 Enter a value between 1 and 100 as needed by using the numeric keys. 
4 Press the Enter soft key. 

 

Setting sweep mode 

The default setting is Continue to sweep continuously for most on-going measurements. If you want to 
hold the measurement or get a single sweep, you can change the sweep mode. 
 

Procedure 

To select the single sweep mode: 
1 Press the SWEEP hot key. 
2 Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key. 

The letter HOLD in red appears and the sweeping is paused. 
3 Optional. Press the Sweep Once soft key to get a new measurement. 

 
To return to the continuous sweep mode: 

1 Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key. 
The letter HOLD in red disappears and the sweeping resumes. 

 

Setting trigger source 

You can set the trigger source option for your measurements. 

Procedure 

1 Press the TRIGGER hot key. 
2 Select the trigger source option from the choices: Internal, External, and GPS. 
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Setting external clock 

To enhance the reliability of modulation analysis measurements the JD700B series must be 
synchronized with a base station. When an external clock is not supplied, the instrument works with its 
built-in internal high-accuracy time base and some measurement results may exhibit inaccurate values. 
Therefore, it is highly recommended that you use the same reference clock as the signal source. You 
can use the TRIGGER hot key to set the external clock. 
 

Figure 194 Connection ports for external reference clock 

 
 

Procedure 

1 Connect an external reference or a GPS antenna to the JD700B series. 
2 Press the SYSTEM hot key. 
3 Press the Freq Reference soft key, and then select the reference option: Internal, External 10 

MHz, External 13 MHz, External 15 MHz, or GPS. 

 
Table 19 External reference indicators 

Type Indicator Description 

Internal  (green) The green INT icon indicates that the instrument uses the built-in 
internal time base. 

External  (green) The green EXT icon indicates that an external reference is connected 
and locked and that the instrument uses the same reference clock as 
the signal source. 

External  (red) The red EXT icon indicates that an external reference is connect but not 
locked. 

GPS      (green) The green GPS antenna icon indicates that a GPS antenna is 
connected and locked. 

GPS      (yellow) The yellow GPS antenna icon indicates that a GPS antenna is 
connected and locking is in progress. 

GPS      (grey) The grey GPS antenna icon indicates that a GPS antenna is not 
connected, failed, or unable to be locked. 

 

Conducting spectrum measurements 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 375, you 
can continue your measurement. 
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Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1, 

TS2, TS3, TS4, TS5, or TS6. 
3 Optional. To set the delay, complete the following steps: 

 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

 NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

 
Your measurement result is displayed on the screen as like the following example, Figure 195. 
 

Figure 195 Spectrum measurement screen with TD-SCDMA signal analyzer 

 
 

Setting trace 

You can display up to six traces on the measurement chart simultaneously. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6. 

The legend shape of the selected trace changes from square to round to indicate that the trace is 
the active one now. 

3 Toggle the Trace View soft key and select On. 
4 Do one of the following: 

 

To Select Trace Legend 

Clear current data and display with new 
measurements 

Clear Write W 

Display the input signal’s maximum response only 
(unlimited or for a certain amount of time) 

Max Hold M 
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Display the input signal’s minimum response only 
(unlimited or for a certain amount of time) 

Min Hold m 

Capture the selected trace and compare traces Capture C 

Load a saved trace More (1/2) > Load L 

Hide the selected trace Trace View > Off F 

Remove all the traces and initialize the trace 
settings 

More (1/2) > Trace 
Clear All 

 

 

 NOTE 
For the Max Hold and Min Hold, your instrument compares newly acquired data with the 
active trace and displays larger maximum values or smaller minimum values on the 
screen. You can set it to Unlimited to hold and view maximum or minimum data or 
specify a certain amount of time up to 60 seconds by using numeric keys or the rotary 
knob. 

5 Optional. Press the More (1/2) > Trace Info soft key, and then select the trace number to view 
the trace’s parameter setting information stored at the time of the measurement or None to hide 
the information display. 

6 Optional. If you have the two traces T1 and T2, you can perform trace math. To view the power 
difference between the traces, press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key. 
The result is overlaid on the screen along with the second Y-axis. 

 

Conducting RF measurements 

Channel power 

The Channel Power measurement determines the average power of an RF signal burst at or above a 
specified threshold value. 
 
The purpose of the Channel Power measurement is to determine the power delivered to the antenna 
system on the RF channel under test. The instrument acquires a TD-SCDMA signal in the time domain. 
The average power level above the threshold is then computed and displayed. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 375, you 
can continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1, 

TS2, TS3, TS4, TS5, or TS6. 
3 Optional. To set the delay, complete the following steps: 

 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

 NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 
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Measurement example 

Figure 196 Channel power measurement with TD-SCDMA signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 388 for more 
information. 

 

Occupied bandwidth 

The Occupied Bandwidth measures the spectrum shape of the carrier. It is defined as the bandwidth, 
which includes 99% of the transmitted power among total transmitted power. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 375, you 
can continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1, 

TS2, TS3, TS4, TS5, or TS6. 
3 Optional. To set the delay, complete the following steps: 

 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

 NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 
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Measurement example 

Figure 197 Occupied bandwidth measurement with TD-SCDMA signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 388 for more 
information. 

 

Spectrum emission mask (SEM) 

The Spectrum Emission Mask (SEM) measurement required by 3GPP specifications encompasses 
different power limits and different measurement bandwidths (resolution bandwidths) at various 
frequency offsets. It may be expressed as a ratio of power spectral densities between the carrier and 
the specified offset frequency band. It provides useful figures-of-merit for the spectral re-growth and 
emissions produced by components and circuit blocks, without the rigor of performing a full SEM 
measurement. 
 
The SEM measures spurious signal levels in up to five pairs of offset or region frequencies and relates 
them to the carrier power. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 375, you 
can continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1, 

TS2, TS3, TS4, TS5, or TS6. 
3 To select the mask type according to the output power of the base station, complete the following 

steps: 
 Press the Mask Type soft key. a
 Select the mask type option: - 26 dBm, 26 – 34 dBm, or 34 dBm –. b

4 Optional. To set the delay, complete the following steps: 
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 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

 NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

 

Measurement example 

Figure 198 SEM measurement with TD-SCDMA signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 388 for more 
information. 

 

ACLR 

The Adjacent Channel Leakage power Ratio (ACLR) measures the amount of interference or power in 
an adjacent frequency channel according to the standards. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 375, you 
can continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1, 

TS2, TS3, TS4, TS5, or TS6. 
3 Optional. To set the delay, complete the following steps: 

 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c
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 NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

 

Measurement example 

Figure 199 ACLR measurement with TD-SCDMA signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 388 for more 
information. 

 

Multi-ACLR 

The Multi-ACLR measurement is used to perform multi-channel ACLR measurements with as many 
channels as possible. It helps you to measure ACLR in multi-channel transmitting Base Station 
environment. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 375, you 
can continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the frequency, do one of the following: 

–  To set the center frequency, complete the following steps: 
 Toggle the Unit soft key and select Freq. a
 Press the Lowest Frequency soft key to set the starting center frequency. b
 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Select the unit: GHz, MHz, kHz, or Hz. d
 Press the Highest Frequency soft key to set the stopping center frequency. e
 Enter a value by using the numeric keys. You can also use the rotary knob. f
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 Select the unit: GHz, MHz, kHz, or Hz. g
–  To set the channel number, complete the following steps: 

 Toggle the Unit soft key and select Channel. a
 To select the standard channel, press the Channel Std soft key and then select the b

band to be measured. 
 Press the Lowest Channel soft key to set the starting channel. c
 Enter a value by using the numeric keys. You can also use the rotary knob. d
 Press the Enter soft key. e
 Press the Highest Channel soft key to set the stopping channel. f
 Enter a value by using the numeric keys. You can also use the rotary knob. g
 Press the Enter soft key. h

 

Measurement example 

Figure 200 Multi-ACLR measurement with TD-SCDMA signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 388 for more 
information. 

 

Spurious emissions 

Out-of-band emissions are unwanted emissions immediately outside the channel bandwidth resulting 
from the modulation process and non-linearity in the transmitter but excluding spurious emissions. The 
Spurious Emissions measurement is to identify and determine the power level of out-of-band spurious 
emission within the necessary channel bandwidth and modulated signal measured at the RF port of 
the Base Station. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 375, you 
can continue your measurement. 
 



Chapter 12 Using TD-SCDMA Signal Analyzer 

 JD700B Series User’s Guide 387 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set up the range table and frequency range, press the Range Table soft key and then 

complete the following steps: 
 Press the Range soft key, and then enter the range number to add a new range or change a

an existing one. 
 Press the Enter soft key. b
 Press the Start Frequency soft key to set up the frequency range. c
 Enter a value by using the numeric keys. You can also use the rotary knob. d
 Select the unit: GHz, MHz, kHz, or Hz. e
 Press the Stop Frequency soft key to set up the frequency range. f
 Enter a value by using the numeric keys. You can also use the rotary knob. g
 Select the unit: GHz, MHz, kHz, or Hz. h

3 Toggle the Range soft key between On and Off to display or hide the selected range. 
4 To set up the test limits for Pass/Fail indication, complete the following steps: 

 Press the Start Limit soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the dBm soft key. c
 Press the Stop Limit soft key. d
 Enter a value by using the numeric keys. You can also use the rotary knob. e
 Select the dBm soft key. f

5 To set up the other parameters, complete the following steps: 
 Select More (1/2) > Attenuation to set up the attenuation value. a
 Enter a value in the multiple of five. b
 Press the dB soft key or the ENTER hard key. c
 Press the RBW soft key. d
 Enter a value by using the numeric keys. e
 Select the unit: GHz, MHz, kHz, or Hz. f
 Press the VBW soft key. g
 Enter a value by using the numeric keys. h

 Select the unit: GHz, MHz, kHz, or Hz. i
6 Press the PREV hard key. 
7 Toggle the Measure Type soft key between Examine and Full to select the measurement type. 

 

 NOTE 
The Examine mode displays only the selected range while the Full mode lets the 
instrument automatically changes the selected range from one another. 

 

8 Set the number of measurements to be averaged: 
 Press the Average soft key. a
 Enter a value between 1 and 100. b
 Press the Enter soft key. c
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Measurement example 

Figure 201 Spurious emissions measurement with TD-SCDMA signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 388 for more 
information. 

 

Setting limit for RF tests 

By default, test limits specified in the standard are set for you. You can change thresholds if you desire. 
 

Procedure 

1 Press the LIMIT hot key. 
2 Press the RF Test Limits soft key. 
3 Select the test item(s) and set the limit(s) depending on your selected measurement mode: 

 

To set the limit for Select Set 

Channel power Channel Power High Limit 
Low Limit 

Occupied bandwidth Occupied BW High Limit 

Spectrum emission mask Spectrum Emission Mask (On/Off only) 

ACLR ACLR (On/Off only) 

Multi-ACLR Multi-ACLR (On/Off only) 

Spurious emissions Spurious Emissions (On/Off only) 
 

4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 32 for more information. 
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Conducting power vs. time measurements 

The Power vs. Time (P vs T) measurement analyzes the amplitude profile and timing of the burst 
signal and provides a time mask for the signal. It measures the mean transmit power during the “useful 
part” of TD-SCDMA bursts and verifies that the power ramp fits within the defined mask. TD-SCDMA is 
a Time Division Multiple Access (TDMA) scheme with seven time slots, or bursts, per RF channel and 
by using the “Multi-Slot” function, up to seven slots in a frame can be viewed at one time. 
 

Power vs. time (slot) 

The Power vs. Time (Slot) in TD-SCDMA Signal Analyzer measures the modulation envelope in the 
time domain, showing the signal rise and fall shape of TD-SCDMA signal. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 375, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1, 

TS2, TS3, TS4, TS5, or TS6. 
3 Press the Spread Factor soft key, and then select the spread factor option: DL Auto for auto 

detection of downlink, UL Auto for auto detection of uplink, SF1, SF2, SF4, SF8, or SF16 
4 To set the number of maximum users, complete the following steps: 

 Press the Max Users soft key. a
 Enter a value up to 16 by using the numeric keys. b
 Press the Enter soft key. c

5 Optional. To set the delay, complete the following steps: 
 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

 NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

6 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To select how to determine scrambling estimation, toggle the Scramble soft key and select 

Spec or Full. 
 

 NOTE 
The Spec searches “Sync Sequence Number” from 0 to 31 based on the TD-SCDMA 
specification and determines “Scrambling Code Number” by using the sync sequence 
number, while the Full does from 0 to 127 fully. 

 

–  To select how to determine the Midamble spread factor estimation either in full or maximum 
power search, toggle the Mid SF Map soft key and select Max or Spec. 

 

 NOTE 
The Max determines the spread factor of the Midamble by using the maximum power of 
the received Midamble, while the Spec searches “Default Midamble Allocation” based on 
the TD-SCDMA specification. 

 

–  To select the detect mode, press the Detect Mode soft key and then select the option: 
Auto, QPSK/8PSK, QPSK, 8PSK, 16 QAM, or 64 QAM. 
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Measurement example 

Figure 202 Power vs. time (slot) measurement with TD-SCDMA signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for power vs. time tests” on page 394 for 
more information. 

 

Power vs. time (frame) 

The Power vs. Time (Frame) measures the modulation envelope in the time domain, showing the 
power of each time slot of the TD-SCDMA signal. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 375, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1, 

TS2, TS3, TS4, TS5, or TS6. 
3 Press the Spread Factor soft key, and then select the spread factor option: DL Auto for auto 

detection of downlink, UL Auto for auto detection of uplink, SF1, SF2, SF4, SF8, or SF16 
4 To set the number of maximum users, complete the following steps: 

 Press the Max Users soft key. a
 Enter a value up to 16 by using the numeric keys. b
 Press the Enter soft key. c

5 Optional. To set the delay, complete the following steps: 
 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 



Chapter 12 Using TD-SCDMA Signal Analyzer 

 JD700B Series User’s Guide 391 

 NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

6 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To select how to determine scrambling estimation, toggle the Scramble soft key and select 

Spec or Full. 
 

 NOTE 
The Spec searches “Sync Sequence Number” from 0 to 31 based on the TD-SCDMA 
specification and determines “Scrambling Code Number” by using the sync sequence 
number, while the Full does from 0 to 127 fully. 

 

–  To select how to determine the Midamble spread factor estimation either in full or maximum 
power search, toggle the Mid SF Map soft key and select Max or Spec. 

 

 NOTE 
The Max determines the spread factor of the Midamble by using the maximum power of 
the received Midamble, while the Spec searches “Default Midamble Allocation” based on 
the TD-SCDMA specification. 

 

–  To select the detect mode, press the Detect Mode soft key and then select the option: 
Auto, QPSK/8PSK, QPSK, 8PSK, 16 QAM, or 64 QAM. 

 

Measurement example 

Figure 203 Power vs. time (frame) measurement with TD-SCDMA signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for power vs. time tests” on page 394 for 
more information. The On/Off Ratio is not used in the power vs. time (frame) tests. 

 

Power vs. time (mask) 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 375, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. 
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Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1, 

TS2, TS3, TS4, TS5, or TS6. 
3 Press the Spread Factor soft key, and then select the spread factor option: DL Auto for auto 

detection of downlink, UL Auto for auto detection of uplink, SF1, SF2, SF4, SF8, or SF16 
4 To set the number of maximum users, complete the following steps: 

 Press the Max Users soft key. a
 Enter a value up to 16 by using the numeric keys. b
 Press the Enter soft key. c

5 Optional. To set the delay, complete the following steps: 
 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

 NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

6 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To select how to determine scrambling estimation, toggle the Scramble soft key and select 

Spec or Full. 
 

 NOTE 
The Spec searches “Sync Sequence Number” from 0 to 31 based on the TD-SCDMA 
specification and determines “Scrambling Code Number” by using the sync sequence 
number, while the Full does from 0 to 127 fully. 

 

–  To select how to determine the Midamble spread factor estimation either in full or maximum 
power search, toggle the Mid SF Map soft key and select Max or Spec. 

 

 NOTE 
The Max determines the spread factor of the Midamble by using the maximum power of 
the received Midamble, while the Spec searches “Default Midamble Allocation” based on 
the TD-SCDMA specification. 

 

–  To select the detect mode, press the Detect Mode soft key and then select the option: 
Auto, QPSK/8PSK, QPSK, 8PSK, 16 QAM, or 64 QAM. 
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Measurement example 

Figure 204 Power vs. time (mask) measurement with TD-SCDMA signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for power vs. time tests” on page 394 for 
more information. The DwPTS Power and UpPTS Power are not used in the power vs. 
time (mask) tests. 

 

Timogram 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 375, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Spread Factor soft key, and then select the spread factor option: DL Auto for auto 

detection of downlink, UL Auto for auto detection of uplink, SF1, SF2, SF4, SF8, or SF16 
3 To set the number of maximum users, complete the following steps: 

 Press the Max Users soft key. a
 Enter a value up to 16 by using the numeric keys. b
 Press the Enter soft key. c

4 To set the time interval, complete the following steps: 
 Press the Time Interval soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

5 To place the time cursor to analyze your measurements, complete the following steps: 
 Toggle the Time Cursor soft key between On and Off to enable or disable the time cursor. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

 

 NOTE 
When the time cursor is enabled, the measurement is put on hold and information about 
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the time cursor is displayed. 

 

6 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To set the delay, complete the following steps: 

 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

 NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

–  To select how to determine scrambling estimation, toggle the Scramble soft key and select 
Spec or Full. 

 

 NOTE 
The Spec searches “Sync Sequence Number” from 0 to 31 based on the TD-SCDMA 
specification and determines “Scrambling Code Number” by using the sync sequence 
number, while the Full does from 0 to 127 fully. 

 

–  To select how to determine the Midamble spread factor estimation either in full or maximum 
power search, toggle the Mid SF Map soft key and select Max or Spec. 

 

 NOTE 
The Max determines the spread factor of the Midamble by using the maximum power of 
the received Midamble, while the Spec searches “Default Midamble Allocation” based on 
the TD-SCDMA specification. 

 

–  To select the detect mode, press the Detect Mode soft key and then select the option: 
Auto, QPSK/8PSK, QPSK, 8PSK, 16 QAM, or 64 QAM. 

 

Measurement example 

Figure 205 Timogram with TD-SCDMA signal analyzer 

 
 

Setting limit for power vs. time tests 

Procedure 



Chapter 12 Using TD-SCDMA Signal Analyzer 

 JD700B Series User’s Guide 395 

1 Press the LIMIT hot key. 
2 Press the PvsT Test Limits soft key. 
3 Select the test item(s) and set the limit(s) depending on your selected measurement mode: 

 

To set the limit for Select Set 

Slot power Slot Power High Limit, Low Limit 

Downlink pilot signal power DwPTS Power High Limit, Low Limit 

Uplink pilot signal power UpPTS Power High Limit, Low Limit 

Power between on and off 
portions of the downlink slots 

On/Off Ratio High Limit, Low Limit 

 

4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 32 for more information. 

 

Conducting modulation measurements 

TD-SCDMA receivers rely on the frequency or phase quality of the QPSK or 8PSK signal in order to 
achieve the expected carrier to noise performance. A transmitter with high frequency or phase error is 
often still able to support phone calls during a functional test. It displays the frequency errors 
numerically and graphically, showing the binary representation of the demodulated data bits of the 
received signal using Constellation, Midamble Power, Code Power, and Code Error screens. 
 

Constellation 

The Constellation is used to observe some aspects of modulation accuracy and can reveal certain 
fault mechanisms such as I/Q amplitude imbalance or quadrature imbalance. It displays constellation 
diagram by modulation types. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 375, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the Scramble soft key and select Auto or Manual to set the scramble code automatically 

or manually. 
3 Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1, 

TS2, TS3, TS4, TS5, or TS6. 
4 Press the Spread Factor soft key, and then select the spread factor option: DL Auto for auto 

detection of downlink, UL Auto for auto detection of uplink, SF1, SF2, SF4, SF8, or SF16 
5 To set the number of maximum users, complete the following steps: 

 Press the Max Users soft key. a
 Enter a value up to 16 by using the numeric keys, and then press the Enter soft key. b
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6 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To set the delay, complete the following steps: 

 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

 NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

–  To select how to determine scrambling estimation, toggle the Scramble soft key and select 
Spec or Full. 

 

 NOTE 
The Spec searches “Sync Sequence Number” from 0 to 31 based on the TD-SCDMA 
specification and determines “Scrambling Code Number” by using the sync sequence 
number, while the Full does from 0 to 127 fully. 

 

–  To select how to determine the Midamble spread factor estimation either in full or maximum 
power search, toggle the Mid SF Map soft key and select Max or Spec. 

 

 NOTE 
The Max determines the spread factor of the Midamble by using the maximum power of 
the received Midamble, while the Spec searches “Default Midamble Allocation” based on 
the TD-SCDMA specification. 

 

–  To select the detect mode, press the Detect Mode soft key and then select the option: 
Auto, QPSK/8PSK, QPSK, 8PSK, 16 QAM, or 64 QAM. 

–  To set the relative threshold, complete the following steps: 
 Press the Threshold soft key. Its default setting is -27 dB. a
 Enter a value between -50 and zero by using the numeric keys. b
 Press the Enter soft key. c

 

Measurement example 

Figure 206 Constellation measurement with TD-SCDMA signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 401 for 
more information. The Max Inactive is not used in the Constellation mode. 
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Midamble power 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 375, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the Scramble soft key and select Auto or Manual to set the scramble code automatically 

or manually. 
3 Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1, 

TS2, TS3, TS4, TS5, or TS6. 
4 Press the Spread Factor soft key, and then select the spread factor option: DL Auto for auto 

detection of downlink, UL Auto for auto detection of uplink, SF1, SF2, SF4, SF8, or SF16 
5 To set the number of maximum users, complete the following steps: 

 Press the Max Users soft key. a
 Enter a value up to 16 by using the numeric keys. b
 Press the Enter soft key. c

6 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To set the delay, complete the following steps: 

 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

 NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

–  To select how to determine scrambling estimation, toggle the Scramble soft key and select 
Spec or Full. 

 

 NOTE 
The Spec searches “Sync Sequence Number” from 0 to 31 based on the TD-SCDMA 
specification and determines “Scrambling Code Number” by using the sync sequence 
number, while the Full does from 0 to 127 fully. 

 

–  To select how to determine the Midamble spread factor estimation either in full or maximum 
power search, toggle the Mid SF Map soft key and select Max or Spec. 

 

 NOTE 
The Max determines the spread factor of the Midamble by using the maximum power of 
the received Midamble, while the Spec searches “Default Midamble Allocation” based on 
the TD-SCDMA specification. 

 

–  To select the detect mode, press the Detect Mode soft key and then select the option: 
Auto, QPSK/8PSK, QPSK, 8PSK, 16 QAM, or 64 QAM. 

–  To set the relative threshold, complete the following steps: 
 Press the Threshold soft key. Its default setting is -27 dB. a
 Enter a value between -50 and zero by using the numeric keys. b
 Press the Enter soft key. c
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Measurement example 

Figure 207 Midamble measurement with TD-SCDMA signal analyzer 

 
 

Code power 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 375, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the Scramble soft key and select Auto or Manual to set the scramble code automatically 

or manually. 
3 Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1, 

TS2, TS3, TS4, TS5, or TS6. 
4 Press the Spread Factor soft key, and then select the spread factor option: DL Auto for auto 

detection of downlink, UL Auto for auto detection of uplink, SF1, SF2, SF4, SF8, or SF16 
5 To set the number of maximum users, complete the following steps: 

 Press the Max Users soft key. a
 Enter a value up to 16 by using the numeric keys. b
 Press the Enter soft key. c

6 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To set the delay, complete the following steps: 

 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

 NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

–  To select how to determine scrambling estimation, toggle the Scramble soft key and select 
Spec or Full. 
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 NOTE 
The Spec searches “Sync Sequence Number” from 0 to 31 based on the TD-SCDMA 
specification and determines “Scrambling Code Number” by using the sync sequence 
number, while the Full does from 0 to 127 fully. 

 

–  To select how to determine the Midamble spread factor estimation either in full or maximum 
power search, toggle the Mid SF Map soft key and select Max or Spec. 

 

 NOTE 
The Max determines the spread factor of the Midamble by using the maximum power of 
the received Midamble, while the Spec searches “Default Midamble Allocation” based on 
the TD-SCDMA specification. 

 

–  To select the detect mode, press the Detect Mode soft key and then select the option: 
Auto, QPSK/8PSK, QPSK, 8PSK, 16 QAM, or 64 QAM. 

–  To set the relative threshold, complete the following steps: 
 Press the Threshold soft key. Its default setting is -27 dB. a
 Enter a value between -50 and zero by using the numeric keys. b
 Press the Enter soft key. c

 

Measurement example 

Figure 208 Code power measurement with TD-SCDMA signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication for the Max Inactive. See “Setting limit for modulation tests” 
on page 401 for more information. 

Code error 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 375, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 



Chapter 12 Using TD-SCDMA Signal Analyzer 

400 JD700B Series User’s Guide 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the Scramble soft key and select Auto or Manual to set the scramble code automatically 

or manually. 
3 Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1, 

TS2, TS3, TS4, TS5, or TS6. 
4 Press the Spread Factor soft key, and then select the spread factor option: DL Auto for auto 

detection of downlink, UL Auto for auto detection of uplink, SF1, SF2, SF4, SF8, or SF16 
5 To set the number of maximum users, complete the following steps: 

 Press the Max Users soft key. a
 Enter a value up to 16 by using the numeric keys. b
 Press the Enter soft key. c

6 Optional. Press the Miscellaneous soft key, and then do the following as needed: 
–  To set the delay, complete the following steps: 

 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

 NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

–  To select how to determine scrambling estimation, toggle the Scramble soft key and select 
Spec or Full. 

 

 NOTE 
The Spec searches “Sync Sequence Number” from 0 to 31 based on the TD-SCDMA 
specification and determines “Scrambling Code Number” by using the sync sequence 
number, while the Full does from 0 to 127 fully. 

 

–  To select how to determine the Midamble spread factor estimation either in full or maximum 
power search, toggle the Mid SF Map soft key and select Max or Spec. 

 

 NOTE 
The Max determines the spread factor of the Midamble by using the maximum power of 
the received Midamble, while the Spec searches “Default Midamble Allocation” based on 
the TD-SCDMA specification. 

 

–  To select the detect mode, press the Detect Mode soft key and then select the option: 
Auto, QPSK/8PSK, QPSK, 8PSK, 16 QAM, or 64 QAM. 

–  To set the relative threshold, complete the following steps: 
 Press the Threshold soft key. Its default setting is -27 dB. a
 Enter a value between -50 and zero by using the numeric keys. b
 Press the Enter soft key. c
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Measurement example 

Figure 209 Code error measurement with TD-SCDMA signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication for the Max Inactive. See “Setting limit for modulation tests” 
on page 401 for more information. 

 

Setting limit for modulation tests 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Modulation Test Limits soft key. 
3 Select the test item(s) and set the limit(s) depending on your selected measurement mode: 

 

To set the limit for Select Set 

Frequency error Frequency Error High Limit 
Low Limit 

Error vector magnitude rms EVM RMS High Limit 

Peak code domain error PCDE High Limit 

Highest level among inactive channels Max Inactive High Limit 
 

4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 32 for more information. 

 

Performing auto measurements 

The Auto Measure function of the JD700B series allows a complete signal profiling covering RF 
characterization and modulation quality parameters of up to 10 different carriers, particularly useful on 
an overlay architecture where base stations are transmitting in different frequencies. 
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The Auto Measure can be easily executed either by selecting a menu in the instrument or by running a 
programmed scenario in the PC-based application so that the instrument automatically configure and 
perform tests on every aspect of all the carriers. 
 

Setting limit 

You can set test limits for test item(s) in the auto measurement. 

Procedure 

1 Press the LIMIT hot key. 
2 Press the RF Test Limits soft key, and then enable test limits as desired. 
3 Press the PvsT Test Limits soft key, and then enable test limits as desired. 
4 Press the Modulation Test Limits soft key, and then enable test limits as desired. 
5 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 

Toggle the Beep soft key between On and Off to enable or disable the beep sound. 
6 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 

See “Using save” on page 32 for more information. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 375, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the Configuration soft key and select the configuration option: 

–  Current: Lets the instrumnet use current frequency (single carrier) and determine pass or 
fail based on the instrument’s limit settings in Auto Measure. 

–  Scenario: Runs a test with a programmed scenario in JDViewer. 
The Scenario menu becomes activated. 

3 To load a scenario, press the Scenario soft key, and then select a scenario file to load. 
4 Toggle the Test Time soft key and select the test time option: 

–  Now: Lets the instrument run a test only once. 

–  Schedule: Lets the instrument repeat tests as defined in the Set Timing. 
The Set Timing menu becomes activated. 

5 To define a schedule for an auto measurement, complete the following steps: 
 Press the Set Timing soft key. a
 Press the Start Time (HH:MM) soft key. b
 Enter the time in the HH:MM format, and then press the Enter soft key. c
 Press the Stop Time (HH:MM) soft key. d
 Enter the time in the HH:MM format, and then press the Enter soft key. e
 Press the Time Interval soft key. f
 Enter the amount of time in minutes, and then press the Enter soft key. g

6 Press the Settings soft key, and then set the following: 
 Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, a

TS1, TS2, TS3, TS4, TS5, or TS6. 
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 Toggle the External Offset soft key and select On. b
 Enter a value by using the numeric keys, and then press the dB soft key. c

7 To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you 
desire. See “Using save” on page 32 for more information. 

8 Press the Run Test soft key to start to run a test. 
The Auto Measure Results window appears at the end of the test. 

9 To stop running the test, press the Abort soft key. 
10 To change the view on the screen during the test, press the Display and then select the view 

option from the following choices: 
–  Screen: You can view each measurement screen as the test progresses. 

–  Results: You can view a measurement result table as the test progresses. 

–  Settings: You can view a measurement setting table as the test progresses. 

 

Setting display 

After completion of the auto measurement, the screen menu changes to Trace/Display so that you can 
view the results in different forms. 
 

Procedure 

1 Toggle the Display soft key and select the display option: 
–  Result: You can view the result table. 

The Display Result menu becomes activated. 

–  Settings: You can view the measurement settings for the auto measurement. 

2 Toggle the Display Result soft key and select the display result option: 
–  Full: You can view detailed measurement readings with the pass/fail indication. 

–  Quick: You can view only the Pass/Fail results. 

3 To view the measurement results for a different carrier, press the View Carrier soft key and then 
select the carrier number to view. 

 

Conducting TD-SCDMA OTA measurements 

Sync-DL ID scanner 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 375, you 
can continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the Sync-DL ID soft key and select Auto or Manual to set the Sync Downlink ID 

automatically or manually. 
3 Optional. To select the delay, complete the following steps: 

 Press the Miscellaneous soft key. a
 Press the Delay soft key to set the amount of delay in µs. b
 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Press the µs soft key. d
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 NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

4 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 32 for more information. 

 

Measurement example 

Figure 210 Sync-DL ID scanner measurement with TD-SCDMA OTA signal analyzer 

 
 

Sync-DL ID vs. Tau 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 375, you 
can continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the Sync-DL ID soft key and select Auto or Manual to set the Sync Downlink ID 

automatically or manually. 
3 Optional. To select the delay, complete the following steps: 

 Press the Miscellaneous soft key. a
 Press the Delay soft key to set the amount of delay in µs. b
 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Press the µs soft key. d

 

 NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

4 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 32 for more information. 
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Measurement example 

Figure 211 Sync-DL ID vs. Tau measurement with TD-SCDMA OTA signal analyzer 

 
 

Sync-DL ID multipath 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 375, you 
can continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the Sync-DL ID soft key and select Auto or Manual to set the Sync Downlink ID 

automatically or manually. 
3 Optional. To select the delay, complete the following steps: 

 Press the Miscellaneous soft key. a
 Press the Delay soft key to set the amount of delay in µs. b
 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Press the µs soft key. d

 

 NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

4 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 32 for more information. 
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Measurement example 

Figure 212 Sync-DL ID multipath measurement with TD-SCDMA OTA signal analyzer 

 
 

Sync-DL ID analyzer 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 375, you 
can continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the Sync-DL ID soft key and select Auto or Manual to set the Sync Downlink ID 

automatically or manually. 
3 Optional. To select the delay, complete the following steps: 

 Press the Miscellaneous soft key. a
 Press the Delay soft key to set the amount of delay in µs. b
 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Press the µs soft key. d

 

 NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

4 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 32 for more information. 

 

Setting limit for Sync-DL ID analyzer 

Procedure 

1 Press the LIMIT hot key. 
2 To set the limit for rms of the error vector magnitude, complete the following steps: 

 Press the EVM RMS soft key. a
 Toggle the Test Limits soft key between On and Off to enable or disable the limit. b
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 Press the High Limit soft key, and then enter a value for the upper threshold. c
 Press the Enter soft key. d

3 To set the limit for frequency error, complete the following steps: 
 Press the Frequency Error soft key. a
 Toggle the Test Limits soft key between On and Off to enable or disable the limit. b
 Press the High Limit soft key, and then enter a value for the upper threshold. c
 Press the ppm soft key. d
 Press the Low Limit soft key, and then enter a value for the lower threshold. e
 Press the ppm soft key. f

4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 32 for more information. 

 

Measurement example 

Figure 213 Sync-DL ID analyzer measurement with TD-SCDMA OTA signal analyzer 

 
 

Route map 

The JD700B Series provides indoor and outdoor mapping function that allows a user to collect data of 
points in an indoor or outdoor environment and track the received signals and coverage of RF 
transmitters plotting real time directly on top of a loaded floor plan or a map. 
 

Setting measure setup 

Procedure 

1 If required, connect a GPS receiver to your JD700B series for outdoor mapping. 
Indoor mapping does not necessarily need a GPS antenna. 

2 Configure test parameters as described in the “Configuring test parameters” on page 375. 
3 To load your map file, complete the following steps: 

 Plug in your USB drive that has a floor map or .mcf file type created in JDMapCreator. a
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 NOTE 
The JDMapCreator converts and resizes any scanned floor plan or layout to fit onto your 
instrument’s display. You must save your map file (.mcf) into the “SavedMap” folder of 
your USB drive so that you can load them onto your instrument. 

 

 Press SAVE/LOAD hot key, and then select Load > Load Map. b
See “Using load” on page 34 for more information. 

4 Press the MEASURE SETUP hot key. 
5 Press the Plot Point soft key, and then select the plot point option from the following choices: 

–  To collect data/plot points automatically as you move around in a vehicle or outside, press 
the GPS soft key and then toggle the Screen Mode soft key between Map and Full. 

 

 NOTE 
With the Map setting, you can view only the collected points that can be seen within the 
boundary of the loaded map. If a point is off the map, the instrument displays an arrow to 
indicate the direction of the current location on the map and the distance from the center 
to the location at the top of the screen. 
 
With the Full setting, you can view all the collected points of the route without the loaded 
map. 

 

–  To collect data/plot points manually without a GPS antenna in an indoor environment, press 
the Position soft key. 

6 Toggle the Plot soft key and select Start to start plotting. 
7 Touch directly on the screen or press the ENTER hard key to collect data and plot points on the 

loaded map for the Position setting. 
 

 NOTE 
For the Position setting, you can change the direction of the route with the arrow keys 
and the distance with the rotary knob. 

 

8 Toggle the Plot soft key and select Stop to stop plotting. 
9 Press the SAVE/LOAD hot key to save the result. 

See “Using save” on page 32 for more information. 
 

 NOTE 
The instrument does not automatically save the collected data. It is recommended that 
you save the result. Otherwise, you will lose all the collected data. 

 

 

Setting limit for route map 

You can set the thresholds for each test item. 
 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Excellent soft key to set its threshold. 
3 Enter a value, and then press the Enter soft key. You can also use the rotary knob. 
4 Press the Very Good soft key to set its threshold. 
5 Enter a value, and then press the Enter soft key. You can also use the rotary knob. 
6 Press the Good soft key to set its threshold. 
7 Enter a value, and then press the Enter soft key. You can also use the rotary knob. 
8 Press the Fair soft key to set its threshold. 
9 Enter a value, and then press the Enter soft key. You can also use the rotary knob. 
10 Press the Poor soft key to set its threshold. 
11 Enter a value, and then press the Enter soft key. You can also use the rotary knob. 
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12 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 32 for more information. 

 

Measurement example 

Figure 214 Route map measurement with TD-SCDMA OTA signal analyzer 

1) Map view 

 

2) Full view 
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Chapter 13 Using Mobile WiMAX Signal 

Analyzer 

This chapter provides instructions for using the Mobile WiMAX Signal Analyzer function (option 026) 
with the Mobile WiMAX OTA Analyzer function (option 046). Topics discussed in this chapter are as 
follows: 
 

 Introduction .............................................................................................................................. 411 

 Display overview ...................................................................................................................... 411 

 Connecting a cable .................................................................................................................. 412 

 Selecting measurement mode ................................................................................................. 414 

 Configuring test parameters .................................................................................................... 414 

 Conducting spectrum measurements ...................................................................................... 418 

 Conducting RF measurements ................................................................................................ 420 

 Conducting power vs. time (frame) measurements ................................................................. 427 

 Conducting modulation measurements ................................................................................... 429 

 Performing auto measurements .............................................................................................. 437 

 Performing power statistics CCDF measurements ................................................................. 438 

 Conducting Mobile WiMAX OTA measurements ..................................................................... 439 
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Introduction 

The Mobile WiMAX Signal Analyzer performs power and spectrum measurements as well as 
modulation analysis to test the proper transmitter performance of Mobile WiMAX systems. It performs 
conformance testing according to the following standards providing a simple Pass/Fail indication on 
each test. 
 

 IEEE 802.16e-2005 

 WiBro (Korean Mobile WiMAX OFDMA Service) 
 
This instrument provides the following measurement tools for Mobile WiMAX system: 
 

 Spectrum Analysis 

 RF Analysis 
- Channel Power 
- Occupied Bandwidth 
- Spectrum Emission Mask 
- Spurious Emissions 

 Power vs. Time (Frame) 

 Modulation Analysis 
- Constellation 
- Spectral Flatness 
- EVM vs. Subcarrier 
- EVM vs. Symbol 

 Auto Measure 

 Power Statistics CCDF 

 Over The Air (OTA) 
- Preamble Scanner 
- Multipath Profile 
- Preamble Power Trend 
- Route Map 

 

Display overview 

Figure 215 provides descriptions for each segment of the measurement screen. 
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Figure 215 Mobile WiMAX signal analyzer measurement screen 

 

 

Connecting a cable 

Direct connection 

Procedure 

1 Connect the Spectrum Analyzer RF In port of the JD700B series and the Power amplifier output 
port of BTS. 

 
Figure 216 Direct connection 

 
JD785B/JD745B 

 
JD788B/JD748B 

 

Indirect connection 

Procedure 

1 Connect the Spectrum Analyzer RF In port of the JD700B series and the monitor (test) port of 
BTS. 
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Figure 217 Indirect connection 

 
JD785B/JD745B 

 
JD788B/JD748B 

 

 

CAUTION 
The maximum power for the Spectrum Analyzer RF In port is +25 dBm (0.316 W) for 
JD780B series and +20 dBm (0.1 W) for JD740B series. If the level of the input signal to 
be measured is greater than this, use a High Power Attenuator to prevent damage 
when you directly connect the signal to the instrument or connect the signal from the 
coupling port of a directional coupler. 

 

Over the air (OTA) 

Procedure 

1 Connect an Omni/directional RF antenna to the Spectrum Analyzer RF In port of the JD700B 
series. 

2 Connect a GPS antenna to the GPS port of the JD700B series. 

 
Figure 218 OTA connection 

 
JD785B/JD745B 

 
JD788B/JD748B 

 

 

CAUTION 
If the input signal level to be measured is less than 0 dBm, set 0 dB attenuation or turn on 
the preamp to have better dynamic range for the OTA testing. 
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Selecting measurement mode 

Procedure 

1 Press the MODE hard key. 
2 Press the Signal Analyzer soft key. 
3 Press the More (1/2) > Mobile WiMAX soft key. The Spectrum mode is set by default. 
4 Press the MEASURE hot key, and then select the measurement mode option from the following 

choices: 
–  Spectrum 

–  RF Analysis > Channel Power, Occupied BW, Spectrum Emission Mask, or  
Spurious Emissions 

–  Power vs Time (Frame) 

–  Modulation Analysis > Constellation, Spectral Flatness, EVM vs Subcarrier, or  
EVM vs. Symbol 

–  Auto Measure 

–  Power Statistics CCDF 

–  OTA > Preamble Scanner, Multipath Profile, Preamble Power Trend, or Route Map 

 

Configuring test parameters 

Setting frequency 

You can set the frequency with either frequency or channel number. If a frequency to be set matches 
to the frequency corresponding to the selected channel standard, the instrument calculates its channel 
number and updates the screen with it automatically. 
 

Procedure 

To set the center frequency: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Freq. 
3 Press the Center Frequency soft key. 
4 Enter a value by using the numeric keys. You can also use the rotary knob. 
5 Select the unit: GHz, MHz, kHz, or Hz. 
6 Optional. To define the amount of frequency increment for the rotary knob, complete the following 

steps: 
 Press the Frequency Step soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the unit: GHz, MHz, kHz, or Hz. c

 
To set the channel number: 

1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Channel. 
3 To select the standard channel, complete the following steps: 

 Press the Channel Std soft key. The standard channel window appears. a
See “Appendix C – Band, frequency & channel standard” on page 530 for more information. 

 Highlight the band to be measured by using the rotary knob, the arrow keys, or the Page b
Up/Page Down soft keys. 

 Press the Select soft key or the rotary knob to confirm the selection. c
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4 Press the Channel Number soft key. 
5 Enter a value by using the numeric keys. You can also use the rotary knob. 
6 Press the Enter soft key. 
7 The instrument automatically displays the corresponding center frequency value for the selected 

channel number. 
8 Optional. To define the amount of channel increment for the rotary knob, complete the following 

steps: 
 Press the Channel Step soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

 
 NOTE 

This frequency setting is not used in the Spurious Emissions mode. 
 

Setting amplitude 

Reference level and attenuation 

You can set the reference and attenuation levels automatically or manually to optimize the display of 
the traces measured, as you desire. 
 

Procedure 

To automatically set the reference and attenuation level: 
1 Press the AMP/SCALE hard key. 
2 Press the Auto Scale soft key. 

Each time you press this key, both of the Y-axis scale and input attenuation level change to be 
optimized with some margin. 

 
To set the reference or attenuation level manually: 

1 Press the AMP/SCALE hard key. 
2 To set the maximum reference value on the Y-axis manually, complete the following steps: 

 Press the Reference Level soft key. a
 Enter a value by using the numeric keys or the rotary knob with 10 dB increments. b
 Press the dBm soft key or the ENTER hard key. c

This unit key name changes according to the setting in the Units menu. 
 

 NOTE 
In the measurements such as Midamble Power, Code Power, and Code Error, you 
may need to select the reference option between Relative and Absolute before setting 
the reference level. 

 

3 To set the attenuation option, select one from the following choices: 
–  To set the input attenuator’s level automatically, select Attenuation > Auto. 

 

 NOTE 
It is recommended that you set the Attenuation to Auto in most situations so that the 
level of the input attenuator can be set automatically according to your input signal level. 

 

–  To set the input attenuation manually up to 55 dB for JD780B series or 50 dB for JD740B 
series to optimize S/N, complete the following steps: 

 Select Attenuation > Manual. a
 Press the Attenuation Value soft key to set the level. b
 Enter a value in fives by using the numeric keys. c
 Press the dB soft key or the ENTER hard key. d
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–  To couple the input attenuator’s level with your reference level setting, select Attenuation > 
Couple. 
As you increase the reference setting, the attenuation level also increases acoordingly. 

 
Optional. To change the scale unit: 

1 Select More (1/2) > Units. 
2 Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W. 

The scale unit on the screen changes accordingly. 
 

 NOTE 
This Units menu is available in the Spectrum and RF Analysis modes. 

 

 

Scale per division 

You can use the Scale/Div feature available for the spectrum and RF analysis. It represents the value 
of one division on the horizontal scale. The default setting is 10 dB per division and the maximum 
value can be set up to 20 dB. 
 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Select More (1/2) > Scale/Div. 
3 Enter a value between 1 and 20 by using the numeric keys. 
4 Press the dB soft key to complete the entry. 

 

Pre-amplifier 

You can turn the internal pre-amplifier on to correct and compensate for the gain of the preamp so that 
amplitude readings show the value at the input connector. 
 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Toggle the Preamp soft key and select On or Off as needed. 

 
 NOTE 

You can turn the Preamp on when the input attenuation range is from 0 dB to 10 dB. If 
the attenuation value is manually set to greater than 10 dB, the instrument will 
automatically turn off the pre-amplifier to display low-level signal properly on the chart. 

 

External offset 

You can turn the External Offset on and manually set the external offset value. An offset consists of a 
cable loss and a user offset and the measurement result shows the value reflecting both offset values. 
When the external offset value is set at 40 dB in the Spectrum mode, the measurement result 
compensates 40 dB at both the Spectrum Analyzer and Signal Analyzer modes 
 

Procedure 

To set the external offset: 
1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select On. 
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3 Enter a value by using the numeric keys. 
4 Press the dB soft key to complete the entry. 

 
To turn the external offset off: 

1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select Off. 

 

Setting average 

You can set the number of measurements to be averaged for the trace presentation. A maximum of 
100 times of averaging can be set. When the averaging reaches to your setting, a new measurement 
value replaces the measurement value in sequence from the earliest. 
 

Procedure 

1 Press the BW/AVG hard key. 
2 Press the Average soft key. 
3 Enter a value between 1 and 100 as needed by using the numeric keys. 
4 Press the Enter soft key. 

 

Setting sweep mode 

The default setting is Continue to sweep continuously for most on-going measurements. If you want to 
hold the measurement or get a single sweep, you can change the sweep mode. 
 

Procedure 

To select the single sweep mode: 
1 Press the SWEEP hot key. 
2 Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key. 

The letter HOLD in red appears and the sweeping is paused. 
3 Optional. Press the Sweep Once soft key to get a new measurement. 

 
To return to the continuous sweep mode: 

1 Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key. 
The letter HOLD in red disappears and the sweeping resumes. 

 

Setting trigger source 

You can set the trigger source option for your measurements. 

Procedure 

1 Press the TRIGGER hot key. 
2 Select the trigger source option from the choices: Internal, External, and GPS. 

 

Setting external clock 

To enhance the reliability of modulation analysis measurements the JD700B series must be 
synchronized with a base station. When an external clock is not supplied, the instrument works with its 
built-in internal high-accuracy time base and some measurement results may exhibit inaccurate values. 
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Therefore, it is highly recommended that you use the same reference clock as the signal source. You 
can use the TRIGGER hot key to set the external clock. 
 

Figure 219 Connection ports for external reference clock 

 
 

Procedure 

1 Connect an external reference or a GPS antenna to the JD700B series. 
2 Press the SYSTEM hot key. 
3 Press the Freq Reference soft key, and then select the reference option: Internal, External 10 

MHz, External 13 MHz, External 15 MHz, or GPS. 

 
Table 20 External reference indicators 

Type Indicator Description 

Internal  (green) The green INT icon indicates that the instrument uses the built-in 
internal time base. 

External  (green) The green EXT icon indicates that an external reference is connected 
and locked and that the instrument uses the same reference clock as 
the signal source. 

External  (red) The red EXT icon indicates that an external reference is connect but not 
locked. 

GPS      (green) The green GPS antenna icon indicates that a GPS antenna is 
connected and locked. 

GPS      (yellow) The yellow GPS antenna icon indicates that a GPS antenna is 
connected and locking is in progress. 

GPS      (grey) The grey GPS antenna icon indicates that a GPS antenna is not 
connected, failed, or unable to be locked. 

 

Conducting spectrum measurements 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 414, you 
can continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the System Config soft key, and then do the following: 

 Press the Bandwidth soft key, and then select the nominal channel bandwidth to be a
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measured from the following choices: 
–  7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In 

conjunction with nominal channel bandwidth 

–  8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7 

–  10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25 

 Toggle the Frame Length soft key and select 5 ms or 10 ms. b
 Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last c

sample of the downlink burst and the first sample of the subsequent uplink burst. 
 Enter a value by using the numeric keys, and then press the Enter soft key. d
 Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or e

1/32. 
 Press the DL Symbols soft key to set the number of downlink symbols. f
 Enter a value by using the numeric keys, and then press the Enter soft key. g
 Press the UL Symbols soft key to set the number of uplink symbols. h

 Enter a value by using the numeric keys, and then press the Enter soft key. i
3 Optional. To set the delay, complete the following steps: 

 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

 NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

 
Your measurement result is displayed on the screen as like the following example, Figure 220. 
 

Figure 220 Spectrum measurement screen with Mobile WiMAX signal analyzer 

 
 

Setting trace 

You can display up to six traces on the measurement chart simultaneously. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
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2 Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6. 
The legend shape of the selected trace changes from square to round to indicate that the trace is 
the active one now. 

3 Toggle the Trace View soft key and select On. 
4 Do one of the following: 

 

To Select Trace Legend 

Clear current data and display with new 
measurements 

Clear Write W 

Display the input signal’s maximum response only 
(unlimited or for a certain amount of time) 

Max Hold M 

Display the input signal’s minimum response only 
(unlimited or for a certain amount of time) 

Min Hold m 

Capture the selected trace and compare traces Capture C 

Load a saved trace More (1/2) > Load L 

Hide the selected trace Trace View > Off F 

Remove all the traces and initialize the trace 
settings 

More (1/2) > Trace 
Clear All 

 

 

 NOTE 
For the Max Hold and Min Hold, your instrument compares newly acquired data with the 
active trace and displays larger maximum values or smaller minimum values on the 
screen. You can set it to Unlimited to hold and view maximum or minimum data or 
specify a certain amount of time up to 60 seconds by using numeric keys or the rotary 
knob. 

5 Optional. Press the More (1/2) > Trace Info soft key, and then select the trace number to view 
the trace’s parameter setting information stored at the time of the measurement or None to hide 
the information display. 

6 Optional. If you have the two traces T1 and T2, you can perform trace math. To view the power 
difference between the traces, press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key. 
The result is overlaid on the screen along with the second Y-axis. 

 

Conducting RF measurements 

Channel power 

The Channel Power measurement is a common test used in the wireless industry to measure the total 
transmitted power of a radio within a defined frequency channel. It acquires a number of points 
representing the input signal in the time domain, transforms this information into the frequency domain 
using Fast Fourier Transform (FFT), and then calculates the channel power. The effective resolution 
bandwidth of the frequency domain trace is proportional to the number of points acquired for the FFT. 
 
The channel power measurement identifies the total RF power, power spectral density (PSD) and peak 
to average ratio (PAR) of the signal in the Mobile WiMAX channel bandwidth. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 414, you 
can continue your measurement. 
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Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the System Config soft key, and then do the following: 

 Press the Bandwidth soft key, and then select the nominal channel bandwidth to be a
measured from the following choices: 
–  7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In 

conjunction with nominal channel bandwidth 

–  8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7 

–  10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25 

 Toggle the Frame Length soft key and select 5 ms or 10 ms. b
 Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last c

sample of the downlink burst and the first sample of the subsequent uplink burst. 
 Enter a value by using the numeric keys, and then press the Enter soft key. d
 Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or e

1/32. 
 Press the DL Symbols soft key to set the number of downlink symbols. f
 Enter a value by using the numeric keys, and then press the Enter soft key. g
 Press the UL Symbols soft key to set the number of uplink symbols. h

 Enter a value by using the numeric keys, and then press the Enter soft key. i
3 Optional. To set the delay, complete the following steps: 

 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

 NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

4 To set the start/stop symbols, complete the following steps: 
 Press the Start Symbol soft key. a
 Enter a value by using the numeric keys, and then press the Enter soft key. b
 Press the Stop Symbol soft key. c
 Enter a value by using the numeric keys, and then press the Enter soft key. d

 



Chapter 13 Using Mobile WiMAX Signal Analyzer 

422 JD700B Series User’s Guide 

Measurement example 

Figure 221 Channel power measurement with Mobile WiMAX signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 427 for more 
information. 

 

Occupied bandwidth 

The Occupied Bandwidth measures the spectrum shape of the carrier. It is defined as the bandwidth, 
which includes 99% of the transmitted power among total transmitted power. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 414, you 
can continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the System Config soft key, and then do the following: 

 Press the Bandwidth soft key, and then select the nominal channel bandwidth to be a
measured from the following choices: 
–  7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In 

conjunction with nominal channel bandwidth 

–  8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7 

–  10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25 

 Toggle the Frame Length soft key and select 5 ms or 10 ms. b
 Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last c

sample of the downlink burst and the first sample of the subsequent uplink burst. 
 Enter a value by using the numeric keys, and then press the Enter soft key. d
 Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or e

1/32. 
 Press the DL Symbols soft key to set the number of downlink symbols. f
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 Enter a value by using the numeric keys, and then press the Enter soft key. g
 Press the UL Symbols soft key to set the number of uplink symbols. h

 Enter a value by using the numeric keys, and then press the Enter soft key. i
3 Optional. To set the delay, complete the following steps: 

 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

 NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

4 To set the start/stop symbols, complete the following steps: 
 Press the Start Symbol soft key. a
 Enter a value by using the numeric keys, and then press the Enter soft key. b
 Press the Stop Symbol soft key. c
 Enter a value by using the numeric keys, and then press the Enter soft key. d

 

Measurement example 

Figure 222 Occupied bandwidth measurement with Mobile WiMAX signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 427 for more 
information. 

 

Spectrum emission mask (SEM) 

The Spectrum Emission Mask (SEM) measurement compares the total power level within the defined 
carrier bandwidth and the given offset channels according to the standards. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 414, you 
can continue your measurement. 
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Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the System Config soft key, and then do the following: 

 Press the Bandwidth soft key, and then select the nominal channel bandwidth to be a
measured from the following choices: 
–  7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In 

conjunction with nominal channel bandwidth 

–  8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7 

–  10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25 

 Toggle the Frame Length soft key and select 5 ms or 10 ms. b
 Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last c

sample of the downlink burst and the first sample of the subsequent uplink burst. 
 Enter a value by using the numeric keys, and then press the Enter soft key. d
 Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or e

1/32. 
 Press the DL Symbols soft key to set the number of downlink symbols. f
 Enter a value by using the numeric keys, and then press the Enter soft key. g
 Press the UL Symbols soft key to set the number of uplink symbols. h

 Enter a value by using the numeric keys, and then press the Enter soft key. i
3 Optional. To set the delay, complete the following steps: 

 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

 NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

4 To set the start/stop symbols, complete the following steps: 
 Press the Start Symbol soft key. a
 Enter a value by using the numeric keys, and then press the Enter soft key. b
 Press the Stop Symbol soft key. c
 Enter a value by using the numeric keys, and then press the Enter soft key. d
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Measurement example 

Figure 223 SEM measurement with Mobile WiMAX signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 427 for more 
information. 

 

Spurious emissions 

Out-of-band emissions are unwanted emissions immediately outside the channel bandwidth resulting 
from the modulation process and non-linearity in the transmitter but excluding spurious emissions. The 
Spurious Emissions measurement is to identify and determine the power level of out-of-band spurious 
emission within the necessary channel bandwidth and modulated signal measured at the RF port of 
the Base Station. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 414, you 
can continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set up the range table and frequency range, press the Range Table soft key and then 

complete the following steps: 
 Press the Range soft key, and then enter the range number to add a new range or change a

an existing one. 
 Press the Enter soft key. b
 Press the Start Frequency soft key to set up the frequency range. c
 Enter a value by using the numeric keys. You can also use the rotary knob. d
 Select the unit: GHz, MHz, kHz, or Hz. e
 Press the Stop Frequency soft key to set up the frequency range. f
 Enter a value by using the numeric keys. You can also use the rotary knob. g
 Select the unit: GHz, MHz, kHz, or Hz. h
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3 Toggle the Range soft key between On and Off to display or hide the selected range. 
4 To set up the test limits for Pass/Fail indication, complete the following steps: 

 Press the Start Limit soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the dBm soft key. c
 Press the Stop Limit soft key. d
 Enter a value by using the numeric keys. You can also use the rotary knob. e
 Select the dBm soft key. f

5 To set up the other parameters, complete the following steps: 
 Select More (1/2) > Attenuation to set up the attenuation value. a
 Enter a value in the multiple of five. b
 Press the dB soft key or the ENTER hard key. c
 Press the RBW soft key. d
 Enter a value by using the numeric keys. e
 Select the unit: GHz, MHz, kHz, or Hz. f
 Press the VBW soft key. g
 Enter a value by using the numeric keys. h

 Select the unit: GHz, MHz, kHz, or Hz. i
6 Press the PREV hard key. 
7 Toggle the Measure Type soft key between Examine and Full to select the measurement type. 

 

 NOTE 
The Examine mode displays only the selected range while the Full mode lets the 
instrument automatically changes the selected range from one another. 

 

8 Set the number of measurements to be averaged: 
 Press the Average soft key. a
 Enter a value between 1 and 100. b
 Press the Enter soft key. c

 

Measurement example 

Figure 224 Spurious emissions measurement with Mobile WiMAX signal analyzer 
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 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 427 for more 
information. 

 

Setting limit for RF tests 

By default, test limits specified in the standard are set for you. You can change thresholds if you desire. 
 

Procedure 

1 Press the LIMIT hot key. 
2 Press the RF Test Limits soft key. 
3 Select the test item(s) and set the limit(s) depending on your selected measurement mode: 

 

To set the limit for Select Set 

Channel power Channel Power High Limit 
Low Limit 

Occupied bandwidth Occupied BW High Limit 

Spectrum emission mask Spectrum Emission Mask (On/Off only) 

Spurious emissions Spurious Emissions (On/Off only) 
 

4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 32 for more information. 

 

Conducting power vs. time (frame) measurements 

The Power vs. Time (Frame) measures the modulation envelope in the time domain, showing the 
power of each time slot in a Mobile WiMAX signal. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 414, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the System Config soft key, and then do the following: 

 Press the Bandwidth soft key, and then select the nominal channel bandwidth to be a
measured from the following choices: 
–  7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In 

conjunction with nominal channel bandwidth 

–  8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7 

–  10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25 

 Toggle the Frame Length soft key and select 5 ms or 10 ms. b
 Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last c

sample of the downlink burst and the first sample of the subsequent uplink burst. 
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 Enter a value by using the numeric keys, and then press the Enter soft key. d
 Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or e

1/32. 
 Press the DL Symbols soft key to set the number of downlink symbols. f
 Enter a value by using the numeric keys, and then press the Enter soft key. g
 Press the UL Symbols soft key to set the number of uplink symbols. h

 Enter a value by using the numeric keys, and then press the Enter soft key. i
3 To set the start/stop symbols, complete the following steps: 

 Press the Start Symbol soft key. a
 Enter a value by using the numeric keys, and then press the Enter soft key. b
 Press the Stop Symbol soft key. c
 Enter a value by using the numeric keys, and then press the Enter soft key. d

4 Toggle the Preamble Index soft key and select the preamble search method: Auto or Manual. 
5 Toggle the Search Type soft key and select Full or Window. 
6 Toggle the Video Filter soft key and select On or Off to enable or disable the video filter. 
7 Optional. Press the Miscellaneous soft key, and then do the following as needed: 

–  To set the delay, complete the following steps: 
 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

 NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

–  To select the detect mode, press the Detect Mode soft key and then select the option: 
Auto, QPSK, 16 QAM, or 64 QAM. 
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Setting limit for power vs. time tests 

Procedure 

1 Press the LIMIT hot key. 
2 Press the PvsT Test Limits soft key. 
3 Select the test item(s) and set the limit(s): 

 

To set the limit for Select Set 

Preamble power Preamble Power High Limit, Low Limit 

Downlink burst power DL Burst Power High Limit, Low Limit 

Uplink burst power UL Burst Power High Limit, Low Limit 

Frame average power Frame Average Power High Limit, Low Limit 

Time offset Time Offset High Limit, Low Limit 

I/Q origin offset IQ Origin Offset High Limit 
 

4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 32 for more information. 

 

Measurement example 

Figure 225 Power vs. time (frame) measurement with Mobile WiMAX signal analyzer 

 
 

Conducting modulation measurements 

Constellation 

The Constellation is used to observe some aspects of modulation accuracy and can reveal certain 
fault mechanisms such as I/Q amplitude imbalance or quadrature imbalance. It displays constellation 
diagram by modulation types. 
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Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 414, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the System Config soft key, and then do the following: 

 Press the Bandwidth soft key, and then select the nominal channel bandwidth to be a
measured from the following choices: 
–  7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In 

conjunction with nominal channel bandwidth 

–  8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7 

–  10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25 

 Toggle the Frame Length soft key and select 5 ms or 10 ms. b
 Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last c

sample of the downlink burst and the first sample of the subsequent uplink burst. 
 Enter a value by using the numeric keys, and then press the Enter soft key. d
 Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or e

1/32. 
 Press the DL Symbols soft key to set the number of downlink symbols. f
 Enter a value by using the numeric keys, and then press the Enter soft key. g
 Press the UL Symbols soft key to set the number of uplink symbols. h

 Enter a value by using the numeric keys, and then press the Enter soft key. i
3 To set the start/stop symbols, complete the following steps: 

 Press the Start/Stop Symbol soft key. a
 Enter a value by using the numeric keys, and then press the Enter soft key. b

4 Toggle the Preamble Index soft key and select the preamble search method: Auto or Manual. 
5 Toggle the Search Type soft key and select Full or Window. 
6 Optional. Press the Miscellaneous soft key, and then do the following as needed: 

–  To select the detect mode, press the Detect Mode soft key and then select the option: 
Auto, QPSK, 16 QAM, or 64 QAM. 

–  To select the downlink zone, press the DL Zone soft key and then select the permutation 
zone option: Auto, PUSC for partial usage of subcarrier channels, FUSC for full usage of 
subcarrier channels, or AMC2X3 for adaptive modulation and coding. 

 

 NOTE 
The permutation zone that is a number of contiguous OFDMA symbols in downlink that 
use the same permutation. The DL subframe may contain more than one permutation 
zone. The maximum number of DL zone is 8 in one DL subframe. 

 

–  To set the delay, complete the following steps: 
 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

 NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 
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Measurement example 

Figure 226 Constellation measurement with Mobile WiMAX signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 436 for 
more information. The Spectral Flatness is not used in the Constellation mode. 

 

Spectral flatness 

The Spectral Flatness is used to measure the flatness energy of the constellation according to the 
WiMAX specification IEEE 802.16e. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 414, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the System Config soft key, and then do the following: 

 Press the Bandwidth soft key, and then select the nominal channel bandwidth to be a
measured from the following choices: 
–  7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In 

conjunction with nominal channel bandwidth 

–  8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7 

–  10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25 

 Toggle the Frame Length soft key and select 5 ms or 10 ms. b
 Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last c

sample of the downlink burst and the first sample of the subsequent uplink burst. 
 Enter a value by using the numeric keys, and then press the Enter soft key. d
 Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or e



Chapter 13 Using Mobile WiMAX Signal Analyzer 

432 JD700B Series User’s Guide 

1/32. 
 Press the DL Symbols soft key to set the number of downlink symbols. f
 Enter a value by using the numeric keys, and then press the Enter soft key. g
 Press the UL Symbols soft key to set the number of uplink symbols. h

 Enter a value by using the numeric keys, and then press the Enter soft key. i
3 To set the start/stop symbols, complete the following steps: 

 Press the Start Symbol soft key. a
 Enter a value by using the numeric keys, and then press the Enter soft key. b
 Press the Stop Symbol soft key. c
 Enter a value by using the numeric keys, and then press the Enter soft key. d

4 Toggle the Preamble Index soft key and select the preamble search method: Auto or Manual. 
5 Toggle the Search Type soft key and select Full or Window. 
6 Optional. Press the Miscellaneous soft key, and then do the following as needed: 

–  To select the detect mode, press the Detect Mode soft key and then select the option: 
Auto, QPSK, 16 QAM, or 64 QAM. 

–  To select the downlink zone, press the DL Zone soft key and then select the permutation 
zone option: Auto, PUSC for partial usage of subcarrier channels, FUSC for full usage of 
subcarrier channels, or AMC2X3 for adaptive modulation and coding. 

 

 NOTE 
The permutation zone, which is a number of contiguous OFDMA, symbols in downlink 
that use the same permutation. The DL subframe may contain more than one 
permutation zone. The maximum number of DL zone is 8 in one DL subframe. 

 

–  To set the delay, complete the following steps: 
 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

 NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

 

Measurement example 

Figure 227 Spectral flatness measurement with Mobile WiMAX signal analyzer 
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 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication for the Spectral Flatness. See “Setting limit for modulation 
tests” on page 436 for more information. 

 

EVM vs. subcarrier 

The EVM vs Subcarrier shows the error vector magnitude representing the average constellation error 
of WIMAX OFDMA subcarriers. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 414, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the System Config soft key, and then do the following: 

 Press the Bandwidth soft key, and then select the nominal channel bandwidth to be a
measured from the following choices: 
–  7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In 

conjunction with nominal channel bandwidth 

–  8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7 

–  10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25 

 Toggle the Frame Length soft key and select 5 ms or 10 ms. b
 Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last c

sample of the downlink burst and the first sample of the subsequent uplink burst. 
 Enter a value by using the numeric keys, and then press the Enter soft key. d
 Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or e

1/32. 
 Press the DL Symbols soft key to set the number of downlink symbols. f
 Enter a value by using the numeric keys, and then press the Enter soft key. g
 Press the UL Symbols soft key to set the number of uplink symbols. h

 Enter a value by using the numeric keys, and then press the Enter soft key. i
3 To set the start/stop symbols, complete the following steps: 

 Press the Start/Stop Symbol soft key. a
 Enter a value by using the numeric keys, and then press the Enter soft key. b

4 Toggle the Preamble Index soft key and select the preamble search method: Auto or Manual. 
5 Toggle the Search Type soft key and select Full or Window. 
6 Optional. Press the Miscellaneous soft key, and then do the following as needed: 

–  To select the detect mode, press the Detect Mode soft key and then select the option: 
Auto, QPSK, 16 QAM, or 64 QAM. 

–  To select the downlink zone, press the DL Zone soft key and then select the permutation 
zone option: Auto, PUSC for partial usage of subcarrier channels, FUSC for full usage of 
subcarrier channels, or AMC2X3 for adaptive modulation and coding. 

 

 NOTE 
The permutation zone, which is a number of contiguous OFDMA, symbols in downlink 
that use the same permutation. The DL subframe may contain more than one 
permutation zone. The maximum number of DL zone is 8 in one DL subframe. 
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–  To set the delay, complete the following steps: 
 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

 NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

 

Measurement example 

Figure 228 EVM vs. subcarrier measurement with Mobile WiMAX signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 436 for 
more information. The Spectral Flatness and Frequency Error are not used in the EVM 
vs. Subcarrier mode. 

 

EVM vs. symbol 

The EVM vs Symbol is used to show the error vector magnitude representing the average 
constellation error of WiMAX OFDMA symbols. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 414, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the System Config soft key, and then do the following: 

 Press the Bandwidth soft key, and then select the nominal channel bandwidth to be a
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measured from the following choices: 
–  7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In 

conjunction with nominal channel bandwidth 

–  8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7 

–  10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25 

 Toggle the Frame Length soft key and select 5 ms or 10 ms. b
 Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last c

sample of the downlink burst and the first sample of the subsequent uplink burst. 
 Enter a value by using the numeric keys, and then press the Enter soft key. d
 Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or e

1/32. 
 Press the DL Symbols soft key to set the number of downlink symbols. f
 Enter a value by using the numeric keys, and then press the Enter soft key. g
 Press the UL Symbols soft key to set the number of uplink symbols. h

 Enter a value by using the numeric keys, and then press the Enter soft key. i
3 To set the start/stop symbols, complete the following steps: 

 Press the Start/Stop Symbol soft key. a
 Enter a value by using the numeric keys, and then press the Enter soft key. b

4 Toggle the Preamble Index soft key and select the preamble search method: Auto or Manual. 
5 Toggle the Search Type soft key and select Full or Window. 
6 Optional. Press the Miscellaneous soft key, and then do the following as needed: 

–  To select the detect mode, press the Detect Mode soft key and then select the option: 
Auto, QPSK, 16 QAM, or 64 QAM. 

–  To select the downlink zone, press the DL Zone soft key and then select the permutation 
zone option: Auto, PUSC for partial usage of subcarrier channels, FUSC for full usage of 
subcarrier channels, or AMC2X3 for adaptive modulation and coding. 

 

 NOTE 
The permutation zone, which is a number of contiguous OFDMA, symbols in downlink 
that use the same permutation. The DL subframe may contain more than one 
permutation zone. The maximum number of DL zone is 8 in one DL subframe. 

 

–  To set the delay, complete the following steps: 
 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

 NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 
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Measurement example 

Figure 229 EVM vs. symbol measurement with Mobile WiMAX signal analyzer 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 436 for 
more information. The Spectral Flatness and Frequency Error are not used in the EVM 
vs. Subcarrier mode. 

 

Setting limit for modulation tests 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Modulation Test Limits soft key to set the limits. 
3 Select the test item(s) and set the limit(s) depending on your selected measurement mode: 

 

To set the limit for Select Set 

Spectral flatness Spectral Flatness On/Off 

Frequency error Frequency Error High Limit 
Low Limit 

RMS for RCE RCE RMS High Limit 

Peak for RCE RCE Peak High Limit 

RMS for error vector magnitude EVM RMS High Limit 

Peak for error vector magnitude EVM Peak High Limit 
 

4 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 32 for more information. 
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Performing auto measurements 

The Auto Measure function of the JD700B series allows a complete signal profiling covering RF 
characterization and modulation quality parameters of up to 10 different carriers, particularly useful on 
an overlay architecture where base stations are transmitting in different frequencies. 
 
The Auto Measure can be easily executed either by selecting a menu in the instrument or by running a 
programmed scenario in the PC-based application so that the instrument automatically configure and 
perform tests on every aspect of all the carriers. 
 

Setting limit 

You can set test limits for test item(s) in the auto measurement. 

Procedure 

1 Press the LIMIT hot key. 
2 Press the RF Test Limits soft key, and then enable test limits as desired. 
3 Press the PvsT Test Limits soft key, and then enable test limits as desired. 
4 Press the Modulation Test Limits soft key, and then enable test limits as desired. 
5 Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 

Toggle the Beep soft key between On and Off to enable or disable the beep sound. 
6 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 

See “Using save” on page 32 for more information. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 414, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the Configuration soft key and select the configuration option: 

–  Current: Lets the instrumnet use current frequency (single carrier) and determine pass or 
fail based on the instrument’s limit settings in Auto Measure. 

–  Scenario: Runs a test with a programmed scenario in JDViewer. 
The Scenario menu becomes activated. 

3 To load a scenario, press the Scenario soft key, and then select a scenario file to load. 
4 Toggle the Test Time soft key and select the test time option: 

–  Now: Lets the instrument run a test only once. 

–  Schedule: Lets the instrument repeat tests as defined in the Set Timing. 
The Set Timing menu becomes activated. 

5 To define a schedule for an auto measurement, complete the following steps: 
 Press the Set Timing soft key. a
 Press the Start Time (HH:MM) soft key. b
 Enter the time in the HH:MM format, and then press the Enter soft key. c
 Press the Stop Time (HH:MM) soft key. d
 Enter the time in the HH:MM format, and then press the Enter soft key. e
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 Press the Time Interval soft key. f
 Enter the amount of time in minutes, and then press the Enter soft key. g

6 Press the Settings soft key, and then set the following: 
 Press the Start Symbol soft key. a
 Enter a value by using the numeric keys, and then press the Enter soft key. b
 Press the Stop Symbol soft key. c
 Enter a value by using the numeric keys, and then press the Enter soft key. d
 Toggle the External Offset soft key and select On or Off. e
 Enter a value by using the numeric keys, and then press the dB soft key. f

7 To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you 
desire. See “Using save” on page 32 for more information. 

8 Press the Run Test soft key to start to run a test. 
The Auto Measure Results window appears at the end of the test. 

9 To stop running the test, press the Abort soft key. 
10 To change the view on the screen during the test, press the Display and then select the view 

option from the following choices: 
–  Screen: You can view each measurement screen as the test progresses. 

–  Results: You can view a measurement result table as the test progresses. 

–  Settings: You can view a measurement setting table as the test progresses. 

 

Setting display 

After completion of the auto measurement, the screen menu changes to Trace/Display so that you can 
view the results in different forms. 
 

Procedure 

1 Toggle the Display soft key and select the display option: 
–  Result: You can view the result table. 

The Display Result menu becomes activated. 

–  Settings: You can view the measurement settings for the auto measurement. 

2 Toggle the Display Result soft key and select the display result option: 
–  Full: You can view detailed measurement readings with the pass/fail indication. 

–  Quick: You can view only the Pass/Fail results. 

3 To view the measurement results for a different carrier, press the View Carrier soft key and then 
select the carrier number to view. 

 

Performing power statistics CCDF measurements 

The Power Statistics Complementary Cumulative Distribution Function (CCDF) measurement 
characterizes the power statistics of the input signal. It provides PAR (Peak to Average power Ratio) 
versus different probabilities. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 414, you 
can continue your measurement. The measurement settings can be saved and recalled as a file. You 
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 
the file on to the instrument. 
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Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the CCDF Length soft key to set the length of the CCDF. 
3 Enter a value between 1 and 100 by using the numeric keys. You can also use the rotary knob. 
4 Press the Enter soft key. 

 

Measurement example 

Figure 230 CCDF measurement with Mobile WiMAX signal analyzer 

 
 

Conducting Mobile WiMAX OTA measurements 

This Over The Air (OTA) measurement has preamble scanner, multipath profile, and preamble power 
trend screens. Preamble scanner displays six preambles and relative powers to inform neighbor cells 
existence. The multipath profile graph helps the user to determine testing area's RF environmental 
condition. The preamble power trend shows power variations of selected preamble over time along 
with relative power trend for strongest preamble. 
 

Preamble scanner 

The OTA Preamble Scanner displays the six strongest preambles to inform neighbor cells existence of 
testing area. Preamble Index, Relative Power, Cell ID, and Sector ID are listed in for each preamble 
signal with Time Offset in us. Positioning information, latitude, and longitude will be displayed if a GPS 
antenna is supplied and locked to the GPS satellites on the bottom of the screen. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 414, you 
can continue your measurement. 
  



Chapter 13 Using Mobile WiMAX Signal Analyzer 

440 JD700B Series User’s Guide 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the System Config soft key, and then do the following: 

 Press the Bandwidth soft key, and then select the nominal channel bandwidth to be a
measured from the following choices: 
–  7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In 

conjunction with nominal channel bandwidth 

–  8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7 

–  10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25 

 Toggle the Frame Length soft key and select 5 ms or 10 ms. b
 Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last c

sample of the downlink burst and the first sample of the subsequent uplink burst. 
 Enter a value by using the numeric keys, and then press the Enter soft key. d
 Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or e

1/32. 
 Press the DL Symbols soft key to set the number of downlink symbols. f
 Enter a value by using the numeric keys, and then press the Enter soft key. g
 Press the UL Symbols soft key to set the number of uplink symbols. h

 Enter a value by using the numeric keys, and then press the Enter soft key. i
3 Optional. Press the Miscellaneous soft key, and then do the following steps: 

 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

 NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

4 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 32 for more information. 

 

Measurement example 

Figure 231 Preamble scanner measurement with Mobile WiMAX OTA signal analyzer 
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Multipath profile 

The Multipath Profile enables the user to determine RF environmental conditions of testing area. It 
indicates the multipath power with time delay in us up to six. 
 
The multipath profile is the result of portions of the original broadcast signal arriving at the receiving 
antenna out of phase. This can be caused by the signal being reflected off objects such as buildings, 
or being refracted through the atmosphere differently from the main signal. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 414, you 
can continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the System Config soft key, and then do the following: 

 Press the Bandwidth soft key, and then select the nominal channel bandwidth to be a
measured from the following choices: 
–  7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In 

conjunction with nominal channel bandwidth 

–  8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7 

–  10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25 

 Toggle the Frame Length soft key and select 5 ms or 10 ms. b
 Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last c

sample of the downlink burst and the first sample of the subsequent uplink burst. 
 Enter a value by using the numeric keys, and then press the Enter soft key. d
 Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or e

1/32. 
 Press the DL Symbols soft key to set the number of downlink symbols. f
 Enter a value by using the numeric keys, and then press the Enter soft key. g
 Press the UL Symbols soft key to set the number of uplink symbols. h

 Enter a value by using the numeric keys, and then press the Enter soft key. i
3 Optional. Press the Miscellaneous soft key, and then do the following steps: 

 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

 NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

4 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 32 for more information. 
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Measurement example 

Figure 232 Multipath profile measurement with Mobile WiMAX OTA signal analyzer 

 
 

Preamble power trend 

The Preamble Power Trend shows power variations of a strongest preamble signal over time along 
with the relative power trend compare to total preamble power. Searching preamble index can be set 
auto to detect strongest or manual to search specific preamble. Positioning information, latitude, and 
longitude will be displayed if a GPS antenna is supplied and locked to the GPS satellites on the bottom 
of the screen. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 414, you 
can continue your measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the System Config soft key, and then do the following: 

 Press the Bandwidth soft key, and then select the nominal channel bandwidth to be a
measured from the following choices: 
–  7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In 

conjunction with nominal channel bandwidth 

–  8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7 

–  10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25 

 Toggle the Frame Length soft key and select 5 ms or 10 ms. b
 Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last c

sample of the downlink burst and the first sample of the subsequent uplink burst. 
 Enter a value by using the numeric keys, and then press the Enter soft key. d
 Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or e

1/32. 
 Press the DL Symbols soft key to set the number of downlink symbols. f
 Enter a value by using the numeric keys, and then press the Enter soft key. g
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 Press the UL Symbols soft key to set the number of uplink symbols. h
 Enter a value by using the numeric keys, and then press the Enter soft key. i

3 Toggle the Preamble Index soft key and select the preamble search method: Auto or Manual. 
4 Optional. Press the Miscellaneous soft key, and then do the following steps: 

 Press the Delay soft key to set the amount of delay in µs. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the µs soft key. c

 

 NOTE 
The Delay setting is used only when there is a time offset in the signals to be measured. 

 

5 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 32 for more information. 

 

Measurement example 

Figure 233 Preamble power trend with Mobile WiMAX OTA signal analyzer 

 
 

Route map 

The JD700B Series provides indoor and outdoor mapping function that allows a user to collect data of 
points in an indoor or outdoor environment and track the received signals and coverage of RF 
transmitters plotting real time directly on top of a loaded floor plan or a map. 
 

Setting measure setup 

Procedure 

1 If required, connect a GPS receiver to your JD700B series for outdoor mapping. 
Indoor mapping does not necessarily need a GPS antenna. 

2 Configure test parameters as described in the “Configuring test parameters” on page 414. 
3 To load your map file, complete the following steps: 

 Plug in your USB drive that has a floor map or .mcf file type created in JDMapCreator. a
 

 NOTE 
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The JDMapCreator converts and resizes any scanned floor plan or layout to fit onto your 
instrument’s display. You must save your map file (.mcf) into the “SavedMap” folder of 
your USB drive so that you can load them onto your instrument. 

 

 Press SAVE/LOAD hot key, and then select Load > Load Map. b
See “Using load” on page 34 for more information. 

4 Press the MEASURE SETUP hot key. 
5 Press the Plot Point soft key, and then select the plot point option from the following choices: 

–  To collect data/plot points automatically as you move around in a vehicle or outside, press 
the GPS soft key and then toggle the Screen Mode soft key between Map and Full. 

 

 NOTE 
With the Map setting, you can view only the collected points that can be seen within the 
boundary of the loaded map. If a point is off the map, the instrument displays an arrow to 
indicate the direction of the current location on the map and the distance from the center 
to the location at the top of the screen. 
 
With the Full setting, you can view all the collected points of the route without the loaded 
map. 

 

–  To collect data/plot points manually without a GPS antenna in an indoor environment, press 
the Position soft key. 

6 Toggle the Plot soft key and select Start to start plotting. 
7 Touch directly on the screen or press the ENTER hard key to collect data and plot points on the 

loaded map for the Position setting. 
 

 NOTE 
For the Position setting, you can change the direction of the route with the arrow keys 
and the distance with the rotary knob. 

 

8 Toggle the Plot soft key and select Stop to stop plotting. 
9 Press the SAVE/LOAD hot key to save the result. 

See “Using save” on page 32 for more information. 
 

 NOTE 
The instrument does not automatically save the collected data. It is recommended that 
you save the result. Otherwise, you will lose all the collected data. 

 

 

Setting limit for route map 

You can set the thresholds for each test item. 
 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Excellent soft key to set its threshold. 
3 Enter a value, and then press the Enter soft key. You can also use the rotary knob. 
4 Press the Very Good soft key to set its threshold. 
5 Enter a value, and then press the Enter soft key. You can also use the rotary knob. 
6 Press the Good soft key to set its threshold. 
7 Enter a value, and then press the Enter soft key. You can also use the rotary knob. 
8 Press the Fair soft key to set its threshold. 
9 Enter a value, and then press the Enter soft key. You can also use the rotary knob. 
10 Press the Poor soft key to set its threshold. 
11 Enter a value, and then press the Enter soft key. You can also use the rotary knob. 
12 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
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See “Using save” on page 32 for more information. 

 

Measurement example 

Figure 234 Route map measurement with Mobile WiMAX OTA signal analyzer 
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Chapter 14 Using Cable and Antenna 

Analyzer 

This chapter provides instructions for using the Cable and Antenna Analyzer function, which is 
available for the JD785B/JD745B Base Station Analyzer and the JD786B/JD746B RF Analyzer. Topics 
discussed in this chapter are as follows: 
 

 Introduction .............................................................................................................................. 447 

 Display overview ...................................................................................................................... 447 

 Selecting measurement mode ................................................................................................. 448 

 Configuring test parameters .................................................................................................... 448 

 Performing calibration .............................................................................................................. 450 

 Connecting a cable .................................................................................................................. 454 

 Performing reflection measurements....................................................................................... 457 

 Performing DTF measurements .............................................................................................. 458 
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Introduction 

The Cable and Antenna Analyzer is a diagnostic tool needed to accurately detect operational problems 
by performing cable and antenna measurements to verify the base station’s infrastructure, including 
feed lines, connectors, antennas, cables, jumpers, amplifiers, and filters. The JD785B/JD745B Base 
Station Analyzer and the JD786B/JD746B RF Analyzer have all of the measurement functions 
necessary to verify cable and antenna systems from Voltage Standing Wave Ratio (VSWR) to power 
measurements. In addition, the JD785B/JD745B and the JD786B/JD746B make distance-to-fault 
measurements to pinpoint a faulty location accurately. 
 
To get maximum power into a load it is required that the load impedance match the generator 
impedance. Any difference in impedance or mismatching would not produce maximum power transfer. 
An impedance mismatch at the antenna system produces a reflective ‘traveling wave’, which goes in 
the opposite direction from the incident wave. As the two traveling waves cross each other in opposite 
direction, it is produce an interference pattern called a "standing wave". VSWR is the ratio between the 
power sent forward to the cable and/or antenna and the amount of power that is reflected back to the 
transmitter. 
 
Some of the consequences of having a high VSWR condition in cellular services include dropped calls, 
poor reception, and an overall unacceptable performance in the cell (or section of cell) covered by the 
base station antenna. Therefore, the VSWR of the antenna system including the feed line is one of the 
most critical factors in the service and maintenance of the RF transmitter systems. 
 
This Cable and Antenna Analyzer function performs following measurements: 
 

 Reflection: VSWR and Return Loss 

 Distance to Fault (DTF): VSWR and Return Loss 

 Reflection-DTF (dual measurement) 

 2 Port Measurements: Vector and Scalar (Optional) 

 Cable Loss (1 Port) 

 1 Port Phase 

 Smith Chart 
 

Display overview 

Figure 235 provides descriptions for each segment of the measurement screen. 
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Figure 235 Reflection measurement screen 

 

 

Selecting measurement mode 

Procedure 

1 Press the MODE hard key. 
2 Press the Cable & Antenna Analyzer soft key. The Reflection (VSWR) mode is selected by 

default. 
3 To change the mode, press the MEASURE hot key and then select the measurement mode: 

–  Reflection (Return Loss) 

–  DTF (VSWR) 

–  DTF (Return Loss) 

–  Reflection-DTF 

–  Cable Loss (1 Port) 

–  1 Port Phase, Smith Chart 

–  2 Port Measurement (Vector/Scalar) 

 

Configuring test parameters 

Setting frequency  

You can set frequencies manually using the Start Frequency/Stop Frequency or Center 
Frequency/Span. You can also select from the band list stored in the instrument. It is recommended to 
set the frequency to a value that covers the normal range of the measurement with enough margins. 
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Procedure 

To set the start and stop frequencies: 
1 Press the FREQ/DIST hard key. 
2 Press the Start Frequency soft key. 
3 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 
4 Select the unit: GHz, MHz, kHz, or Hz. 
5 Press the Stop Frequency soft key. 
6 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 
7 Select the unit: GHz, MHz, kHz, or Hz. 

 
To set the center frequency and span: 

1 Press the FREQ/DIST hard key. 
2 Press the Center Frequency soft key. 
3 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 
4 Select the unit: GHz, MHz, kHz, or Hz. 
5 Press the Span soft key. 
6 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 
7 Select the unit: GHz, MHz, kHz, or Hz. 

 
To select the band from the band list: 

1 Press the FREQ/DIST hard key. 
2 Press the Band List soft key, and then select Standard Band or Custom Band. 

The band list window appears. 
3 Select a frequency band from the list, and then press the Select soft key. 

The start and stop frequency information on the screen changes according to your choice. 

 

Setting distance 

In the DTF measurement mode, you need to set the start and stop distances. The maximum 
measurable distance is displayed on the left side of the screen depending on the frequency setting. 
You can set any distance within the maximum measurable distance. Optimum resolution is achieved 
when the user setting distance is the same as the maximum measurable distance 
 

Procedure 

1 Press the FREQ/DIST hard key. 
2 Press the Start Distance soft key. 
3 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 
4 Select the Enter soft key. 
5 Press the Stop Frequency soft key. 
6 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 
7 Select the Enter soft key. 

 

Adjusting scale 

You can adjust the Y-axis scale to optimize the display of measurement trace(s). Adjusting scale does 
not affect the calibration state. 
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Procedure 

1 Press the AMP/SCALE hard key. 
2 Do one of the following choices: 

–  Press the Auto Scale to optimize the display of the measured trace by letting the 
instrument set the minimum and maximum values for the Y-axis automatically. 
Each time this key is pressed, the top and bottom scales are set to the minimum and 
maximum values with margin on the Y-axis of the chart. 

–  Press the Full Scale to restore the insturment’s default amplitude range for the Y-scale 
automatically. 

–  To set the minimum and maximum values for the Y-axis manually, complete the following 
steps: 

 Press the Maximum (Top) soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c
 Press the Minimum (Top) soft key. d
 Enter a value by using the numeric keys. e
 Press the Enter soft key. f

 
 NOTE 

This setting is not used in the Smith Chart measurement mode. 
 

Setting sweep mode 

The default setting is Continue to sweep continuously for most on-going measurements. If you want to 
hold the measurement or get a single sweep, you can change the sweep mode. 
 

Procedure 

To select the single sweep mode: 
1 Press the SWEEP hot key. 
2 Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key. 

The letter HOLD in red appears and the sweeping is paused. 
3 Optional. Press the Sweep Once soft key to get a new measurement. 

 
To return to the continuous sweep mode: 

1 Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key. 
The letter HOLD in red disappears and the sweeping resumes. 

 

Performing calibration 

To get reliable and accurate measurement results, you must perform a calibration on your instrument 
after setting frequencies and prior to making a measurement. You need to have the following ready: 
 

 Calibration accessories (optional). 

 Calibration Kit: Includes one 50-ohm load, one open standard, and one short standard. 

 Test Cable: Use a phase stable cable for reliable and consistent measurement results. 
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1-port calibration 

Measurements that need the 1-port calibration are in the Reflection, DTF, Cable Loss, 1 Port Phase, or 
Smith Chart mode. 
 
Figure 236 illustrates the connection method when a port extension cable is used for calibration. To 
compensate errors caused by a port extension cable or adapters, perform an Open-Short-Load 
calibration including the port extension cable. 
 

Figure 236 Connection for 1-port calibration 

 
 

 NOTE 
Do not use an unnecessary extension cable or adapter in order to prevent a 
measurement error. 
 
Bending or moving the extension cable while making a measurement may cause errors in 
the measurement. 

 
 NOTE 

If O-S-L calibration is done at the end of the port extension cable for DTF measurement, 
the length of the port extension cable is compensated automatically and is not included in 
the distance to the point of discontinuity. 

 

O-S-L calibration 

The Open-Short-Load calibration must be performed after setting frequency and connecting a test 
cable. When using an extension cable connected to the Cable and Antenna Analyzer Reflection/RF 
Out port, the calibration kit must be connected to the other end of the extension cable. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Calibrate soft key. 

The on-screen instruction for the calibration appears. 
3 Connect the OPEN connector of the CAL Kit directly to the Cable and Antenna Analyzer 

Reflection/RF Out port or at the end of the connected extension cable. 
4 Press the Continue soft key to start calibration.  

The calibration progress bar appears. 
5 Connect the SHORT connector of the CAL Kit directly to the Cable and Antenna Analyzer 

Reflection/RF Out port or at the end of the connected extension cable. 
6 Press the Continue soft key to continue calibration.  

The calibration progress bar appears. 
7 Connect the LOAD connector of the CAL Kit directly to the Cable and Antenna Analyzer 
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Reflection/RF Out port or at the end of the connected extension cable. 
8 Press the Continue soft key to continue calibration.  

The calibration progress bar appears. 
After completion, the calibration status on the screen changes to CAL ON. 

 

Quick calibration 

The Quick Calibration is useful when you want to measure only cable length in DTF measurements. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Calibrate soft key. 
3 Connect the OPEN connector of the CAL Kit directly to the Cable and Antenna Analyzer 

Reflection/RF Out port or at the end of the connected extension cable. 
4 Press the Quick Cal. soft key to turn the quick calibration off. 

The calibration status on the screen changes back to the previous state. 

 

2-port calibration 

You must perform 2-port calibration for 2-port measurements before making a measurement. 
 

Vector measurement 

Figure 237 illustrates the connection diagram for calibration in Vector measurements. 

Figure 237 Connection for 2-port calibration in vector measurement 

1) 

 

2) 

 

 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Calibrate soft key. 

The on-screen instruction for the calibration appears. 
3 Connect the OPEN connector of the CAL Kit directly to the Cable and Antenna Analyzer 

Reflection/RF Out port or at the end of the connected test cable as illustrated in Figure 237-1). 
4 Press the Continue soft key to start calibration.  

The calibration progress bar appears. 
5 Connect the SHORT connector of the CAL Kit directly to the Cable and Antenna Analyzer 

Reflection/RF Out port or at the end of the connected test cable. 
6 Press the Continue soft key to continue calibration.  
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The calibration progress bar appears. 
7 Connect the LOAD connector of the CAL Kit directly to the Cable and Antenna Analyzer 

Reflection/RF Out port or at the end of the connected test cable. 
8 Press the Continue soft key to continue calibration. 

The calibration progress bar appears. 
9 Connect the Reflection/RF Out port and the RF In port for the Cable and Antenna Analyzer with 

the test cable (THRU cable) and the proper adapter as illustrated in Figure 237-2). 
10 Press the Continue soft key to continue calibration.  

The calibration progress bar appears. 
After completion, the calibration status on the screen changes to CAL ON. 

 

Scalar measurement 

Figure 238 illustrates the connection diagram for calibration in Scalar measurements. 

Figure 238 Connection for 2-port calibration in scalar measurement 

 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Calibrate soft key. 

The on-screen instruction for the calibration appears. 
3 Connect the Reflection/RF Out port for the Cable and Antenna Analyzer and the RF In port for 

the Spectrum Analyzer with a test cable as illustrated in Figure 238. 
4 Press the Continue soft key to continue calibration.  

The calibration progress bar appears. 
After completion, the calibration status on the screen changes to CAL ON. 

 

Calibration status indicators 

The instrument displays calibration status that is an important indicator to get reliable and accurate 
measurement results from CAA testing. The calibration status includes CAL ON, CAL ON (I), CAL ON 
(Q), CAL OFF (T), and CAL OFF. 
 

Table 21 Calibration status indicators 

Indicator(s) Description 

CAL ON Indicates that the O-S-L calibration is performed and the instrument is ready to make a 
measurement. 

CAL ON (I) Indicates that the frequency setting is changed within the frequency range registered 
for the O-S-L calibration and so the calibration is still valid. When the calibration status 
changes from CAL ON to CAL ON (I), re-calibration is not necessarily required. 

CAL ON (Q) Indicates that quick calibration (Quick Cal) is performed. It is useful only if cable length 
measurement is needed. 

CAL OFF (T) Indicates that the temperature registered during the calibration is changed by ±10C or 
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greater. It is recommended that you perform a new O-S-L calibration to obtain accurate 
measurement results. When the temperature comes back within the registered range, 
the status may be changed to CAL ON. 

CAL OFF Indicates that the frequency setting is changed off the frequency range registered for 
the calibration. The calibration is no longer valid. 

 

Connecting a cable 

Connecting a cable for reflection, DTF, 1-port phase, and Smith 

Chart measurements 

Procedure 

1 Connect the one end of the port extension cable to the Cable and Antenna Analyzer 
Reflection/RF Out port of the instrument. 

2 Connect the other end of the port extension cable to an antenna or feed line as illustrated in 
Figure 239. Measurement result is displayed on the screen. 

 
Figure 239 Connection for reflection measurement 

 
 

 NOTE 
After calibration, do not change the connection of the port extension cable or the 
frequency setting. It may cause a measurement error. 
 
Changing any frequency settings will automatically turn the calibration status to OFF on 
the display screen, which requires re-calibration to proceed next measurement. 
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CAUTION 
The maximum input power for the Cable and Antenna Analyzer Reflection/RF Out port 
is +25 dBm. Do not connect this port directly to the output port of the system to prevent 
degraded performance or malfunctioning. 

 

 

WARNING 
Do not attempt to connect the instrument to the antenna when there is a risk of lightning. 
Electric shock may cause malfunction of or damage to the instrument. 

 

Connecting a cable for cable loss (1 port) measurements 

Procedure 

1 Connect the one end of the cable under test to the Cable and Antenna Analyzer Reflection/RF 
Out port of the instrument. 

2 Connect the SHORT standard of the Cal Kit to the other end of the cable under test as illustrated 
in Figure 240. Measurement result is displayed on the screen. 

 
Figure 240 Connection for cable loss (1 port) measurement 

 
 

Connecting a cable for 2-port vector measurements 

Procedure 

1 Connect the one end of the Thru test cable to the Cable and Antenna Analyzer Reflection/RF Out 
port of the instrument and the other end of the cable to DUT. 

2 Connect the DUT to the Cable and Antenna Analyzer RF In port of the instrument as illustrated 
in Figure 241. Measurement result is displayed on the screen. 
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Figure 241 Connection for 2-port vector measurement 

 
 

 

CAUTION 
The maximum input power for the Cable and Antenna Analyzer RF In port is +25 dBm. 
However, a proper level of input to the Cable and Antenna Analyzer RF In port is  
0 dBm. When the input power is expected to be greater than 0 dBm, you must adjust the 
output power for the RF Out. 

 

Connecting a cable for 2-port scalar measurements 

Procedure 

1 Connect the one end of the Thru test cable to the Cable and Antenna Analyzer Reflection/RF Out 
port of the instrument and the other end of the cable to DUT. 

2 Connect the DUT to the Spectrum Analyzer RF In port of the instrument as illustrated in Figure 
242. Measurement result is displayed on the screen. 

 
Figure 242 Connection for 2-port scalar measurement 

 
 

 

CAUTION 
The maximum input power for the Spectrum Analyzer RF In port is +25 dBm for JD780B 
series and +20 dBm for JD740B series. 
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Performing reflection measurements 

The Reflection measurement can be used to characterize cable and antenna system to ensure 
transmission line impedance performance and signal reflection characteristics of cell-site across a 
specific frequency range in voltage standing-wave ration (VSWR) or return loss. 
 

Making a measurement 

Procedure 

1 Make a proper cable connection as described in “Connecting a cable for reflection, DTF, 1-port 
phase, and Smith Chart measurements” on page 454. 

2 Press the MEASURE SETUP hot key. 
3 Press the Data Points soft key to change the resolution of your measurement, and then select 

the data point option: 126, 251, 501, 1001, and 2001. Changing the data point does not affect 
current calibration. 

 

 NOTE 
The larger number you choose, the higher resolution you get and the longer the 
instrument takes to sweep and display results. Selecting the data point larger than what 
you need for a measurement will result in unnecessarily long sweep time. It is 
recommended that you select high resolution data points only for an instance of 
measuring wide frequency bands or requiring precise measurement data. 

 

4 Optional. To turn the bias tee on, complete the following steps: 
 Toggle the Bias Tee soft key and select On. a
 Enter a value between 12 and 32 with 0.1 V step. b
 Enter the V soft key. c

 

 NOTE 
The instrument’s built-in bias tee function (option 002) supplies 12-32 VDC bias to active 
devices through the RF In port, eliminating the need of an external power supply. 

 

5 Optional. To select the output power, toggle the Output Power soft key between 0 dBm and  
-30 dBm. 

 

 NOTE 
When an amplifier’s reflection is measured, it is recommended that you change this 
output power level to -30 dBm and then re-calibrate. Changing to -30 dBm may result in 
reduced measurement dynamic range. 

 

6 Optional. To turn the interference rejection on, toggle the Interference Rej soft key between On 
and Off to enable or disable the feature. 

 

 NOTE 
It is recommended that you use this feature only when you suspect interfering signals in 
the area as turning this on slows down the measurement. 
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Measurement example 

Figure 243 Reflection measurement in return loss scale 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for cable and antenna analyzer” on page 
470 for more information. 

 
 NOTE 

You can go to MEASURE SETUP > Zone to view your measurements in detail with the 
user-definable zoom zones. See “Setting zoom zones” on page 469 for more information. 

 

Performing DTF measurements 

The Distance-To-Fault (DTF) measurement can be used to accurately identify fault locations in the 
cell-site transmission (cable and feed line) system, indicating signal discontinuities in VSWR or return 
loss over distance in meter or foot. This measurement precisely pinpoints the location of such things 
as damaged or degraded antennas, connectors, amplifiers, filters, and duplexers. 
 

Making a measurement 

Procedure 

1 Make a proper cable connection as described in “Connecting a cable for reflection, DTF, 1-port 
phase, and Smith Chart measurements” on page 454. 

2 Press the MEASURE SETUP hot key. 
3 Press the Data Points soft key to change the resolution of your measurement, and then select 

the data point option: 126, 251, 501, 1001, and 2001. Changing the data point does not affect 
current calibration. 

 

 NOTE 
The larger number you choose, the higher resolution you get and the longer the 
instrument takes to sweep and display results. Selecting the data point larger than what 
you need for a measurement will result in unnecessarily long sweep time. It is 
recommended that you select high resolution data points only for an instance of 
measuring wide frequency bands or requiring precise measurement data. 
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4 Press the DTF Settings soft key, and then do the following: 
–  To select a cable from the list, complete the following steps: 

 Press the Cable List soft key, and then select Standard Cable or Custom Cable. a
The cable list window appears. 

 Select a cable by using the rotary knob or the Page Up/Page Down soft keys. b
 Press the Select soft key. c
 Optional. In the standard cable list window, press the Add to Custom soft key to add d

the selected cable to the custom list. 
–  To define a new cable, complete the following steps: 

 Press the Prop Velocity soft key to define the cable’s relative propagation delay. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c
 Press the Cable Loss soft key to define the cable’s cable loss. d
 Enter a value by using the numeric keys. You can also use the rotary knob. e
 Press the Enter soft key. f

 

 NOTE 
The propagatin velocity affects the calucation of the distance and the cable loss does the 
peak level of the discontinuity in a DTF measurement. 

 

–  Toggle the Metrics soft key and select the unit option for the X-axis: Meter or Foot. 

–  Press the Windowing soft key, and then select the video filtering option: Rectangular, 
Blackman, Nominal Side Lobe, Low Side Lobe, or Minimum Side Lobe. 

5 Optional. To turn the bias tee on, complete the following steps: 
 Toggle the Bias Tee soft key and select On. a
 Enter a value between 12 and 32 with 0.1 V step. b
 Enter the V soft key. c

 

 NOTE 
The instrument’s built-in bias tee function (option 002) supplies 12-32 VDC bias to active 
devices through the RF In port, eliminating the need of an external power supply. 

 

6 Optional. To select the output power, toggle the Output Power soft key between 0 dBm and -30 
dBm. 

 

 NOTE 
When an amplifier’s reflection is measured, it is recommended that you change this 
output power level to -30 dBm and then re-calibrate. Changing to -30 dBm may result in 
reduced measurement dynamic range. 

 

7 Optional. To turn the interference rejection on, toggle the Interference Rej soft key between On 
and Off to enable or disable the feature. 

 

 NOTE 
It is recommended that you use this feature only when you suspect interfering signals in 
the area as turning this on slows down the measurement. 
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Measurement example 

Figure 244 DTF measurement 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for cable and antenna analyzer” on page 
470 for more information. 

 
 

Figure 245 DTF measurement with the alternate sweep on 

 
 

 NOTE 
You can go to MEASURE SETUP > Alternate Sweep Settings to scale down a specific 
sub-band. See “Setting alternate sweep” on page 470 for more information. 
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Performing reflection-DTF measurements 

You can view two measurement results simultaneously on the screen as you configure each 
measurement setting. 
 

Making a measurement 

Procedure 

1 Make a proper cable connection as described in “Connecting a cable for reflection, DTF, 1-port 
phase, and Smith Chart measurements” on page 454. 

2 Press the MEASURE SETUP hot key. 
3 Toggle the Active Window soft key between Top and Bottom and select the window to be 

active for setting. 
4 Press the Dual Config soft key, and then select the dual configuration option: 

–  To select the measurement mode for the top window, press the Top soft key, and then 
select Reflection (VSWR) or Reflection (Return Loss). 

–  To select the measurement mode for the bottom window, press the Bottom soft key, and 
then select DTF (VSWR) or DTF (Return Loss). 

–  To configure DTF settings for the bottom window, select Bottom > DTF Settings. 
See “Performing DTF measurements” on page 458 for more information. 

–  To set the alternate sweep settings for the bottom window, select Bottom > Alternate 
Sweep Settings. See “Setting alternate sweep” on page 470 for more information. 

 
 NOTE 

See “Performing reflection measurements” and “Performing DTF measurements” for 
more information on how to set other measurement setup parameters for the Reflection-
DTF measurement. 

 

Measurement example 

Figure 246 Reflection-DTF dual measurement 

1) Alternate sweep off: 
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2) Alternate sweep on: 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for cable and antenna analyzer” on page 
470 for more information. 

 

Performing cable loss (1 port) measurements 

The Cable Loss (1 Port) measurement quantifies signal loss through a cable or other device over a 
defined frequency range by range by connecting one end of the cable to the instrument measurement 
port and terminating the other end of the cable with a short, or leaving it open altogether. This 
measurement can be particularly useful in measuring the loss of feed line connected to the antenna. 
 

Making a measurement 

Procedure 

1 Make a proper cable connection as described in “Connecting a cable for cable loss (1 port) 
measurements” on page 455. 

2 Press the MEASURE SETUP hot key. 
3 Press the Data Points soft key to change the resolution of your measurement, and then select 

the data point option: 126, 251, 501, 1001, and 2001. Changing the data point does not affect 
current calibration. 

 

 NOTE 
The larger number you choose, the higher resolution you get and the longer the 
instrument takes to sweep and display results. Selecting the data point larger than what 
you need for a measurement will result in unnecessarily long sweep time. It is 
recommended that you select high resolution data points only for an instance of 
measuring wide frequency bands or requiring precise measurement data. 

 

4 Optional. To turn the bias tee on, complete the following steps: 
 Toggle the Bias Tee soft key and select On. a
 Enter a value between 12 and 32 with 0.1 V step. b
 Enter the V soft key. c
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 NOTE 
The instrument’s built-in bias tee function (option 002) supplies 12-32 VDC bias to active 
devices through the RF In port, eliminating the need of an external power supply. 

 

 
 NOTE 

See “Performing reflection measurements” for more information on how to set other 
measurement setup parameters for the Cable Loss (1 Port) measurement. 

 

Measurement example 

Figure 247 Cable loss (1 port) measurement 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for cable and antenna analyzer” on page 
470 for more information. 

 
Figure 248 Cable loss (1 port) measurement with the zone enabled 
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 NOTE 
You can go to MEASURE SETUP > Zone to view your measurements in detail with the 
user-definable zoom zones. See “Setting zoom zones” on page 469 for more information. 

 

Performing 1-port phase measurements 

The 1-port Phase measurement is used to measure S11 phase to tune antennas and to phase-match 
cables. 
 

Making a measurement 

Procedure 

1 Make a proper cable connection as described in “Connecting a cable for reflection, DTF, 1-port 
phase, and Smith Chart measurements” on page 454. 

2 Press the MEASURE SETUP hot key. 
3 Press the Data Points soft key to change the resolution of your measurement, and then select 

the data point option: 126, 251, 501, 1001, and 2001. Changing the data point does not affect 
current calibration. 

 

 NOTE 
The larger number you choose, the higher resolution you get and the longer the 
instrument takes to sweep and display results. Selecting the data point larger than what 
you need for a measurement will result in unnecessarily long sweep time. It is 
recommended that you select high resolution data points only for an instance of 
measuring wide frequency bands or requiring precise measurement data. 

 

4 Optional. To turn the bias tee on, complete the following steps: 
 Toggle the Bias Tee soft key and select On. a
 Enter a value between 12 and 32 with 0.1 V step. b
 Enter the V soft key. c

 

 NOTE 
The instrument’s built-in bias tee function (option 002) supplies 12-32 VDC bias to active 
devices through the RF In port, eliminating the need of an external power supply. 

 

 
 NOTE 

See “Performing reflection measurements” on page 457 for more information on how to 
set other measurement setup parameters for the Cable Loss (1 Port) measurement. 
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Measurement example 

Figure 249 Cable loss (1 port) measurement 

 
 

Figure 250 Cable loss (1 port) measurement with zoom 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for cable and antenna analyzer” on page 
470 for more information. 

 
 NOTE 

You can go to MEASURE SETUP > Zone to view your measurements in detail with the 
user-definable zoom zones. See “Setting zoom zones” on page 469 for more information. 

 

Performing Smith chart measurements 

The Smith Chart measurement is used to measure DUTs’ impedance and phase to properly tune RF 
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devices. Smith chart also displays impedance-matching characteristics in cable and antenna systems 
or filter and duplexer devices. 
 

Making a measurement 

Procedure 

1 Make a proper cable connection as described in “Connecting a cable for reflection, DTF, 1-port 
phase, and Smith Chart measurements” on page 454. 

2 Press the MEASURE SETUP hot key. 
3 Press the Data Points soft key to change the resolution of your measurement, and then select 

the data point option: 126, 251, 501, 1001, and 2001. Changing the data point does not affect 
current calibration. 

 

 NOTE 
The larger number you choose, the higher resolution you get and the longer the 
instrument takes to sweep and display results. Selecting the data point larger than what 
you need for a measurement will result in unnecessarily long sweep time. It is 
recommended that you select high resolution data points only for an instance of 
measuring wide frequency bands or requiring precise measurement data. 

 

4 Optional. To turn the bias tee on, complete the following steps: 
 Toggle the Bias Tee soft key and select On. a
 Enter a value between 12 and 32 with 0.1 V step. b
 Enter the V soft key. c

 

 NOTE 
The instrument’s built-in bias tee function (option 002) supplies 12-32 VDC bias to active 
devices through the RF In port, eliminating the need of an external power supply. 

 

 
 NOTE 

See “Performing reflection measurements” on page 457 for more information on how to 
set other measurement setup parameters for the Smith Chart measurement. 

 

Performing 2-port vector measurements 

The Vector measurement is used to perform faster and more accurate measurement with around 80 
dB dynamic range. It also provides antenna isolation measurement. You can determine DUT’s S21 
phase characteristic by selecting the measurement display type as Phase. 
 

Making a measurement 

Procedure 

1 Make a proper cable connection as described in “Connecting a cable for 2-port vector 
measurements” on page 455. 

2 Press the MEASURE SETUP hot key. 
3 Press the Data Points soft key to change the resolution of your measurement, and then select 

the data point option: 126, 251, 501, 1001, and 2001. Changing the data point does not affect 
current calibration. 

 

 NOTE 
The larger number you choose, the higher resolution you get and the longer the 
instrument takes to sweep and display results. Selecting the data point larger than what 
you need for a measurement will result in unnecessarily long sweep time. It is 
recommended that you select high resolution data points only for an instance of 
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measuring wide frequency bands or requiring precise measurement data. 

 

4 Toggle the Display soft key and select Magnitude to view measurements in dB or Phase in 
degree. 

5 Optional. To turn the bias tee on, complete the following steps: 
 Toggle the Bias Tee soft key and select On. a
 Enter a value between 12 and 32 with 0.1 V step. b
 Enter the V soft key. c

 

 NOTE 
The instrument’s built-in bias tee function (option 002) supplies 12-32 VDC bias to active 
devices through the RF In port, eliminating the need of an external power supply. 

 

6 Optional. To select the output power, toggle the Output Power soft key between 0 dBm and -30 
dBm. 

 

 NOTE 
When an amplifier’s reflection is measured, it is recommended that you change this 
output power level to -30 dBm and then re-calibrate. Changing to -30 dBm may result in 
reduced measurement dynamic range. 

. 

7 Optional. To set the number of measurements to be averaged, press the Average soft key and 
then adjust the number between one and five by using the rotary knob. 

8 Optional. To turn the interference rejection on, toggle the Interference Rej soft key between On 
and Off to enable or disable the feature. 

 

 NOTE 
It is recommended that you use this feature only when you suspect interfering signals in 
the area as turning this on slows down the measurement. 

 

 

Measurement example 

Figure 251 2-port vector measurement 

 
 

Performing 2-port scalar measurements 

The Scalar measurement enables full characterization of DUT with dynamics over 100 dB. 
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Making a measurement 

Procedure 

1 Make a proper cable connection as described in “Connecting a cable for 2-port scalar 
measurements” on page 456. 

2 Press the MEASURE SETUP hot key. 
3 Press the Data Points soft key to change the resolution of your measurement, and then select 

the data point option: 126, 251, 501, 1001, and 2001. Changing the data point does not affect 
current calibration. 

 

 NOTE 
The larger number you choose, the higher resolution you get and the longer the 
instrument takes to sweep and display results. Selecting the data point larger than what 
you need for a measurement will result in unnecessarily long sweep time. It is 
recommended that you select high resolution data points only for an instance of 
measuring wide frequency bands or requiring precise measurement data. 

 

4 Optional. To select the output power, toggle the Output Power soft key between 0 dBm and -30 
dBm. 

 

 NOTE 
When an amplifier’s reflection is measured, it is recommended that you change this 
output power level to -30 dBm and then re-calibrate. Changing to -30 dBm may result in 
reduced measurement dynamic range. 

 

 

Measurement example 

Figure 252 2-port scalar measurement 

 
 

Analyzing measurements 

Setting trace and display 

You can display up to six traces on the measurement chart simultaneously. 
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Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6. 

The legend shape of the selected trace changes from square to round to indicate that the trace is 
the active one now. 

3 Toggle the Trace View soft key and select On to display the selected trace. 
4 Do one of the following: 

 

To Select Trace Legend 

Clear current data and display with new 
measurements 

Clear Write W 

Capture the selected trace and compare traces Capture C 

Load a saved trace Load L 

Hide the selected trace Trace View > Off F 

Remove all the traces and initialize the trace 
settings 

Trace Clear All  

 

5 Optional. If you have at least two traces (T1 and T2), you can perform trace math: 
 Press the Trace Math soft key. a
 Press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key. b

 
 NOTE 

The trace to be loaded must be in the same measurement mode and has the same 
frequency setting as the current measurement. 

 

Setting zoom zones 

You can define up to three zoom-in zones so that you can view uplink and downlink frequencies in 
detail on a single measurement window for compliance verification. 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Zone soft key. 
3 To zoom in a zone, complete the following steps: 

 Press the Zoom soft key, and then select the zone number to zoom in: Zone 1, Zone 2, or a
Zone 3. 

 Toggle the Zoom soft key and select On. b
The zoom-in chart for the selected zone appears under the measurement result. 

4 To define a zone range, complete the following steps: 
 Press the Zone [1|2|3] soft key to select an active zone. a
 Toggle the Zone [1|2|3] soft key between On and Off to view or dismiss the active zone. b
 Press the Start Frequency soft key. c
 Enter a value by using the numeric keys. You can also use the rotary knob. d
 Select the unit: GHz, MHz, kHz, or Hz. e
 Press the Stop Frequency soft key. f
 Enter a value by using the numeric keys. You can also use the rotary knob. g
 Select the unit: GHz, MHz, kHz, or Hz. h

5 To clear all the zone settings, press the Clear All soft key. 
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Setting alternate sweep 

You can use the Alternate Sweep in DTF measurements to scale down a specific sub-band without a 
need of an additional calibration. 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Alternate Sweep Settings soft key. 
3 Toggle the Alternate Sweep soft key and select On or Off to enable or disable the alternate 

sweep feature. 
4 To set the start and stop distances for the alternate sweep, complete the following steps: 

 Press the Start Distance soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow b

keys. 
 Select the Enter soft key. c
 Press the Stop Frequency soft key. d
 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow e

keys. 
 Select the Enter soft key. f

5 To set the start and stop frequencies for the alternate sweep, complete the following steps: 
 Press the Alternate Start Frequency soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow b

keys. 
 Select the unit: GHz, MHz, kHz, or Hz. c
 Press the Alternate Stop Frequency soft key. d
 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow e

keys. 
 Select the unit: GHz, MHz, kHz, or Hz. f

6 To set the center and span frequencies for the alternate sweep, complete the following steps: 
 Press the Alternate Center Frequency soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow b

keys. 
 Select the unit: GHz, MHz, kHz, or Hz. c
 Press the Alternate Span Frequency soft key. d
 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow e

keys. 
 Select the unit: GHz, MHz, kHz, or Hz. f

 

Setting limit for cable and antenna analyzer 

Procedure 

1 Press the LIMIT hot key. 
2 Press the Multi Segment Line soft key for Pass/Fail indication. 
3 Toggle the Limit soft key between Upper and Lower to select the one to be displayed. 
4 Set the number of segments for the selected upper or lower limit line. You can set up to 50 

segments. 
 Press the # of Line soft key. a
 Enter a value between 1 and 50 by using the numeric keys. b
 Press the Enter soft key. c

5 Press the Autoset soft key to let the instrument set the limit for each segment and display the 
line. 
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6 Optional. To move the limit line, complete the following steps: 
 Select Limit Up/Down or Limit Left/Right. a
 Turn the rotary knob to move the line as desired. You can also manually enter a value. b

7 Optional. To edit the segment properties, complete the following steps: 
 Press the Edit Limit soft key. a
 Press the Move soft key and then turn the rotary knob to select the segment to edit. b
 Select the menu option, from the following choices: c

–  To hide the line for the selected segment, toggle the Line soft key and select Off. 

–  To add a new point, press the Add Point soft key. 

–  To delete the selected point, press the Delete Point soft key. 

–  To change the position, press the Frequency or Amplitude soft key, and then turn the 
rotary knob to change the value as desired. 

8 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 32 for more information. 
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Chapter 15 Using RFoCPRI Interference 

Analyzer 

This chapter provides instructions for using the RFoCPRI function that requires Optical Hardware 
(option 008) and RFoCPRI Interference Analyzer (options 060 – 065). Topics discussed in this chapter 
are as follows: 
 

 Introduction .............................................................................................................................. 473 

 Display overview ...................................................................................................................... 473 

 Connecting a cable .................................................................................................................. 474 

 Selecting measurement mode ................................................................................................. 474 

 Monitoring layer 2 .................................................................................................................... 475 

 Performing layer 2 term testing ............................................................................................... 476 

 Performing interference analysis ............................................................................................. 479 

 Performing PIM detection (single and multiple carriers).......................................................... 492 
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Introduction 

Cell sites today have a distributed architecture of the radio that consists of the radio equipment control 
(REC) or base band unit (BBU) installed at the bottom of the tower and the radio equipment (RE) or 
remote radio head (RRH) installed at the top of the tower. These two elements communicates with 
each other via the Common Public Radio Interference (CPRI) protocol over fiber links. 
 
This distributed architecture provides the benefit of replacing coax-based feeders with fiber- based 
feeders, significantly reducing the problems of signal loss and reflections. However, since all the RF 
interfaces reside on the RRH, any RF maintenance or troubleshooting requires climbing to the top of 
the tower to access the RRH, increasing operational cost and unnecessary safety issues. 
 
JD700B series analyzers provide the option of RFoCPRI that allows you to perform RF maintenance 
and troubleshooting activities on the ground via the fiber interfaces at the BBU, significantly reducing 
maintenance time and operational expenses. Thanks to the RFoCPRI technology, you can verify the 
CPRI control signals and extracts the IQ data transmitted between the BBU and RRU to monitor and 
analyze the uplink interferences and the downlink signals. 
 
The RFoCPRI option provides following measurements and analysis: 
 

 Layer 2 monitoring  

 Layer 2 terminate testing 

 Interference analysis including spectrum, spectrogram, RSSI, and spectrum replay 

 PIM detection of single or multiple carrier(s) 
 

Display overview 

Figure 253 provides descriptions for each segment of the measurement screen. 
 

Figure 253 RFoCPRI analysis screen 
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Connecting a cable 

There are two ways of connecting a cable: monitoring mode and terminate mode. The monitoring 
mode lets you perform in-service testing by using coupler(s) while the terminate mode allows you to do 
out-of-service testing. 
 
When selecting a SFP/SFP+ to connect, you need to make sure that your SFP/SFP+ is compatible 
with your DUT and that you have the information such as line rate, wavelength, and mode (MM or SM) 
handy. 
 

In-service testing (monitoring mode) 

Figure 254 Coupled mode 

 
JD785B/JD786B/JD745B/JD746B 

 
JD788B/JD748B 

 

Out-of-service testing (terminate mode) 

Figure 255 Terminate mode 

 
JD785B/JD786B/JD745B/JD746B 

 
JD788B/JD748B 

 

Selecting measurement mode 

Procedure 

1 Press the MODE hard key. 
2 Press the RFoFiber soft key. 
3 Press the RFoCPRI soft key. The Layer 2 Monitoring mode is set by default. 
4 Press the MEASURE hot key, and then select the measurement mode option from the following 

choices: 
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–  Layer 2 Monitoring 

–  Layer 2 Term 

–  Interference Analyzer > Spectrum, Spectrogram, RSSI, or Spectrum Replay 

–  PIM Detection > PIM Detection Single Carrier, PIM Detection Multiple Carriers, or 
Calculated PIM 

 

Monitoring layer 2 

The Layer 2 Monitoring is used to monitor the L1 inband protocol, for the link maintenance of the 
physical layer (layer 1), that resides on the layer 2 of CPRI. 
 

Selecting measurement mode 

Procedure 

1 Connect cables as illustrated in Figure 254 Coupled mode. 
2 Press the MEASURE hot key. 
3 Select Layer 2 Monitoring. 

 

Starting layer 2 monitoring 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the CPRI Parameters soft key. 

3 To set the CPRI line bit rate of the front haul under testing, complete the following steps: 
 Press the Link Rate soft key. a
 Select the CPRI line bit rate option from the choices: 614.4 Mbps, 1228.8 Mbps,  b

2457.6 Mbps, 3072.0 Mbps, 4915.2 Mbps, 6144.0 Mbps, and 9830.4 Mbps. 
 

 NOTE 
It is important to set the link rate correctly. If not, you will have LOS and LOF alarms on 
the screen. 

 

4 Check the results if any of the following layer 1 alarms were detected and if the optical signal 
level is good. Red indicates the occurrence of the alarm. 
–  LOS: Loss of Signal 

–  LOF: Loss of Frame 

–  RAI: Remote Alarm Indication 

–  SDI: SAP Defect Indication 

–  Optic Rx Level: If the optical signal level is lower than the threshold, RRH may not be in 
service mode. 

5 Optional. You can use the Save Logging Data soft key to record the event logging in .csv file 
format. See “Using save” on page 32 for more information. 

6 To clear the previous event history and restart a new monitoring, press the Clear History soft 
key. 
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Measurement example 

Figure 256 CPRI layer 2 monitoring 

 
 

Performing layer 2 term testing 

The Layer 2 Term is used to test the CPRI front haul in the terminated status. CellAdvisor JD700B 
series can act as a BBU (Baseband Unit) to enable the RRH (Remote Radio Head) to be in the 
operation state. Once the RRH enters the operation status, JD700B series can generate an alarm or 
error and send it to the RRH to verify the optical cable installation from the test point to the RRH. 
 

Selecting measurement mode 

Procedure 

1 Connect cables as illustrated in Figure 255 Terminate mode. 
2 Press the MEASURE hot key. 
3 Select Layer 2 Term. 

 

Starting layer 2 term test as master 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the CPRI Parameters soft key. 
3 To set the CPRI line bit rate of the front haul under test, complete the following steps: 

 Press the Link Rate soft key. a
 Select the CPRI link rate option from the choices: 614.4 Mbps, 1228.8 Mbps,  b

2457.6 Mbps, 3072.0 Mbps, 4915.2 Mbps, 6144.0 Mbps, and 9830.4 Mbps. 
 

 NOTE 
It is important to set the link rate correctly. If not, you will have LOS and LOF alarms on 
the screen. 
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4 To set the clock reference, complete the following steps: 
 Press the Tx Clock soft key. a
 Select the transmission clock reference option Internal from the choices: Internal, b

Recovered, and External. 
5 Toggle the Port Type soft key between Master and Slave and select Master. 
6 Press the BBU Emulation soft key. 
7 Toggle the Start-up Sequence soft key between Normal and Bypass and select the start-up 

sequence you want. 
–  Normal: Negotiates with the RRH to support the start-up procedure. 

–  Bypass: Forces to configure the predefined parameters. Selecting Bypass activates 
additional soft keys. 

8 If you have set the start-up sequence to Bypass, complete the following steps: 
 Press the Protocol Version soft key, and then enter a value between one and 10 by using a

the numeric keys and press the Enter soft key. You can also use the rotary knob. 
 Press the HDLC Rate soft key, and then select the HDLC (High level Data Link Control) b

rate option from the choices: No HDLC, 240, 480, 960, 1920, and 2400. 
 Toggle the Eth Channel soft key between Enable and Disable. Setting this to Enable c

activates the Eth Subchannel Number menu. 
 Press the Eth Subchannel Number soft key, and then enter a value between 20 and 63 by d

using the numeric keys and press the Enter soft key. You can also use the rotary knob. 
9 Press the PREV hard key twice to return the Measure Setup screen bar. 
10 Toggle the Laser soft key and select On to activate the transmission. 
11 Press the Alarm/Error soft key and then do the following: 

–  To insert an alarm, complete the following steps: 
 Press the Alarm Type soft key. a
 Select the alarm type option from the choices: R-LOS, R-LOF, RAI, and SDI. b
 Toggle the Alarm Insertion soft key and select On to start to insert the selected alarm. c
 To stop inserting the alarm, toggle the Alarm Insertion soft key and select Off. d

–  To insert a code error, complete the following steps: 
 Toggle the Error Type soft key between Code and K30.7 and select Code. a
 Toggle the Insert Type soft key between Single and Rate, and then select the insert b

type option you want. 
–  Single: Inserts an error once and then turns the error insertion off. 

–  Rate: Inserts an error at the error rate set in the Error Rate menu. Setting this to 
Rate activates the Error Rate soft key. 

 Press the Error Rate, and then select the error rate option from the choices:  c
1E-3, 1E-4, 1E-5, 1E-6, 1E-7, 1E-8, and 1E-9. 

 Toggle the Error Insertion soft key and select On to start to insert the error. d
 To stop inserting the error, toggle the Error Insertion soft key and select Off. e

–  To insert a K30.7 error, complete the following steps: 
 Toggle the Error Type soft key between Code and K30.7 and select K30.7. a
 Toggle the Error Insertion soft key and select On to insert the error. b

This setting returns to Off after one insertion as it is a single insertion of K30.7 error. 
12 Check the real time results on the screen. 

13 Optional. You can use the Save Logging Data soft key to record the event logging in .csv file 
format. See “Using save” on page 32 for more information. 

14 To clear the previous event history and restart a new monitoring, press the PREV hard key and 
then press the Clear History soft key. 
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Starting layer 2 term test as slave 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the CPRI Parameters soft key. 
3 To set the CPRI line bit rate of the front haul under test, complete the following steps: 

 Press the Link Rate soft key. a
 Select the CPRI link rate option from the choices: 614.4 Mbps, 1228.8 Mbps,  b

2457.6 Mbps, 3072.0 Mbps, 4915.2 Mbps, 6144.0 Mbps, and 9830.4 Mbps. 
 

 NOTE 
It is important to set the link rate correctly. If not, you will have LOS and LOF alarms on 
the screen. 

 

4 To set the clock reference with the received clock signal, complete the following steps: 
 Press the Tx Clock soft key. a
 Select the clock reference option Recovered from the choices: Internal, Recovered, and b

External. 
5 Toggle the Port Type soft key between Master and Slave and select Slave. 
6 Press the PREV hard key to return the Measure Setup screen bar. 
7 Toggle the Laser soft key and select On to activate the transmission. 
8 Check the real time results on the screen. 
9 Optional. You can use the Save Logging Data soft key to record the event logging in .csv file 

format. See “Using save” on page 32 for more information. 
10 To clear the previous event history and restart a new monitoring, press the PREV hard key and 

then press the Clear History soft key. 

 

Measurement example 

Figure 257 CPRI layer 2 term test as master 
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Figure 258 CPRI layer 2 term test as slave 

 
 

Performing interference analysis 

After checking that the link connection is good with no errors and alarms, you can proceed to the 
interference analysis activities including spectrum measurements, spectrogram, RSSI, and spectrum 
replayer. 
 

Selecting measurement mode 

Procedure 

1 Connect cables as illustrated in Figure 254 Coupled mode. 
2 Press the MEASURE hot key. 
3 Press the Interference Analyzer soft key. 

4 Select the interference measurement mode from the following choices: 

–  Spectrum 

–  Spectrogram 

–  RSSI 

–  Spectrum Replay 

 

Setting CPRI measure setup 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the bandwidth of the downlink signal, complete the following steps: 

 Press the Bandwidth soft key. a
 Select the bandwidth option from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, b

and 20 MHz. The RBW range changes based on this bandwidth setting. 
3 To use the pre-configured settings for a NEM, press the NEM soft key and then select the NEM 

option from the following choices: 
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–  None (no pre-configuration) 

–  Ericsson (UL) 

–  Ericsson (DL) 

–  Alcatel-Lucent (UL/DL) 

–  Samsung (UL/DL) 

–  Huawei (UL) 

–  Huawei (DL) 
 

 NOTE 
The pre-configured information may be subject to changes at any times by NEMs. 

 

4 Press the CPRI Parameters soft key to set the CPRI parameters. 
5 To set the CPRI line bit rate of the front haul under test, complete the following steps: 

 Press the Link Rate soft key. a
 Select the CPRI link rate option from the choices: 614.4 Mbps, 1228.8 Mbps,  b

2457.6 Mbps, 3072.0 Mbps, 4915.2 Mbps, 6144.0 Mbps, and 9830.4 Mbps. 
 

 NOTE 
It is important to set the link rate correctly. If not, you will have LOS and LOF alarms on 
the screen. 

 

6 To set the antenna per carrier group, complete the following steps: 
 Press the AxC Group soft key. a
 Enter a value between one and 24 by using the rotary knob. b
 Press the Enter soft key. c

 NOTE 
The maximum number of the AxC Group is determined by the combination of factors 
such as link rate, sample width, oversampling, and signal bandwidth. 

7 To set the clock reference, press the Tx Clock soft key, and then select Recovered from the 
choices: Internal, Recovered, and External. 

8 Toggle the Port Type soft key between Master and Slave and select Slave. 
9 To set the I and Q sample widths, complete the following steps: 

 Press the IQ Sample Width soft key a
 Enter a value between four and 20 by using the rotary knob. b
 Press the Enter soft key. c

10 To set the mapping method, complete the following steps: 
 Press the Mapping Method soft key. a
 Select the mapping method option from the choices: 1and 3. b

–  Mapping Method 1: IQ sample based for packed position. An RRH of GSM, UMTS, 
and LTE supports this mapping method. 

–  Mapping Method 3: Backward compatible with the mapping method 1 for flexible 
position. An RRH of GSM, UMS, and LTE supports this mapping method. 

11 To set the first bit position of each AxC Container in the IQ data block of a basic frame, complete 
the following steps: 

 Press the Map Position soft key. a
 Select the AxC Container number you want to set from the choices: AxC 0, AxC 1, AxC 2,  b

AxC 3, AxC 4, AxC 5, AxC 6, and AxC 7. 
 Enter a value using the numeric keys. You can also use the rotary knob. c
 Press the Enter soft key. d

 

 NOTE 
The number of required AxC Container for a basic frame are two AxCs for 5 MHz, four 
AxCs for 10 MHz, and eight AxCs for 20 MHz. 
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Following is an example of test configuration for a DUT. 
 

     
 
 
For this test configuration, IQ allocation will be like this in the CPRI basic frame. 
 

    
 

 

12 Press the PREV hard key twice to return the Measure Setup screen bar. 

 

Configuring test parameters 

Configuration of test parameters described in this section is used in the Interference Analyzer mode 
including spectrum measurements, spectrogram, and RSSI. 
 

Setting frequency 

You can set the frequency with either frequency or channel number. If a frequency to be set matches 
to the frequency corresponding to the selected channel standard, the instrument calculates its channel 
number and updates the screen with it automatically. 
 

Procedure 

To set the frequency with center frequency: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Freq. 
3 Press the Center Frequency soft key. 
4 Enter a value by using the numeric keys. You can also use the rotary knob. 
5 Select the unit: GHz, MHz, kHz, or Hz. 
6 Optional. To define the amount of frequency increment for the rotary knob, complete the following 

steps: 
 Press the Frequency Step soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the unit: GHz, MHz, kHz, or Hz. c
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To set the frequency with channel number: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Channel. 
3 To select the standard channel, complete the following steps: 

 Press the Channel Std soft key. The standard channel window appears. a
See “Appendix C – Band, frequency & channel standard” on page 530 for more information. 

 Highlight the band to be measured by using the rotary knob, the arrow keys, or the Page b
Up/Page Down soft keys. 

 Press the Select soft key or the rotary knob to confirm the selection. c
4 Press the Channel Number soft key. 
5 Enter a value by using the numeric keys. You can also use the rotary knob. 
6 Press the Enter soft key. 
7 The instrument automatically displays the corresponding center frequency value for the selected 

channel number. 
8 Optional. To define the amount of channel increment for the rotary knob, complete the following 

steps: 
 Press the Channel Step soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

 

Setting reference level 

You can set the reference level automatically or manually to optimize the display of the traces 
measured, as you desire. 
 

Procedure 

To automatically set the reference level: 
1 Press the AMP/SCALE hard key. 
2 Press the Auto Scale soft key. 

Each time you press this key, the Y-axis scale changes to be optimized with some margin. 
 
To set the reference level manually: 

1 Press the AMP/SCALE hard key. 
2 To set the maximum reference value on the Y-axis manually, complete the following steps: 

 Press the Reference Level soft key. a
 Enter a value by using the numeric keys or the rotary knob with 10 dB increments. b
 Press the dBm soft key or the ENTER hard key. c

This unit key name changes according to the setting in the Units menu. 
 
Optional. To change the scale unit: 

1 Select More (1/2) > Units. 
2 Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W. 

The scale unit on the screen changes accordingly. 

 

Setting scale per division 

You can use the Scale/Div feature to change the scale per division, representing the value of one 
division on the horizontal scale. The default setting is 10 dB per division and the maximum value can 
be set up to 20 dB. 
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Procedure 

1 Press the AMP/SCALE hard key. 
2 Select More (1/2) > Scale/Div. 
3 Enter a value between 1 and 20 by using the numeric keys. 
4 Press the dB soft key to complete the entry. 

 

Setting external offset 

You can turn the External Offset on and manually set the external offset value. An offset consists of a 
cable loss and a user offset, and the measurement result shows the value reflecting both offset values. 
When the external offset value is set at 40 dB, the measurement result compensates 40 dB. 
 

Procedure 

To set the external offset: 
1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select On. 
3 Enter a value by using the numeric keys. 
4 Press the dB soft key to complete the entry. 

 
To turn the external offset off: 

1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select Off. 

 

Setting RBW 

You can set the RBW and VBW in the Spectrum, Spectrogram, and RSSI modes. The RBW range is 
limited as per the bandwidth of the signal under test. 
 

Procedure 

1 Press the BW/AVG hard key. 
2 Press the RBW soft key to set the resolution bandwidth. 
3 Enter a value in 1-3 sequence by using the numeric keys, and then select kHz soft key. 

You can also use the rotary knob. 
–  For signal bandwidths 1.4 MHz and 3 MHz: RBW from 1 kHz to 30 kHz 

–  For signal bandwidths 5 MHz, 10 MHz, 15 MHz, and 20 MHz: RBW from 1 kHz to 100 kHz 

4 Press the VBW soft key to set the video bandwidth. 
5 Enter a value by using the numeric keys, and then select the unit option from the choices:  

MHz, kHz, and Hz. You can also use the rotary knob. 

 

Setting average 

You can set the number of measurements to be averaged for the trace presentation in the Spectrum, 
Spectrogram, and RSSI modes. A maximum of 100 times of averaging can be set. When the 
averaging reaches to your setting, a new measurement value replaces the measurement value in 
sequence from the earliest. 
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Procedure 

1 Press the BW/AVG hard key. 
2 Press the Average soft key. 
3 Enter a value between one and 100 as needed by using the numeric keys. 
4 Press the Enter soft key. 

 

Setting sweep mode 

The default setting is Continue to sweep continuously for most on-going measurements. If you want to 
hold the measurement or get a single sweep, you can change the sweep mode. This setting is used in 
the Spectrum, Spectrogram, and RSSI modes. 
 

Procedure 

To select the single sweep mode: 
1 Press the SWEEP hot key. 
2 Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key. 

The letter HOLD in red appears and the sweeping is paused. 
3 Optional. Press the Sweep Once soft key to get a new measurement. 

 
To return to the continuous sweep mode: 

1 Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key. 
The letter HOLD in red disappears and the sweeping resumes. 

 

Setting trace 

You can display up to six traces on the measurement chart simultaneously. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6. 

The legend shape of the selected trace changes from square to round to indicate that the trace is 
the active one now. 

3 Toggle the Trace View soft key and select On. 
4 Do one of the following: 

 

To Select Trace Legend 

Clear current data and display with new 
measurements 

Clear Write W 

Display the input signal’s maximum response only 
(unlimited or for a certain amount of time) 

Max Hold M 

Display the input signal’s minimum response only 
(unlimited or for a certain amount of time) 

Min Hold m 

Capture the selected trace and compare traces Capture C 

Load a saved trace More (1/2) > Load L 

Hide the selected trace Trace View > Off F 

Remove all the traces and initialize the trace 
settings 

More (1/2) > Trace 
Clear All 
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 NOTE 
For the Max Hold and Min Hold, your instrument compares newly acquired data with the 
active trace and displays larger maximum values or smaller minimum values on the 
screen. You can set it to Unlimited to hold and view maximum or minimum data or 
specify a certain amount of time up to 60 seconds by using numeric keys or the rotary 
knob. 

 

5 To select the detection option, press the More (1/2) > Detectors, and then do one of the 
following: 

 

To display Select 

Random noise better than the peak without missing signals Normal 

The highest value in each data point Peak 

The root mean squared average power across the spectrum RMS 

The lowest value in each data point Negative Peak 

The center value in each data point Sample 
 

6 Optional. Press the More (1/2) > Trace Info soft key, and then select the trace number to view 
the trace’s parameter setting information stored at the time of the measurement or None to hide 
the information display. 

7 Optional. If you have the two traces T1 and T2, you can perform trace math. To view the power 
difference between the traces, press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key. 
The result is overlaid on the screen along with the second Y-axis. 

 
 NOTE 

To be able to load a trace, the trace to be overlaid must be saved in the same 
measurement mode and frequency setting as the current measurement. 

 

Conducting spectrum measurements 

After configuring test parameters as described in the “Configuring test parameters” on page 481, you 
can continue to proceed to the spectrum measurement with an audible indicator. You can also turn the 
interference ID on. 
 

Sound indicator 

The Sound Indicator is used to identify interfering signals with alarm sound. It is especially useful for 
locating interferer sources with a directional antenna. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Sound Indicator soft key. 
3 Select the alarm reference option from the choices: Marker and Line. 

–  Marker: Sets the active marker position as the alarm reference. 

–  Line: Lets the limit line as the alarm reference. Selecting this option activates the Limit Line 
soft key. 

4 To define a threshold for the limit line, complete the following steps: 
 Press the Limit Line soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the dBm soft key. c
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5 Toggle the Sound soft key between On and Off and select On to enable to sound. To turn it off, 
select Off. 

6 Optional. To adjust the volume for alarm sound, press the Volume soft key, and then turn the 
rotary knob clockwise or counter clockwise. 

7 Optional. You can save logging data automatically so that you can load the measurement data 
and replay in the Spectrum Replayer mode. See “Using save” on page 32 for more information. 

 

Interference ID 

The Interference ID automatically classifies interfering signals over a designated spectrum and 
displays a list of possible signal types corresponding to the selected signal. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Interference ID soft key. 

3 To set the threshold, complete the following steps: 
 Press the Threshold soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the dBm soft key. c

4 Toggle the Interference ID soft key between On and Off and select On to enable the Interference 
ID. To turn it off, select Off. 

5 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 32 for more information. 

 
 NOTE 

You can use the LIMIT hot key to analyze your measurements with the display line, multi-
segment line, and channel limit. See “Setting limit for interference analyzer” on page 491 
for more information. 

 

Measurement example 

Figure 259 RFoCPRI spectrum measurement 
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Figure 260 RFoCPRI spectrum analysis on LTE Uplink 10 MHz, antenna 1 

 
 

Figure 261 RFoCPRI spectrum analysis on LTE Uplink 10 MHz, antenna 2 

 
 

Conducting spectrogram 

The Spectrogram is particularly useful when attempting to identify periodic or intermittent signals as it 
captures spectrum activity over time and uses various colors to differentiate spectrum power levels. 
When the directional antenna is used to receive the signal, you will see a change in the amplitude of 
the tracked signal as you change the direction of the antenna and see a change in the Spectrogram 
colors. The source of the signal is located in the direction that results in the highest signal strength. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 481, you 
can continue to proceed to the spectrogram measurement. 
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Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set the amount of time between each trace measurement: 

 Press the Time Interval soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Sec soft key. c

3 To set the time cursor on a specific trace position, complete the following steps: 
 Toggle the Time Cursor soft key and select On. a
 Turn the rotary knob to move the time cursor. You can also enter a value and then press the b

Enter soft key. 
 To turn the time cursor off, select Off. c

 

 NOTE 
Enabling the time cursor puts the measurement on hold and you can make post-
processing analysis for each measurement over time using the time cursor. 

 

4 To start a new measurement, press the Reset/Restart soft key. 
5 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 32 for more information. 

 

Measurement example 

The spectrogram shows a vertical line on the chart when the marker is enabled on the screen. 
 

Figure 262 RFoCPRI interference measurement in spectrogram 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the display line, multi-
segment line, and channel limit. See “Setting limit for interference analyzer” on page 491 
for more information. 

 

Conducting RSSI 

The Received Signal Strength Indicator (RSSI) is a multi-signal tracking metric that is particularly 
useful for measuring power-level variations over time. The RSSI measurement lets you assign power 
limit line for audible alarms and increase alarm counters every time a signal exceeds a defined limit 
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line. For long-term analysis, the spectrogram and RSSI measurements can be automatically saved 
into an external USB memory. Post-analysis can be performed with JDViewer application software. 
 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 481, you 
can continue to proceed to the spectrogram measurement. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 To set up the alarm parameters, complete the following steps: 

 Press the Alarm soft key. a
 Press the Alarm at soft key, and then select the marker number you want to set. b
 Press the Limit Line soft key to set a threshold for the alarm. c
 Enter a value by using the numeric keys. You can also use the rotary knob. d
 Press the dBm soft key. e
 Toggle the Alarm soft key between On and Off to turn the alarm feature on or off. f

 

 NOTE 
You must set the marker(s) first by using the MARKER hard key as these features use 
the marker position to sound an alarm. See “Using marker” on page 49 for more 
information. 

 

 Optional. Press the Volume soft key and adjust the volume. g
3 Press the PREV hard key to return to the Measure Setup screen bar. 

4 To start a new measurement, press the Reset/Restart soft key. 
5 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 32 for more information. 

 

Measurement example 

Figure 263 RFoCPRI interference measurement in RSSI 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the display line, multi-
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segment line, and channel limit. See “Setting limit for interference analyzer” on page 491 
for more information. 

 

Performing spectrum replayer 

The Spectrum Replayer lets you retrieve and replay recorded spectrum analyzer traces in interference 
analysis mode. These traces can be played back in the spectrogram or RSSI. You can configure the 
limit line to create failure points when signals exceed it. The failure points are clearly displayed on the 
trace timeline for quick access during playback. 
 

Setting measure setup 

Procedure 

1 Press the MEASURE hot key. 
2 Press the Spectrum Replayer soft key. 

The file manager window appears. 
3 Select a file to be loaded, and then press the Load soft key. 

The Measure Setup screen menus appear. 
4 Toggle the Replay Direction soft key between FWD and REV to change play direction to forward 

or reverse. 
5 Press the Replay Speed soft key, and then select the speed option: X1, X2, X3, and X4. 
6 Press the Play soft key to start playing. 
7 Press the Pause soft key to pause or stop playing data. 
8 To move to a particular failure position directly and play from there, complete the following steps: 

 Press the Jump to Fail Index soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key. c

9 Optional. Toggle the Time Cursor soft key between On and Off to display or dismiss the time 
cursor on the screen. This key becomes activated when you play logged data in the Spectrogram 
mode. 

 
 NOTE 

If you connected a USB drive, do not remove it while playing. Doing so may freeze the 
USB port, which will require you to restart the instrument to get a USB drive recognized 
again. 
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Measurement example 

Figure 264 RFoCPRI spectrum replay 

 
 

Setting display 

You can select the display option to view data in a different mode. 
 

Procedure 

1 Press the TRACE/DISPLAY hard key. 
2 Select the display option from the choices: Spectrum, Spectrogram, and RSSI. 

 
 NOTE 

You can use the LIMIT hot key to analyze your measurements with the display line, multi-
segment line, and channel limit. See “Setting limit for interference analyzer” on page 491 
for more information. 

 

Setting limit for interference analyzer 

Procedure 

To use the display line: 
1 Press the LIMIT hot key. 
2 Press the Display Line soft key for a reference line. 
3 Enter a value, and then press the dBm unit soft key. 
4 Toggle the Display Line soft key between On and Off to display and dismiss the reference line. 

The straight line appears across the screen to be used as a visual reference only. 
 
To display the multiple segment line: 

1 Press the LIMIT hot key. 
2 Press the Multi Segment Line soft key for Pass/Fail indication. 
3 Toggle the Limit soft key between Upper and Lower to select the one to be displayed. 
4 Set the number of segments for the selected upper or lower limit line. You can set up to 50 

segments. 
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 Press the # of Line soft key. a
 Enter a value between 1 and 50 by using the numeric keys. b
 Press the Enter soft key. c

5 Press the Autoset soft key to let the instrument set the limit for each segment and display the 
line. 

6 Optional. To move the limit line, complete the following steps: 
 Select Limit Up/Down or Limit Left/Right. a
 Turn the rotary knob to move the line as desired. You can also manually enter a value. b

7 Optional. To edit the segment properties, complete the following steps: 
 Press the Edit Limit soft key. a
 Press the Move soft key and then turn the rotary knob to select the segment to edit. b
 Select the menu option, from the following choices: c

–  To hide the line for the selected segment, toggle the Line soft key and select Off. 

–  To add a new point, press the Add Point soft key. 

–  To delete the selected point, press the Delete Point soft key. 

–  To change the position, press the Frequency or Amplitude soft key, and then turn the 
rotary knob to change the value as desired. 

8 Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings. 
See “Using save” on page 32 for more information. 

 

Performing PIM detection (single and multiple carriers) 

The Passive Intermodulation (PIM) Detection allows you to detect Uplink PIM across the full spectrum 
for any technology. When PIM is detected, the normal repair mode is to replace the offending cable 
and what you need to do is replacing the whole cable irrespective of the location of the fault. 
 

Selecting measurement mode 

Procedure 

1 Connect cables as illustrated in Figure 254 Coupled mode. 
2 Press the MEASURE hot key. 
3 Press the PIM Detection soft key. 
4 Select the PIM detection mode from the following choices: 

–  PIM Detection Single Carrier 

–  PIM Detection Multiple Carriers 

–  Calculated PIM 

 

Calculating possible PIM 

The Calculated PIM is used when you want to check any possible existence of PIM before the actual 
measurement. The instrument displays possible PIM in red color. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Calculated PIM soft key. 
3 Toggle the Radio Config soft key between Single and Multi and select the mode you want to 
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use. 
–  Single: Sets the frequency of Radio 1. 

–  Multi: Sets the frequency of Radio 1 and Radio 2. 

4 Do one of the following: 
–  To set the frequency and span, complete the following steps: 

 Toggle the Mode soft key between Freq and Band and select Freq. a
 Press the Radio [1]2] Frequency soft key. b
 Enter a value by using the numeric keys. c
 Select the unit option from the choices: GHz, MHz, kHz, and Hz. d
 Press the Radio [1|2] Span soft key. e
 Enter a value by using the numeric keys. f
 Select the unit option from the choices: GHz, MHz, kHz, and Hz. g

–  To set the radio band, complete the following steps: 
 Toggle the Mode soft key between Freq and Band and select Band. a
 Press the Radio [1]2] Band soft key. b
 Highlight the radio band to select by using the rotary knob. c
 Press the Select soft key. d

 

Detecting PIM (single and multiple carriers) 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Connect cables as instructed on the screen. 

 NOTE 
Make sure that the Tx of RRH is connected to the Rx port of SFP/SFP+ installed in your 
CellAdvisor. 

3 Configure CPRI measure setup as described in “Setting CPRI measure setup” on page 479. 
4 Do one of the following: 

–  To set the uplink center frequency and span to be measured, complete the following steps: 
 Toggle the Unit soft key between Freq and Channel and select Freq. a
 Press the Uplink Center Frequency soft key. b
 Enter a value by using the numeric keys. You can also use the rotary knob. c
 Select the unit from the choices: GHz, MHz, kHz, and Hz. d

–  To set the channel number to be measured, complete the following steps: 
 Toggle the Unit soft key between Freq and Channel and select Channel. a
 Press the Channel Std soft key, and then highlight a desired band. b
 Press the Select soft key. c
 Press the Channel Number soft key. d
 Enter a value by using the numeric keys, and then press the Enter soft key. e

The instrument automatically displays the corresponding center frequency value for the 
selected channel number. 

5 Press the Continue soft key, and then follow the instructions on the screen. 
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Measurement example 

Figure 265 PIM detection 
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Chapter 16 Using Channel Scanner 

This chapter provides instructions for using the Channel Scanner function (option 012). Topics 
discussed in this chapter are as follows: 
 

 Introduction .............................................................................................................................. 496 

 Display overview ...................................................................................................................... 496 

 Connecting a cable .................................................................................................................. 496 

 Selecting measurement mode ................................................................................................. 498 

 Configuring test parameters .................................................................................................... 498 

 Making channel scanner measurements ................................................................................. 501 

 Making frequency scanner measurements ............................................................................. 502 

 Making custom scanner measurements .................................................................................. 503 

 Analyzing measurements ........................................................................................................ 505 
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Introduction 

A Channel Scanner is a radio receiver that can automatically tune or scan two or more discrete 
frequencies and multi-channels, indicating when it finds a signal on one of them and then continuing 
scanning when that frequency goes silent. 
 
You can measure up to 20 channels with this channel scanner. Using existing format-based or custom 
parameters, you will be able to easily verify improper multi-channel power levels. 
 

 Channel Scanner 

 Frequency Scanner 

 Custom Scanner (Channel or Frequency) 
 

Display overview 

Figure 266 provides descriptions for each segment of the measurement screen. 
 

Figure 266 Channel scanner screen 

 

 

Connecting a cable 

Direct connection 

Procedure 

1 Connect the Spectrum Analyzer RF In port of the JD700B series and the Power amplifier output 
port of BTS. 
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Figure 267 Direct connection 

 
JD785B/JD786B/JD745B/JD746B 

 
JD788B/JD748B 

 

Indirect connection 

Procedure 

1 Connect the Spectrum Analyzer RF In port of the JD700B series and the monitor (test) port of 
BTS. 

 
Figure 268 Indirect connection 

 
JD785B/JD786B/JD745B/JD746B 

 
JD788B/JD748B 

 

 

CAUTION 
The maximum power for the Spectrum Analyzer RF In port is +25 dBm (0.316 W) for 
JD780B series and +20 dBm (0.1 W) for JD740B series. If the level of the input signal to 
be measured is greater than this, use a High Power Attenuator to prevent damage 
when you directly connect the signal to the instrument or connect the signal from the 
coupling port of a directional coupler. 

 

Over the air (OTA) 

Procedure 

1 Connect an Omni/directional RF antenna to the Spectrum Analyzer RF In port of the JD700B 
series. 

2 Connect a GPS antenna to the GPS port of the JD700B series. 
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Figure 269 OTA connection 

 
JD785B/JD786B/JD745B/JD746B 

 
JD788B/JD748B 

 

 

CAUTION 
If the input signal level to be measured is less than 0 dBm, set 0 dB attenuation or turn on 
the preamp to have better dynamic range for the OTA testing. 

 

Selecting measurement mode 

Procedure 

1 Press the MODE hard key. 
2 Press the Channel Scanner soft key. The Channel Scanner mode is selected by default. 
3 To change the measurement mode, press the MEASURE hot key and then select the 

measurement mode: 
–  Channel Scanner 

–  Frequency Scanner 

–  Custom Scanner 

 

Configuring test parameters 

Setting frequency 

You need to set the channel or frequency to be scanned depending on the scanner mode: channel 
scanner, frequency scanner, and custom scanner. Refer to each scanner mode for how to set the 
channel or frequency. 
 

Setting amplitude 

Reference level and attenuation 

You can set the reference and attenuation levels automatically or manually to optimize the display of 
the traces measured, as you desire. 
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Procedure 

To automatically set the reference and attenuation level: 
1 Press the AMP/SCALE hard key. 
2 Press the Auto Scale soft key. 

Each time you press this key, both of the Y-axis scale and input attenuation level change to be 
optimized with some margin. 

 
To set the reference or attenuation level manually: 

1 Press the AMP/SCALE hard key. 
2 To set the maximum reference value on the Y-axis manually, complete the following steps: 

 Press the Reference Level soft key. a
 Enter a value by using the numeric keys or the rotary knob with 10 dB increments. b
 Press the dBm soft key or the ENTER hard key. c

This unit key name changes according to the setting in the Units menu. 
3 To set the attenuation option, select one from the following choices: 

–  To set the input attenuator’s level automatically, select Attenuation > Auto. 
 

 NOTE 
It is recommended that you set the Attenuation to Auto in most situations so that the 
level of the input attenuator can be set automatically according to your input signal level. 

 

–  To set the input attenuation manually up to 55 dB for JD780B series or 50 dB for JD740B 
series to optimize S/N, complete the following steps: 

 Select Attenuation > Manual. a
 Press the Attenuation Value soft key to set the level. b
 Enter a value in fives by using the numeric keys. c
 Press the dB soft key or the ENTER hard key. d

–  To couple the input attenuator’s level with your reference level setting, select Attenuation > 
Couple. 
As you increase the reference setting, the attenuation level also increases acoordingly. 

 
Optional. To change the scale unit: 

1 Select More (1/2) > Units. 
2 Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W. 

The scale unit on the screen changes accordingly. 

 

Pre-amplifier 

You can turn the internal pre-amplifier on to correct and compensate for the gain of the preamp so that 
amplitude readings show the value at the input connector. 
 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Toggle the Preamp soft key and select On or Off as needed. 

 
 NOTE 

You can turn the Preamp on when the input attenuation range is from 0 dB to 10 dB. If 
the attenuation value is manually set to greater than 10 dB, the instrument will 
automatically turn off the pre-amplifier to display low-level signal properly on the chart. 

 

External offset 

You can turn the External Offset on and manually set the external offset value. An offset consists of a 
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cable loss and a user offset and the measurement result shows the value reflecting both offset values. 
When the external offset value is set at 40 dB in the Spectrum mode, the measurement result 
compensates 40 dB at both the Spectrum Analyzer and Signal Analyzer modes 
 

Procedure 

To set the external offset: 
1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select On. 
3 Enter a value by using the numeric keys. 
4 Press the dB soft key to complete the entry. 

 
To turn the external offset off: 

1 Press the AMP/SCALE hard key. 
2 Toggle the External Offset soft key and select Off. 

 

Setting average 

You can set the number of measurements to be averaged for the trace presentation. A maximum of 
100 times of averaging can be set. When the averaging reaches to your setting, a new measurement 
value replaces the measurement value in sequence from the earliest. 
 

Procedure 

1 Press the BW/AVG hard key. 
2 Press the Average soft key. 
3 Enter a value between 1 and 100 as needed by using the numeric keys. 
4 Press the Enter soft key. 

 

Setting sweep mode 

The default setting is Continue to sweep continuously for most on-going measurements. If you want to 
hold the measurement or get a single sweep, you can change the sweep mode. 
 

Procedure 

To select the single sweep mode: 
1 Press the SWEEP hot key. 
2 Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key. 

The letter HOLD in red appears and the sweeping is paused. 
3 Optional. Press the Sweep Once soft key to get a new measurement. 

 
To return to the continuous sweep mode: 

1 Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key. 
The letter HOLD in red disappears and the sweeping resumes. 

 
 NOTE 

Selecting Sweep Mode > Fast may reduce the measurement accuracy, but you can use 
this fast sweep mode to identify the existence of interfering signals. 
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Making channel scanner measurements 

Setting channel 

You need to set the channel to be scanned. 
 

Procedure 

1 Press the FREQ/DIST hard key. 
2 To select the standard channel, complete the following steps: 

 Press the Channel Std soft key. The standard channel window appears. a
See “Appendix C – Band, frequency & channel standard” on page 530 for more information. 

 Highlight the band to be measured by using the rotary knob, the arrow keys, or the Page b
Up/Page Down soft keys. 

 Press the Select soft key or the rotary knob to confirm the selection. c
3 Toggle the Link soft key to select the scanning direction and select Fwd for forward or Rev for 

reverse. 
4 To set the starting channel, complete the following steps: 

 Press the Start Channel soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

5 To set the amount of channel increment in scanning channels, complete the following steps: 
 Press the Channel Step soft key. a
 Enter a value by suing the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

6 To set the integration bandwidth, complete the following steps: 
 Press the Integration Bandwidth soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

7 To set the number of channels to be displayed in the measurement table, complete the following 
steps: 

 Press the # of Channels soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

 

Measurement example 

Test results can be saved as a *.csv file format so that you can work on it in any spreadsheet 
software. 
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Figure 270 Channel scanner measurement 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the display line and 
channel limit. See “Setting limit for channel scanner” on page 505 for more information. 

 

Making frequency scanner measurements 

Setting frequency 

You need to set the frequency to be scanned. 
 

Procedure 

1 Press the FREQ/DIST hard key. 
2 To set the starting center frequency, complete the following steps: 

 Press the Start Frequency soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

3 To set the amount of frequency increment in scanning channels, complete the following steps: 
 Press the Frequency Step soft key. a
 Enter a value by suing the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

4 To set the integration bandwidth, complete the following steps: 
 Press the Integration Bandwidth soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

5 To set the number of frequencies to be displayed in the measurement table, complete the 
following steps: 

 Press the # of Frequency soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c
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Measurement example 

Figure 271 Frequency scanner measurement 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the display line and 
channel limit. See “Setting limit for channel scanner” on page 505 for more information. 

 

Making custom scanner measurements 

Setting channel/frequency 

You can customize channels or frequencies to be scanned as you desire. 
 

Procedure 

To set the channels to be scanned: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Channel. 
3 To select the standard channel, complete the following steps: 

 Press the Channel Std soft key. The standard channel window appears. a
See “Appendix C – Band, frequency & channel standard” on page 530 for more information. 

 Highlight the band to be measured by using the rotary knob, the arrow keys, or the Page b
Up/Page Down soft keys. 

 Press the Select soft key or the rotary knob to confirm the selection. c
4 Toggle the Link soft key to select the scanning direction and select Fwd for forward or Rev for 

reverse. 
5 Press the Index soft key, and then enter an index number by turning the rotary knob or using the 

numeric keys. 
6 To set the channel number for the selected index, complete the following steps: 

 Press the Channel Number soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the Enter soft key. c

The instrument displays a corresponding center frequency for the channel number. 
7 To set the integration bandwidth for the selected index, complete the following steps: 
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 Press the Integration Bandwidth soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

8 To add more channels to be scanned, repeat steps 5-7. 
9 Press the ESC hard key to dismiss the channel list window and view the scanning result. 

 
To set the frequencies to be scanned: 

1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Freq. 
3 Press the Index soft key, and then enter an index number by turning the rotary knob or using the 

numeric keys. 
4 To set the center frequency for the selected index, complete the following steps: 

 Press the Center Frequency soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

5 To set the integration bandwidth for the selected index, complete the following steps: 
 Press the Integration Bandwidth soft key. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Select the unit: GHz, MHz, kHz, or Hz. c

6 To add more channels to be scanned, repeat steps 3-5. 
7 Press the ESC hard key to dismiss the channel list window and view the scanning result. 

 

Measurement example 

Figure 272 Custom scanner measurement 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the display line and 
channel limit. See “Setting limit for channel scanner” on page 505 for more information. 
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Analyzing measurements 

Setting limit for channel scanner 

Procedure 

To use the display line: 
1 Press the LIMIT hot key. 
2 Press the Display Line soft key to set a threshold for the limit line and Pass/Fail indication. 
3 Enter a value, and then press the dBm unit soft key. 
4 Toggle the Display Line soft key between On and Off to display or dismiss the limit line. 

 
To use the channel limit: 

1 Press the LIMIT hot key. 
2 Press the Channel Limit soft key to set the limits for each channel index. 
3 Press the Index soft key, and then select the channel/frequency index number by turning the 

rotary knob or using the numeric keys. 
4 Toggle the Limit soft key between On and Off to enable or disable the Pass/Fail indication. 
5 Set the upper threshold: 

 Press the High Limit soft key. a
 Enter a value for the upper limit. b
 Press the dBm unit soft key. c

6 Set the lower threshold: 
 Press the Low Limit soft key. a
 Enter a value for the lower limit. b
 Press the dBm unit soft key. c

7 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 32 for more information. 
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Chapter 17 Using Power Meter 

This chapter provides instructions for using the RF Power Meter function and the Optical Power Meter 
function. Topics discussed in this chapter are as follows: 
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 Display overview ...................................................................................................................... 507 
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 Performing external RF power measurements ........................................................................ 511 

 Performing optical power measurements ................................................................................ 515 

 Setting limit for power meter .................................................................................................... 517 
 
 
 
  



Chapter 17 Using Power Meter 

 JD700B Series User’s Guide 507 

Introduction 

The Power Meter of the JD700B series uses power measurement based on spectrum measurement 
results to provide an accurate power measurement result unlike a general spectrum analyzer, of which 
power accuracy may be degraded if the span is set too wide. 
 
The power meter also provides Pass/Fail indication with user-defined lower and upper limits. 
 
The Power Meter function provides following measurements: 

 Internal RF Power Measurement 

 External RF Power Measurement 

 Optical Power Measurement 
 

Display overview 

Figure 273 provides descriptions for each segment of the measurement screen. 
 

Figure 273 Power measurement screen 

 

 

Performing internal RF power measurements 

The internal power measurement of the JD700B series collects powers from the raw data of spectrum 
analyzer in the optimal span and integrates the powers up to the specified user span, which results in 
an accurate power measurement, independent of the span setting. 
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Connecting a cable 

Direct connection 

Procedure 

1 Connect the Spectrum Analyzer RF In port of the JD700B series and the Power amplifier output 
port of BTS as shown in Figure 274. 

 
Figure 274 Direct connection 

 
JD785B/JD786B/JD745B/JD746B 

 
JD788B/JD748B 

 

Indirect connection 

Procedure 

1 Connect the Spectrum Analyzer RF In port of the JD700B series and the monitor (test) port of 
BTS as shown in Figure 275. 

 
Figure 275 Indirect connection 

 
JD785B/JD786B/JD745B/JD746B 

 
JD788B/JD748B 

 

 

CAUTION 
The maximum power for the Spectrum Analyzer RF In port is +25 dBm (0.316 W) for 
JD780B series and +20 dBm (0.1 W) for JD740B series. If the level of the input signal to 
be measured is greater than this, use a High Power Attenuator to prevent damage 
when you directly connect the signal to the instrument or connect the signal from the 
coupling port of a directional coupler. 

 

Selecting measurement mode 

Procedure 

1 Press the MODE hard key. 
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2 Select More (1/2) > Power Meter > Internal RF Power Meter. 

 

Setting frequency  

You need to set the frequency range to be measured with either the center frequency/span or the 
start/stop frequencies. You can also set the frequency with the channel number and span. 
 

Procedure 

To set the center frequency and span: 
1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Freq. 
3 Press the Center Frequency soft key. 
4 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 
5 Select the unit: GHz, MHz, kHz, or Hz. 
6 Press the Span soft key, and then do one of the following: 

–  To set the span manually, select Span, enter a value, and then select the unit. 

–  To set the span automatically, select Full Span, Zero Span, or Last Span as needed. 
 

 NOTE 
The Zero Span option is available only in the Spectrum mode. If you have selected Zero 
Span, select TRIGGER > Free Run, External, GPS, Video, or Display Position. 

 
To set the start and stop frequencies: 

1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Freq. 
3 Press the Start Frequency soft key. 
4 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 
5 Select the unit: GHz, MHz, kHz, or Hz. 
6 Press the Stop Frequency soft key. 
7 Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 
8 Select the unit: GHz, MHz, kHz, or Hz. 

 
To set the channel number and span: 

1 Press the FREQ/DIST hard key. 
2 Toggle the Unit soft key and select Channel. 
3 To select the standard channel, complete the following steps: 

 Press the Channel Std soft key. The standard channel window appears. a
See “Appendix C – Band, frequency & channel standard” on page 530 for more information. 

 Highlight the band to be measured by using the rotary knob, the arrow keys, or the Page b
Up/Page Down soft keys. 

 Press the Select soft key or the rotary knob to confirm the selection. c
4 Toggle the Link soft key to select the sweep direction and select Fwd for forward or Rev for 

reverse. 
5 To set the channel number, complete the following steps: 

 Press the Channel Number soft key. a
 Enter a value by using the numeric keys. b
 Press the Enter soft key or ENTER hard key to complete the entry. c

The instrument automatically displays the corresponding center frequency value for the 
selected channel number. 

6 To set the span, complete the following steps: 
 Press the Span soft key. a
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 Select the span option, from the following choices: b
–  To set the span manually, select Span, enter a value, and then select the unit. 

–  To set the span automatically, select Full Span, Zero Span, or Last Span as needed. 
 

 NOTE 
The Zero Span option is available only in the Spectrum mode. If you have selected Zero 
Span, select TRIGGER > Free Run, External, GPS, Video, or Display Position. 

 
Optional. To define the amount of frequency increment for the rotary knob: 

1 Press the Frequency Step soft key, if the Freq is selected. 
2 Enter a value by using the numeric keys. 
3 Press the unit: GHz, MHz, kHz, or Hz. 

 
Optional. To define the amount of channel increment for the rotary knob: 

1 Press the Channel Step soft key, if the Channel is selected. 
2 Enter a value by using the numeric keys. 
3 Press the Enter soft key. 

 

Setting amplitude 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Toggle the Display soft key and select the display method: Relative or Absolute. 
3 If the Relative is selected, press the Set Reference soft key to set the current value as the 

reference. 
4 To specify the display range, complete the following steps: 

 Press the Display Maximum soft key to set the maximum value for the power meter. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the dBm soft key. c
 Press the Display Minimum soft key to set the minimum value for the power meter. d
 Enter a value by using the numeric keys. You can also use the rotary knob. e
 Press the dBm soft key. f

5 Optional. To enable the external offset, complete the following steps: 
 Toggle the External Offset soft key and select On. a
 Enter a value between 0 and 60 by using the numeric keys. b
 Press the dB soft key. c

 

Setting sweep mode 

The default setting of the sweep mode is Continue. If you want to hold the measurement, you can 
change the sweep mode. 
 

Procedure 

1 Press the SWEEP hot key. 
2 To select the single sweep mode, toggle the Sweep Mode soft key and select Single. You can 

also use the HOLD hot key. 
The letter HOLD in red appears and the sweeping is paused. 

3 To return to the continuous sweep mode, toggle the Sweep Mode soft key and select Continue. 
You can also use the HOLD hot key. 
The letter HOLD in red disappears and the sweeping resumes. 
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Making a measurement 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Resolution soft key, and then select the resolution option from the following choices: 

–  0: Displays the reading with no decimal place 

–  1: Displays the reading with one decimal place 

–  2 : Displays the reading with two decimal places 

3 To set the resolution bandwidth, complete the following steps: 
 Press the RBW soft key. a
 Enter a value by using the numeric keys. b
 Press the unit: MHz, kHz, or Hz. c

4 Press the Accuracy Mode soft key, and then select the accuracy mode option: Low, Middle, 
and High. 

5 To specify the number of measurements to be averaged, complete the following steps: 
 Press the Average soft key. a
 Enter a value between 1 and 100 by using the numeric keys. b
 Press the Enter soft key. c

 

Measurement example 

Figure 276 Internal power measurement 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for power meter” on page 517 for more 
information. 

 

Performing external RF power measurements 

This instrument performs radio output power measurement with the use of optional external power 
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sensors including JD730 series power sensors. It serves as the highly accurate RF power meter and 
gives wider range of power measurement. 
 

Connecting a cable 

There are two types of power sensors. Directional power sensors are used in in-service power 
measurement. Terminating power sensors are used in out-of-service power measurement. 
 

Table 22 External power sensor type 

Part No. Description Frequency Range Power Range 

JD731B Directional Power Sensor 300-3800 MHz Average: +21.76 to +51.76 dBm 
(0.15 to 150 W) 
Peak: +36.02 to +56.02 dBm 
(4 to 400 W) 

JD732B Terminating Power Sensor 20-3800 MHz Average: -30 to +20 dBm 

JD733A Directional Power Sensor 150-3500 MHz Average/Peak: +20 to +47 dBm 
(0.1 to 50 W) 

JD734B Terminating Power Sensor 20-3800 MHz Peak: -30 to +20 dBm 

JD736B Terminating Power Sensor 20-3800 MHz Average/Peak: -30 to +20 dBm 

 

Terminating power sensor connection 

Procedure 

1 Connect an external power sensor to the USB Host port of the JD700B series and to the RF 
output port of BTS. 
The JD700B series automatically detects and initializes the power sensor connected to the 
instrument. Connecting an external power sensor is mandatory. 

 
Table 23 Terminating power sensor connection 

 
JD785B/JD786B/JD745B/JD746B 

 
JD788B/JD748B 

 

Directional power sensor connection 

Procedure 

1 Connect an external power sensor to the USB Host port of the JD700B series and to the RF 
output port of BTS as shown in Figure 277. 
The JD700B series automatically detects and initializes the power sensor connected to the 
instrument. Connecting an external power sensor is mandatory. 
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Figure 277 Directional power sensor connection 

 
JD785B/JD786B/JD745B/JD746B 

 
JD788B/JD748B 

 

Selecting measurement mode 

Procedure 

1 Press the MODE hard key. 
2 Select More (1/2) > Power Meter > External RF Power Meter. 

 

Setting frequency 

You need to set the frequency to be measured depending on your connected external power sensor. 
 

Procedure 

1 Press the FREQ/DIST hard key. 
2 Press the Frequency soft key. 
3 Enter a value by using the numeric keys. You can also use the rotary knob. 
4 Select the unit: GHz, MHz, kHz, or Hz. 

 

Setting amplitude 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Toggle the Display soft key and select the display method: Relative or Absolute. 
3 If the Relative is selected, press the Set Reference soft key to set the current value as the 

reference. 
4 To specify the display range, complete the following steps: 

 Press the Display Maximum soft key to set the maximum value for the power meter. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the dBm soft key. c
 Press the Display Minimum soft key to set the minimum value for the power meter. d
 Enter a value by using the numeric keys. You can also use the rotary knob. e
 Press the dBm soft key. f

5 Optional. To enable the external offset, complete the following steps: 
 Toggle the External Offset soft key and select On. a
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 Enter a value between 0 and 60 by using the numeric keys. b
 Press the dB soft key. c

 

Making a measurement 

Procedure 

1 Press the MEASURE hot key. 
2 Depending your connected power sensor, do one of the following: 

–  For JD736B, select the power range option: Average Power, Peak Power, or Pulse Power. 

–  For JD734B, select Peak Power. 

–  For JD732B, select Average Power. 

–  For JD731B, select the power range option: Forward Avg Power, Reverse Avg Power, 
Forward Peak Power, Pulse Power, or VSWR. 

–  For JD733A, select the power range option: Forward Avg Power, Reverse Avg Power, 
Forward Peak Power, or VSWR. 

3 Press the MEASURE SETUP hot key. 
4 Press the Resolution soft key, and then select the resolution option from the following choices: 

–  0: Displays the reading with no zero decimal place 

–  1: Displays the reading with one decimal place 

–  2: Displays the reading with two decimal places 

 

Measurement example 

You can measure and understand a trend of a system output in operation where output power 
constantly varies depending on the amount of calls being processed by the BTS or Repeater. In 
addition, the Log graph benefits you to easily examine the discontinuance of output power caused by 
the transmission problems or defective connection. 
 

Figure 278 External power measurement of pulse power 
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 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for power meter” on page 517 for more 
information. 

 

Performing optical power measurements 

The optical power measurement is available in conjunction with MP-series power sensor, which 
measures optical power via a USB connection. 
 

Connecting a cable 

There are two types of optical power sensors. 
 

Table 24 Optical power sensors 

Part No. Wavelength Range Dynamic Range 

MP-60A 780-1650 nm 1300, 1310, 1490, 1550 nm: -50 to +10 dBm 
850 nm: -45 to +10 dBm 

MP-80A 780-1650 nm 1300, 1550 nm: -35 to +23 dBm  
980 nm: -30 to +23 dBm 

 

Optical power sensor connection 

Procedure 

1 Connect a MP-series optical power sensor to the USB Host port of the JD700B series as shown 
in Figure 279. 

 
Figure 279 Optical power sensor connection 

 
JD785B/JD786B/JD745B/JD746B 

 
JD788B/JD748B 

 

Selecting measurement mode 

Procedure 

1 Press the MODE hard key. 
2 Select More (1/2) > Power Meter > Optical Power Meter. 

 



Chapter 17 Using Power Meter 

516 JD700B Series User’s Guide 

Setting amplitude 

Procedure 

1 Press the AMP/SCALE hard key. 
2 Toggle the Display soft key and select the display method: Relative or Absolute. 
3 If the Relative is selected, press the Set Reference soft key to set the current value as the 

reference. 
4 To specify the display range, complete the following steps: 

 Press the Display Maximum soft key to set the maximum value for the power meter. a
 Enter a value by using the numeric keys. You can also use the rotary knob. b
 Press the dBm soft key. c
 Press the Display Minimum soft key to set the minimum value for the power meter. d
 Enter a value by using the numeric keys. You can also use the rotary knob. e
 Press the dBm soft key. f

5 Optional. To enable the external offset, complete the following steps: 
 Toggle the External Offset soft key and select On. a
 Enter a value between 0 and 60 by using the numeric keys. b
 Press the dB soft key. c

 

Making a measurement 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Toggle the Wavelength soft key and select the wavelength option: 

–  To set the wave length automatically, select Auto. 

–  To select the wave length from the standard wave list, select StdWave. 
The StdWave soft key becomes activated. 

3 Press the StdWave soft key, and then select the standard wavelength option: 850 nm, 980 nm, 
1300 nm, 1310 nm, 1480 nm, 1490 nm, or 1550 nm. 

4 Press the Resolution soft key, and then select the resolution option from the following choices: 
–  0: Displays the reading with nodecimal place 

–  1: Displays the reading with one decimal place 

–  2: Displays the reading with two decimal places 
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Measurement example 

Figure 280 optical power measurement 

 
 

 NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for power meter” on page 517 for more 
information. 

 

Setting limit for power meter 

You can use the Limit hot key to set the threshold for the Pass/Fail indication. 
 

Procedure 

1 Press the LIMIT hot key. 
2 Toggle the Limit soft key between On and Off to enable or disable the Pass/Fail indication. 
3 To set the upper and lower limits, complete the following steps: 

 Press the High Limit soft key. a
 Enter a value for the upper threshold by using the numeric keys. b
 Press the dBm unit soft key. c
 Press the Low Limit soft key. d
 Enter a value for the lower threshold by using the numeric keys. e
 Press the dBm unit soft key. f

4 Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 
for your measurement mode. See “Using save” on page 32 for more information. 
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Introduction 

Inspection of fiber optic connections is essential for the optimal performance and longevity of fiber 
optic connectivity. Throughout their lives, fiber connectors must be inspected, analyzed, and cleaned 
to maintain an acceptable level of functionality. The JD700B series makes it fast and easy to 
troubleshoot and certify that every connection at a cell site is optimized for a lifetime of performance. 
 
The JD700B series supports the handheld fiber microscope P5000i that can capture video images 
from the sensor and analyzes the images for fiber end face defects and contamination with reliable 
PASS/FAIL results to guarantee the performance of your optical connections. 
 

Display overview 

Figure 281 provides descriptions for each segment of the measurement screen. 
 

Figure 281 Fiber inspection screen 

 

 

Connecting a fiber microscope 

Connecting an optional fiber microscope P5000i is mandatory for fiber inspection and analysis. See 
“JD700B Series Common Options” on page 547 for available options. 
 

Procedure 

1 Connect your fiber microscope P5000i to the USB Host port of the JD700B series. 
The instrument detects the connected microscope automatically and displays the icon. 

 
  



Chapter 18 Performing Fiber Inspection 

520 JD700B Series User’s Guide 

Selecting measurement mode 

Procedure 

1 Press the MODE hard key. 
2 Select More (1/2) > Fiber Inspection. 

 

Configuring test parameters 

Selecting profile and tip 

You can select analysis profiles and inspection tips from the list. 
 

Procedure 

1 Press the MEASURE SETUP hot key. 
2 Press the Profile & Tip soft key. 

The profile and tip pane appears. 
3 To select one of the pre-configured analysis profiles that match the PASS/FAIL criteria in the IEC 

visual inspection standard, complete the following steps: 
 Tap the drop-down list button for the Profile. a
 Select the profile that you want to use, from the following choices: b

–  MM (IEC-61300-3-35) 

–  Ribbon, MM (IEC-61300-3-35) 

–  Ribbon, SM APC (IEC-61300-3-35) 

–  SM APC (IEC-61300-3-35) 

–  SM PC (IEC-61300-3-35) 

–  SM UPC (IEC-61300-3-35) 
 

 NOTE 
All of the profiles are factory set and cannot be edited or removed. 

 

4 To select the inspection tip (optical settings) that you want to use, complete the following steps: 
 Tap the drop-down list button for the Tip. a
 Select one of the tips available to your selected profile, from the following choices: b

–  Standard Tips (with BAP1) and Simplex Long Reach (-L) Tips 

–  Ribbon Tips and Ribbon Tips – Long Reach 
 

 NOTE 
This setting allows you to select the best optical settings for the type of inspection tip 
that is attached to your microscope probe. 

 

5 Tap the Apply button or press the Apply soft key to save and return to the previous state. 

 

Setting preferences 

You can set your preferences of auto center and QuickCapture button function. The QuickCapture 
button is the small grey round button on the side of the microscope. 
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Procedure 

1 To set the function of the QuickCapture button on the side of the P5000i, toggle the Test Button 
soft key and select the option from the following choices: 
–  Test: Sets the capture button to function as Test. Pressing the Quickcapture button 

analyzes fiber image as like the Test soft key on your JD700B series. 

–  Freeze: Sets the capture button to function as Freeze. Pressing the Quickcapture button 
captures fiber image as like the Freeze soft key on your JD700B series. 

2 To turn the auto center feature on or off, toggle the Auto Center soft key between On and Off 
and select the option you want to set. Default setting is On. It automatically displays the center of 
the fiber when viewing at high magnification. 

 

Performing fiber inspection 

Capturing fiber image 

Procedure 

1 Connect the fiber to be inspected to the tip of your microscope P5000i. 
The live image of the fiber is displayed on the screen. 
See the user manual of your fiber microscope for details on using the P5000i. 

2 Focus the image by rotating the Focus Control on the P5000i until the image is in focus. 
3 Toggle the Magnification soft key between Low and High and select the option you want to use. 

You can also press the Magnification Control button on either side of the P5000i. 
4 Press the Freeze soft key to capture the properly focused image. 

The text “Capturing…” appears. 
5 Optional. To save the captured image as a file (.png), complete the following steps: 

 Tap the Save PNG soft key.  a
The Save window appears with the on-screen key. 

 Type a file name in the File Name field. b
 Select a folder where you want to save the file, if desired. c
 Press the Save soft key. d

6 Press the Live soft key to return to the live image screen or press the Quit soft key to exit. 
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Measurement example 

Figure 282 Captured fiber image 

 
 

Testing a fiber 

Procedure 

1 Connect the fiber to be inspected to the tip of your microscope P5000i. 
The live image of the fiber is displayed on the screen. 
See the user manual of your fiber microscope for details on using the P5000i. 

2 Focus the image by rotating the Focus Control on the P5000i until the image is in focus. 
3 Toggle the Magnification soft key between Low and High and select the option you want to use. 

You can also press the Magnification Control button on either side of the P5000i. 
4 Press the Test soft key to start fiber analysis. 

The text “Analyzing…” appears. 
5 Once the test is completed, check the result displayed on the screen with the following 

information: 
–  Image overlay of the zone locations, defects, and scratches 

–  PASS or FAIL result 

–  Specific test result for each zone 

6 To show or hide image overlays, press the Overlay soft key. 
Each time this key is pressed, the selection changes. 

7 Optional. To save the fiber inspection result with specific details as a report (.pdf), complete the 
following steps: 

 Tap the Save PDF soft key. a
The Save window appears with the on-screen key. 

 Type a file name in the File Name field. b
 Select a folder where you want to save the file, if desired. c
 Press the Save soft key. d

The information input window appears. 
 Type in information as required. e
 Tap the Apply button or press the Apply soft key to save and return to the previous state. f

8 Press the Live soft key to return to the live image screen or press the Quit soft key to exit the 
fiber inspection. 

 



Chapter 18 Performing Fiber Inspection 

 JD700B Series User’s Guide 523 

Measurement example 

Figure 283 Analyzed fiber image and fiber inspection result 

 
 

Figure 284 Fiber inspection report 
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Appendix A – Product general information 

JD780B series 

 JD785B/JD786B JD788B Supplemental Information 
Inputs and Outputs    

RF In   Spectrum Analyzer 
Connector Type-N female Type-N female  

Impedance 50 Ω 50 Ω Nominal 
Damage Level >+33 dBm, ±50 V DC >+33 dBm, ±50 V DC Nominal 

    
Reflection/RF Out   Cable and Antenna Analyzer 

Connector Type-N female Type-N female  
Impedance 50 Ω 50 Ω Nominal 

Damage Level >+40 dBm, ±50 V DC >+40 dBm, ±50 V DC Nominal 
    

RF In   Cable and Antenna Analyzer 
Connector Type-N female N/A  

Impedance 50 Ω N/A Nominal 
Damage Level >+25 dBm, ±50 V DC N/A Nominal 

    
External Trigger, GPS    

Connector SMA female SMA female  
Impedance 50 Ω 50 Ω Nominal 

    
External Ref    

Connector SMA female SMA female  
Impedance 50 Ω 50 Ω Nominal 

Input Frequency 10, 13, 15 MHz 10, 13, 15 MHz  
Input Range -5 to +5 dBm -5 to +5 dBm  

    
USB    

USB Host Type A, 1 port Type A, 1 port  
USB Client Type B, 1 port Type B, 1 port  

    
LAN RJ45, 10/100 Base-T RJ45, 10/100 Base-T  

    
SFP/SFP+ MSA compliant MSA compliant In optical hardware option 

    
Audio Jack 3.5 mm headphone 

jack 
3.5 mm headphone 
jack 

 

    
External Power 5.5 mm barrel 

connector 
5.5 mm barrel 
connector 

 

    
Speaker Built-in speaker Built-in speaker  

    
Display    

Type 
 

Size 

Resistive touch 
screen 
8” 

Resistive touch 
screen 
8” 

 
 
LCD backlight, transflective LCD 
with anti-glare coating 

Resolution 800 x 600 800 x 600  
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 JD785B/JD786B JD788B Supplemental Information 
Power    

External DC Input 18 V DC 18 V DC  
Power Consumption 42 W 42 W 54 W maximum when charging 

battery 
    

Battery    
 10.8 V, 7800 mA-h 10.8 V, 7800 mA-h Lithium Ion 

Operating Time > 3 hours (Typical) > 3 hours (Typical) In balance mode 
Charge Time 2.5 hours (80 %) 

5 hours (100 %) 
2.5 hours (80 %) 
5 hours (100 %) 

In case of a fully discharged 
battery 

Storage Temperature 0 to 25°C 
(32 to 77°F) 
 

0 to 25°C 
(32 to 77°F) 
 

The battery pack should be 
stored in an environment with 
low humidity. Extended 
exposure to temperature above 
45°C could degrade battery 
performance and life. 

    
Data Storage    

Internal Maximum 500 MB Maximum 500 MB  
External Limited to the size of 

USB flash drive 
Limited to the size of 
USB flash drive 

Supports USB 2.0 compatible 
memory devices 

    
Environmental    

Operating Temperature 
AC Power 

 
Battery 

 
0 to 40°C 
(32 to 104°F) 
0 to 40°C 
(32 to 104°F) 
-10 to 55 °C 
(14 to 131

 
°F) 

 
0 to 40°C 
(32 to 104°F) 
0 to 40°C 
(32 to 104°F) 
-10 to 55 °C 
(14 to 131

 
°F) 

 
With no derating 
 
At charging 
 
At discharging 

Maximum Humidity 95% RH 95% RH Non-condensing 
Shock and Vibration MIL-PRF-28800F Class 2 MIL-PRF-28800F Class 2  

Storage Temperature -30 to 71°C 
(-22 to 160°F) 

-30 to 71°C 
(-22 to 160°F) 

With the battery pack removed 

    
EMC    
 EN 61326-1:2013 EN 61326-1:2013 Complies with European EMC 
 CISPR11:2009 Class A CISPR11:2009 Class A  

Safety    
 EN 61010-1:2010 EN 61010-1:2010 Complies with European LVD 
 UL 61010-1:2012 & 

CAN/CSA C22.2 No. 
61010-1-12 

UL 61010-4:2012 & 
CAN/CSA C22.2 No. 
61010-1-12 

Complies with TUV NRTL 

Size and Weight (Standard Configuration) 
Weight <4.6 kg (10.1 lb.) <4.2 kg (9.3 lb.) With battery 

    
Size 295 x 195 x 82 (mm) 295 x 195 x 82 (mm) Approximately (W x H x D) 

 11.6 x 7.7 x 3.2 (Inch) 11.6 x 7.7 x 3.2 (Inch)  
    

Warranty    
 2 years 2 years  
    
Calibration Cycle    
 1 year 1 year  
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JD740B series 

 JD745B/JD746B JD748B Supplemental Information 
Inputs and Outputs    

RF In   Spectrum Analyzer 
Connector Type-N female Type-N female  

Impedance 50 Ω 50 Ω Nominal 
Damage Level >+40 dBm, ±50 V DC >+40 dBm, ±50 V DC Nominal 

    
Reflection/RF Out   Cable and Antenna Analyzer 

Connector Type-N female Type-N female  
Impedance 50 Ω 50 Ω Nominal 

Damage Level >+37 dBm, ±50 V DC >+37 dBm, ±50 V DC Nominal 
    

RF In   Cable and Antenna Analyzer 
Connector Type-N female N/A  

Impedance 50 Ω N/A Nominal 
Damage Level >+25 dBm, ±50 V DC N/A Nominal 

    
External Trigger, GPS    

Connector SMA female SMA female  
Impedance 50 Ω 50 Ω Nominal 

    
External Ref    

Connector SMA female SMA female  
Impedance 50 Ω 50 Ω Nominal 

Input Frequency 10, 13, 15 MHz 10, 13, 15 MHz  
Input Range -5 to +5 dBm -5 to +5 dBm  

    
USB    

USB Host Type A, 1 port Type A, 1 port  
USB Client Type B, 1 port Type B, 1 port  

    
LAN RJ45, 10/100 Base-T RJ45, 10/100 Base-T  

    
SFP/SFP+ MSA compliant MSA compliant In optical hardware option 

    
Audio Jack 3.5 mm headphone 

jack 
3.5 mm headphone 
jack 

 

    
External Power 5.5 mm barrel 

connector 
5.5 mm barrel 
connector 

 

    
Speaker Built-in speaker Built-in speaker  

    
Display    

Type 
 

Size 

Resistive touch 
screen 
8” 

Resistive touch 
screen 
8” 

 
 
LCD backlight, transflective LCD 
with anti-glare coating 

Resolution 800 x 600 800 x 600  
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 JD745B/JD746B JD748B Supplemental Information 
Power    

External DC Input 18 V DC 18 V DC  
Power Consumption 42 W 42 W 54 W maximum when charging 

battery 
    

Battery    
 10.8 V, 7800 mA-h 10.8 V, 7800 mA-h Lithium Ion 

Operating Time > 3 hours (Typical) > 3 hours (Typical) In balance mode 
Charge Time 2.5 hours (80 %) 

5 hours (100 %) 
2.5 hours (80 %) 
5 hours (100 %) 

In case of a fully discharged 
battery 

Storage Temperature 0 to 25°C 
(32 to 77°F) 
 

0 to 25°C 
(32 to 77°F) 
 

The battery pack should be 
stored in an environment with 
low humidity. Extended 
exposure to temperature above 
45°C could degrade battery 
performance and life. 

    
Data Storage    

Internal Maximum 500 MB Maximum 500 MB  
External Limited to the size of 

USB flash drive 
Limited to the size of 
USB flash drive 

Supports USB 2.0 compatible 
memory devices 

    
Environmental    

Operating Temperature 
AC Power 

 
Battery 

 
0 to 40°C 
(32 to 104°F) 
0 to 40°C 
(32 to 104°F) 
-10 to 55 °C 
(14 to 131

 
°F) 

 
0 to 40°C 
(32 to 104°F) 
0 to 40°C 
(32 to 104°F) 
-10 to 55 °C 
(14 to 131

 
°F) 

 
With no derating 
 
At charging 
 
At discharging 

Maximum Humidity 95% RH 95% RH Non-condensing 
Shock and Vibration MIL-PRF-28800F Class 2 MIL-PRF-28800F Class 2  

Storage Temperature -30 to 71°C 
(-22 to 160°F) 

-30 to 71°C 
(-22 to 160°F) 

With the battery pack removed 

    
EMC    
 IEC/EN 61326-1:2013 IEC/EN 61326-1:2013 Complies with European EMC 
 CISPR11:2009 Class A CISPR11:2009 Class A  
Safety    
 EN 61010-1:2010 EN 61010-1:2010 Complies with European LVD 
 UL 61010-1:2012 & 

CAN/CSA C22.2 No. 
61010-1-12 
 

UL 61010-4:2012 & 
CAN/CSA C22.2 No. 
61010-1-12 

Complies with TUV NRTL 

Size and Weight (Standard Configuration) 
Weight <4.04 kg (8.9 lb.) <3.75 kg (8.3 lb.) With battery 

    
Size 295 x 195 x 82 (mm) 295 x 195 x 82 (mm) Approximately (W x H x D) 

 11.6 x 7.7 x 3.2 (Inch) 11.6 x 7.7 x 3.2 (Inch)  
    

Warranty    
 2 years 2 years  
    
Calibration Cycle    
 1 year 1 year  
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Appendix B – Cable list 

 

Cable Type Relative Propagation 
Velocity (V¦) 

Nominal Attenuation dB/m 
@ 1000 MHz 

FSJ1-50A 0.84 0.197 
FSJ250 0.83 0.134 
FSJ4-50B 0.81 0.119 
HCC 12-50J 0.915 0.092 
HCC 158-50J 0.95 0.023 
HCC 300-50J 0.96 0.014 
HCC 312-50J 0.96 0.013 
HCC 78-50J 0.915 0.042 
HF 4-1/8” Cu2Y 0.97 0.01 
HF 5” Cu2Y 0.96 0.007 
HF 6-1/8”Cu2Y 0.97 0.006 
HJ4.5-50 0.92 0.054 
HJ4-50 0.914 0.087 
HJ5-50 0.916 0.042 
HJ7-50A 0.921 0.023 
LDF12-50 0.88 0.022 
LDF4-50A 0.88 0.077 
LDF5-50A 0.89 0.043 
LDF6-50 0.89 0.032 
LDFF7-50A 0.88 0.027 
LMR100 0.8 0.792 
LMR1200 0.88 0.044 
LMR1700 0.89 0.033 
LMR200 0.83 0.344 
LMR240 0.84 0.262 
LMR400 0.85 0.135 
LMR500 0.86 0.109 
LMR600 0.87 0.087 
LMR900 0.87 0.056 
RG142 0.69 0.443 
RG17, 17A 0.659 0.18 
RG174 0.66 0.984 
RG178B 0.69 1.509 
RG187, 188 0.69 1.017 
RG213/U 0.66 0.292 
RG214 0.659 0.292 
RG223 0.659 0.165 
RG55, 55A, 55B 0.659 0.541 
RG58, 58B 0.659 1.574 
RG58A, 58C 0.659 0.787 
RG8, 8A, 10, 10A 0.659 0.262 
RG9, 9A 0.659 0.289 
HFSC-12D(1/2") 0.81 0.112 
HFC-12D(1/2") 0.88 0.072 
HFC-22D(7/8") 0.88 0.041 
HFC-33D(1_1/4") 0.88 0.0294 
HFC-42D(1_5/8") 0.87 0.0243 
RFCX-12D(1/2") 0.88 0.088 
RFCX-22D(7/8") 0.88 0.049 
RFCX-33D(1_1/4") 0.88 0.038 
RFCX-42D(1_5/8") 0.87 0.028 
RFCL-22D(7/8") 0.88 0.044 
RFCL-33D(1_1/4") 0.88 0.034 
RFCL-42D(1_5/8") 0.87 0.0315 
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Appendix C – Band, frequency & channel standard 

 

Standard 
Uplink Downlink 
Start Freq 
(MHz) 

Stop Freq 
(MHz) Valid Channels Start Freq 

(MHz) 
Stop Freq 
(MHz) Valid Channels 

GSM 
GSM 450  450.40  457.60  259≤n≤293 460.40  467.60  259≤n≤293 

GSM 480  478.80  486.00  306≤n≤340 488.80  496.00  306≤n≤340 

GSM 850  824.00  849.00  128≤n≤251 869.00  894.00  128≤n≤251 

P-GSM 900  890.00  915.00  1≤n≤124 935.00  960.00  1≤n≤124 

E-GSM 900  880.00 915.00 
0≤n≤124 

925.00 960.00 
0≤n≤124 

975≤n≤1023 975≤n≤1023 

R-GSM 900  876.00 915.00 
0≤n≤124 

921.00 960.00 
0≤n≤124 

955≤n≤1023 955≤n≤1023 

R-GSM 900 (China)  885.00  889.00  999≤n≤1019 930.00  934.00  999≤n≤1019 

DCS 1800 1710.00  1785.00  512≤n≤885 1805.00  1880.00  512≤n≤885 

PCS 1900 1850.00  1910.00  512≤n≤810 1930.00  1990.00  512≤n≤810 

CDMA 

Band 0 (800) 824.00  849.00  
1≤n≤799 

869.00  894.00  
1≤n≤799 

991≤n≤1023 991≤n≤1023 

Band 1 (NA PCS) 1850.00  1910.00  0≤n≤1199 1930.00  1990.00  0≤n≤1199 

Band 2 (TACS) 872.0125  914.9875  
0≤n≤1000 

917.0125  959.9875  
0≤n≤1000 

1329≤n≤2047 1329≤n≤2047 

Band 3 (JTACS) 887.0125  924.9875  

1≤n≤799 

832.0125  869.9875  

1≤n≤799 

801≤n≤1039 801≤n≤1039 

1041≤n≤1199 1041≤n≤1199 

1201≤n≤1600 1201≤n≤1600 

Band 4 (KR PCS) 1750.00  1780.00  0≤n≤599 1840.00  1870.00  0≤n≤599 

Band 5 (450) 411.675  483.480  

1≤n≤300 

421.6750  493.4800  

1≤n≤300 

539≤n≤871 539≤n≤871 

1039≤n≤1473 1039≤n≤1473 

1792≤n≤2016 1792≤n≤2016 

Band 6 (2100) 1920.00  1980.00  0≤n≤1199 2100.00  2170.00  0≤n≤1199 

Band 7 (700) 776.00  794.00  0≤n≤359 746.00  764.00  0≤n≤359 

Band 8 (1800) 1710.00  1784.95  0≤n≤1499 1805.00  1879.95  0≤n≤1499 

Band 9 (900) 880.00  914.95  0≤n≤699 925.00  959.95  0≤n≤699 

Band 10 (2nd 800) 806.000  900.975  
0≤n≤719 

851.000  939.975  
0≤n≤719 

720≤n≤919 720≤n≤919 

WCDMA 
Band Global       

Band 1 (2100-General) 1920.0  1980.0  9612≤n≤9888 2110.0  2170.0  10562≤n≤10838 

Band 2 (1900-General) 
1850.0  1910.0  

9262≤n≤9538 
1930.0  1990.0  

9662≤n≤9938 

Band 2 (1900-Additional) 12≤n≤287 412≤n≤687 

Band 3 (1800-General) 1710.0  1780.0  937≤n≤1288 1805.0  1880.0  1162≤n≤1513 

Band 4 (1700-General) 
1710.0  1775.0  

1312≤n≤1513 
2110.0  2155.0  

1537≤n≤1738 

Band 4 (1700-Additional) 1662≤n≤1862 1887≤n≤2087 

Band 5 (850-General) 
824.0  849.0  

4132≤n≤4233 
869.0  894.0  

4357≤n≤4458 

Band 5 (850-Additional) 782≤n≤862 1007≤n≤1087 

Band 6 (800-General) 
830.0  840.0  

4162≤n≤4188 
875.0  885.0  

4387≤n≤4413 

Band 6 (800-Additional) 812≤n≤837 1037≤n≤1062 

Band 7 (2600-General) 
2500.0  2570.0  

2012≤n≤2338 
2620.0  2690.0  

2237≤n≤2563 

Band 7 (2600-Additional) 2362≤n≤2687 2587≤n≤2912 

Band 8 (900-General) 880.0  915.0  2712≤n≤2863 925.0  960.0  2937≤n≤3088 

Band 9 (1700-General) 1749.9  1784.9  8762≤n≤8912 1844.9  1879.9  9237≤n≤9387 

Band 10 (1700-General) 
1710.0  1770.0  

2887≤n≤3163 
2110.0  2170.0  

3112≤n≤3388 

Band 10 (1700-Additional) 3187≤n≤3462 3412≤n≤3687 

Band 11 (1500-General) 1427.9  1447.9  3487≤n≤3562 1475.9  1495.9  3712≤n≤3787 

Band 12 (700-General) 
699.0  716.0  

3617≤n≤3678 
729.0  746.0  

3842≤n≤3903 

Band 12 (700-Additional) 3707≤n≤3767 3932≤n≤3992 

Band 13 (700-General) 
777.0  787.0  

3792≤n≤3818 
746.0  756.0  

4017≤n≤4043 

Band 13 (700-Additional) 3842≤n≤3867 4067≤n≤4092 

Band 14 (700-General) 
788.0  798.0  

3892≤n≤3918 
758.0  768.0  

4117≤n≤4143 

Band 14 (700-Additional) 3942≤n≤3967 4167≤n≤4192 

Band 19 (800-General) 
830.0  845.0  

312≤n≤363 
875.0  890.0  

712≤n≤763 

Band 19 (800-Additional) 387≤n≤437 787≤n≤837 

Band 20 (800-General) 832.0  862.0  4287≤n≤4413 791.0  821.0  4512≤n≤4638 
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Band 21 (1500-General) 1447.9  1462.9  462≤n≤512 1495.9  1510.9  862≤n≤912 

Band 22 (3500-General) 3410.0  3490.0  4437≤n≤4813 3510.0  3590.0  4662≤n≤5038 

Band 25 (1900-General) 
1850.0  1915.0  

4887≤n≤5188 
1930.0  1995.0  

5112≤n≤5413 

Band 25 (1900-Additional) 5212≤n≤5512 5437≤n≤5737 

Band 26 (800-General) 
814.0  849.0  

5537≤n≤5688 
859.0  894.0  

5762≤n≤5913 

Band 26 (800-Additional) 5712≤n≤5862 5937≤n≤6087 

LTE - FDD 

Band Global       

Band 1 (2100) 1920.0  1980.0  18000≤n≤18599 2110.0  2170.0  0≤n≤599 

Band 2 (1900) 1850.0  1910.0  18600≤n≤19199 1930.0  1990.0  600≤n≤1199 

Band 3 (1800) 1710.0  1785.0  19200≤n≤19949 1805.0  1880.0  1200≤n≤1949 

Band 4 (1700) 1710.0  1755.0  19950≤n≤20399 2110.0  2155.0  1950≤n≤2399 

Band 5 (850) 824.0  849.0  20400≤n≤20649 869.0  894.0  2400≤n≤2649 

Band 7 (2600) 2500.0  2570.0  20750≤n≤21449 2620.0  2690.0  2750≤n≤3449 

Band 8 (900) 880.0  915.0  21450≤n≤21799 925.0  960.0  3450≤n≤3799 

Band 9 (1700) 1749.9  1784.9  21800≤n≤22149 1844.9  1879.9  3800≤n≤4149 

Band 10 (1700) 1710.0  1770.0  22150≤n≤22749 2110.0  2170.0  4150≤n≤4749 

Band 11 (1500) 1427.9  1447.9  22750≤n≤22949 1475.9  1495.9  4750≤n≤4949 

Band 12 (700) 699.0  716.0  23010≤n≤23179 729.0  746.0  5010≤n≤5179 

Band 13 (700) 777.0  787.0  23180≤n≤23279 746.0  756.0  5180≤n≤5279 

Band 14 (700) 788.0  798.0  23280≤n≤23379 758.0  768.0  5280≤n≤5379 

Band 17 (700) 704.0  716.0  23730≤n≤23849 734.0  746.0  5730≤n≤5849 

Band 18 (800) 815.0  830.0  23850≤n≤23999 860.0  875.0  5850≤n≤5999 

Band 19 (800) 830.0  845.0  24000≤n≤24149 875.0  890.0  6000≤n≤6149 

Band 20 (800) 832.0  862.0  24150≤n≤24449 791.0  821.0  6150≤n≤6449 

Band 21 (1500)  1447.9  1462.9  24450≤n≤24599 1495.9  1510.9  6450≤n≤6599 

Band 22 (3500) 3410.0  3490.0  24600≤n≤25399 3510.0  3590.0  6600≤n≤7399 

Band 23 (2100) 2000.0  2020.0  25500≤n≤25699 2180.0  2200.0  7500≤n≤7699 

Band 24 (1500) 1626.5  1660.5  25700≤n≤26039 1525.0  1559.0  7700≤n≤8039 

Band 25 (1900) 1850.0  1915.0  26040≤n≤26689 1930.0  1995.0  8040≤n≤8689 

Band 26 (800) 814.0  849.0  26690≤n≤27039 859.0  894.0  8690≤n≤9039 

LTE - TDD 

Band Global    

 

Band 33 (1900) 1900.0  1920.0  36000≤n≤36199 

Band 34 (2100) 2010.0  2025.0  36200≤n≤36349 

Band 35 (1850) 1850.0  1910.0  36350≤n≤36949 

Band 36 (1930) 1930.0  1990.0  36950≤n≤37549 

Band 37 (1910) 1910.0  1930.0  37550≤n≤37749 

Band 38 (2570) 2570.0  2620.0  37750≤n≤38249 

Band 39 (1880) 1880.0  1920.0  38250≤n≤38649 

Band 40 (2300) 2300.0  2400.0  38650≤n≤39649 

Band 41 (2496) 2496.0  2690.0  39650≤n≤41589 

Band 42 (3400) 3400.0  3600.0  41590≤n≤43589 

Band 43 (3600) 3600.0  3800.0  43590≤n≤45589 

TD-SCDMA 

FBN 0 1785.0  1805.0  0≤n≤92 

 

FBN 1 1900.0  1920.0  0≤n≤92 

FBN 2 1920.0  1980.0  0≤n≤255 

FBN 3 1920.0  1980.0  0≤n≤36 

FBN 4 1980.0  2010.0  0≤n≤142 

FBN 5 2010.0  2025.0  0≤n≤67 

FBN 6 2100.0  2170.0  0≤n≤255 

FBN 7 2100.0  2170.0  0≤n≤36 

FBN 8 2170.0  2220.0  0≤n≤242 

WiMAX 

ProfR1 (1.25 2150) 2150.625  2159.375  0≤n≤7  

ProfR2 (1.25 2305) 2305.625  2320.625  0≤n≤12 

ProfR3 (1.25 2361) 2361.875  2375.625  13≤n≤24 

ProfR4 (1.25 2500) 2500.625  2688.125  0≤n≤150 

ProfR5 (1.25 3400) 3400.625  3700.625  0≤n≤240 

ProfR6 (3.5 2598) 2524.750  2591.250  0≤n≤38 2598.750  2665.250  0≤n≤38 

ProfR7 (3.5 3461) 3411.750  3443.250  0≤n≤18 3461.750  3493.250  0≤n≤18 

ProfR8 (3.5 3551) 3501.750  3598.000  0≤n≤55 3551.750  3648.000  0≤n≤55 

ProfR9 (3.5 3651) 3601.750  3698.000  0≤n≤55 3651.750  3748.000  0≤n≤55 

ProfR10 (3.5 3751) 3701.750  3798.000  0≤n≤55 3751.750  3848.000  0≤n≤55 

ProfR11 (7 2600) 2526.500  2589.500  0≤n≤36 2600.50  2663.50  0≤n≤36 

ProfR12 (7 3463) 2413.500  3441.500  0≤n≤16 3463.50  3491.50  0≤n≤16 

ProfR13 (7 3553) 3503.500  3596.250  0≤n≤53 3553.50  3646.25  0≤n≤53 
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ProfR14 (7 3653) 3603.500  3696.250  0≤n≤53 3653.50  3746.25  0≤n≤53 

ProfR15 (7 3753) 3703.500  3796.250  0≤n≤53 3753.50  3846.25  0≤n≤53 

ProfR26 (10 5275) 5275.000  5335.000  55≤n≤67  

ProfR27 (10 5740) 5740.000  5830.000  148≤n≤166 

ProfR28 (10 5735) 5735.000  5845.000  147≤n≤169 

ProfR29 (8.75 2304) 2304.375  2395.625  0≤n≤730 
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Appendix D – VSWR-Return loss conversion table 

This information is for the Cable and Antenna Analyzer mode of the JD785B/JD745B Base Station 
Analyzer and the JD786B/JD746B RF Analyzer. 
 
 Return Loss=20log10(VSWR+1/VSWR-1) (dB) 

 VSWR=(10
R.L./20

+1/10
R.L./20

-1) 

 
VSWR Return 

Loss 
(dB) 

Trans. 
Loss 
(dB) 

Volt. 
Refl 
Coeff 

Power 
Trans 
(%) 

Power 
Refl 
(%) 

 VSWR Return 
Loss 
(dB) 

Trans. 
Loss 
(dB) 

Volt. 
Refl 
Coeff 

Power 
Trans 
(%) 

Power 
Refl 
(%) 

1.00 -- 0.000 0.00 100.0 0.0  1.64 12.3 0.263 0.24 94.1 5.9 
1.01 46.1 0.000 0.00 100.0 0.0  1.66 12.1 0.276 0.25 93.8 6.2 
1.02 40.1 0.000 0.01 100.0 0.0  1.68 11.9 0.289 0.25 93.6 6.4 
1.03 36.6 0.001 0.01 100.0 0.0  1.70 11.7 0.302 0.26 93.3 6.7 
1.04 34.2 0.002 0.02 100.0 0.0  1.72 11.5 0.315 0.26 93.0 7.0 
1.05 32.3 0.003 0.02 99.9 0.1  1.74 11.4 0.329 0.27 92.7 7.3 
1.06 30.7 0.004 0.03 99.9 0.1  1.76 11.2 0.342 0.28 92.4 7.6 
1.07 29.4 0.005 0.03 99.9 0.1  1.78 11.0 0.356 0.28 92.1 7.9 
1.08 28.3 0.006 0.04 99.9 0.1  1.80 10.9 0.370 0.29 91.8 8.2 
1.09 27.3 0.008 0.04 99.8 0.2  1.82 10.7 0.384 0.29 91.5 8.5 
1.10 26.4 0.010 0.05 99.8 0.2  1.84 10.6 0.398 0.30 91.3 8.7 
1.11 25.7 0.012 0.05 99.7 0.3  1.86 10.4 0.412 0.30 91.0 9.0 
1.12 24.9 0.014 0.06 99.7 0.3  1.88 10.3 0.426 0.31 90.7 9.3 
1.13 24.3 0.016 0.06 99.6 0.4  1.90 10.2 0.440 0.31 90.4 9.6 
1.14 23.7 0.019 0.07 99.6 0.4  1.92 10.0 0.454 0.32 90.1 9.9 
1.15 23.1 0.021 0.07 99.5 0.5  1.94 9.9 0.468 0.32 89.8 10.2 
1.16 22.6 0.024 0.07 99.5 0.5  1.96 9.8 0.483 0.32 89.5 10.5 
1.17 22.1 0.027 0.08 99.4 0.6  1.98 9.7 0.497 0.33 89.2 10.8 
1.18 21.7 0.030 0.08 99.3 0.7  2.00 9.5 0.512 0.33 88.9 11.1 
1.19 21.2 0.033 0.09 99.2 0.8  2.50 7.4 0.881 0.43 81.6 18.4 
1.20 20.8 0.036 0.09 99.2 0.8  3.00 6.0 1.249 0.50 75.0 25.0 
1.21 20.4 0.039 0.10 99.1 0.9  3.50 5.1 1.603 0.56 69.1 30.9 
1.22 20.1 0.043 0.10 99.0 1.0  4.00 4.4 1.938 0.60 64.0 36.0 
1.23 19.7 0.046 0.10 98.9 1.1  4.50 3.9 2.255 0.64 59.5 40.5 
1.24 19.4 0.050 0.11 98.9 1.1  5.00 3.5 2.553 0.67 55.6 44.4 
1.25 19.1 0.054 0.11 98.8 1.2  5.50 3.2 2.834 0.69 52.1 47.9 
1.26 18.8 0.058 0.12 98.7 1.3  6.00 2.9 3.100 0.71 49.0 51.0 
1.27 18.5 0.062 0.12 98.6 1.4  6.50 2.7 3.351 0.73 46.2 53.8 
1.28 18.2 0.066 0.12 98.5 1.5  7.00 2.5 3.590 0.75 43.7 56.3 
1.29 17.9 0.070 0.13 98.4 1.6  7.50 2.3 3.817 0.76 41.5 58.5 
1.30 17.7 0.075 0.13 98.3 1.7  8.00 2.2 4.033 0.78 39.5 60.5 
1.32 17.2 0.083 0.14 98.1 1.9  8.50 2.1 4.240 0.79 37.7 62.3 
1.34 16.8 0.093 0.15 97.9 2.1  9.00 1.9 4.437 0.80 36.0 64.0 
1.36 16.3 0.102 0.15 97.7 2.3  9.50 1.8 4.626 0.81 34.5 65.5 
1.38 15.9 0.112 0.16 97.5 2.5  10.00 1.7 4.807 0.82 33.1 66.9 
1.40 15.8 0.122 0.17 97.2 2.8  11.00 1.6 5.149 0.83 30.6 69.4 
1.42 15.2 0.133 0.17 97.0 3.0  12.00 1.5 5.466 0.85 28.4 71.6 
1.44 14.9 0.144 0.18 96.7 3.3  13.00 1.3 5.762 0.86 26.5 73.5 
1.46 14.6 0.155 0.19 96.5 3.5  14.00 1.2 6.040 0.87 24.9 75.1 
1.48 14.3 0.166 0.19 96.3 3.7  15.00 1.2 6.301 0.88 23.4 76.6 
1.50 14.0 0.177 0.20 96.0 4.0  16.00 1.1 6.547 0.88 22.1 77.9 
1.52 13.7 0.189 0.21 95.7 4.3  17.00 1.0 6.780 0.89 21.0 79.0 
1.54 13.4 0.201 0.21 95.5 4.5  18.00 1.0 7.002 0.89 19.9 80.1 
1.56 13.2 0.213 0.22 95.2 4.8  19.00 0.9 7.212 0.90 19.0 81.0 
1.58 13.0 0.225 0.22 94.9 5.1  20.00 0.9 7.413 0.90 18.1 81.9 
1.60 12.7 0.238 0.23 94.7 5.3  25.00 0.7 8.299 0.92 14.8 85.2 
1.62 12.5 0.250 0.24 94.4 5.6  30.00 0.6 9.035 0.94 12.5 87.5 
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Appendix E – Cyclic prefix table 

This information is for the LTE – FDD Signal Analyzer mode and the LTE – TDD Signal Analyzer mode 
of the JD785B/JD745B Base Station Analyzer and the JD788B/JD748B Signal Analyzer. Following 
table shows OFDM parameter details by different bandwidth. 
 
 

Bandwidth Configuration (Downlink) 
Cyclic Prefix Length 

TS µs 

20 MHz 

Normal CP ∆f=15 kHz 
160 for l =0 

144 for l =1,2,..,6 

5.208 

4.6875 

Extended CP 
∆f=15 kHz 512 for l =0,1,…,5 16.667 

∆f=7.5 kHz 1024 for l =0,1,2 33.333 

15 
MHz 

Normal CP ∆f=15 kHz 
120 for l =0 

108 for l =1,2,..,6 

5.208 

4.6875 

Extended CP 
∆f=15 kHz 384 for l =0,1,…,5 16.667 

∆f=7.5 kHz 768 for l =0,1,2 33.333 

10 
MHz 

Normal CP ∆f=15 kHz 
80 for l =0 

72 for l =1,2,..,6 

5.208 

4.6875 

Extended CP 
∆f=15 kHz 256 for l =0,1,…,5 16.667 

∆f=7.5 kHz 512 for l =0,1,2 33.333 

5 
MHz 

Normal CP ∆f=15 kHz 
40 for l =0 

36 for l =1,2,..,6 

5.208 

4.6875 

Extended CP 
∆f=15 kHz 128 for l =0,1,…,5 16.667 

∆f=7.5 kHz 248 for l =0,1,2 33.333 

3 
MHz 

Normal CP ∆f=15 kHz 
20 for l =0 

18 for l =1,2,..,6 

5.208 

4.6875 

Extended CP 
∆f=15 kHz 64 for l =0,1,…,5 16.667 

∆f=7.5 kHz 128 for l =0,1,2 33.333 

1.4 
MHz 

Normal CP ∆f=15 kHz 
10 for l =0 

9 for l =1,2,..,6 

5.208 

4.6875 

Extended CP 
∆f=15 kHz 32 for l =0,1,…,5 16.667 

∆f=7.5 kHz 64 for l =0,1,2 33.333 
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Appendix F – Motorola CDMA/EV-DO LMF 

Motorola’s CDMA/EV-DO base stations (BTS) are optimized with the assistance of Local Maintenance 
Facility (LMF), a Motorola’s software tool that interfaces with the cell site and the instrument. The 
optimization process identifies the accumulated loss (or gain) for all receiving and transmitting paths at 
the cell site and stores that value in the system’s database. 
 

Using JD700B series LMF interface 

An emulation interface to LMF has been implemented in JDSU’s base station analyzer (JD785B/ 
JD745B) in order to perform BTS optimization procedures. The scope of this emulation is to do 
maintenance tests of TX Calibration and TX Audit required in routine maintenance practices with or 
without the use of an external power sensor. Using the external power sensor, you can get highly 
accurate measurement results. 
 

Setting up for a LMF test 

Procedure 

1 To connect your instrument both with BTS and PC, do one of the following: 
–  Internal power sensor: Connect the Motorola CDMA/EV-DO BTS with the Spectrum 

Analyzer RF In 50 Ω port of JD785B/JD745B and connect the WinLMF running PC with 
JD785B/JD745B via a hub as illustrated in the Figure 285. 

–  External power sensor: Connect an external power sensor to the USB Host port of JD785B/ 
JD745B and to the BTS and connect the WinLMF running PC with JD785B/JD745B via a 
hub as illustrated in the Figure 286. 

 
Figure 285 Using internal power sensor 
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Figure 286 Using external power sensor 

 
 

Performing a LMF test 

Procedure 

1 Press the SYSTEM hot key. 
2 To set the IP address, complete the following steps: 

 Select System Configuration > Ethernet Config. a
 Toggle the Mode soft key and select Static. b
 Press the Field > IP Address soft key. c
 Set the IP address as “192.167.10.1”. d

3 Select Remote Interface > LAN > LMF. 
4 To set up the LMF settings, complete the following steps: 

 Press the LMF Settings soft key. a
 Select the power measurement and BTS option from the following choices: b

–  External PM 800 MHz Band for external measurement on cellular basestation 

–  External PM 1900 MHz Band for external meausrement on PCS basestation 

–  Internal PM 800 MHz Band for internal measurement on celluar basestation 

–  Internal PM 1900 MHz Band for internal measurement on PCS basestation 

5 To select the measurement mode, complete the following steps: 
 Press the MODE hard key. a
 Press the Power Meter soft key. b
 Select Internal RF Power Meter or External RF Power Meter depending on your LMF c

settings. The measurement result is displayed on the screen. 
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Appendix G – Bluetooth connection 

JD700B series’ Bluetooth mode is used for communication between the instrument and your computer 
with JDRemote or a storage device in order to use the following services if needed. 
 

 Bluetooth Personal Area Network (PAN) profile service for JDRemote. 

 Bluetooth File Transfer Profile (FTP) or Object Push Profile (OPP) service for file transfer from 
the instrument to a Bluetooth storage device. 

 
The Bluetooth Connectivity option includes a pair of Bluetooth USB Parani-UD100 Adapters and 5 dBi 
Dipole Antennas as well as the BlueSoleil application software. 
 

Installing and setting up Bluetooth software 

The BlueSoleil application must be installed in your computer prior to making a Bluetooth connection. 
After installing the software, you must disable DHCP Server option in order to use the PAN service 
properly. 
 

Procedure 

1 Insert the provided CD-ROM into your computer and install the software as instructed. 
The BlueSoleil Space shortcut icon appears on the desktop. 

 

 NOTE 
For more information on installation, refer to the Quick Start Guide or the User Guide 
provided with the adapter. 

 

2 Double-click the BlueSoleil Space shortcut icon on your computer desktop to launch the 
application. 
The BlueSoleil program window appears. 

3 Right-click the My Device icon (the orange ball) in the center of the window, and then click 
Properties > Services tab. 
The My Device Properties window appears. 

4 Select the Bluetooth Personal Area Network from the list, and then click the Properties button. 
The Bluetooth Personal Area Network Properties window appears. 

5 Click the Options tab, and then uncheck the Enable DHCP Server option. 
 

 NOTE 
You must uncheck it to disable this option as the Enable DHCP Server option is checked 
by default. 

 

6 Click the OK button. 
The Bluetooth Personal Area Network Properties window dismisses. 

7 Click the OK button. 
The My Device Properties window dismisses. 

 

Making Bluetooth connection 

The JD700B series detects a connected Parani-UD100 USB Bluetooth Adapter automatically. 
 

Procedure 

1 Connect the 5 dBi Dipole Antenna to the Parani-UD100 Bluetooth USB Adapter: one for the 
computer and the other for JD700B series. 
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2 Plug in the Bluetooth adapters to the USB port of the computer and the instrument. 
The instrument detects the connected adapter and turns the Bluetooth mode on automatically. 
The Bluetooth icon appears in the status bar at the top of the instrument screen. 

3 Double-click the BlueSoleil Space icon on the computer desktop to launch the application if not 
opened already. 
The BlueSoleil program window appears. 

4 Double-click the My Device icon (orange ball) in the center of the application window to search 
the JD700B series. 
You can view an added icon around the orange ball labeled with the detected JD700B series’ BD 
address or model and serial numbers. 

5 Right-click the device icon for the JD700B series, and then click the Pair. 
The Bluetooth Passkey window appears. 

6 Enter 0000 in the Passkey box, and then click the OK button. 
The word “Paired” appears on the window. The instrument also turns the Bluetooth Mode on 
automatically and displays the paired device and service information on the screen. 

7 Double-click the device icon for the JD700B series to search services. 
8 Right-click the icon for the JD700B series, and then select either the Connect Bluetooth 

Personal Area Network or the Connect Bluetooth File Transfer. 
 

 NOTE 
Select one of these services as needed. If the Connect Bluetooth Personal Area Network 
is selected, a fixed IP address (192.168.10.10) is assigned for JD700B series and this 
address must be typed into the TCP/IP setting on JDViewer or JDRemote. See “Setting 
up communication in application” on page 538 for more information. 

 

 

Setting up communication in application 

If the Connect Bluetooth Personal Area Network service is selected on BlueSoleil, you need to 
configure communication setting on the application JDViewer or JDRemote by entering the fixed IP 
address for the instrument. 
 

JDViewer setup 

Procedure 

1 Launch the JDViewer application. 
2 Go to Settings > Communication. 

The Settings dialog box appears. 
3 Click the drop-down list in the Instrument pane, and then select the instrument series to be 

communicated. 
4 In the Connection Method pane, select the TCP/IP, and then enter 192.168.10.10 without dots. 
5 Click OK to finish the communication setup. 
6 Go to Load > Connect to make a connection between the instrument and JDViewer. 

JD700B series and JDViewer become ready for communication. 

 

JDRemote setup 

Procedure 

1 Launch the JDRemote application. 
The Select Model dialog box appears. 

2 Select the 740A, 780A Series, and then click the OK button. 
3 Right-click on the JDRemote window, and then click the Communication. 

The Communication dialog box appears. 
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4 Select the TCP/IP, and then enter 192.168.10.10 without dots. 
5 Click OK to finish the communication setup. 
6 Right-click on the JDRemote window, and then click the Connect. 

This enables communication between the instrument and JDRemote. 
7 Right-click on the JDRemote window, and then click the Start. 

JD700B series and JDRemote become ready for communication. 
8 Optional. To adjust the image quality, complete the following steps: 

 Right-click on the JDRemote. a
 Click the Quality. b
 Select the image quality option among High, Medium, or Low. c

You can improve refresh rate, if experiencing low-quality signal, by adjusting the image 
quality in JDRemote. 

 

Turning Bluetooth mode on/off manually 

JD700B series turns the Bluetooth Mode on automatically if connected. You can also turn it on and off 
manually. 
 

Procedure 

1 Press the SYSTEM hot key. 

2 Press the System Configuration > Remote Interface > Bluetooth soft key. 
The Bluetooth screen appears with the device information. 

3 Toggle the Bluetooth soft key between On and Off to turn it on and off. 
Connecting or disconnecting the adapter also turns the mode on or off automatically. 
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Appendix H – Device driver installation 

JD700B series can be controlled from the application software JDViewer or JDRemote installed on 
your computer. You must install driver software for the instrument on to the computer if USB Client 
connection is used for communication. 
 

Procedure 

1 Go to Control Panel > System > Device Manager. 
The Device Manager window appears. 

2 Right-click the Unknown Device under the Other Devices, and then click the Update Driver 
Software. 
The Update Driver Software – Unknown Device window appears as shown in Figure 287 below. 

3 Select the Browse my computer for driver software, and then click the Browse button to 
search for the location where the driver software is. 
The Browse For Folder window appears. 

4 Search for the JDRemote folder, and then select the driver folder for the installed OS. 
For example, OSDisk (C:) > Program Files (x86) > JDRemote > Driver > Win7 > 64bit. 

5 Click the OK button. 
The Browse For Folder window dismisses. 

6 Click the Next button to start installation. 
If the Windows Security window appears, select the Install this driver software anyway. 
Installing driver software starts. 

7 Click the Close button at the end of the installation. 

 
Figure 287 Device manager screen 
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Appendix I – Ordering information 

JD785B Base Station Analyzer 

JD785B   
9 kHz to 8 GHz Spectrum Analyzer  
5 MHz to 6 GHz Cable and Antenna Analyzer 

1
  

10 MHz to 8 GHz RF Power Meter Internal mode 
   
Options   
NOTE: Upgrade options for the JD785B use the designation JD785BU before the respective last three-digit option number. 
JD785B001 2-Port Transmission Measurements 

2
  

JD785B002 Bias Tee (Requires option 01) 
JD785B003 High Power CW Signal Generator  
JD785B008 Optical Hardware 

3
  

JD785B010 GPS Receiver and Antenna  
JD785B011 Interference Analyzer 

4, 5
  

JD785B012 Channel Scanner  
JD785B013 Bluetooth Connectivity  
JD785B020 cdmaOne/cdma2000 Signal Analyzer  
JD785B021 EV-DO Signal Analyzer (Requires option 20) 
JD785B022 GSM/GPRS/EDGE Signal Analyzer  
JD785B023 WCDMA/HSPA+ Signal Analyzer  
JD785B025 TD-SCDMA Signal Analyzer  
JD785B026 Mobile WiMAX Signal Analyzer  
JD785B028 LTE-FDD Signal Analyzer  
JD785B029 LTE-TDD Signal Analyzer  
JD785B030 LTE Advanced-FDD Signal Analyzer (Requires option 28) 
JD785B031 LTE Advanced-TDD Signal Analyzer (Requires option 29) 
JD785B040 cdmaOne/cdma2000 OTA Analyzer 

5
 (Requires option 10) 

JD785B041 EV-DO OTA Analyzer 
5
 (Requires option 10) 

JD785B042 GSM/GPRS/EDGE OTA Analyzer 
5
 (Requires option 10) 

JD785B043 WCDMA/HSPA+ OTA Analyzer 
5
 (Requires option 10) 

JD785B045 TD-SCDMA OTA Analyzer 
5
 (Requires option 10) 

JD785B046 Mobile WiMAX OTA Analyzer 
5
 (Requires option 10) 

JD785B048 LTE-FDD OTA Analyzer 
5
 (Requires option 10) 

JD785B049 LTE-TDD OTA Analyzer 
5
 (Requires option 10) 

JD785B060 RFoCPRI 614M & 1.2G Interference Analyzer 
6
 (Requires option 08) 

JD785B061 RFoCPRI 2.4G Interference Analyzer 
6
 (Requires option 08) 

JD785B062 RFoCPRI 3.1G Interference Analyzer 
6
 (Requires option 08) 

JD785B063 RFoCPRI 4.9G Interference Analyzer 
6
 (Requires option 08) 

JD785B064 RFoCPRI 6.1G Interference Analyzer 
6
 (Requires option 08) 

JD785B065 RFoCPRI 9.8G Interference Analyzer 
6
 (Requires option 08) 

JD785B200 Calibration Service for Asia, North America 
JD785B201 Calibration Service for Latin America, EMEA 
JD785B250 Warranty extension of 1 year for Asia, North America 
JD785B251 Warranty extension of 1 year for Latin America, EMEA 
 
 

  

Standard Accessories 
JD70050326 AC/DC Power Adapter for JD700B Series 

7
 

G710550335 Cross LAN Cable (1.5 m) 
7
 

GC73050515 USB A to B Cable (1.8 m) 
7
 

GC72450518 > 1 G Byte USB Memory 
7
 

G710550325 Rechargeable Lithium Ion Battery 
7
 

G710550323 Automotive Cigarette Lighter 12 V DC Adapter 
7
 

G710550316 Stylus Pen 
7
 

JD700B361 JD700B Series User’s Guide and Application Software – CD 
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1 

Requires calibration kit 
2 

Requires dual port calibration kit 
3 

Requires RFoCPRI options 
4 

Highly recommended adding JD785B010 
5 

Highly recommended adding G70005035x and/or G70005036x 
6 

Requires proper SFP/SFP+ transceiver and optical tap. 
7 

Standard accessories can be purchased separately. 

 

JD786B RF Analyzer 

JD786B   
9 kHz to 8 GHz Spectrum Analyzer  
5 MHz to 6 GHz Cable and Antenna Analyzer 

1
  

10 MHz to 8 GHz RF Power Meter Internal mode 
   
Options   
NOTE: Upgrade options for the JD786B use the designation JD786BU before the respective last three-digit option number. 
JD786B001 2-Port Transmission Measurements 

2
  

JD786B002 Bias Tee (Requires option 01) 
JD786B003 High Power CW Signal Generator  
JD786B008 Optical Hardware 

3
  

JD786B010 GPS Receiver and Antenna  
JD786B011 Interference Analyzer 

4,5
  

JD786B012 Channel Scanner  
JD786B013 Bluetooth Connectivity  
JD786B060 RFoCPRI 614M & 1.2G Interference Analyzer 

6
 (Requires option 08) 

JD786B061 RFoCPRI 2.4G Interference Analyzer 
6
 (Requires option 08) 

JD786B062 RFoCPRI 3.1G Interference Analyzer 
6
 (Requires option 08) 

JD786B063 RFoCPRI 4.9G Interference Analyzer 
6
 (Requires option 08) 

JD786B064 RFoCPRI 6.1G Interference Analyzer 
6
 (Requires option 08) 

JD786B065 RFoCPRI 9.8G Interference Analyzer 
6
 (Requires option 08) 

JD786B200 Calibration Service for Asia, North America 
JD786B201 Calibration Service for Latin America, EMEA 
JD786B250 Warranty extension of 1 year for Asia, North America 
JD786B251 Warranty extension of 1 year for Latin America, EMEA 

 
Standard Accessories 
JD70050326 AC/DC Power Adapter for JD700B Series 

7
 

G710550335 Cross LAN Cable (1.5 m) 
7
 

GC73050515 USB A to B Cable (1.8 m) 
7
 

GC72450518 > 1 G Byte USB Memory 
7
 

G710550325 Rechargeable Lithium Ion Battery 
7
 

G710550323 Automotive Cigarette Lighter 12 V DC Adapter 
7
 

G710550316 Stylus Pen 
7
 

JD700B361 JD700B Series User’s Guide and Application Software – CD 
  

1 
Requires calibration kit 

2 
Requires dual port calibration kit 

3 
Requires RFoCPRI options 

4 
Highly recommended adding JD786B010 

5 
Highly recommended adding G70005035x and/or G70005036x 

6 
Requires proper SFP/SFP+ transceiver and optical tap 

7 
Standard accessories can be purchased separately. 
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JD788B Signal Analyzer 

JD788B   
9 kHz to 8 GHz Spectrum Analyzer  
10 MHz to 8 GHz RF Power Meter Internal mode 
   
Options   
NOTE: Upgrade options for the JD788B use the designation JD788BU before the respective last three-digit option number. 
JD788B001 2-Port Transmission Measurements 

1
 (Requires option 07) 

JD788B003 High Power CW Signal Generator (Requires option 07) 
JD788B007 Signal Generator Hardware  
JD788B008 Optical Hardware 

2
  

JD788B009 20 MHz Demodulation Hardware  
JD788B010 GPS Receiver and Antenna  
JD788B011 Interference Analyzer 

3,4
  

JD788B012 Channel Scanner  
JD788B013 Bluetooth Connectivity  
JD788B020 cdmaOne/cdma2000 Signal Analyzer (Requires option 09) 
JD788B021 EV-DO Signal Analyzer (Requires options 09 and 20) 
JD788B022 GSM/GPRS/EDGE Signal Analyzer (Requires option 09) 
JD788B023 WCDMA/HSPA+ Signal Analyzer (Requires option 09) 
JD788B025 TD-SCDMA Signal Analyzer (Requires option 09) 
JD788B026 Mobile WiMAX Signal Analyzer (Requires option 09) 
JD788B028 LTE-FDD Signal Analyzer (Requires option 09) 
JD788B029 LTE-TDD Signal Analyzer (Requires option 09) 
JD788B030 LTE Advanced-FDD Signal Analyzer (Requires options 09 and 28) 
JD788B031 LTE Advanced-TDD Signal Analyzer (Requires options 09 and 29) 
JD788B040 cdmaOne/cdma2000 OTA Analyzer 

4
 (Requires options 09 and 10) 

JD788B041 EV-DO OTA Analyzer 
4
 (Requires options 09 and 10) 

JD788B042 GSM/GPRS/EDGE OTA Analyzer 
4
 (Requires options 09 and 10) 

JD788B043 WCDMA/HSPA+ OTA Analyzer 
4
 (Requires options 09 and 10) 

JD788B045 TD-SCDMA OTA Analyzer 
4
 (Requires options 09 and 10) 

JD788B046 Mobile WiMAX OTA Analyzer 
4
 (Requires options 09 and 10) 

JD788B048 LTE-FDD OTA Analyzer 
4
 (Requires options 09 and 10) 

JD788B049 LTE-TDD OTA Analyzer 
4
 (Requires options 09 and 10) 

JD788B060 RFoCPRI 614M & 1.2G Interference Analyzer 
5
 (Requires option 08) 

JD788B061 RFoCPRI 2.4G Interference Analyzer 
5
 (Requires option 08) 

JD788B062 RFoCPRI 3.1G Interference Analyzer 
5
 (Requires option 08) 

JD788B063 RFoCPRI 4.9G Interference Analyzer 
5
 (Requires option 08) 

JD788B064 RFoCPRI 6.1G Interference Analyzer 
5
 (Requires option 08) 

JD788B065 RFoCPRI 9.8G Interference Analyzer 
5
 (Requires option 08) 

JD788B200 Calibration Service for Asia, North America 
JD788B201 Calibration Service for Latin America, EMEA 
JD788B250 Warranty extension of 1 year for Asia, North America 
JD788B251 Warranty extension of 1 year for Latin America, EMEA 
   
Standard Accessories 
JD70050326 AC/DC Power Adapter for JD700B Series 

6
 

G710550335 Cross LAN Cable (1.5 m) 
6
 

GC73050515 USB A to B Cable (1.8 m) 
6
 

GC72450518 > 1 G Byte USB Memory 
6
 

G710550325 Rechargeable Lithium Ion Battery 
6
 

G710550323 Automotive Cigarette Lighter 12 V DC Adapter 
6
 

G710550316 Stylus Pen 
6
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1 
Requires dual port calibration kit 

2 
Requires RFoCPRI options 



Appendix 

544 JD700B Series User’s Guide 

3 
Highly recommended adding JD788B010 

4 
Highly recommended adding G70005035x and/or G70005036x 

5
 Requires proper SFP/SFP+ transceiver and optical pad 

6 
Standard accessories can be purchased separately. 

 

JD745B Base Station Analyzer 

JD745B   
100 kHz to 4 GHz Spectrum Analyzer  
5 MHz to 4 GHz Cable and Antenna Analyzer 

1
  

10 MHz to 4 GHz RF Power Meter Internal mode 
   
Options   
NOTE: Upgrade options for the JD745B use the designation JD745BU before the respective last three-digit option number. 
JD745B001 2-Port Transmission Measurements 

2
  

JD745B002 Bias Tee (Requires option 01) 
JD745B003 CW Signal Generator  
JD745B008 Optical Hardware 

3
  

JD745B010 GPS Receiver and Antenna  
JD745B011 Interference Analyzer 

4, 5
  

JD745B012 Channel Scanner  
JD745B013 Bluetooth Connectivity  
JD745B020 cdmaOne/cdma2000 Signal Analyzer  
JD745B021 EV-DO Signal Analyzer (Requires option 20) 
JD745B022 GSM/GPRS/EDGE Signal Analyzer  
JD745B023 WCDMA/HSPA+ Signal Analyzer  
JD745B025 TD-SCDMA Signal Analyzer  
JD745B026 Mobile WiMAX Signal Analyzer  
JD745B028 LTE-FDD Signal Analyzer  
JD745B029 LTE-TDD Signal Analyzer  
JD745B030 LTE Advanced-FDD Signal Analyzer (Requires option 28) 
JD745B031 LTE Advanced-TDD Signal Analyzer (Requires option 29) 
JD745B040 cdmaOne/cdma2000 OTA Analyzer 

5
 (Requires option 10) 

JD745B041 EV-DO OTA Analyzer 
5
 (Requires option 10) 

JD745B042 GSM/GPRS/EDGE OTA Analyzer 
5
 (Requires option 10) 

JD745B043 WCDMA/HSPA+ OTA Analyzer 
5
 (Requires option 10) 

JD745B045 TD-SCDMA OTA Analyzer 
5
 (Requires option 10) 

JD745B046 Mobile WiMAX OTA Analyzer 
5
 (Requires option 10) 

JD745B048 LTE-FDD OTA Analyzer 
5
 (Requires option 10) 

JD745B049 LTE-TDD OTA Analyzer 
5
 (Requires option 10) 

JD745B060 RFoCPRI 614M & 1.2G Interference Analyzer 
6
 (Requires option 08) 

JD745B061 RFoCPRI 2.4G Interference Analyzer 
6
 (Requires option 08) 

JD745B062 RFoCPRI 3.1G Interference Analyzer 
6
 (Requires option 08) 

JD745B063 RFoCPRI 4.9G Interference Analyzer 
6
 (Requires option 08) 

JD745B064 RFoCPRI 6.1G Interference Analyzer 
6
 (Requires option 08) 

JD745B065 RFoCPRI 9.8G Interference Analyzer 
6
 (Requires option 08) 

JD745B200 Calibration Service for Asia, North America 
JD745B201 Calibration Service for Latin America, EMEA 
JD745B250 Warranty extension of 1 year for Asia, North America 
JD745B251 Warranty extension of 1 year for Latin America, EMEA 
 
 

  

Standard Accessories 
JD70050326 AC/DC Power Adapter for JD700B Series 

7
 

G710550335 Cross LAN Cable (1.5 m) 
7
 

GC73050515 USB A to B Cable (1.8 m) 
7
 

GC72450518 > 1 G Byte USB Memory 
7
 

G710550325 Rechargeable Lithium Ion Battery 
7
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G710550323 Automotive Cigarette Lighter 12 V DC Adapter 
7
 

G710550316 Stylus Pen 
7
 

JD700B361 JD700B Series User’s Guide and Application Software – CD 
  

1 
Requires calibration kit 

2 
Requires dual port calibration kit 

3 
Requires RFoCPRI options 

4 
Highly recommended adding JD745B010 

5 
Highly recommended adding G70005035x and/or G70005036x 

6 
Requires proper SFP/SFP+ transceiver and optical tap. 

7 
Standard accessories can be purchased separately. 

 

JD746B RF Analyzer 

JD746B   
100 kHz to 4 GHz Spectrum Analyzer  
5 MHz to 4 GHz Cable and Antenna Analyzer 

1
  

10 MHz to 4 GHz RF Power Meter Internal mode 
   
Options   
NOTE: Upgrade options for the JD746B use the designation JD746BU before the respective last three-digit option number. 
JD746B001 2-Port Transmission Measurements 

2
  

JD746B002 Bias Tee (Requires option 01) 
JD746B003 CW Signal Generator  
JD746B008 Optical Hardware 

3
  

JD746B010 GPS Receiver and Antenna  
JD746B011 Interference Analyzer 

4,5
  

JD746B012 Channel Scanner  
JD746B013 Bluetooth Connectivity  
JD746B060 RFoCPRI 614M & 1.2G Interference Analyzer 

6
 (Requires option 08) 

JD746B061 RFoCPRI 2.4G Interference Analyzer 
6
 (Requires option 08) 

JD746B062 RFoCPRI 3.1G Interference Analyzer 
6
 (Requires option 08) 

JD746B063 RFoCPRI 4.9G Interference Analyzer 
6
 (Requires option 08) 

JD746B064 RFoCPRI 6.1G Interference Analyzer 
6
 (Requires option 08) 

JD746B065 RFoCPRI 9.8G Interference Analyzer 
6
 (Requires option 08) 

JD746B200 Calibration Service for Asia, North America 
JD746B201 Calibration Service for Latin America, EMEA 
JD746B250 Warranty extension of 1 year for Asia, North America 
JD746B251 Warranty extension of 1 year for Latin America, EMEA 

 
Standard Accessories 
JD70050326 AC/DC Power Adapter for JD700B Series 

7
 

G710550335 Cross LAN Cable (1.5 m) 
7
 

GC73050515 USB A to B Cable (1.8 m) 
7
 

GC72450518 > 1 G Byte USB Memory 
7
 

G710550325 Rechargeable Lithium Ion Battery 
7
 

G710550323 Automotive Cigarette Lighter 12 V DC Adapter 
7
 

G710550316 Stylus Pen 
7
 

JD700B361 JD700B Series User’s Guide and Application Software – CD 
  

1 
Requires calibration kit 

2 
Requires dual port calibration kit 

3 
Requires RFoCPRI options 

4 
Highly recommended adding JD746B010 

5 
Highly recommended adding G70005035x and/or G70005036x 

6 
Requires proper SFP/SFP+ transceiver and optical tap 

7 
Standard accessories can be purchased separately. 
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JD748B Signal Analyzer 

JD748B   
100 kHz to 4 GHz Spectrum Analyzer  
10 MHz to 4 GHz RF Power Meter Internal mode 
   
Options   
NOTE: Upgrade options for the JD748B use the designation JD748BU before the respective last three-digit option 
number. 
JD748B001 2-Port Transmission Measurements 

1
 (Requires option 07) 

JD748B003 CW Signal Generator (Requires option 07) 
JD748B007 Signal Generator Hardware  
JD748B008 Optical Hardware 

2
  

JD748B009 20 MHz Demodulation Hardware  
JD748B010 GPS Receiver and Antenna  
JD748B011 Interference Analyzer 

3,4
  

JD748B012 Channel Scanner  
JD748B013 Bluetooth Connectivity  
JD748B020 cdmaOne/cdma2000 Signal Analyzer (Requires option 09) 
JD748B021 EV-DO Signal Analyzer (Requires options 09 and 20) 
JD748B022 GSM/GPRS/EDGE Signal Analyzer (Requires option 09) 
JD748B023 WCDMA/HSPA+ Signal Analyzer (Requires option 09) 
JD748B025 TD-SCDMA Signal Analyzer (Requires option 09) 
JD748B026 Mobile WiMAX Signal Analyzer (Requires option 09) 
JD748B028 LTE-FDD Signal Analyzer (Requires option 09) 
JD748B029 LTE-TDD Signal Analyzer (Requires option 09) 
JD748B030 LTE Advanced-FDD Signal Analyzer (Requires options 09 and 28) 
JD748B031 LTE Advanced-TDD Signal Analyzer (Requires options 09 and 29) 
JD748B040 cdmaOne/cdma2000 OTA Analyzer 

4
 (Requires options 09 and 10) 

JD748B041 EV-DO OTA Analyzer 
4
 (Requires options 09 and 10) 

JD748B042 GSM/GPRS/EDGE OTA Analyzer 
4
 (Requires options 09 and 10) 

JD748B043 WCDMA/HSPA+ OTA Analyzer 
4
 (Requires options 09 and 10) 

JD748B045 TD-SCDMA OTA Analyzer 
4
 (Requires options 09 and 10) 

JD748B046 Mobile WiMAX OTA Analyzer 
4
 (Requires options 09 and 10) 

JD748B048 LTE-FDD OTA Analyzer 
4
 (Requires options 09 and 10) 

JD748B049 LTE-TDD OTA Analyzer 
4
 (Requires options 09 and 10) 

JD748B060 RFoCPRI 614M & 1.2G Interference Analyzer 
5
 (Requires option 08) 

JD748B061 RFoCPRI 2.4G Interference Analyzer 
5
 (Requires option 08) 

JD748B062 RFoCPRI 3.1G Interference Analyzer 
5
 (Requires option 08) 

JD748B063 RFoCPRI 4.9G Interference Analyzer 
5
 (Requires option 08) 

JD748B064 RFoCPRI 6.1G Interference Analyzer 
5
 (Requires option 08) 

JD748B065 RFoCPRI 9.8G Interference Analyzer 
5
 (Requires option 08) 

JD748B200 Calibration Service for Asia, North America 
JD748B201 Calibration Service for Latin America, EMEA 
JD748B250 Warranty extension of 1 year for Asia, North America 
JD748B251 Warranty extension of 1 year for Latin America, EMEA 
   
Standard Accessories 
JD70050326 AC/DC Power Adapter for JD700B Series 

6
 

G710550335 Cross LAN Cable (1.5 m) 
6
 

GC73050515 USB A to B Cable (1.8 m) 
6
 

GC72450518 > 1 G Byte USB Memory 
6
 

G710550325 Rechargeable Lithium Ion Battery 
6
 

G710550323 Automotive Cigarette Lighter 12 V DC Adapter 
6
 

G710550316 Stylus Pen 
6
 

JD700B361 JD700B Series User’s Guide and Application Software – CD 
  

1 
Requires dual port calibration kit 
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2 
Requires RFoCPRI options 

3 
Highly recommended adding JD748B010 

4 
Highly recommended adding G70005035x and/or G70005036x 

5
 Requires proper SFP/SFP+ transceiver and optical pad 

6 
Standard accessories can be purchased separately. 

 

JD700B Series Common Options 

Optional RF Power Sensors 
JD731B Directional Power Sensor. Peak and Average power 300 to 3800 MHz 
JD732B Terminating Power Sensor. Average Power 20 to 3800 MHz 
JD733A Directional Power Sensor. Peak and Average power 150 to 3500 MHz 
JD734B Terminating power sensor, Peak Power 20 to 3800 MHz 
JD736B Terminating power sensor, Dual (Average/Peak) power 20 to 3800 MHz 
  
  
Optional Optical Power Meters 
MP-60A USB Optical Power Meter, with software, 2.5 mm and 1.25 mm interfaces,  

30" USB extender, carrying pouch 
MP-80A USB Optical Power Meter-High Power, with software, 2.5 mm and 1.25 mm interfaces, 

30" USB extender, carrying pouch 
  

 
Optional Calibration Kits 
JD78050509 Y- Calibration Kit Type-N(m), DC to 6 GHz, 50 Ω 
JD78050510 Y- Calibration Kit DIN(m), DC to 6 GHz, 50 Ω  
JD78050507 Dual Port Type-N 6 GHz Calibration Kit 
JD78050508 Dual Port DIN 6 GHz Calibration Kit 

 
 

Optional Fiber Microscope Kits 
FBP-SD101 FBP-P5000i Digital Probe, FiberChekPRO SW, Case, and Tips 
FBP-MTS-101 FBP-P5000i Digital Probe, FiberChekPRO SW, Case, and Tips 
FIT-SD103 FBP-P5000i Digital Probe, MP-60 USB Power Meter, FiberChekPRO SW, Case, Tips and 

Adapters 
FIT-SD103-C FBP-P5000i Digital Probe, MP-60 USB Power Meter, FiberChekPRO SW, Case, Tips and 

Adapters 
FIT-SD113 FBP-P5000i Digital Probe, MP-60 USB Power Meter, FiberChekPRO SW, Case, Tips and 

Adapters 
 
 

Optional RF Cables 
G710050530 RF Cable DC to 8 GHz Type-N(m) to Type-N(m), 1.0 m 
G710050531 RF Cable DC to 8 GHz Type-N(m) to Type-N(f), 1.5 m 
G710050532 RF Cable DC to 8 GHz Type-N(m) to Type-N(f), 3.0 m 
G710050533 RF Cable DC to 18 GHz Type-N(m) to SMA(m), 1.5 m 
G710050534 RF Cable DC to 18 GHz Type-N(m) to QMA(m), 1.5 m 
G710050535 RF Cable DC to 18 GHz Type-N(m) to SMB(m),1.5 m 
G710050536 RF Cable DC to 6 GHz Type-N(m) to DIN(f), 1.5 m 
G700050540 Phase-Stable RF Cable w Grip DC to 6 GHz Type-N(m) to Type-N(f), 1.5 m 
G700050541 Phase-Stable RF Cable w Grip DC to 6 GHz Type-N(m) to DIN(f), 1.5 m 

 
  
Optional RF Omni Antennas 
G700050353 RF Omni Antenna  Type-N(m), 806 MHz to 896 MHz 
G700050354 RF Omni Antenna  Type-N(m), 870 MHz to 960 MHz 
G700050355 RF Omni Antenna  Type-N(m), 1.71 GHz to 2.17 GHz 
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G700050356 RF Omni Antenna  Type-N(m), 720 MHz to 800 MHz 
G700050357 RF Omni Antenna  Type-N(m), 2.3 GHz to 2.7 GHz 

 
 

Optional RF Yagi Antennas 
G700050363 RF Yagi Antenna  Type-N(f), 1.75 GHz to 2.39 GHz, 9.8 dBd 
G700050364 RF Yagi Antenna  Type-N(f), 806 MHz to 896 MHz, 10.2 dBd 
G700050365 RF Yagi Antenna  Type-N(f), 866 MHz to 960 MHz, 10.2 dBd 
G700050366 RF Yagi Antenna  SMA(f), 700 MHz to 4 GHz, 1.85 dBd 

 
 

Optional RF Adapters 
G700050571 Adapter Type-N(m) to DIN(f), DC to 7.5 GHz, 50 Ω 
G700050572 Adapter DIN(m) to DIN(m), DC to 7.5 GHz, 50 Ω 
G700050573 Adapter Type-N(m) to SMA(f) DC to 18 GHz, 50 Ω 
G700050574 Adapter Type-N(m) to BNC(f), DC to 4 GHz, 50 Ω 
G700050575 Adapter Type-N(f) to Type-N(f), DC to 18 GHz, 50 Ω 
G700050576 Adapter Type-N(m) to DIN(m), DC to7.5 GHz, 50 Ω 
G700050577 Adapter Type-N(f) to DIN(f), DC to 7.5 GHz, 50 Ω 
G700050578 Adapter Type-N(f) to DIN(m), DC to 7.5 GHz, 50 Ω 
G700050579 Adapter DIN(f) to DIN(f), DC to 7.5 GHz, 50 Ω 
G700050580 Adapter Type-N(m) to Type-N(m), DC to 11 GHz, 50 Ω 
G700050581 Adapter N(m) to QMA(f), DC to 6.0 GHz, 50 Ω 
G700050582 Adapter N(m) to QMA(m), DC to 6.0 GHz, 50 Ω 
  

 
StrataSync Subscription 
SS-CA-BSA-AM-01 StrataSync for CellAdvisor BSA - Asset Management-1 Yr. 
SS-CA-BSA-TDM-01 StrataSync for CellAdvisor BSA - Test Data Management-1 Yr. 
SS-CA-RFA-AM-01 StrataSync for CellAdvisor RFA - Asset Management-1 Yr. 
SS-CA-RFA-TDM-01 StrataSync for CellAdvisor RFA - Test Data Management-1 Yr. 
SS-CA-SA-AM-01 StrataSync for CellAdvisor SA - Asset Management-1 Yr. 
SS-CA-SA-TDM-01 StrataSync for CellAdvisor SA - Test Data Management-1 Yr. 

 
 

Optional Miscellaneous 
G710050581 Attenuator 40 dB, 100 W, DC to 4 GHz (Unidirectional) 

G710050585 
RF Directional Coupler, 700 to 4000 MHz, 30 dB, 50 W 
Input/Output; Type-N(m) to Type-N(f), Tap Off; Type-N(f)

 1
 

G710050586 RF combiner, 700 to 4000 MHz, Type-N(f) to Type-N(m)
 1

 
G710050587 4x1 RF combiner, 700 to 4000 MHz, Type-N(f) to Type-N(m)

 2
 

JD74050341 Soft carrying case 
JD71050342 Hard Carrying Case 
JD70050342 Hard Carrying Case with wheels 
JD70050343 CellAdvisor Backpack Carrying Case 
JD70050006 USB Bluetooth Dongle and 5 dBi Dipole Antenna 
G710550324 External Battery Charger 
JD700B362 JD700B Series User’s Guide – Printed Version 

 

1 
Highly recommended for LTE testing 

2 
Highly recommended for LTE Advanced testing  
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Appendix J – RoHS information 

This appendix describes the RoHS (Restriction of Hazardous Substances) information, which is a mandatory 
requirement from China. The RoHS directive consists in the restriction on the use of certain hazardous 
substances in electrical or electronic equipment sold or used in the European Union, after July 1, 2006. These 
substances are: lead, mercury, cadmium, hexavalent chromium, polybrominated biphenyls, and polybrominated 
diphenyl ethers. 
 

JD780B series 
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JD740B series 

 
  



Appendix 

 JD700B Series User’s Guide 551 

Appendix K – On-screen keyboard 

You can use the on-screen keyboard to type in texts, file names, and folder names. 
 

Adding or deleting letters 

Procedure 

8 Tap keys on the on-screen keyboard. As you type, each letter is displayed in the name field. If 
you want to change the letter case between uppercase and lowercase, tap the Caps key. 

9 To delete a letter, tap the Back key on the keyboard or press the backspace key on the keypad. 
10 To move the cursor along the name field, tap the < or > key, turn the rotary knob, or touch in 

between letters in the name field. 
11 To delete all the letters displayed in the name field, tap the Clear key on the on-screen keyboard. 

 
Figure 288 On-screen keyboard 

 
 

Editing or adding a custom keyword 

You can edit and delete a keyword or add a new one, as you desire. 

Procedure 

1 Tap the Edit Keywords bar on the on-screen keyboard. 
The edit keywords keyboard appears. 

2 To edit a keyword, select the keyword box and then change the letters. 
3 To delete a keyword, select the keyword box and then tap the Clear key. 
4 To add a keyword, select a blank keyword box and then type in a keyword. 
5 Tap the Save key on the keyboard to save and continue saving. 
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Figure 289 Edit keywords keyboard 

 
 

Appending a keyword 

You can append a factory-stored or custom-defined keyword, as you want. 
 

Procedure 

1 Tap the Append Keywords bar on the on-screen keyboard. 
The append keywords window appears. 

2 To append a keyword, complete the following steps: 
 Select the keyword tag button to view available keywords for the tag. a
 Select one keyword, from the following choices for each keyword tag: b

 

Keyword tag Keyword (tag value) 

Site-ID* SiteA, SiteB, and SiteC 

Sector* Alpha, Beta, and Gamma 

Technology* GSM900, WCDMA850, and LTE180 

Test Type* RL, VSWR, DTF-RL, DTF-VSWR, and CL 

Termination* Open, Load, and Antenna 

Custom Any keywords you have added 
 

 To delete the keyword you have added to the keyword field, tap the Delete button. c
 To clear the keyword field, tap the Clear button. d

3 Optional. You can edit any of the custom keyword tags or tag values by tapping the Edit Tags 
Values or Edit Tags button, but not the factory keyword tags marked with the asterisk (*). 

 

 NOTE 
You must keep the keywords marked with the asterisk (*) intact as the StrataSync 
server uses them when transferring data. 

 

4 Select the Separator option from the choices: hyphen [-], underscore [_], and None. 
5 Select the As a filename option between On and Off. If you select Off, the keyword will not be 

placed in a file name, but in the trace/PNG file information. 
6 Tap the Save and Exit button to save and exit or the Keyboard button to return to the keyboard. 
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Figure 290 Append keywords window 
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